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Configuration and Implementation Tools, for multiple tools; download now for

offline access.

i

\ ¥ F 3
AN

\
* c 000NN

..'. o
o
@
L
#
L]

+ 9OV
. o 990N !

EYYIIIIIRIY L

PIantPAX Distributed Control

System Configuration and
Implementation

System Release 5.10

D Allen-Bradley

h
by ROCKWELL AUTOMATION

USEI’ Manual Original Instructions


https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/1128051

PlantPAx Distributed Control System Configuration and Implementation User Manual

Important User Information

Read this document and the documents listed in the additional resources section about installation, configuration, and
operation of this equipment before you install, configure, operate, or maintain this product. Users are required to familiarize
themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, and standards.

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are required to
be carried out by suitably trained personnel in accordance with applicable code of practice.

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be
impaired.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use
or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability for
actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software
described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., is
prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

may lead to personal injury or death, property damage, or economic loss.

ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property damage,

ﬁ WARNING: |dentifies information about practices or circumstances that can cause an explosion in a hazardous environment, which
A or economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence.

IMPORTANT Identifies information that is critical for successful application and understanding of the product.

These labels may also be on or inside the equipment to provide specific precautions.

SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous voltage
may be present.

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may reach
dangerous temperatures.

ARC FLASH HAZARD: Labels may be on or inside the equipment, for example, a motor control center, to alert people to potential Arc
Flash. Arc Flash will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL Regulatory
requirements for safe work practices and for Personal Protective Equipment (PPE).

B> B>

The following icon may appear in the text of this document.

C ; Identifies information that is useful and can help to make a process easier to do or easier to understand.
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Preface

I About This Publication Welcome to the PlantPAx® system, a modern DCS platform that is designed to
provide the right data to the right person at the right time.

This manual helps you implement process control where controllers, HMI, and
I/O are located in different areas of the plant. The PlantPAx system offers
flexibility, using the latest technology and scalability to build only what you
need to help reduce development time, downtime, and operational cost.

i Y 1 Download firmware, associated files (such as AOP, EDS, and DTM), and access
Download Firmware, AOP, load fi dfil h d d
H product release notes from the Product Compatibility and Download Center at
EDS, and Other Files B e o

I summary of Changes This publication contains the following new or updated information. This list
includes substantive updates only and isn’t intended to reflect all changes.
Topic Page
Updated Figure 1 17
Updated Figure 2 18
Updated Define Areas 63
Updated Configure Runtime Security 3
Updated Redundant PRP Topology 97
Updated Resilient DLR Topology 101
Updated Time Synchronization 107
Updated Configure UTC Time Source 108
Updated Configure PTP Time Synchronization for Ethernet Bridges m
Updated Figure 15 148
Updated Figure 16 148
Updated Figure 17 149
Updated Figure 18 150
Updated Figure 19 150
Updated Figure 20 151
Added Electrical Protection Devices Integration (IEC 61850) 152
Updated information in Appendix A for CIP Security™. 257
Added guidance on integrating FactoryTalk® secure remote access to PlantPAX 266
Updated Appendix C checklist item numbers 273

The following table lists the documentation resources that are available to help
procure, configure, and maintain a PlantPAx system.

Table 1- PlantPAx System Documentation

Stage Publication Description
Define and Procure | Selection Guide, publication PROCES-SG001 Helps you understand the elements of the PlantPAx system to make sure
D that you buy the proper components.
Install Template User Manual, publication 9528-UM001 Provides direction on how to install and deploy PlantPAx virtual templates.
Provides system guidelines and instructions to assist with the development

Configuration and Implementation User Manual, publication PROCES-UM100 of your PlantPAx system.

Develop and Operate Rockwell Automation Library of Process Objects Reference Manual,

publication PROCES-RM200 Describes the Add-On Instructions, PlantPAx instructions, and associated

faceplates that are available to develop applications.

| You can view or download publications at rok.auto/literature.
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http://literature.rockwellautomation.com/idc/groups/literature/documents/um/9528-um001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/proces-um100_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm200_-en-p.pdf
www.rockwellautomation.com/literature

Software and Firmware
Updates

Rockwell Automation
Services and Support

12

When you update software or firmware revisions, we recommend that you
verify the impact on performance and memory utilization before
implementing the upgrade on the production system. For FactoryTalk® View
or ControlLogix® platforms, we recommend that you review the release notes
and verify the impact of the upgrade on performance and memory utilization.

You can also verify the compatibility of an upgrade with the other software and
operating systems in use in your PlantPAx system. See the

Product Compatibility and Download Center.

System Support offers technical assistance that is tailored for control systems.
Some of the features include the following:

« Highly experienced team of engineers with training and
systems experience

« Process support at a systems-level that is provided by process engineers
« Use of online remote diagnostic tools

. Access to otherwise restricted TechConnect>™ Knowledgebase content

« 24-hour, 7 days per week, 365 days per year of phone-support coverage
upgrade option

For more information, contact your local distributor or Rockwell Automation

representative or see http://www.rockwellautomation.com/support.
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Chapter ]

System Workflow

The PlantPAx® distributed control system is an integrated control and
information solution that helps manufacturers achieve Plant-wide
Optimization in a wide range of industries. This single platform can run your
entire plant and integrates all HMI, controls, optimization, engineering,
information, and inputs/outputs into one common system architecture.

The following workflow shows the steps for how to size, design, and
implement a scalable PlantPAx system. Click the links for the information that
is related to each step.

1. Use the PlantPAx System Estimator (part of the Integrated
Architecture® Builder tool) to size your application.

Size Your System

Smaller System
(PASS-C + OWS-
1S0)

Larger System
(PASS + Application
Servers)

2. Manage servers and security paolicies.

«  Smaller systems = Work Group

« Larger systems = Domain Controllers

See Configure System Security Features User Manual, SECURE-UMOO1,
for security configurations

3. Configure the Process Automation System Server (PASS).

« Smaller systems = PASS-C + OWS-ISO

« Larger systems = Virtual templates

See PlantPAx Virtualization User Manual, 3528-UMOO, for template details

4. Design the Network Infrastructure
« Select network topologies
« Configure switches

Work Group

Virtual
Templates

Core, Distribution, and Access Switches

(continued)
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Chapter 1 System Workflow

(previous)

Engineering Wi¥kstation (EWS)

*—@

5. Develop the Process Applications.

« HMI displays (based on the PlantPAx graphic framework guidelines) Logix 5000 Process Controller
« Controller logic (control strategies using the embedded PlantPAx instructions and -
Add-On Instruction)
[ | |

o Alarms

6. Add additional servers for application-specific needs.
«  Smaller systems = all application servers on PASS-C Application Servers
« Larger systems = each application server is separate « Asset management

« Batch management

l « Analytics

7. Deploy your application to clients.
For more information, see Rockwell Automation Library of Process Objects
Reference Manual, PROCES-RM200

Example PlantPAx System

Operator Workstations (OWS)

Operator Workstations (OWS)
Engineering Workstations (EWS)

Application Servers (AppServ)
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Chapter 1 System Workflow

Size Your System

Rockwell Automation includes the PlantPAx System Estimator (PSE) tool as
part of the Integrated Architecture® Builder software. The PSE Estimator tool
helps define your PlantPAx system and verifies that your architecture and
system elements are sized properly. The PSE includes online help that can
assist you as you use the tool.

The PSE employs sizing guidelines that are based on the rules and
recommendations from PlantPAx system characterization to achieve known
performance and reliability. The PSE focuses on the critical system attributes
of a PlantPAx system so you can verify that your system does not exceed system
recommendations.

Before you run the PSE, you must plan the scope of your project so that you
know the I/O requirements. This could be an equipment list or project
database of devices. For more information, see Chapter 5, Process
Applications.

Make sure that your PSE project has no errors. As much as possible, the project
should accurately represent the physical layout of the system, such as the
controllers, I/O, HMI, and data servers. The I/O locations and control rooms
must align with your architectural drawings.

« Ifyousize based on I/O counts, the PSE makes assumptions as to the
devices that I/O is connected to and assigns the I/O to control strategies.

« Ifyouknow the devices, the PSE results are more accurate if you size
based on control strategies.

« Make sure that the logic execution rates accurately represent the
requirements of the process.

« Reserve memory and CPU utilization in the controller for auxiliary logic
(such as logic for batch applications).

« Accurately account for the process and device networks that are defined
in the PSE. Also account for any networks not defined in the PSE.

«  Make sure that your final controller programs execute at the same rate as
entered in to the PSE to make sure that the system performs as expected.

The final PSE project only accounts for devices, not the programming that
automates the devices. Extra programming can include batch, recipe control,
or sequencing of any other logic used in the system. Make sure to consider any
extra programming so that the system does not overload the controller.

IMPORTANT  The PSE, along with the IAB, gives you a high-level Bill of Materials.
You must complete your own panel design to house, mount, and
power the equipment for your environmental needs.
Pre-engineered enclosures for PlantPAx systems are available from
Rockwell Automation.
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Select the Process
Automation System Server

16

Use the sizing results from the PSE, the number of I/O points, and the overall
size of the process to determine the Process Automation System Server (PASS)
that best suits your PlantPAx system.

The PASS is the main component for PlantPAx computing. A PASS supports an
HMI server, displays, alarms, and data connections to controllers. A PASS
contains the following:

« FactoryTalk® Directory and Activation server
« FactoryTalk® View SE HMI server

« FactoryTalk® Alarms and Events server

« FactoryTalk® Linx Data server

« FactoryTalk® Historian node interface

A PASS is scalable from a single standalone server to multiple distributed
servers. You can deploy a PASS directly to a host computer or run as a virtual
guest on a host server.

The sizing recommendations help determine how to best deploy the software
for your PlantPAx system:

« Smaller systems (typically less that 2000 I/O points) place all system
software on a consolidated Process Automation System Server (PASS-C)
with multiple operator workstations (OWS-ISO)

Examples include skid, station, and distributed architectures where a
single PASS-C supports the system.

« Larger systems use a Process Automation System Server (PASS), in
addition to individual application servers (AppServ), engineering
workstations (EWS), and operator workstations (OWS).

Larger systems are typically distributed architectures with multiple PASS
servers.

Consolidated Process Automation System Server (PASS-C)

The consolidated Process Automation System Server (PASS-C) supports
smaller systems, such as skids or stations, where the system software runs on
only a few computers. The PASS-C offers reduced complexity and cost.

A PASS-C computer can be manually installed and configured or is available as
apre-configured .ISO image. The .ISO image installs a server-based Windows®
operating system and contains pre-installed FactoryTalk server software. The
PASS-C is intended to support up to 10 OWS clients

Similar to the PASS-C, an operating workstation OWS-ISO image is also
available. This image installs a client-based Windows operating system that
contains the required FactoryTalk client software.

Figure 1illustrates a small PlantPAx system with a PASS-C that runs all of the
FactoryTalk software and an OWS-ISO that provides a client interface.
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PASS-C

FactoryTalk Directory

FactoryTalk Activation server

» FactoryTalk Security

« Alarm and Event server

HMI server
Data server

SOL server

FactoryTalk Historian server
« FactoryTalk AssetCentre server

Figure 1- Smaller PlantPAx Systems with Single PASS-C Server

)

0OWS-IS0 (optional)

For more information, see the PASS-C chapter in the PlantPAx Template User
Manual, publication 9528-UMoo1.

Process Automation System Server (PASS)

The Process Automation System Server (PASS) supports larger, distributed
systems or customer-defined, critical processes. Whenever possible, use
virtualization to provide greater computing efficiency, enhanced backup and
recovery capability, and to offer high availability with server redundancy.

PlantPAx virtual images are available for PASS and application servers to run
on server-based computer hardware with a hypervisor, such as VMware ESXi.
The PlantPAx virtual images are deployed from templates and contain a
Windows operating system along with pre-installed FactoryTalk software. The
virtual images help:

« Reduce installation time and increase consistency with drop-in virtual
machines with pre-configured system elements

« Enable the consolidation of computing resources that multiple operating
systems and applications can share a single physical server

« Support flexibility and portability across hardware platforms

For configuration details, see the PlantPAx Template User Manual, publication
9528-UMOOLI.

Figure 2 illustrates a larger PlantPAx system, with two PASS computers and
supporting application servers, in a network distributed architecture.

« PASS_O1 server contains the FactoryTalk Network Directory, Security
configuration and often hosts FactoryTalk® Activation licenses.

« PASS_0z2 server contains FactoryTalk View SE (HMI server, data server, and
alarms server) and optional ThinManager® server.

« Anoptional PASS_o3 server could be a secondary (HMI, data, and alarms
server) that would switch over if PASS_02 was unreachable.

« AppServ_Info server contains a Factory Historian SE server and a local
Historian database.

« Anoptional AppServ_Infoz server could be a redundant FactoryTalk
Historian SE server, as part of a collective. In this configuration, the
Historian database would be hosted on a separate computer that both
could access.

- AppServ_Asset server contains FactoryTalk® AssetCentre for system
tracking and verification.

« AppServ_Batch server contains FactoryTalk® Batch software to handle
large batching processes.
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Figure 2 - Large PlantPAx Systems with Multiple Servers

PASS_01:

« FactoryTalk Directory P -

« FactoryTalk Activation server

AppServ_Info:
o SQOL server

« FactoryTalk Security

PASS_02:

«  HMI server
« Data server
PASS_03 « Alarms server

« FactoryTalk Historian server

= AppServ_Asset:
22 « FactoryTalk AssetCentre server

AppServ_Batch:
» FactoryTalk Batch server

Redundant o « FactoryTalk Live Data server
« ThinManager server

Next Steps

Once you have sized your system and decided on whether to use a PASS-C or

PASS, complete the following:

1.

Manage Servers and Security Policies

A Domain Controller is recommended for most PlantPAx systems,
however, in smaller systems a Workgroup can be sufficient.

For more information, see Chapter 2, Domain or Workgroup
Configure the Process Automation System Server

For more information, Chapter 3, Process Automation System Server
Design Network Topologies and Configure Switches

The PlantPAx system supports several network topologies to meet
various system requirements. Each topology is based on system
characterization tests to help ensure system performance.

For more information, see Chapter 4, Network Infrastructure
Develop Process Applications

Process applications implement control strategies that encompass
control logic and HMI displays.

Execute control logic on Logix 5000™ process controllers. The process
controller comes with a default task model and embedded PlantPAx
instructions that improve design and deployment efforts. The process
controller is also conformal-coated for protection from dust and
corrosive pollutants.

Deploy HMI displays for operators and maintenance personnel so they
can monitor and maintain the system.

For more information, see Chapter 5, Process Applications
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Add Application Servers

PlantPAx application servers (AppServ) manage system software that
is required for your application. There can be multiple servers
depending on the size and structure of your application.

Table 2 - System Server Descriptions

AppServ Elements Description

The asset management server acts as a centralized tool for managing automation-
related asset information (both Rockwell Automation and third-party assets). The

AppServ-Asset asset management application server includes capabilities for source control,

audits, change notifications, reporting, and security.
For more information, see Chapter 6, Asset Management.

AppServ-Info (Historian, SOL)

Data management storage can include a Historian or SQL server. These two servers
depend on the function that is being provided: FactoryTalk Historian software or a
SOL server.

For more information, see Chapter 7, Historical Data.

The batch application server provides comprehensive batch management,
including unit supervision, recipe management, process management, and material

AppServ-Batch management. The batch application server can be linked with visualization

elements on the OWS and configuration clients on the EWS.
For more information, see Chapter 8, Batch Management.

Guidelines for Servers and Workstations

The following guidelines for servers and workstations are already
implemented in the PlantPAx templates. If you create custom VMs, follow
these guidelines to align with PlantPAx configurations.

Install the latest software patches for all Rockwell Automation software.

The Patch File Validator utility verifies software versions on your system
and installs a patch roll-up. To download, see the Knowledgebase

Technote Patch File Validator Utility.
Disable power-saving for the Network Interface Card (NIC).

The NIC card connects a workstation to other devices on the network.
The power-saving feature turns off the network card when not in use,
which can interfere with network throughput.

Disable power-saving for the Windows operating system.

The power-saving feature turns off Windows features when not in use,
which can interfere with network throughput.

Enable Remote Desktop Server (RDS) functionality on application
servers that need remote access, such as the AppServ-EWS or AppServ-
OWS (available via templates).

RDS enables multiple instances of the OWS and EWS as thin clients from
one server. Thin clients can run applications and process dataon a
remote computer to minimize the amount of information on a network.

Enable Adjust for Best Performance so that Windows features that are
not is use are turned off, which yields more memory and performance
for the system.

Make sure that the user is never notified by the User Account Control.

Disable automatic Windows updates. This helps prevent updates that
haven’t been qualified by Rockwell Automation from being installed on
the workstation or server.

The only exception is if your organization has a controlled patching
process to verify updates on a non-production system, or when a facility
1s non-active, to reduce the chance of any unexpected results or side
effects.
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PlantPAx System ID The PlantPAx system ID is a unique identifier that helps simplify the
management of your system over its lifecycle. The System ID creates a record
of the installed products in your system and provides a dashboard that shows
the hardware lifecycle status, notifications of updates and patches, and
compatibility information. Use this information to:

« Plan spare and replacement parts to better size inventory
« Define the boundaries of the system
« Plan when and where to implement system upgrades

Search Manage Browso

Automaltion

Lifecycle Change Summary

ATURE END OF LIFE DISCOMTINUET UNVERIFIED

1 3 2
17% e 50% : 33%
3 4 2

PROCESSIN.

| | gt

LOCATION MACHINE LIFECYCLE PANE  MODIFIED
STATUS

LOTY, DATE

The system ID is only available if you purchase a PlantPAx catalog number. The
catalog number determines an activation string for the software products on
the bundle. This activation string (serial number) is the system ID.

The System Integrator uses an Asset Inventory Agent in a FactoryTalk
AssetCentre project to generate an inventory file (.raai file). The System ID is
gathered via the license number of FactoryTalk AssetCentre via FactoryTalk
Activation Manager. The System Integrator registers your System ID with
Rockwell Automation and provides you directions on how to access your
MyEquipment portal.
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System Verification A critical system attribute is a visible performance indicator of a system-wide
characteristic. Critical system attributes do the following:

« Determine system limits

« Establish system rules

« Establish system recommendations

« Measure system element and system infrastructure performance

The following critical system attributes are used to verify PlantPAx system
characterization.

Table 3 - CSA Performance Indicators

Critical System Attribute Performance

A noncached display is called up by the operator and ready for operator use

Display callup (paint time) within 2 seconds.

Display update The display updates control information within 1 second.
Steady state alarm time 2;%?)% state alarms occurring at 20 per second are timestamped within 1
Alarm burst time All alarms in a burst of 2000 alarms are timestamped within 3 seconds.

A system element returns to full operation within 5 minutes of the restoration
after a failure or loss.

Operator-initiated actions are loaded into the controller and the feedback for
the operator action is within 2 seconds.

Batch server: operator action time An operator batch command has been acted on by the controller in 1second.
Batch server: server action time A server batch command has been acted on by the controller in 1second.
Batch server: controller action time | Batch status events display on the operator workstation within 1second.

Recovery

Operator-initiated control

For a complete system verification, use the guidelines in Appendix C, PlantPAx
Deployment Recommendations and Verification Tool.
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Notes:
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Chapter 2

Domain or Workgroup

PlantPAx® systems require computer management, from either a domain
controller or workgroup configuration, for secure interaction.

A Windows® domain is a collection of computers that share rules and
procedures. These computers comprise a central directory database,
which is the Active Directory. The sharing of network objects creates a
unified base to manage users, groups, and security settings

A Windows workgroup computer is independently configured.
Workgroups are only suitable in smaller systems with 10 or fewer
computers.

The following is the recommended workflow to configure a domain controller
or workgroup. For experienced users, each step outlines requirements. For
more detailed information, follow the referenced links.

A

Siep 1: Configure the Domain Controller or a Workgroup

In larger systems, create a dedicated domain controller for the PlantPAx
system. If your control system contains an existing domain controller, add the
configuration that is recommended for a PlantPAx system. Domain controller
components include:

Microsoft Windows Server operation system

Active Directory Domain Services, DHCP, and DNS Server Roles.
Parent and child domains

Reverse DNS Lookup Zone.

Configure DHCP server options and authorize server.

For more information, see Primary Domain Controller.

Windows Workgroups are available for small systems that do not require
complex security controls. Considerations when using a workgroup include:

There are typically no more than 10 computers.
All computers must be on the same local network or subnet.
All computers are peers; no computer has control over another computer.

Each computer has a set of user accounts. To login to any computer in
the workgroup, you must have an account on that computer.

A workgroup isn’t protected by a centrally-managed password.

For more information, see Windows Workgroup.
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Q

Step 2: Configure a Redundant Domain Controller

If needed, create a redundant domain controller for high availability.
Considerations for the redundant domain controller include:

« The redundant domain controller has a unique name and IPv4 address.

« Install the Active Directory Domain Services role and promote to domain
controller.

« Add the Directory Services Restore Mode (DSRM) password.

For more information, see Additional Domain Controller.

Q

Step 3: Create Roles, Areas, and Users

There are required roles for a PlantPAx system. Areas and users depend on
your application. Assign users to Roles and Areas.

The PlantPAx Roles are:
« PlantPAx Administrator
« PlantPAx Engineering
« PlantPAx Maintenance
. PlantPAx Maintenance Supervisor
« PlantPAx Manager
« PlantPAx Operator
« PlantPAx Operator Supervisor

Name areas based on access, for example:
« Areaol_Advanced (engineering access)
« Areaol_Basic (non-engineering access)

Replace ‘Areaor’ with the name of your process area.

For more information, see Create Roles, Areas, and Users.
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O

Step 4: Configure Group Policies

Prerequisites

Workgroup Domain .
=
D ! T

|

Configure recommended group policies for a PlantPAx system, such as:
«  Windows NTP client
«  Windows time service

For more information, see Configure Group Policy Management.

Configure recommended security policies, such as password strength, account
lockout, Kerberos, and interactive logon.

For more information, see Configure Group Policies.

Create a PlantPAx user policy that limits access to USB drives, portable devices,
and other software.

For more information, see PlantPAx Users Policy Object.

Following the System Workflow, configure a domain controller or a
workgroup, depending on the size of your system.

The PlantPAx architecture assumes that there’s a Microsoft Windows forest in
place to host a supervisory and/or control domain network.

«  Youneed at least one domain controller per each parent/root/child
domain.

« The domain controllers are separate computers.
«  Youneed at least two domain controllers for fault tolerance.
« Do notload any application software on a domain controller.

« The domain controllers must be local (within the firewall) to the
PlantPAx system.
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Primary Domain Controller
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We recommend that PlantPAx servers and workstations be members of a
Windows domain. However, workgroups are supported for systems with 10 or
fewer workstations and servers.

Configuration

Details

Workgroup - decentralized administration
(allowed if 10 or fewer computers)

Workgroup advantages:

« No domain controller (Windows Server 0S) to purchase or maintain.

« Recommended for small PlantPAx applications only where user
accounts do not change often

Workgroup rules:

« All workstation and server system elements in a single PlantPAx
system must be members of the same workgroup

« All users participating in the workgroup must be members of the
Administratars group

« Create the same set of user accounts and passwords on every
computer in a FactoryTalk® View application

Domain - centralized administration
(recommended)

Domain advantages:

« Centralized administration of users, policies, and security

« High availability, when both primary and secondary domain controller
are used.

« Recommended for larger systems to provide the best system
performance.

Domain rules:

« Al workstation and server system elements in a single PlantPAx
system must be members of the same domain

« PlantPAx server system elements must not be used as domain
controllers.

« Required for systems with more than 10 computers

« The domain controller must be its own independent computer with no
other application software.

For more information, see this additional resource.

Resource Description

Windows Operating System and
domain references

Microsoft® online libraries, for example TechNet, provide detailed guidelines for all
aspects of the Windows and Windows domains. Examples of detailed guidelines are
design, deployment, maintenance, security, disaster recovery, and so on. PlantPAx
documentation provides best practice critique to certain Windows roles, features,
and such where a typical PlantPAx DCS is hosted.

The domain controller manages:

« IP address scheme for the computer network

« DNS and reverse lookup zone

« DHCP server

« Assigned roles, areas, and users

« Group policies

If your company has an existing domain infrastructure, in which the PlantPAx
system interacts with, please consult with your local IT resources before

continuing.
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Create the Primary Domain Controller

Starting with a new installation of Windows Server 2016 operating system,
login as local administrator. The computer is initially assigned a random 15-
character computer name, which looks something like this: WIN-

VPLC4SD9KWG.

1. Change the computer name to comply with your company naming
guidelines. Or, in this example, to reflect it as being a process automation
domain controller (PADCA, PADCB, and so forth).

2. Next assign the Windows server a fixed IP address (TCP/IPv4), within
the subnet designated for the given network architecture.

For example: 172.18.1.10

Install Active Directory Services, DHCP, and DNS Roles

Before a Windows server can function as a domain controller, additional roles

and features must be installed.

1. Launch the Server Manager.

T Server Manager
©-

122 Dashboard

i Local Server
ii All Servers
L

File and Storage Services P

Server Manager » Dashboard

QUICK START

WHAT'S NEW

LEARN MORE

= @ I r Manage  Tools Vi

2 Add roles and features
3 Add other servers to manage
4 Create a server group

= W

Connect this server to cloud services

2. From the Dashboard, click the second option to 'Add roles and features'.
Use the following table to complete the configuration.

Roles and Features Wizard

Configure

Before You Begin

Read and click next

Installation Type

Check 'Role-based or feature-based installation.’

Select a server from the server pool.

Server Selection Select the local computer PADCA in the Server Pool list
In the Roles dialog, select the following:
« Active Directory Domain Services

Server Roles

« DHCP Server
« DNS Server

Pop up dialog. Add features that are required for
Active Directory Domain Services.

Check the option to Include management tools (if applicable)
and then select Add Features.

Select the available .NET Framework features to be installed on

Features the domain controller.
Check ‘Group Policy Management."
AD DS Active Directory Domain Services requires a DNS server. If
selected for the Server Role, click Next.
- Check 'Restart the destination server automatically if required’,
Confirmation and select Install.
Results Once the installation process completes, close the wizard and

restart the server if necessary.
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Promote the Primary Domain Controller

On the Server Manager management console, complete these steps for the
active domain computer.

1. Select the Alert flag on the header.

e Server Manager - m} *
©e-

i& Dashboard

Server Manager * Dashboard @ | I'a Nanage Tools  View  Help

Il!-!!- §, Post-deployment Canfigura...
|ES

Configuration required for Active Directory Domain ‘

B Local Server 2 i
Services at PADC1

= manage
B All Servers Promote this server to a domain controller | g
T§i AD DS ¥ h
= I j. Post-deployment Configuration P
18 DHeP
cland i
& DNs Configuration required for DHCP Server at PADC o cloud services

¥E File and Storage Services P Hide

LEAR] Complete DHCP configuration

@ Festure instaliation
ROLE! =
Roles: « Configuration required. Installation succeeded on
PADC1.
I"i'i Add Roles and Features 1

@ Tack Details

2. Select 'Promote this server to a domain controller'.

Using the Active Directory Domain Services Configuration Wizard, use
the following for guidance on your deployment.

IMPORTANT Take careful consideration when specifying a new root domain
name.

« Understand domain naming conventions so they make sense given
your system, owner, or location.

« Do not use any reserved words or characters, and use caution if
adding a period, which must not be used in later versions of
Windows.

« See Microsoft Support for more information on naming conventions
in Active Directory for computers, domains, sites, and organizational
units.

Topic Configure

Select to 'Add a new forest'.
Specify the domain information for this operation.
Enter a Root Domain Name.

Deployment Configuration Examples:
« PlantPAx.Company.Local

« DCS.PlantPAxMfg.com

« PlantPAx.RockwellAutomation.com

Select Windows Server 2016 as the Forest functional level.
Select Windows Server 2016 as the Domain functional level.
Check 'Domain Name System (DNS)."

Check ‘Global Catalog (GC).

Domain Controller Options Enter a Directory Services Restore Mode password

IMPORTANT: You use this password when you configure a redundant
domain controller and for any subsequent DC recovery efforts. Record this
password in a safe/secure place.

DNS Options Do not specify 'DNS Delegation options.'

Make sure that the domain name is used for the NetBIOS Domain Name.

Additional Options Accept defaults for the remaining options.

Paths Use the default folder locations.

Review Options Review your selection options.

Prerequisites Check Validate all prerequisites and Install if no errors. The server restarts.
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Additional Domain Controller

IMPORTANT  For each additional domain controller, you must have a fresh

installation of Windows Server 2016 operating system before
repeating the ‘Create the Primary Domain Controller’ procedure.

Create an Additional Domain Controller

To reduce disruptions during unplanned and planned downtime, add another
Domain controller for backup as well as scalability later.

1.

4.

Change the computer name to comply with your company naming
guidelines. Or, in this example, to reflect it as being a process automation
domain controller (PADCB, and so forth).

Next assign the Windows Server a fixed IP address (TCP/IPv4), within
the subnet designated for the given network architecture. For example,
172.20.1.11, and supply the DNS address from the initial domain
controller: 172.20.1.10

Repeat Create the Primary Domain Controller steps. Name, address, and
install Active Directory roles for the additional domain controller.

Install the ‘Active Directory Domain Services’ role.

Install Active Directory Services, DHCP, and DNS Roles

Just like creating the primary domain controller, repeat these steps.

1.

2.

Install Active Directory, DHCP, and DNS roles used on creating the
primary domain controller.

Install the 'Active Directory Domain Services' role.

Refer to the primary domain controller instructions if you need help with
using the roles wizard.
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Promote the Additional Domain Controller

On the Server Manager management console, complete these steps for the

standby domain computer.

1. Select the Alert flag on the header.

e Server Manager

i& Dashboard
i Local Server
ii All Servers
Til AD DS

{8 DHcp

B§ File and Storage Services P

Server Manager * Dashboard

- (Ej | I' 1 fanage Tools View Help
L &

Post-deployment Configura...

=
Configuration required for Active Directory Domain
Services at PADC1

| manage
Promote this server to a domain controller ‘
j. Post-deployment Configuration P
clo i
Configuration required for DHCP Server at PADC o cloud services

Hide

Complete DHCP configuration

@ Festure instaliation

Configuration required. Installation succeeded on

PADCI.
Add Roles and Features

Tack Details

2. Select 'Promote this server to a domain controller'.

Using the Active Directory Domain Services Configuration Wizard, use
the following for guidance on your deployment.

AD DS Configuration Wizard

Configure

Deployment Configuration

Select to 'Add a domain controller to an existing domain.'
Select the Domain:
Select the forest:

Domain Controller Options

Select Windows Server 2016 as the Forest functional level. Select
Windows Server 2016 as the Domain functional level. Check 'Domain
Name System (DNS).

Check ‘Global Catalog (GC).

Enter a Directory Services Restore Mode password.

IMPORTANT: You use this password when you configure a redundant
domain controller and for any subsequent DC recovery efforts. Record
this password in a safe/secure place.

DNS Options

Do not specify 'DNS Delegation options.'

Additional Options

Replicate from: 'your domain name’

Paths Use the default folder locations.
Review Options Review your selection options.
Prerequisites Check Validate all prerequisites and Install if no errors. The server restarts.
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Configure Domain
Controllers

On the primary and additional domain controller, now you can implement and
configure the new features and roles that were added, such as: Active
Directory, DHCP, and DNS.

Server Manager Tools Menu

The Windows ‘Server Manager’ contains a Tools menu that provides quick
access to many of the management consoles required for the following
configurations.

R Server Manager - o =

ver Manager * Dashboard

Artive Directory Administrative Centes

vy Drna

i Dashboard WELCOME TO SERVER MANAGER 5 sey Mochule fo

B Local Server Active Directory Sites and Senvces
B8 A Servers o R T - W /W Active Directory Users and Computers
Wl aDpDs il bbb S ADS! Edit

18 ohee s Compansnt Services

¥ DHC |

Computer Management
o
e DNS

Defragment snd Optimize Drves
WE Fite and Storage Services b add other sarver manaod bR

- : Dotk Claanup

DNS

Event Viewer

WHAT'S NEW

Group Policy Managemert
ISCS! Inisiatar

LEARN MORE Loeal Socurity Policy

Migrens

ROLES AND SERVER GROUPS C0RL Dists 52
. VES Grips Servers ¢ DDSC Data Son

Performance Mandtor

Create a Reverse DNS Lookup Zone

Reverse lookup zones are used to resolve IP addresses to host names, rather
than host names to IP addresses, as is the case with forward lookup zones. You
must program a special domain namespace (in-addr.arpa) as a reverse lookup
zone.

On your initial domain controller, use the Server Manager to access the DNS
Manager console window.

1. Toaccess the DNS Manager, right-click Reverse Lookup Zone
New Zone.

£ DNS Manager — m} X
File Action View Help
e |2@dBEIFED

£ DNS
= e
v i PADU IOI Add a New Zone
| Forward Lookup Zones e
" Rever=e | ankuin 7nnes
— Trot P Sy Jomain Name Systern (DNS) allows a DMS namespace to be divided into zones. Each zone
3 Tru

. s informatien about one or mere contiguous DMNS domains.,
Conc R

B View >
1d a new zone, on the Action menu, click New Zone.

Refresh

Help
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2. Configure the New Zone wizard as shown in the following table.

Basic Step

Configure

Zone Type

Select ‘Primary zone.

Active Directory Zone
Replication Scope

Check 'To all DNS servers running on domain controllers in this domain <your target
domain>".
For example: PlantPAx.MyCompany.Local.

Reverse Lookup Zone Name

Check ‘IPv& Reverse Lookup Zone.

Network ID

Enter the network ID portion of the IP address of the domain controller (omit the last
number). For example, enter 172.20.1.

Dynamic Update

Check ‘Allow only secure dynamic updates (recommended for
Active Directory).

A successful configuration displays details of the lookup zone.

New Zone Wizard

o

Completing the New Zone Wizard

You have successfully completed the New Zone Wizard, You
spedified the following settings:

Name:  1.18.172.in-addr.arpa
Type: Active Directory-Integrated Primary

Lockup type: Reverse

Mote: You should now add records to the zone or ensure
that records are updated dynamically. You can then verify
name resolution using nslookup.

To dose this wizard and create the new zone, dick Finish.
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Map the Host Name to the IP Address

Create a pointer (PTR) record that associates the DNS name to the IP address.

During a search, the IP address is reversed to find the associated DNS name.

From the Server Manager, use the DNS Manager to create the New
Pointer (PTR).

1. GotoTools > DNS > Reverse Lookup Zone > Zone > New Pointer

File Action View Help

e nEXEd=z Bzl 88

2, DNS Manager - O X

5’:1 [ENS Name Type Data
~ 5 PADCI 2
Ej (same as parent folder) Start of Authority (SOA) [1], padcl.plantpax.rockw...  static
Ml Foruasd [ookup foncs E—l (same as parent folder) MName Server (N5) padcl.plantpax.rockwella...  static
~ [ Reverse Lookup Zones
B 118172 in adde amna
| TrustP Update Server Data File
| Condit Reload

Mew Pointer (PTR)...

2. Enter the IP address of the domain controller and browse for the
host name.

Successful configuration shows pointers for both a primary and
secondary domain controller.

Timestam|

£ DNS Manager - O
File Action View Help

«= rnEXEH= §Ea

£ DNs
~ & PaDC1
| Forward Lookup Zones
~ [ Reverse Lookup Zones
izl 1.18.172in-addr.arpa

MName

[El(same as parent falder]
same as parent folder]

Bl 17220110
E 17220011

Type

Start of Authority (50...
MName Server (NS)
Paointer (PTR)

Pointer (PTR)

Data Timestamp

[1], padcl.plantpaxrockwellautomation... static
padcl.plantpax.rockwellautomation.com.  static

~ Trust Points
| Conditional Farwarders
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Add DHCP Features

A DHCP server is a network server that automatically provides and assigns IP
addresses, default gateways, and other network parameters to client devices
that request the information.

On the Server Manager management console, complete these steps to add a

DHCP server.

1. Select the Alert flag on the header.

& Server Manager

Server Manager * Dashboard

58 Dashboard

Local Server

All Servers
AD DS
DHCP
DNS

e =

j. Postdeployment Configura...
WELCOME TO

i

| < ACQUTOICS diu Icatures

Configuration required for DHCP Server at PADCT

Complete DHCP configuration

Task Details

2. Click to ‘Complete DHCP configuration’

3. Open the DHCP management console and right click IPv4 > New Scope
and configure the following for the control network.

Basic Step Configure

Scope Name ﬁr;tte\:vrosikr;'ame (such as Control Network) and a description (such as PlantPAx Control
Enter the start and end of the IP address range.
Example:

IP Address Range Start IP Address: 172.20.1.128

End IP Address: 172.20.1.254
Length: 24
Subnet Mask: 255.255.255.0

Add Exclusions and Delay

Optional: Exclusions are address or a range of addresses that aren't distributed by
the server. A delay is the time duration by which the server delays the transmission
of a DHCPOFFER message.

The lease specifies how long a client can use and IP address from this scope.

Lease Duration Default values: Days: 8 Hours: 0 Minutes: 0
You have to configure the most common DHCP options before clients can use the
Configure DHCP Options scope.

Select: 'Yes, | want to configure these options now'.

Router (Default Gateway)

Enter the gateway IP address. Example: 172.20.1.1

Domain name and DNS servers

Parent Domain: 'your domain name'
Server IP addresses. Example: 172.20.1.10 and 172.20.1.11

WINS

Optional: Computers running Windows can use WINS servers to convert NetBIOS
computer names to IP addresses.

Activate Scope

Select 'Yes, | want to activate this scope now'.
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Configure Failover

This DHCP option provides high availability by synchronizing IP address
information between two DHCP servers.

1. Goto Tools > DHCP > primary domain > IPv4 > Configure Failover and
configure the following.

Basic Step Configure

Configure Failover Click Add Server and locate the secondary domain controller. Example: PADCB

Select 'Hot standby' for mode.

Coatllowalowr | L9n ke ok et aubetcaon e shard st pson) s
Relationship p )

Enter a 'Shared Secret', which can be passwords, pass phrases,
or random numbers.

2. Repeat step 1 to configure a second DHCP server.

A successful configuration displays details of the failover
configuration.

Configure Failover

Failover wil b set up betwsen padca plartpax rockwelau... and
padab plantpax rockwallau. . with the following parameters

Scapes

172.20.1.0

Relatiorship Name padoa plantpax rockweliautomat
Madmum Cliert Lead Tme: 1 hrs Omins

Mode: Hot standby

State Switchover interval Disabled

< >
Hot Standby Configuration

Role of Partner Server Standby

Addresses reserved for standby: 5%

<Back Cancel
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Create Roles, Areas, and From operators and maintenance personnel to engineers, the domain

Users controller manages groups in the Active Directory. Use the Server Manager to
configure the roles, areas, and users.

1. Use the Windows Server Manager Tools menu to launch the ‘Active
Directory Users and Computers’ console.

2. Fromyour domain, right-click, select New> Organizational Unit and type
the name PlantPAx.

3. Under the PlantPAx group, right-click and select New > Organization
Unit to create folders for Users, Areas, and Roles.

] Active Directory Users and Computers = m} x
File Action View Help

e AF B B2 M 38ETA%

: Active Directory Users and Computers [PADCAL | pame

Type Description
- Saved Queries [Z] Areas Organizational Unit
~ B PIantPTQx.Ro(kwel\AutDmat\on.(om =1 Roles Organizational Unit
Z E:::umrs 2] Users Organizational Unit

= | Domain Controllers

| ForeignSecurityPrincipals

~ Managed Service Accounts
w o PlantPax

Add Groups for Role Based Security

Roles define different security access for areas of a plant. We recommend the
following roles:

« PlantPAx Operators

« PlantPAx Operating Supervisor

« PlantPAx Maintenance

« PlantPAx Maintenance Supervisor

« PlantPAx Manager

« PlantPAx Engineering

« PlantPAx Administrator

«  HMI Approver

] Active Directory Users and Computers == [m] *
File Action View Help
e z@ OBz HEPatard%
] Active Directory Users and Computers [PADCA| Name Type Description
o ;Tvadpf:;”aiw ” . EBP\ant PAx Maintenance Security Group - Global
b .a'g T LEOMmafiofcaiy 82, PlantPAx Administrator Security Group - Global
= CU‘ = 3 %P\antPAx Engineering Security Group - Global
omputers
= Dom:m T—— EBP\antPAx Maintenance Supervisor  Security Group - Global
= ForeignSecurityPrincipals 2 PlantPAx Manager Security Group - Global
= Managed Service Accounts EP,P\antPAx Operating Supervisor Security Group - Global
- —= PlantPx %PlantPAx Operaters Security Group - Global
S| Areas
2| Roles
o Users
| Users
< || € >
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Add Groups for Area Based Security

We recommend the following areas that are based on a group:

- Basic— Allows access to non-engineer functions, such as Maintenance,
Operator, on process library faceplates.

« Advanced - Allows access to engineering modifications on process
library faceplates

IMPORTANT  Even though the examples show generic area names, such as
Area01, we recommend that you use more specific names, such as
Packaging, or Molding. And create two types for each area — Basic
and Advanced—for each area.

Create as many areas as needed for the system.

| Active Directory Users and Computers = O X
File Action View Help

e pEl i XEBA Hm A aaTahk

: Active Directory Users and Computers [PADCAL | Name Type Description

.__— saved Queries X %AreaDLAdvanced Security Group - Global

v Pl.antPA)f.RockwellAutomatmn.com E&AreaDZ_Advan(ed Security Group - Global
= Eun::I:uters %AreaD}_Advan(ed Security Group - Global

:'. R — E&AreaN_Advanced Security Group - Global

= E%AreaDS_Advanced Security Group - Global

_ ForeignSecurityPrincipals

“| Managed Service Accounts %AreaDT_Basl( Security Group - Global
v & PlantPAx E&AreaDZ_Basi( Security Group - Global
- = Areas %Area%_Basic Security Group - Global
:_ Roles %AreaD{Basi( Security Group - Global
;: Users E&AreaDS_Ba;i( Security Group - Global
—| Users
< >« >

Assign Users

Users are unique to each system.

1. Create users and assign them to the Member tab on the Properties for the
associated Role.

File Action View Help
=% AE {8 XECR BHE 3 aETHEY

: Active Directory Users and Computers [PADCA | pame v Type Description
~| Saved Queries

v 3 PlantPAxRockwellAutormation.com Dieve Dbyect lset X
~| Builtin
Ricomputes 2 Createin:  PlantP Ax. Rockwell Automation.com//Plant P A/ User
4| Domain Controllers ') . :

_| ForeignSecurityPrincipals
_| Managed Service Accounts

First name

v (] PlantPAx | | nials: | |
;% Areas Last name: | |
= Roles
2 Users Full name | |

| Users

User logon name:

< e [ e Rosmatitonin -

User logon name fpre-Windows 2000):
[PLaNTPaX. Il |
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2. Once the user name and password are created, configure the following
properties as shown in the table for each user.

On This Page Configure
Properties Select the domain on the ‘Member of tab
Select Groups Type Area as the object name and select the appropriate Area

The successful configuration of a user shows both their domain
and area.

File Action View Help
2| AF FBIXEE HM B atEmTa%

: Active Directory Users and Computers [PADCA| Name v Type Description
= saved Queries i &John Smith User
w i PlantPAx.RockwellAutomation.com
~ Builtin John Smith Properties 7 X
~ Computers
2. Domain Controllers Remote control Remote Deskiop Services Profile COM+
— ForeignSecurityPrincipals General Address Account Profile Telephones Organization
| Managed Service Accounts Member Of Dialin Environmert Sessions
w (2] PlantPax
= A Member of:
o Areas
= Roles MName Active Directory Domain Services Folder
2 Users Arealll_Basic Plant P Ax Rockwel Automation com,/Plant P Ae/Ar.
~ Users Domain Users PlanitP A Rockwel Automation.com./Users
PlantPAx Operati... PlantPAx Rockwell Automation .com/Flant PA«R...
< >|| £ >
* H . . . .
Conflgure GI’Ole Pollcy Group policies help reduce the maintenance and complexity when you add
"anagement new users and computers into the PlantPAx system. The group policies

determine what users can and can’t do, such as password maintenance or to
restrict folder access. The same approach applies for how to define server
maintenance.

The settings that are outlined are baseline recommendations. Individual
business, IT, and security requirements could require additional policies.

Configure the Windows NTP Client

The domain is responsible to propagate and enforce the clock time to the
domain computers. Use the Server Manager to configure the Windows NTP
client so that the domain controller is in sync with the Windows NTP server.

1. Go to Tools > Group Policy Management.
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2. Select the Default Domain Controllers Policy to edit.

Open the GPO editor

|, Group Policy Management - [m} X
155 File  Action  View Window Help - | &%
&= d B
(5, Group Policy Management Group Policy Management
v _ﬁ Forest: PlantPAx.RockwellAutomation.com Conterts

~ [543 Domains -
~ _fj PlantPAx.RockwellAutomation.com Name
s/ Default Domain Policy A Forest: PlartPfix Rockwel Automation com
~ [2| Domain Controllers
= Default Domain Controllers Palicy
» 2] PlantPax Edit...
» [t Group Policy Objects B
> Ly WMIFitters v LinkEnabled
» [ Starter GPOs
> [ Sites Save Report...
#& Group Policy Modeling New Window from Here
|4} Group Policy Results
Delete
Rename
Refresh
Help
< >

3. Inthe Group Policy Management Editor, select Policies > System >

Windows Time Service.

=[ Group Policy Management Editor
File Action View Help

oo nE R HEIT

_EJ Default Demain Controllers Policy [P£ | System
~ A Computer Configuration
%‘4 chclas E Windows Time Service Setting &
» [] Software Settings j Shutdown
» [ Windows Settings | Shutdown Options
w || Administrative Templates: || System Restore
> [] Control Panel [ Troubleshooting and Diagnostics
> [ Metwork | Trusted Platform Module Services
] Printers ] User Profiles
[ Server [ Windows File Protection
] Start Menu and Taskba e i
~ [ System |iz] Download missing COM components
] Access-Denied Assi ” % =
H Ame W
< > Extended / Standard [
16 setting(s)

4. Go to Time Providers > Configure Windows NTP Client.

£l Group Policy Management Editor
File Action View Help

o | E = HE| 7T

"] Shutdown Options A
] System Restore
] Troubleshooting an
] Trusted Platform M
7] User Profiles
] Windows File Prote
s [ Windows Time Sen
| Time Providers
» [ Windows Components
iy Al Settings
» || Preferences
w i, User Configuration
» ] Policies
s [ Preferences

. Time Providers
Configure Windows NTP Client

v

Edit policy setting

Requirements:

At least Windows Server 2003
operating systems or Windows XP
Professional

Description:

This policy setting specifies a set
of parameters for controlling the
Windows NTP Client.

v || Ifyou enableth\s po!ir:y setting,

Setting
Configur
P | corfio

ndows NTP Client
iz| Enable Windows NTP Client
=] Enable Windows NTP Server

< > Extended / Standard /

3 setting(s)
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5. Select 'Enable’ and configure the 'Options’ with your NtpServer: IP
address and use Type: NTP.

L Configure Windows MNTP Client [m] x
El

E‘ Configure Windows NTP Client Next Setting

O Mot Configured ~ Comment:
@ Enabled
() Disabled
Supported 01 [ at lesct Windows Server 2003 operating systems or Windows XP Professionsl
Options: Help:
MtpServer [172.18.1.102,0x1 Ihh;swpﬁ-‘lggvfﬁ‘?g ETI:TES a set of parameters for controlling ~
Type NTP v
If you enable this policy setting, you can specify the following
CrossSiteSyncFlags |2 z parameters for the Windows NTP Client,
ResolvePeerBackeffMinutes |13 = If you disable or do not configure this policy setting, the
Windows NTP Client uses the defaults of each of the following
ResolvePeerBackoffMaxTimes parameters.
7 S MtpServer
= The Domain Name System (DMS) name or IP address of an NTP
SpecialPollinterval | 3500 - time source, This value is in the form of ""dnsMame,flags""

where ""flags"" is a hexadecimal bitmask of the flags for that

= host. For more informatien, see the NTP Client Group Policy
Settings Associated with Windows Time section of the Windows
Time Service Group Policy Settings, The default value is
""timewindows.com,ix09"",

EventlogFlags |0

Type
This value controls the authentication that W32time uses, The "

6. Go to Time Providers > Enable Windows NTP Client and
check ‘Enabled.’

Configure Windows Time Service

Enable the NTP server to initiate automatically upon startup.

1. Inthe Group Policy Management Editor, go to Policies > Windows
Settings > Name Resolution Policy > System Services >Windows Time.

=/ Group Policy Management Editor - O X
File Action View Help
e pn XE = H @

=] Default Domain Controllers Policy [PADCAI A || Service Name Startup P—— P

v il Computer Configuration @Windows Management In... Mot Defined Mot Defined

@Wmdows Mobile Hotspot.. Mot Defined Mot Defined
ﬁwindnws Modules Installer Mot Defined Mot Defined
mwiﬂduws Presentation Fo... Mot Defined Mot Defined
&}Windows Push Motificatio... Mot Defined Mot Defined
@Windows Push Motificatio... Mot Defined Mot Defined

~ | | Policies
| Software Settings
~ [7] Windows Settings
| Name Resolution Policy
|= Scripts (Startup/Shutdown)
=1 Deployed Printers

v 51_!' Security Settings @Wmdows Remote Manag... Mot Defined Mot Defined
EE:I Account Policies ﬁwiﬂdnws Search Mot Defined Mot Defined
jﬁ Local Palicies Vindows Time Autematic Mot Defined
j Event Log &_}Windows Update Mot Defined Mot Defined
& Restricted Groups @WinHTI’P Web Proxy Aut.. MNotDefined Mot Defined
1, System Services v @ered AutoConfig Mot Defined Mot Defined
< = R 3 ﬁWM\ Performance Adapter Mot Defined Mot Defined oo

2. In the Windows Time Properties, select the following:
« Check ‘Define this policy setting.’
« Check ‘Automatic’ for service startup mode.
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Enforcing the Domain Controller Policy

Policy enforces the domain controllers to use the NTP server settings.

1. Inthe Group Policy Management Editor, select the Default Domain
Controllers Policy and remove ‘Authenticated Users’ from

Security Filtering.
&, Group Policy Management = m}
E File Action View Window Help - || [
=] 2@ 6]
[5 Group Policy Management Default Domain Contrellers Policy
- _ﬁ ;:r;st: PlantPAx.RockwellAutomation.com Scope | Detsis Settings  Delegation
v omains
~ 3 PlantPAx.RockwellAutomation.com Links
] Default Domain Palicy Display links in this location: PlantP Ax. Rockwell Automation com ~
w [2] Domain Controllers The following sites. domains, and OUs are linked to this GPO:
s/ Default Domain Controllers Policy
=7 PlantPAx Location Enforced Link Enabled
| =t Group Policy Objects [&] Domain Controllers No Yes
» [ WMI Filters
- [F] Starter GPOs b 2
[ Sites

st Group Policy Madeling
% Group Policy Results

Security Filtering

The settings in this GPO can only apply to the following groups, users, and computers:

Name

< >
i
‘WM Filtering
This GPO is linked to the following WMI fitter:
Pt e
2. Add Domain Controllers from the PlantPAx domain to
Security Filtering.
12 Group Policy Management = O X
|Z File Action View Window Help - | &%
ke sl (R
(5 Group Policy Management Default Domain Controllers Policy
v A FEIIFESt: PlantPAx.RockwellAutomation.com Scope | Detalls | Settings  Delegation
~ (g5 Domains .
v 3 PlantPAx.RockwellAutomation.com Lifce
=/ Default Demain Policy Select User, Computer, or Group X
w [2] Domain Controllers
| Default Domain Controllers Policy Select this ohject type
2 PlantPAx ‘User. Group, or Built4n security principal | Object Types...
5 Group Policy Objects From this location
» [ WMI Filters
Ly =
i E t— ‘P\amFP«x.ankwellMomatlon com | Locations
[ Sites | Enterthe object name to select (zxamples
Group Policy Modeling Domain Controllers Check Names
) Group Policy Results
Advanced... OK Cancel
Add Remove Properties
WMI Filtering
This GPQ is linked to the following WMI filtker:

Rockwell Automation Publication PROCES-UM100C-EN-P - June 2022

4



Chapter 2 Domain or Workgroup

Configure Group Policies

42

3.

Right-click Domain Controllers and select Enforced.
12, Group Pelicy Management = m}
[zl File Action View Window Help .
R ol ANl s (W
(5 Group Policy Management Default Domain Controllers Policy
~ _ﬁ F?rest: PlantPAx.RockwellAutormnation.com Scope | Details  Setlings Delegation
~ |55 Domains "
v &2 PlantPAxRockwellAutomation.com Links o
&/ Default Domain Policy Display links in this location PlartP s Rockwel Automation com ~
~ (2] Domain Controllers The following sites. domains. and O Us are linked to this GPO
=i Default Domain Controllers Policy P
= PlantPAx Location Enforced Link Enabled Patl
=t Group Policy Objects | Domain Cortrollers
& WMI Filters ~ Enforced
&l Starter GPOs ¥ Link Enabled
A Sites

#f7 Group Policy Modeling

4 Group Pelicy Results

< Delete Link(s)

Security Filtering

These group policies are recommended:

Use the specifications for your PlantPAx system to set the values for these
policies. If you configure any of these policies, you must enforce the policies on

Password strength
Account lockout
Kerberos
Interactive logon

the domain controller for them to take effect.

Configure the Password Strength Policy

This policy makes sure that security settings are enforced to help protect the

system from unauthorized users upon entering the system.

1.

In the Group Policy Management Editor, select the Default Domain
Policy to edit and select Password Policy.

=] Group Policy Management Editor - o x

File Action View Help

e AE XE = B

v il Computer Configuration * || Policy . Palicy Setting

v s FI_U“UEi |2 Enforce password history 24 passwords remembered
= ‘?;fh:are 5::::‘9; iy Maxirnum password age 42 days
~

plin it il 12z Minimum password age 1 days

_ Mame Reselution Policy
(| Scripts (Startup/Shutdown)
= Deployed Printers
v i Security Settings
~ ;:E=| Account Policies
2 Password Policy
_El Account Lockout Policy
;f] Kerberos Policy w
< >

lig| Minimum password length
;) Password must meet complexity requirements

1| Store passwords using reversible encryption

7 characters
Enabled
Disabled
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Configure the Account Lockout Policy

This policy configures the number of password attempts and how an
administrator resolves a user lockout situation.

1.

In the Group Policy Management Editor, select the Default Domain

Policy to edit and select Account Lockout Policy.

=f Group Policy Management Editor - ]
File Action View Help
e | nFE X HE
v [ Computer Configuration # || Policy 2 Policy Setting
- p_DIKIeS s Account lockout duration 30 minutes
_| Software Settings

v [ ] Windows Settings
| Mame Resolution Policy
= Scripts (Startup/Shutdown)
= Deployed Printers
v i Security Settings
w E Account Policies
;:EI Password Policy
;EI Account Lockout Policy

53 Kerherns Palicu

< >

¥

% Account lockout threshold

| Reset account lockout counter after

3 invalid logen attempts
30 minutes

Configure the Kerberos Policy

This policy helps administer network authentication.

1.

In the Group Policy Management Editor, select the Default Domain

Policy to edit and select Kerberos Policy.
2. Enable the default options or modify if desired.

=f Group Policy Management Editor
File Action View Help

% nE =2 HE

_v' Default Domain Controllers Policy [PADCAPLE &
~ il Computer Configuration
w [ Policies
| Software Settings
~ [ 7] Windows Settings
| Name Resolution Policy
=] Seripts (Startup/Shutdown)
= Deployed Printers
v Security Settings
~ _:C'l Account Policies
jﬂ Password Policy
2 Account Lockout Palicy
_:ﬂ Kerberos Policy
< - B >

]

e

Policy

14 Enforce user logon restrictions

L) Maximum lifetime for service ticket
14 Maxirmum lifetime for user ticket

i) Maximum lifetime for user ticket renewal

1| Maximum tolerance for computer clock synch...

Paolicy Setting
Enabled

600 minutes
10 hours

10 days

3 minutes
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Lt

Configure the Interactive Logon Policy

This policy configures a warning message to users of the consequences for
misusing company information.

1. Inthe Group Policy Management Editor, select the Default Domain
Policy to edit and select Interactive Logon Policy.

2. Inthe tree configuration of the Group Policy Management Editor dialog
box, Go to Computer Configuration > Policies > Windows Settings >
Security Settings > Local Policies.

3. Select the Security Options folder and select the Interactive logon:
Message Title option. Enter the name of the group that receives the

interactive message.

=P Groun D

File Action View Help
e m XE=z HE

J’ Default Domain Policy [PADCAPLANTPAX.RE A
w il Computer Configuration
w [] Policies
| Software Settings
w 7 Windows Settings
~| Name Resolution Policy
| Seripts (Startup/Shutdown)
= Deployed Printers
~ T Security Settings
v _:EI Account Policies
/i Password Policy
5 Account Lackout Palicy
3 Kerberos Policy
v [ Local Policies
& Audit Policy
i User Rights Assignmen
| Security Options

o

Policy Policy Setting )
5] Interactive logon: Message text for users attempting to log en  This system is the pro
5 Interactive logon: Message title for users attempting to log on  PlantPAx System

.| Interactive logon: Message title for users attempting to lo... ?

Security Policy Setting  Explain
;E' Interactive logon: Message title for users attempting to log on

Define this policy setting

|PIamPP« System

x

4. Select the Interactive Logon: Message text option. Enter the message
that appears to users during logon.

g

File Action View Help
e nm XEE Hm

=/ Default Domain Policy [PADCA.PLANTPAX.R( A
~ (i Computer Configuration
~ [ Policies
| Software Settings
~ [] Windows Settings
_| Name Resolution Policy
[ Scripts (Startup/Shutdown)
Deployed Printers
v B Security Settings
v 3 Account Policies
:EI Password Policy
A Account Lockout Palicy
5 Kerberos Policy
v _:ﬂ Local Policies
il Audit Policy
5| User Rights Assignment
j Security Options

Fuent | ne

B

Policy Palicy Setting &
£ Interactive logon: Message text for users attempting to log on  This system is the pro
U] Interactive logon: Message title for users attempting to log on  PlantPAx System

| Interactive logon: Message text for users attempting to lo... 7
Security Policy Setting  Explain

agl Interactive logon: Message text for users attempting to log on

Define this policy setting in the template

This system is the property of Rockwell Automation and is for author
The use of computing and network services and devices provided |
'We reserve the right to monitor and audit assets and resources, in &
Personal use must be consistent with our palicies and Code of Conc
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PlantPAx Users Policy Object You can create a PlantPAx Users Policy to restrict privileges and site access.
Recommended policies include access for the following:
« USBdrive
. Portable device
. Software

Use the specifications for your PlantPAx system to set the values for these
policies. If you configure any of these policies, you must enforce the policies on
the domain controller for them to take effect.

For how to configure recommended FactoryTalk® Security settings, see
Configure System Security Features User Manual, publication SECURE-
UMoot.

Knowledgebase Technote, PlantPAx System Release 5.10
Configuration and Implementation Tools, contains recommended
FactoryTalk Security policy settings for PlantPAx systems. Download
the spreadsheet from this public article.

You may be asked to log in to your Rockwell Automation web account
or create an account if you do not have one. You do not need a support
contract to access the article.

Create the PlantPAx Users Policy Object

You can select a group and set restrictions. For example, a group of users can’t
use USB drives as a layer of system security.

1. Inthe Group Policy Management Editor, select the PlantPAx Domain
and select ‘Create a GPO in this domain and link it here..’

&, Group Policy Management

1zl File Action View Window Help
= 25 0| XEc HE

=L Group Policy Management PlantPAx
v _ﬂ Forest: PlantPAx.RockwellAutomation.com

v (54 Domains ”
v 3 PlantPAx.RockwellAutomation.com Link Order GPO
=/ Default Domain Policy

Linked Group Policy Objects  Group Poli

2| Domain Controllers

2| PlantP?
Create a GPO in this domain, and Link it here...

=t Group
F WMIF Link an Existing GPQ...
3 Starter Block Inheritance

@ Sites

Group Policy Update...
si Group Policy

1+ Group Policy Group Policy Medeling Wizard...
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Configure the USB Drive Policy

A group of users can be restricted from using a USB drive.

1. Inthe Group Policy Management Editor, select the PlantPAx Users Policy
Object to edit and select Removable Storage Access.

=L Group Policy Management

5L File  Action View Window Help
e 2T LB X6 R

5, Group Policy Management
v & Forest: PlantPAx. RockwellAutomation.com
~ |55 Domains
v 3 PlantPAx.RockwellAutomation.com
Default Domain Policy
Domain Controllers
| PlantPix

~ [ 5 Group Policy Objects

=/ Default Domain Policy
=/ PlantPAx USers Policy Obje-+-
& WMI Filters
g Starter GPOs
[ Sites
Group Policy Modeling
) Group Policy Results

=/ Default Domain Controllers Policy

PlantPAx USers Policy Objects
Scope  Detals Settings
Links
Display links in this location:

Delegation Status

Plart P Ax Rockwell Automation.com
The following sites, domaing, and OUs are linked to this GPO:

Location Erforced Link Enabled
51 PlantP Ax Mo Yes

Edit...

GPO Status >

Back Up...

Restore from Backup...

2. Go to Computer Configuration >User Configuration > Policies >

Administrative Templates > System.
Select Removable Storage Access and choose All Removable Storage

classes: Deny all access.
4. Select Enabled.

= Group Policy Management Editor
File Action View Help
LL ARCCTHERN 2 Ro i 4

=] PlantPAx USers Policy Objects [PADCAPLANTPAX.ROCK\ ~
~ (& Computer Configuration
| Policies
| Preferences
~ i User Configuration
v [| Policies
1 Software Settings
“| Windows Settings
w [ Administrative Templates: Policy definitions (£
| Control Panel
“| Desktop
Metwork
Shared Folders
~ Start Menu and Taskbar
v System
| Ctrl+Alt+Del Options.
| Driver Installation
| Folder Redirection
“ Group Palicy

L £

“| Internet Communication Management
| Locale Services

“ Logon

Mitigation Options

Power Management

| Removable Storage Access

Removable Storage Access

All Removable Storage classes: Deny
all access

Edit policy setting

Requirements:
At least Windows Vista

Description:
Configure access to all removable
storage classes.

This policy setting takes precedence
over any individual removable
sterage policy settings. To manage
individual classes, use the policy
settings available for each class,

If you enable this policy setting, no
access is allowed ta any removable
storage class.

If you disable or do not configure this
policy setting, write and read
accesses are allowed to all removable
storage classes,
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== | Set time (in seconds) to force reboot
CD and DVD: Deny read access

CD and DVD: Deny write access
Custom Classes: Deny read access
Custom Classes: Deny write access
Floppy Drives: Deny read access
Floppy Drives: Deny write access
Removable Disks: Deny read access
2| Removable Disks: Deny write access
2] All Removable Storage d
==| Tape Drives: Deny read access

Deny all access

(2| Tape Drives: Deny write access
22 WPD Devices: Deny read access

2] WPD Devices: Deny write access
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Configure the Portable Device Enumeration Policy

This policy enforces Group Policy Objects for connected mass storage devices.

1. Inthe Group Policy Management Editor, select the PlantPAx Users Policy
Object to edit and select Portable Device Enumeration Policy.

3 -

File Action View Help

e nEXE = HE

~

|=[ Default Domain Policy [PADCAPLANTPAXR( A || Service Name Startup Permission
~ % Computer Configuration @Portable Device Enumerator Service Automatic Mot Defined
w || Policies
| Software Settings Portable Device Enumerator Service Properties ? X
~w ] Windows Settings
| Name Resolution Policy Security Policy Sefting
|2 Seripts (Startup/Shutdown) ;{ Portable Device Enumerator Service
= Deployed Printers = g‘
v [ Security Settings =

j_-ﬂ f::an‘upnotl:i?!:les Define this policy setting

j EventLog Select service startup mode:
4 Restricted Groups (@ Automatic
o System Services
3 Registry () Manual
4 File System (O Disabled

2o Wired Network (IEEE 802.3)
| Windows Firewall with Adv. Edit Security
~| Network List Manager Polit

il Wireless Network (IEEE 802,
_| Public Key Policies
| Software Restriction Policie
| Application Contrel Policie e Apply

&, 1P Security Policies on Activ ,,

Configure the Software Access Policy

This policy helps protect against the use of non-approved system software.

1. Inthe Group Policy Management Editor, select the PlantPAx Users Policy
Object to edit and select Software Access Policy.

2. Go to Computer Configuration > User Configuration > Policies >

Administrative Templates.

3. Inthe System folder, select ‘Don’t run specified Windows applications.’

=] Group Policy Management Editor
File Action

o= s = HBE T

View Help

e [m] X

=/ PlantPAx USers Policy Objects [PADCA.PLANTPAX.ROCKL A
~ (& Computer Configuration
| Policies
| Preferences
v i, User Configuration
v [ Policies
7| Software Settings
“| Windows Settings
w || Administrative Templates: Policy definitions (£
“| Control Panel
| Desktop
| Network
| Shared Folders
_| Start Menu and Taskbar
~ ] System
“| Ctrl+Alt+Del Options
“| Driver Installation
| Folder Redirection
Group Policy
Internet Communication Management

| Locale Services

~| Logen

| Mitigation Options

| Power Management

“| Removable Storage Access

< >

10 setting(s)

| System
Don't run specified Windows
applications

Edit policy setting

Requirements:
At least Windows 2000

Description:
Prevents Windows from running
the programs you specify in this
policy setting.

If you enable this policy setting,
users cannot run programs that
you add to the list of disallowed
applications.

If you disable this policy setting or
do not configure it, users can run
any programs.

This policy setting only prevents
users from running pregrams that
are started by the File Explorer
process. It does not prevent users
from running programs, such as
Task Manager, which are started

Setting
_| Folder Redirection
A , Group Policy
_| Internet Communication Management
" Locale Services
" Legon
“ Mitigation Options
~| Power Management
| Remnovable Storage Access
| Scripts
| User Profiles

| Download missing COM companents
Century interpretation for Year 2000
Restrict these programs from being launche
Do not display the Getting Started welcome
Custom User Interface
Prevent access to the command prompt
2] Prevent access to registry editing tools
© T pr——"
ii=| Run only specified Windows applications
v iz, Windows Automatic Updates

< >

\ Extended /(Standard
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4. Select Enabled, Show, and then type any application software to create
an access restriction. Example: Regedit.exe

& Don't run sp O >

E‘ Don't run specified Windows applications RS Next Sefting

(O Not Configured Comment:

(®) Enabled

() Disabled

Supported on: [t |east Windows 2000
Options: Help:
List of disallowed applications | Show.. | ‘ Preyents‘d\_.’lndow;from running the programs you specify in this |
policy setting.
Show Contents = = annot run programs that
ations,
List of disallowed applications X X
not configure it, users can
Value
ey REGEDIT.EXE| from running programs
. cess, [t does not prevent
Task Manager, which are
her processes. Also, if
pmpt (Cmd.exe), this
rom starting programs in
ey would be prevented
Windows 2000 or later
ith this policy setting.
gtions, click Show. Inthe |,
OK Cancel Cancel Apply
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Windows Workgroup

For small PlantPAx systems, you can use a Windows Workgroup where
complexity and security controls are kept to a minimum. An example might be

a PASS-C server for a Process skid.

Assign Static IP Addresses

Without a domain controller, there’s no DCHP server to assign IP addresses.
The workgroup requires all workstations and servers to contain manually set

(static) IP address assignments.

1. On each workstation, access the Network Adapter TCP/IPv4 properties

and assign a unique IP address.

Internet Protocol Yersion 4 (TCP/IPwd) Praperties
General
‘fou can get IP settings assigned automatically if wour netwark supparks
this capability, Otherwise, wou need ko ask vour network administrator
for the appropriate IP settings.
() Obtain an IP address automatically
(®) Use the Following IP address:
IP address: |17z 20 . 1 .12 |
Subnet mask: | 255 .255 .255 . 0 |
Default gateway: | 172,20 .1 .1 |
ibtain DMS server address aukomatically
(®) Use the follawing DMS server addresses:
Preferred DM server: | |
Alternate DN server: | |
[Jvalidate settings upon exit Advanced. .
Cancel

*

IMPORTANT Stratix® managed switches can be set to operate as a DHCP server
and provide DHCP persistence. See the switch user manual if using

DHCP for workgroup computers.
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Map Computer IP Addresses

Without a domain controller, there’s no DNS server to provide name
resolution, meaning the computers can only communicate by IP address. To
communicate by using a computer host name, mapping is required. All
Windows computers contain a HOSTS plaintext file that maps IP addresses to
host names.

1. Locate the HOSTS file in C:\Windows\System32\Drivers\etc directory
and specify to open with Notepad.

2. Create a list of your workgroup computers, starting with each IP address
followed by the corresponding computer name. Use a tab to delimit
space between each mapping.

¥ =1 ]
Home Share Wiewy 0
] f [F i o] -
;__'I _J o Cut aMaveta~ 3 Delete - IiE] ﬂ %] Open BaSelect all
t w.l Copy path = Edit Select hohe
Pin ta Quick Co Paste (5] - = Mews Fropetties
access £ ?| Paste shortout L/ Copy o _E Rename folder pv DD Irvert selection
Clipboard Qrganize M Qpen Select
1 <« Local Disk (C) » Windows » System32 » drivers » etc v O Search etc 2
Desktop A Marme Diate rnodified Type Size
5| Documents | | hosts | hosts - Motepad b m] X
4 Dainloads | | Imhostssam | File  Edit  Format  View Help
J’I Music || netwarks # For example: ~
=] Pictures || pratocol #
B videos || services # 162.54.94.97 rhino.acme. com # source server
# 38.25.63.18 3}, acme. com # x client host

‘i Local Disk {C:

# localhost name resclution is handled within DNS itself.

P st # 127.8.0.1 localhost
" # HEH localhost
Sitems  1item selected 912 bytes

172.2@.1.12 EWsEl
172.26.1.13 CWsSE1
172.26a.1.14 PASSEL
172.26.1.15 PASSE2A
172.26.1.16 PASSE2E
172.26.1.17 AsTHEeL
172.26.1.18 AsIHE2
172.26.1.189 AsIs@el o
< >

3. Copy the HOSTS file to all other computers in the workgroup.

IMPORTANT  Anytime a change or new computer is added, all workgroup
computers must receive the updated HOSTS file.
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Test Communication by Host Name

You can verify that each workgroup computer responds to a PING command
from another workgroup computer, referencing the remote computers
host name.

1. Opena Command Prompt and type PING followed by a host name.

For example: CMD: PING PASSo1

2. Verify that a reply from the remote computer is returned with the correct
IP address.

E¥ Command Prompt — O X

from
from
ply from

Create Local Users

While not required, increased security is achieved when using local user
accounts of varying privilege.

Use the most restrictive account to help protect from security threats that
could otherwise use elevated privileges to exploit the operating system. Only
log into an administrative account as needed.

1. Open Computer Management. (Run > compmgmt.msc)

2. Select Local Users and Groups in the left window pane.

3. Right-click the Users folder and select New User.

4. Enter a user name, password, and select ‘password never expires’.

5. After the user is created, right-click user and select Properties.

6. Go to the Member Of tab and Add the local group as desired.

Local Users and Groups Example

User Name Local Group
PlantPAx Engineering Administrators
PlantPAx Operators Power users

IMPORTANT  Local user accounts must be duplicated on all workstations with
shared credentials for seamless access.

Rockwell Automation Publication PROCES-UM100C-EN-P - June 2022 5l



Chapter 2 Domain or Workgroup

Create Local Security Policies

While not required, if you have various levels of local users you can set local
security policies that the more restricted accounts will not be able to modify.
1. Log on to the highest privilege local account with administrator access.
2. Open the Local Group Policy Editor (Run > gpedit.msc).
3. Expand Computer Configuration and go to Windows Settings > Security

Settings.
=/ Local Group Policy Editor — O >
File  Action View Help
o5 75 X= HE
L=[ Local Computer Policy A Mame Description ~
v O Cprgp::;r(ﬁn;ﬁguratmn adccount Palicies Password and account lockout pal
— ‘JIT' d are ;t::.ngs 4 Local Policies Auditing, user rights and security c
‘1 = |nans F: mlgi I Pali | Windows Firewall with Advanced Security \Windeows Firewall with Adwvanced =
arme Fesolution Paolic :
W Y | Metwork List Manager Policies Metnrark narne, icon and location

| Scripts (Startup/Shutdown)

=

= Deployed Printers

% Security Setings | Software Restriction Policies

,_'_:,I Account Policies ;.ﬂ\pplicatinn Contral Policies Application Cantrol Policies
@ IP Security Policies on Local Computer Internet Protocol Security (IPsec) 2,

| Public Key Palicies

7 Local Policies v
< > < b

4. Expand Computer Configuration and go to Windows Settings > Security
Settings > Account Policies.

You can configure a lockout policy for several failed login attempts of
unauthorized users.

5. Expand Computer Configuration and go to Windows Settings > Security
Settings > Local Policies.

You can configure User Rights Assignment and Security Options. You
can limit actions such as who can shut down the computer, change the
system time, access the computer from a network, and so on.

IMPORTANT Local Policies must be duplicated on all workstations for seamless
operation. This can be tedious and is why a domain controller with
the ability to push domain policies is recommended over a
workgroup.
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FactoryTalk DeskLock Utility (Optional)

DeskLock is a FactoryTalk® View tool for the Windows operating system.
DeskLock provides control options for smaller systems that do not use policy
or domain management.

Use the DeskLock tool to:

« Choose setting so that an operator using FactoryTalk View can’t gain
access to functionality not expressly configured by the system
administrator.

« Hide items on the Windows Explorer desktop, including the Taskbar and
Start menu.

« Disable key combinations that are used to perform specific Windows
actions, such as accessing the Task Manager.

Launch the DeskLock tool on computers with FactoryTalk View SE,
FactoryTalk® Studio, server, or client components.

1. Go to Rockwell Software > FactoryTalk View > Tools > DeskLock
2. Select Set Up DeskLock.

Desklock

Application 1 |

Restart wWindows |

Esit DeskLack |

I Set Up DeskLock .. 1

3. Explore each of the four tabs (Logon, Desktop, Password, Behavior).

Desklock Setup

Logon T Desktop T Password T Eehavior

‘windows Logon
[ Automatically Logon to Windows

Default Domain N arme: |F'ASSD1

Default User Name: [&sciministrator

Default Password: |

Canfirm Password: |

Options

7 Goto the background when it startz

Defaults | oK | Canecel |

4. Use the Help button for information on how to configure and use the
DeskLock utility.
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Notes:
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Process Automation System Server

The Process Automation System Server (PASS) can be configured after joining
an active domain or workgroup. The configuration steps described here cover

larger system implementations.

This is the recommended workflow to configure a Process Automation System

Server. For experienced users, each step outlines requirements. For more
detailed information, follow the referenced links.

Siep 1: Determine FactoryTalk Components

O
Step 2: Configure the PASS

The PASS hosts the FactoryTalk® Services Platform that provides a set of
common services (such as diagnostic messages, health monitoring services,
and access to real-time data).

« FactoryTalk® Administration Console
« FactoryTalk® Directory

« FactoryTalk® Activation

« FactoryTalk® Security

« FactoryTalk® Diagnostics

« FactoryTalk® Alarms and Events

For more information, see FactoryTalk Components.

Configure the PASS for standalone or distributed connectivity.
« Specify FactoryTalk Directory
« Configure the FactoryTalk Directory
« Run the Windows® Firewall Configuration Utility
« Configure FactoryTalk Activation servers

For more information, see Configure the PASS

For redundant PASS considerations, see Redundant Server Considerations
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O

Step 3: Configure Servers on the PASS

A FactoryTalk® View SE application is required to create the three major server
components that run on the PASS.

«  HMI server — Stores HMI project components, such as graphic displays,
and provides these components to Operator Workstations (OWS) upon
request

« Data server — Accesses information from the process controllers and
provides information to servers and workstations in the PlantPAx®
system

« TagAlarm and Event server — Provides alarm information from the
controllers and servers to each OWS upon request

Large distributed systems may require multiple servers running remotely in a
more elaborate architecture.

For more information, see Configure Servers on the PASS.

O

Step 4: Configure the Runtime Security

Runtime security must be configured to provide each account or user group
with the correct FactoryTalk View security codes. The security codes verify that
operators, maintenance personnel, and engineers have permission to run
secured commands, open secured graphic displays, or write to secured tags at
runtime.

For more information, see Configure Runtime Security With Control power
present, set the desired EtherNet/IP™ address.

Prerequisites Following the System Workflow, configure a PASS or PASS-C, depending on
the size of your system. Your results from the PSE determine the size of the
- e system.
PASS-C PASS

« The PASS server or servers must be deployed before doing the

g! ! E procedures in this section.

1 - For templates based on your system requirements, see the PlantPAx
I Template User Manual, publication 9528-UMoo1.

« PASS servers can be configured as redundant for HMI servers, data
servers, and/or alarm servers.
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FactoryTaIk Components The PASS hosts the FactoryTalk® Services Platform that provides a set of

common services (such as diagnostic messages, health monitoring services,
and access to real-time data). FactoryTalk software products and applications
depend on these services in a PlantPAx system.

FactoryTalk Service Platform components for the PASS include:

Component

Description

FactoryTalk Administration Console

FactoryTalk Administration Console is a stand-alone tool for developing, managing, and securing multiple FactoryTalk View applications.
On the Administration Console, delete old computer names from the FactoryTalk Directory. By deleting old computer names, the
FactoryTalk Directory contains current computer names only. Deletions also make sure that applications do not attempt to communicate
with computers that are no longer in the FactoryTalk Directory.

Required: Yes; a prerequisite on every PlantPAx computer containing FactoryTalk software.

FactoryTalk Directory

FactoryTalk Directory provides a central lookup service for a PlantPAx system so all definitions do not have to exist in a single physical
project file. References that are saved by FactoryTalk Directory are used by FactoryTalk-enabled products and FactoryTalk services to
locate definitions when they're needed.

It allows clients to locate key configuration information such as system organization, server locations, and policy information.
FactoryTalk Directory provides a common address or phone book of factory resources that are shared among FactoryTalk-enabled
applications in a distributed system.

Required: Yes; install as FactoryTalk Network Directory type

FactoryTalk Activation

FactoryTalk Activation services provide a secure, software-based system for activating Rockwell Software® products and managing
software activation files.

Required: Yes; a prerequisite on every PlantPAx computer containing FactoryTalk software. Activation file access is required for continuous
use of FactoryTalk software otherwise a 7-day grace period is started.

Placement: A PASS is recommended location to bind and place the license files. Other servers and workstations can refer to the PASS location
for floating or time borrowed activations. For more robust applications, activate each server locally to remove the dependency of remote license
access.

FactoryTalk® Security

FactoryTalk Security centralizes user authentication and authorization at the FactoryTalk Directory.

The users and groups are very similar in their management to Active Directory and can be linked to the Active Directory. This centralized
authentication and access contral allows for a ‘single user sign-in' experience when using FactoryTalk enabled products.

Required: Yes, for PlantPAx system release 5.0 and earlier.

Placement: Same server that is hosting the FactoryTalk Directory.

FactoryTalk® Diagnostics

FactoryTalk Diagnostics collects and provides access to activity, status, warning, and error messages generated throughout a
FactoryTalk system.

Required: Yes, for PlantPAx system release 5.0 and earlier.

Placement: Yes; a prerequisite on every PlantPAx computer containing FactoryTalk software.

FactoryTalk Alarms and Events

FactoryTalk Alarms and Events provides system-wide alarm monitoring and
control centralized at the FactoryTalk Directory.

Required: Yes, for PlantPAx system release 5.0 and earlier.

Placement: Alarm and Events Server on the PASS
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System SQL Server
Deployment

Configure the PASS

58

Before configuring the PASS server, confirm that the SQL Server deployment
has been completed and is accessible via the PASS server. This is required to
ensure that Alarms and Events can be recorded in the SQL Database.
Additionally, Batch server and Asset Management server will also create a DB
in the SQL Server. PlantPAx requires the following SQL features to be enabled
to ensure that data recording is possible.

Instance Features

Database Engine Services

SQL Server Replication

Full Text and Semantic Extractions for Search
Data Quality Service

Analysis Services

Shared Features

Data Quality Client

Client Tools Connectivity

Integration Services

Client Tools Backwards Compatibility
Client Tools SDK

Documentation Components

SQL Client Connectivity SDK

To configure the PASS:

Specify the location of the FactoryTalk Directory
Configure the FactoryTalk Directory

Run the Windows Firewall Configuration Utility
Configure FactoryTalk Activation servers
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Specify FactoryTalk Directory Location

Every computer must know whether to use its own local directory or to use a

network directory on a remote computer. Do the following for each computer
in the system.

1. Goto Rockwell Software > FactoryTalk Tools > FactoryTalk Directory
Server Location Utility and specity the location.

« For a PASS-C, specify the LOCAL directory and for each OWS client
specify the PASS-C directory.

« For distributed PASS system, specify that PASSo1 hosts the directory,
and for all other servers and workstations specify PASSo1.

FactoryTalk Directary Server Location Utility x

Use this dislog to change the Metwark directary that this computer belongs ta. This setting affects all software that connects
to the Metwark directory from this computer.

Use the FactomT alk Directory installed on: 0K

Computer hosting directory zerver [connected) Cancel |

|:| Help

pasll

2. Restart each computer after specifying its directory location.
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Configure the FactoryTalk Directory

Once you specify the FactoryTalk Directory location and restart the computer,
configure the FactoryTalk Network Directory or Local Directory on each
computer.

1. Goto Rockwell Software > FactoryTalk Tools > FactoryTalk Directory

Configuration and select Network or Local or both, depending upon the
perspective of the computer being configured.

2. Enter the Windows Administrative account user name and password.
In the Summary, verify that the configuration was successful.

f@ FactoryTalk Directory Configuration Wizard *

Summary

FactomT alk Metwork, Directory
Metwork Directory was successfully configured on this local computer.
Metwork Directory Server iz located on 'pazs01' remote computer.

FactoryT alk Local Directory
Configuration successful

Toreset a disabled FactoryTalk Security Administrator account, run this FactoryTalk
Directory Configuration Wizard again.

To close this wizard, click Close. Close | Help

Run Firewall Configuration Utility

The FactoryTalk Services Platform includes a Windows Firewall Configuration
Utility (WFCU) to provide firewall port exceptions to incoming and outgoing

processes that require remote access. Run this utility on every computer that

has installed FactoryTalk software.

1. Goto Rockwell Software > FactoryTalk Tools > Windows Firewall
Configuration Utility.
And process-related exceptions are displayed at the bottom.

2. Ifneeded, save a list of exceptions for future reference and the WFCU
activity is logged to C:\ProgramData\WFCU\WFCULog.txt

3. Ifno exceptions are needed, click Exit.

7, Itsrecommended to enable Windows Defender Firewall notifications to inform
&/ you of any additional applications that would be blocked.
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Configure FactoryTalk Activation Servers

The FactoryTalk Activation Manager (FTAM) software is a prerequisite that is
automatically installed on every PlantPAx computer that contains FactoryTalk
software.

For a PlantPAx system, the computer that hosts the FactoryTalk Directory,
such as the PASS, hosts the license files.

1. Go to Rockwell Software > FactoryTalk Activation > FactoryTalk
Activation Manager and select new activations, as needed.

2. After all new activations are generated, go to the Advanced Tab and click
‘Refresh Server’.

FactoryTalk &ctivation Manager . _ ;

Help | About

Home Manage Activations Advanced

The button below provides a conwvenient way to restart the activation servers running on this
. computer. Refreshing the servers causes them to notice recent changes.
) Refresh This Server

Refresh Server

Configure CodeMeter Server

Configure all other computers to reference the PASS location.

1. Goto Rockwell Software > FactoryTalk Activation > FactoryTalk
Activation Manager and select Update Activation Search Path.

[# FactaryTalk Activation Manager = [m} *

\‘:“ 1

b

Help | About

FactoryTalk™ Activation Manager

Home Manage Activations  Advanced

Select the location that will provide your activations or add

a new activation location: Update Activation Search Path
) Find Availahle Activations Path ta Activations
> Cillsers\Public\Documents\Rockwell AutomationiActivations

2. Select Add a server and enter the name or IP address of the license server
(PASSo1).
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3. Ifthere are no local activations, move PASSo1 to the top as the first

location to search for activations.

Update Sctivation Search Path *

Select the locations that will provide your activations or add a new activation location. Unchecked locations will not appear
on the list of search paths on the Find Available Activations page.

Selected  Path to Activations

Add Server Delete. .. Up Down Save Cancel

PASS01

ChllsersiPublic\Documents\Rockwell AutormationiActivations

4. Update the search path on all computers that require an activation.

Configure Servers on the A FactoryTalk View SE application is required to create the three major server

PASS

62

components that run on the PASS.

«  HMI server — Stores HMI project components, such as graphic displays,
and provides these components to Operator Workstations (OWS) upon
request.

« Data server — Accesses information from the process controllers and
provides information to servers and workstations in the PlantPAx
system.

« TagAlarm and Event server — Provides alarm information from the
controllers and servers to each OWS upon request.

The number of servers and how they’re configured can impact the speed of
system communication. Servers can be simplex or redundant.

« Asingle HMI server is sufficient for most PlantPAx systems.

« Multiple data servers are common. By locating each in separate areas, tag
lookup performance is improved as an HMI server knows specifically
which data server to browse and can ignore others.

The following steps provide basic server creation on a single PASS. Large
distributed systems can require multiple servers running remotely in a more
elaborate architecture.
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Create a New HMI Project

This section provides a method to create your own project and then import the
components from the PlantPAx Graphic Framework.

1. Goto FactoryTalk® View Studio software > New and select an application
type of View Site Edition.

The application types are Local Station, Network Station, or Network
Distributed.

&, PlantPAx systems are Network Distributed applications, even when server

&) components are consolidated on a stand-alone computer (PASS-C). The
exception is a process skid, where a Local Station application provides sufficient
functionality.

You now have a default application.

Define Areas

Areas organize and subdivide applications in a network directory into logical
and physical divisions. Areas can be created for different processes within a
manufacturing facility or to group each server type. This name hierarchy can
be visible externally, such as in the historian or alarm database.

Server assignment helps optimize performance. To help prevent unpredictable
search results, do not insert a server into the application root path. Each server
must be in its own area.

."21 FactoryTalk View Studio - View Site Edition (Network Distributed)
File View Settings Tools Window Help

‘FHE D0 S a0Er ey
=-0E Metwork (LOCALHOST)

C1f@ PlantPAx_ HMI
:.we Runtime Security

« Alarm area folder stores the Alarm and Event server.
« Data area folder contains the data server.

ESEI’VEH « HMl area folder stores FactoryTalk® View tags and I
: = FactoryTalk Linx Instance 01 .
iy displays.

@i = FactoryTalk Linx Instance 02
=gl FTAE I
=+-F* Tag Alarm and Events
i /2] Alarm and Event Setup
gl HMI
=13 HMI Server
System
HMI Tags
Graphics
Logic and Control
Data Log
RecipePro+

= |

]

E-E

System

Use the Explorer window in FactoryTalk View Studio to add areas.
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Go to the application and select New Area.

..121 FactoryTalk View Studio - View Site Edition (Metwork Distributed)
File View Settings Tools Window Help
mHe hsE QL8 ROE: > =}
=-[E Network (LOCALHOST)
=35 Pl :
_ B Delete
Add New Server >
Legical Name >
Backup...
Resource Editor...
Security..,
Properties...

2. Create three Areas, one for each of the three main server types (DATA,

FTAE, and HMI).

Explorer - HMI Server *+ 1 X

=10 MNetwark (LOCALHOST)
=B PlantPx HMI
-8 Runtime Security

IMPORTANT  Once you create an area, you can't change the name. You must delete and

recreate if you need to modify the name.
Do not use spaces in the Area name to achieve proper HMI functionality.
Do not put multiple servers in the root location of an area.
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Add an HMI Server

All PlantPAx systems require an HMI server.

1. Gotothe HMI area and select Add New Server> HMI Server. Each area
can only contain one HMI server.

Explorer - HMI Server v 1 X
=-[E Network (LOCALHOST)

= ga PlantPAx HMI

‘- Runtime Security

in) Scripts
[~ Eﬁ: e
- Delete
New Area...
Add New Server > HMI Server
Logical Name S Rockwell Automation Device Server (FactoryTalk Linx)...
OPC DA Server...
R reslE . Tag Alarm and Event Server...
Security... OPC UA Server...

Starting with FactoryTalk View SE 13.0, developers have the ability to
add all the process library components to a new or existing HMI
server.

Add HMI Server Wizard - Select Operation

Select the operation to be performed.

(®) Create a new HMI server

Add PlantPAx Library of Process Objects
() Copy an HMI server
(2 Import a project

() Attach to an existing HMI server

| < Back | MNext = || Cancel |

2. Enter a name, startup type, and specify the computer that hosts the
service (for example, PASSo1).

3. (optional) Click the Redundancy tab to specify a secondary PASS.
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4. Select startup items on the Components tab, such as data logging,
derived tags, events, and macros.

HMI Server Properties X || HMI Server Properties x
General Redundancy Componerts General Redundancy Compenents
MName: On startup components
| HMI Server
Description: Data logging:
| Derived tags:
Events:
Macro:
Computer hosting the server: A
[passoz
On shutdown macro:
Startup Type
(C) on demand (Redundancy will be disabled) On active macra:

(®) Load and run startup components when operating system initializes
On standby macror

Project file (relative to server computer):
| Ci\Users\Public\Documents'\RSView Enterprise\SE\HMI Projects'HMI Server ‘

Primary server

Mumber of displays: 50 Licensed maximum: 250 Run Startup Companents I Stop All Running Companents

Secondary server

Run Startup Companents Stop All Running Compaonents
Cancel Apply Help Cancel Apply Help

5. Click OK.

Add the Alarms and Events Database

The data servers and the alarms and events servers can log alarm and event
history to a SQL database. You must create this database before you can enable
logging to the servers.

1. Useeither FactoryTalk View SE Studio or the FactoryTalk Administrative
Console to add a database connection.

=-[E Metwork (LOCALHOST)

Ege PlantPlo HMI

E System

Action Groups

=8 Policies
@ Computers and Groups
&5 Metworks and Devices
=8 Users and Groups
= Connections

Databiases]

Add Database Connection...

Security..

2. Configure the database connection properties.
« Type: FactoryTalk Alarm & Events History Database
« Definition name: (new or existing)
« Server that hosts your SQL database: (local or remote)
« SQL database authentication
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« Database a name (new or existing)

Database Connection Properties X
Database Connection  Alarms Size Management  Alarms Advanced settings

Database type:

I FactoryTalk Alarm & Events History Database ~ Show Usage. ..

Definition name:

|

Server namelinstance: 0

| AppSery-SQLMSSQLSERVER |

Log in to database

Authentication: SGL Authentication v

User name: | 53 |

Password: | seseneeee |

Datahase name:

[FlantpasFrac | |

Test Connection Q Succeeded

O Cancel Apply Help

If the database does not exist, you get a prompt when you clock OK.
Click YES to create the database.

Add a Data Server (FactoryTalk Linx)

A FactoryTalk Linx data server is required to communicate to controllers. This
server type supports Logix Tag-based and Logix Instruction-based alarm
subscriptions.

1. Gotothe Data area and select Add New Server > Rockwell Automation
Device server (FactoryTalk® Linx).

Explorer - HMI Server v 1 X

{1 Network (LOCALHOST)
2@ PlantPAx HMI

o Runtime Security

LT Scripts

[~ E;:z!"“

) B Delete

=L New Area...

[oF Add New Server > HMI Server

=EEH

é iD Logical Name S Rockwell Automation Device Server (FactoryTalk Linx)...

OPC DA Server...
@ R reslE . Tag Alarm and Event Server...
@ Security... OPC UA Server...

2. Enter a name, startup type, and specify the computer that hosts the
service (for example, PASSo1).

3. Create a first or second instance Data server (FactoryTalk Linx), each in
its own area.

4. Enter a name, startup type, and specify the computer that hosts the
service (for example, PASSo1).

5. (optional) Click the Redundancy tab to specify a secondary PASS.

On the Alarm and Events tab, enable alarm and event support and enable
history.

7. Enable server-assigned priorities and configure as required.
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8. Enable history to configure alarm and event logging.

FactoryTalk Linx Server Properties X FactoryTalk Linx Server Properties x
General Redundancy Alamms and Events General Redundancy Alams and Everts
Name /& [ Enable alam and event support
FactoryTalk Lir Instance 01 Priorities
Enable server-assigned priorties
Descrption Severty Range
| Prioriy Low High
High
Medium
ew 0] [ ]
Computer hosting the Factory Talk Lirx server.
& | PASSD Tt Alam and Event History
Enable history
Server Type: Database definition:
Factory Talk Linx Instancell Server &l
Computer name:

Database name
Cache file path:
|C'\ngmm Data"\Rockwel\Alarms

Log languages: Default language:
English (United States... ~ English (United States), & ~
Cocd | fowy || Heb Concel | [ rowy | [ b

IMPORTANT  FactoryTalk Linx Instance(2 is a separate independent service on
the Windows operating system that is designed to allow applications
to have more tags, data clients, and/or controllers without affecting
the first instance.

Instance02 isn't supported on FactoryTalk View SE local station and
is limited to an Ethernet driver.

For information on verifying the data server, see Appendix C, PlantPAx
Deployment Recommendations and Verification Tool.

Once the data server is created, name and configure device shortcuts

to controllers and subscribe to the data server. Select All Alarms & Events
Notification Messages to support Logix tag-based alarms and automatic
diagnostic messages.

Expiloter - HMI Server ® ication Setup - RNA/SGlobal HMIDATA Server 1/FactoryTalk Linx Instance 01 x -
[ Netwark (LOCALHOST) Device Shortous |
= Bo PlantPax_HMI —
- Runtime Security add | _Remove |[ 2o | w0 190.0601.109, 1756-ENETR, 1756-ENTRIC
IT Seripts - @ 1927880, 1900152.168.1,109], 1756-EMZTR, *
= gl DATA @ 1901681101, 1756-ENITR, 1756-ENITR/C
E Server 1 R | 1521681112, 5065-L3406RP, RA LIB Proce|
5 B FactoryTalk Lins Instance 01 Made: Online Mot Brorwesing
Eenmicsmsed |l
B s:vlerz : oifine Tog Fle '
tout T I
5l FTAE Phatat Type |Processce
! HM Logi Extended Tog Properties
Systern =
Action Groups I Uipload ol etersdend bag profertiss
- Paligaes
¥ Cornputers and Groups — ’
L) Al Alsreves B Events NotFication Messages
i &5 Metworks and Devices for T T %
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Add a Data Server (OPC UA)

An OPC UA data server is required to communicate with OPC UA devices. This
server type supports OPC UA data and OPC UA Alarms and Conditions.

1. Use the Explorer window in FactoryTalk View Studio to add a new area
for the OPC UA server.

2. Gotothe new area and select Add New Server > OPC UA Server.

3. (optional) Click the Help button for more information about configuring
the OPC UA server.

4. Enter a name and specify the computer that hosts the service. It’s a best
practice to host the OPC UA server on a dedicated computer with no
other FactoryTalk servers.

5. (optional) Enable option to keep configuration when service is
uninstalled.

6. (optional) Enable redundancy option if using a secondary server. Click
the Redundancy tab and specify a secondary server.

7. Click the OPC UA Servers tab.

Enter a name for the OPC UA server. Specify an Endpoint URL for the
server.

9. (optional) If Redundancy is enabled and using a different standby URL,
click the (Secondary) tab and specify a standby URL. Otherwise, enable
the option to utilize the same URL as primary.

10. Specify Security settings for the OPC UA server.

11. Specify Authentication Settings for the OPC UA server.

12. Specify Data Access settings for the OPC UA server.

13. (optional) Enable alarm support and History in the Alarms Settings.
14. Specify Diagnostic Logging settings for the OPC UA server.

15. (optional) Click Add and repeat previous steps for any additional OPC UA
servers.

16. (optional) Click the Certificate Management tab to manage access and
certificates for the OPC UA servers.

ncy tab 3nd rastse the OPC LA Cannecior Making changes o1 nun lime coukd cats unexpicied results
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FactoryTak Linx OPC LA Connector 1

®
Connecdar
I g dent Demdancy
name and locabon
0 . Cen FactoryTak Lins DPC LA Connacior
e ores ' '
Rt
endpors URLs e
. senver bacos
B Cerithonte Management
cumgong certBostes v
el Turm Shsich b Premary Such 10 Secondary
O R o
kool Sorve Sk
£] Owmostc Log [ OFCUASerme | R [ & s Redwrdancy Sibe | E
diagrostics
| |
FactoryTak Linx DFC LA Connector ¥ =
I g dent Frman) | ey |
name and locabon OPC UA Sarvars
Hedundancy [ |
i ] Marign sedurdancy fhers | Loseken I T —
S | ket Py
B Dl e
‘endpomt URLs LSerene 01
Certtheate Management [
B fisrase necmesg
cumgong certBostes
ol T
O frma Endpoint UL
-

[ Ukze the 3ame UL a3 prmary endport
fl Factory Talt ) Swich to sty URL when scine UA server fils
" Dsgrostie Log

Virw histoncal
o =
= Commanication i not staed
[ RN
i covemion 5

Becunty Fobey
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Security Mode

Neone

Conficats pat
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For information on verifying the data server (OPC UA), see Appendix C.

Add an Alarm Server

An alarms and events server is required for server tag-based alarms.

1. Gotothe FTAE area and select Add New Server > Tag Alarm and Event
Server.

Explorer - HMI Server * I X
=-[E Network (LOCALHOST)

= ga PlantPAx HMI
‘- Runtime Security

in) Scripts
ot Delete
New Area...
Add New Server > HMI Server
Logical Name S Rockwell Automation Device Server (FactoryTalk Linx)...

OPC DA Server...
R reslE . Tag Alarm and Event Server...

Security... OPC UA Server...

e - -

n
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2. Enter a name, startup type, and specify the computer that hosts the

12

service (for example, PASSo1).

3. (optional) Click the Redundancy tab to specify a secondary PASS.
Click the Priorities and History tab and enable server-assigned priorities.

5. Enable history to configure alarm and event logging.

Tag Alarm and Events Properties 2 || Tag Alarm and Events Properties
General Redundancy Priorities and History General  Redundancy —Priorties and History
Hanme: Friorties
Tag Alaim and Events Enable server-assigned priorties
Description: Severty Range
Priority Low High
Urgent EE]
High
: Medim
Computer hasting the alam server:
Ay PaSsOY ~ Low (=]
Startup type:
Al d Event Hist
(® Load when operating system initializes = and Bvent Riseny
] Enable hist
() when first client connects (Fedundancy wil be disabled) avle fistory
Database defintion:
Computer name
Database name:
Cache file path
|C “ProgramData*Rockwel\Alams |
Log languages:
[ Engish (Unted States), 2105 “]
Cancel Apply Help Cancel Help

Now that your servers are organized into areas, you're ready to start

developing your HMI application.

2 FactoryTalk View Studio - View Site Edition (Network Distributed)

File View Settings Tools Window Help

‘HHe et 0@ A

=108 Metwork (LOCALHOST)
/@ PlantP A HMI
w0 Runtime Security
LT Scripts
= FactoryTalk Linx
E
Tag Alarm and Events
E8 o

S HMI Server
System
HMI Tags
Graphics

Legic and Centrol
Data Log
RecipePro+

System

For details on building an HMI template, see the Rockwell Automation Library

of Process Objects Reference Manual, publication PROCES-RM2.00.
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Redundant Server
Considerations

Configure Runtime Security

Redundant HMI, Data, and Alarm servers provide higher availability on a
network distributed architecture. Primary and secondary servers are hosted
on different PASS servers where control can be switched between them.

When implementing a primary and secondary server (PASSo2A and
PASS02B), we recommend that you use a single PASSo1 (non-redundant) to
host the FactoryTalk Network Directory and FactoryTalk Activations. By using
the PASSo1, these common components still are accessible in case one of the
redundant servers is unreachable.

Access the Redundancy tab of each servers' properties to enable redundancy
and specify the secondary server.

HMI Server Properties X

Generall Redundancy | Components

Provide redundancy using a secondary server I
SCEnEy Server
Computer hosting the server:
[Passoze

Startup type:
Load and un startup components when operating system initializes

Mumber of displays:  Unknown Licensed masimum:  Unknown
Switchover options

® Continue using the secondary server even when the primary server
becomes available again

() Switch aver to the primary server when it becames available

Replication

Replicate Active ta Standby.

Cancel Apply Help

Configuration and command execution can be secured in Process Library by
user role, user training or qualification, and by workstation location. Role
based security uses user roles such as ‘Operator’ or ‘Engineer’ to allow access to
configuration changes and command execution. Area security restricts access
to users who have the proper training or qualifications by assigning users to
area user groups that correspond to the area configured for a device. Finally,
line of sight security may be implemented to restrict operation to specific
computers. All three of these security methods may be implemented

concurrently. Refer to Security Example on page 88 for an example
implementation.

Role Based Security

See the link on the front cover of this manual to access the security
information spreadsheet.

#, Theimages in this section depict a single application with both FactoryTalk User
' Groups and Domain User Groups together. However, it isn't recommended to use
both types of user groups in a single application

Runtime security must be configured to provide each account or user group
with the correct FactoryTalk View security codes. The security codes verify that
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operators, maintenance personnel, and engineers have permission to run
secured commands, open secured graphic displays, or write to secured tags at
runtime.

1. On the PASS, go to Rockwell Software > FactoryTalk View > Tools > Tag
Import and Export Wizard.

Page

Action

Tag Import and Export Wizard
Operations field

From the Operation pull-down menu, select Import FactoryTalk View tag CSV files and click Next.

From the pull-down menu, select Site Edition and click Browse (ellipsis ...).

Select the path of SE > HMI Projects > HMI Server.

Select HMI Server.sed and click Open.

Click Next and Browse (ellipsis ...)) for the FTViewSE_ProcessLibrary_Tags_5_00_xx.CSV file; where xx = the
service release number.
This file is distributed with the PlantPAx Library of Process Objects Library.

Click Open, click Next twice, and then Finish.
The import results appear on the Database Import window.

14

To set security permissions to groups on the workstation, complete these
steps.
1. Open the HMI application with FactoryTalk View Studio software.

2. Verify that the security tags have been imported by expanding the HMI
Area and viewing HMI Tags folders. (Const, RALibrary, and Security)

| FactoryTalk View Studio - View Site Edition (Network Distributed)
File Edit View Settings Tools Window Help
EEaeneE 0@ AnE i re a0 HB AN 9CERIESET Lk > F
Ee———ss
=-[E Network (LOCALHOST) =] %
£fe PlantPA HMI < Tags - /PlantPix_HMIHMI -
‘- Runtime Security O W E O
Tag
Name: Security\Alarmack | Close |
Type: Security: | ¥ = [ oz 1
Description: | Acknowledge/Reset Alarms |-T|
EX|
Length: 16 =
New
HMI Tags Data Source | Help7|
7 Tags Type: ()Device  (® Memory .
3 Craphics Initial Val ABCDEF
-7 Logic and Control i
+ Data Log [ Retentive
: S)::-tem Recipebros Search For: Alm | Tag Name Type Description ~
T Action Groups | ‘ SecuritylAlarmAck String  Acknowledge/Reset Alarms
Policies SecurityldlarmConfig String |Alarm Configuration
@ I Computers and Groups & - SecurityldlarmDisable String Disable Alarms
35 Networks and Devices = ;:'j; Security\ilarmShelve String  Shehve Alarms
[ I Users and Groups : au: SecuritylBypassFeedback String Can Bypass Feedback
i \
i I Connections ; Security\Bypassinterlocks String Bypass Permissives and Interlocks
H spstem
Permission Sets ¥ SecuritACmdSrcMaint String  Acquire/Release Equipment Maintenance
SecuritACmdSrcOperProg String |Acquire/Lock and Release Equipment Ope
SecuribtACmdSrcOutOfService  String  Can put device infout of service
SecurityiConfigSecurity String Change the security for a device %
> = - P TP 7 T R PR WTT—rS .
< >

3. Select Runtime Security from the Explorer window or top menu bar
under Settings.

4. Within Runtime Security, click the Security Accounts button.

5. From the Security Settings dialog box, select 'All Users' and
click Remove.

6. Click Add.

From the Select Users and Computer dialog box, select a PlantPAx group
and click OK.

Rockwell Automation Publication PROCES-UM100C-EN-P - June 2022



Chapter 3

Process Automation System Server

For FactoryTalk user groups:

=8 Runtime Security - RNA://$Global/PlantPax -
R 2¢ &
Specily the FactonT alk Security accounts that will have runtime access to the FactoryT alk View SE application
Chick the Security Accounts bulton to add of fsmove an account, and to sssign AP secuty codes. Chick the bowse
Ibuttons [...] to select optional Login and Logout macios for the account
Account|D:  |ALL USERS]
P Effei
Logn Macio: s | Select User and Computer >
View permissions b
Logout Macta | Sielect 3 user [of user group) and compeder (or computer group) pai
1 U | T
Securly Accounts. .. | 'ﬂ;:u | bl ~ | | Computers
- - | e $HPLANTPAX_ADMINISTRATOR 840 Computess
Account T FLANTPAX_ENGINEERING
Fil PLANTPAX_MAINTENANCE
il PLANTPAX_MAINTEMANCE_SUPERY,
| | €0 PLANTPEX MANAGER
| [1l PLANTPAX_OPERATING_SUPERVISO
Pemissions for A |ERPLANTPAX OPERATORS
r % B 575 TEMVAREADT_ADVANCED
B Adien | | o) cveTEMAREADT_BASIC
All Actia | @8 < s TEMVAREANZ_ADVANCED
@ Facton | ghcySTEMAREAN BASIC v
< >
Create New > Create New ->
| FiterUsers Fiter Computers
(®) Show gioups only (®) Show groups only
() Show uzers only () Show computers only
O Showal O Show al
| oK Cancel Help
L
< >

For Domain user groups:

=8 Runtime Security - RNAL/SGlobal/FlantPax = g =
H 2C &
Speciy the FactoryTalk Secunty accounts that wall have nuntime access to the FactoryTalk View SE appication
Chick the Secusity Accounts button to add or remove an account, and to aszign A-P secunty codes. Chck the browss
battons [...] to select optional Login and Logout macros for the account
AccountID: [ALL USERS]
Pemmissions  Effey .
Login Macro | Select User and Computer ®
Wiews panmissons by
Logout Macto: | Select a uses or user group] and computes for computer group) pai.
Secusty Accounts... | 'g:u Users A | | Computess
= | 0 S TEMVAREADT_ADVANCED 8 A8 Computers
Account B STSTEMVAREADT_BASIC |
| B SYSTEMVAREADZ_ADVANCED [
<4 SYSTEMPLANTPAX ADMINISTRATOR
‘ SYSTEM\PLANTPAX ENGINEERING
Peamissions for A | 81 SYSTEM\PLANTPAX MAINTENANCE
a ¥ -1 SYSTEM\PLANTPAX MAINTENANCE
Ackon. SYSTEM\PLANTPAX MANAGER
All Actiq | &8} <5 TEMPLANTPAX DPERATING SU
B Factory | #9)ysTEM\PLANTPAX OPERATORS
>
|
Crmate New > Create New -
| Filter Users Filter Computers
(®) Show groups only (@) Show groups only
(O) Show usess only () Show computers only
() Show al (2 Show all
‘ 0K Cancel Help
3 L = =

Repeat adding users until all PlantPAx groups are selected.
9. You can assign security to each PlantPAx group based on letters (A...G).
10. If you're using e-signature with approval, add the group HMI_Approver.

A-P codes aren’t required for HMI_Approver.
11. Select a group from the Users list.

The default is that all FactoryTalk View Security Codes are

checked Allow.

12. Click the Allow box beside each FactoryTalk View Security Code that you
want to allow permission for the selected account.
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For example, allow security of 'A’ for an Operator.
Table 4 - Recommended Group Security Codes

Group Security Code

Operators

Operating Supervisor

Maintenance

Maintenance Supervisor

Engineering

Manager

QM| M| ol O | =

Administrator

For FactoryTalk user groups:

(T ey — *

T [ Ry

Wil GG Wl by * U AstGn
|
| Comguren &
| B4 Compter
£ AT mal_S0PE i BBl Compuims
PLARTRR, DPTRATORS |l Compuiers
L >
il Remcrs_|
P el Rt PLANTPRC OPERAT DRS o Al Comgadiaii
B Ackon How ey
| AN Actiana o o |
B Faoteiy] sk Veew Seculy Cided ] Q
A ) =]
B o o
e a o
0 o =]
E o =]
F a o
[ a o
" a o
1 o o
J o o
K O o
L o o
" o o
W =] =]
] o =
P a o

For Domain user groups:

| W79 Saeuriny Sersiregs for Plusthtc x

1T s—

e i Ly CHT Zakon

Usa Eomputens =
| FYRTEMPLANTPR ARG Bl Comgateny

PISTEMPLANTRAS DPERAT 4G | MLl Compdani

SYSTEMPLANTPAR OPERATORS LA Compuion:

f 3
Prosmayiscrd ki 505 TERAWPLAHT PG OPERATORS bnoas A Commge
B chion Fy e [
AN Actans o o |
£ Fatlony| ok View Secusty Cobes O o
A B o
€ = o
o O o
F o o
& o o
H o o
K O [n]
L u] o
" o o
N o o
= =

o | Careel Help

13. Repeat the steps for each user or group account that you want to
configure with runtime security.
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Area Based Security

Complete these steps to create area FactoryTalk user groups for each secure
area of a production facility.

1. From the FactoryTalk Administration Console, click ‘+ to expand System
and then click ‘+’ to expand Users and Groups.

IR Network (PPPASST)

e PlantPAx
== Runtime Security
LT Seripts
Systern
Action Groups
Policies
Computers and Groups
5 5 Nebworks and Devices
Users and Groups
Ustrs Hew 3 User Graup.. I
Connections Security... Windows-Linked User Group...
Permission Sew |

2. Right-click User Groups and choose New>User Group.

On the New User Group dialog box, you must add two groups:
‘areao1_Advanced,” ‘areao1_Basic’. These groups define which Areao1
Users have basic functions on the faceplate or advanced functions
(engineering, maintenance).

@, Theinstructions default to Area01. You may modify the area name in the
&/ instruction and group names to meet your needs.

3. Toadd groups, type the name (example, AREAo1_ADVANCED) and
click Add.

MNew User Group x

General

Name AREANT_ADVANCED

Descrptiorc |
E-mad

Membess:
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4. Select Authenticated Users and use the default ‘Show groups only’ and

click OK.

5. Click OK again.

[E=NNCR =<~

Select User or Group

“windows Administratars

how groups only

() Show uzers only

() Show all

I n]S I[ Cancel ][ Help

Your two groups for AREAo1 look like the example.

Users and Groups

& Authenticated Users

A8 SYSTEMMVAREADT_ADVANCED

25 SYSTEMVAREAQT_BASIC

£5 SYSTEMVAREAD2 ADVANCED

25 SYSTEMVAREAQZ_BASIC

£& SYSTEM\PLANTPRAX ADMINISTRATOR

5 SYSTEM\PLANTPAX ENGINEERING

A& SYSTEMPLANTRAX MAINTENANCE

5 SYSTEM\PLANTPAX MAINTENANCE SUPERVISOR
&5 SYSTEMVPLANTPAX MANAGER

£ SYSTEM\PLANTPAX OPERATING SUPERVISOR
A& SYSTEMPLANTRAX OPERATORS

E& Windows Administrators

&2 Adrinistrators

B5 AREADT ADVANLED

8,07 B
&8 Engineers
&2 HMI_APPROVER

=5 Maintenance

22 PLANTPAX_ADMINISTRATOR

S5 PLANTPAX_ENGINEERING

&5 PLANTPAX_MAINTENANCE

28 PLANTPAX_MAINTENANCE_SUPERVISOR
&5 PLANTPAX_MAMNAGER

22 PLANTPAX_OPERATING_SUPERVISOR
&2 PLANTPAX_OPERATORS

6. Repeat step 3 and step 4 to add groups for additional areas.
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Complete these steps to import area Domain user groups for each secure area
of a production facility.

1. From the FactoryTalk Administration Console, click ‘+ to expand System

and then click “+’ to expand Users and Groups.

2. Right-click User Groups and choose New>Windows-Linked Group.

= [0 Network (PPPASST)
5 fe PlantPax
o Runtime Security
LT Seripts
= Systemn
Action Groups
& Palicies
+ 1 Computers and Groups
+ 55 Networks and Devices
= Users and Groups

22} m
® Users New &

+# 10 Connections

Security.. Windows-Linked User Group...
Permission Seo

User Group...

3. Select Add.

MNew Windows-Linked User Group x
Genersl
Chick the Add button to select one of more Windows user
groups. wWhen you cick the Create button, a new inked
uzet account will be created for each Windows user group
you have selected
Goen | [ e
4. Select Locations.
Select Groups X
Select this object type:
| Groups or Bultin security principals Dbject Types...
From this location
fprews1 | e
Enter the object names to select [examples)
Advanced... Ok Cancel
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5. Browse to your domain directory where you created areas. For this
example System.PlantPAx.Local\PlantPAx\Areas

Locations
Select the location you want to search.

Location:

PPEWS1

Entire Directory

5 System PlantPAx Local
#-5] Bultin

#1151 Computers

#1721 Domain Controllers

3

+

~
3

2 ForeignSecurityPrincipals
Managed Senice Accounts

Cancel

6. Select Find Now.

Select Groups

Selct this cbyect lype:

Friotn et locahons
Auess

Common Ousees
Mame: Sty wih

Description: | Stats wih

Search resully

Name Deserphion In

7. Select all areas from the search

results that you want to import.

For this example Areao1_Basic, Areao1_Advanced, Areao2_Basic,

Areao2_Advanced. Click OK.

Select Groups

Select this object lype:
| Gaoups

From this location
|Areas

Common Quenes
Mame: Stats with

Descrpbion: | Stads with ~ | |

Search resuls:
Name: Description

Aueall]_Advanced
2 fveal_Basc
B piesl2_pdvanced
B, Aresl2_Basic
B, fuea3_Advanced
2 feal3 Basic
R Auesld_Advanced
B, Aiwald_Basic
2 freals_Advanced
B veals_Basic

| | Dbject Types...

Locations. .

In Folder

System PlantPix Local/ PlaniPixAreas
Syztem PlartPlx Local/PlantPixieas
System PlantPio Local PlantPhoisess
Syztem PlantPéu Local/PlantPiedseas
System PlaniPic Local PlantPix/dseas
System PlantPio Local PlantPhoxdsess
System PlantPlo Local PlantPloAsess
Syztem PlantPix Local/PlantPls/beas
Syetem PlartPio Local PlantiPix fdreas
System PlantPho Local PlantPlhodsess
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8. Select OK on the next two displays.

P 5 | NewWindows-Linked User Group
Select his obiect ype: Ganwal
!GW ]. Obgect Types... Chick the Add button to select one o more Windows uses
s 5 groups. When you click the Create button, a new inked
[Firom this location: uepes sccount vill be created for each Windows user group
[Bress | | Locations... youhavs selecied.
== S [ g svsTEMwREAD_ADVANCED
Entot s objoct romet fo seloct | | €8 SYSTEM\AREAD_BASIC
- Aueall] Basic: Area} Advanced. freal? Baticl | Check Names | €S YSTEM\AREANZ_ADVANCED
: SYSTEMMAREADZ_BASIC
e =
| < >
l
A,
Cocel || Hap

The domain areas are added to User Groups and look as follows:

Users and Groups

g uthenticated Llier

5 SYSTEMVAREADT ADVANCED
5 SYSTEMVAREADT BASIC

&5 SYSTEMVAREADZ ADVANCED
2= SYSTEMVAREADD BASIC

Bs SYSTEM\PLANTPAX ADMINISTRATOR

25 SYSTEM\PLANTRAX ENGINEERING

25 SYSTEMPLANTPAX MAINTEMANCE

A5 SYSTEM\PLANTPAX MAINTEMANCE SUPERVISOR
85 SYSTEM\PLANTRAX MANAGER

£5 SYSTEM\PLANTPAX OPERATING SUPERVISOR
8 SYSTEMPLANTPAX OPERATORS
E& Windows Administratars

&8 Administrators

25 AREADI ADVANCED

25 AREADI_BASIC

25 AREADI ADVANCED

25 AREAD_BASIC

28 Engineers

&2 HMI_APPROVER

28 Maintenance

25 PLANTPAX ADMINISTRATOR

£5 PLANTPAX_ENGINEERING

25 PLANTPAX_MAINTENANCE

52 PLANTPAX_ MAINTENANCE_SUPERVISOR

£5 PLANTPAX_MANAGER

S5 PLANTPAX_OPERATING_SUPERMISOR

22 PLANTPAX_OPERATORS
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Configure an Area

For each object instance in controller code, it’s required to configure an area
using the instruction dialog box (PlantPAx instructions) or extended tag
property area (Add-On Instructions). Configuring each instruction with the
specified area name will grant or deny permissions on the faceplates for these
objects. The following displays use the default value “Areao1”.

To grant permission on faceplates, the Area name in the controller must match
the area that is created within the HMI application (without _Basic \ _Advanced).

For FactoryTalk user groups:

Figure 3 - PlantPAx Instruction Dialog Box

| @ i Prapesies - xe1ore o x

| @ Pan Properer - xz101* o =

Geners

HM =501 Labet ] e

Ares name for security:

| | |

Felp button UAL:
Tz I | g

Farameters

tian 10 an object with mare information:

| Drewhoe state; A1 taeges
Device lsswes: Mone

Device state; 4z sarget
Device awes: None

Cancel Apsly Hep |

Figure 4 - Add-On Instruction Extended Tag Property
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<7 Controller Tags - RA_LIB_ControlStrategies_5_00_02(controller) X <7 Controller Tags - RA_LIB_ControlStrategies_5_00_02(controller) % _
Scape: \ [RA_LIE_Cantrolt v| Shau |AH Tags VH ¥, D4sD “ Scope: | [3AA_LIB_Cantok | Shaw [aTans - |[r.ps0 o
Name =g|~ Value® Force Mask® Style DataType  Description * T -1 Name 2|4 Value# Force Mask+ Style Data Type A | properties v
| e 1 1.1 raP_| 4 Textended Properties.. | | 1.} .} 13P_Duc_D4SD Tag =N [Evtended Properties..  +
> DISDIO0 P o] I} P_PERMISSIVE TogDescript - £ || b [General b D400 GPerm L Lt P_PERMISSIVE TagDescript-F | » General
b DISDIO0TPerm du Ll P_PERMISSVE TagDescript-F || 4 Data b DASDI00_TPerm  {.} [ P_PERMISSIVE TogDescript -F ] 4 Data
- - Value [
b DASDI002Perm  fud L P_PERMISSIVE TogDescript - F Value Lo} b DASDI0O 2Perm  {. {et P_PERMISSIVE TagDescript - F aren
Area b DASDIO0 WPerm [} ot P_PERMISSIVE TagDescript - F
> DASDIOD BPern [ [ P_PERMISSIVE TagDescript - F engunenring Uit k d aDescrip Enginesring Unit
b DASDIOOIntk .0 fud L P_INTERLOGK. TegDescript - | Instruction 1oP_Dwve_DASD D BEDEARES  ful Lt G [ERORRY TegD<script - | Instruction 1aP_Dve_D4sD)
b D4SD100_Intlk_1 Ll [ PINTERLOCK TogDescript - | Label Discrete Device D BEDEAGDS  ful Lt G IEROSY TegD=script - | tab'"‘ D‘;‘:B‘OD“‘“
b DASDI00 Inelk_2 P_INTERLOCK. TagDescript - | farary rap-
b DASDIOOIrtk 2 {.} [ P_INTERLOCK. TagDescript - | Library raP-5_00 Undles & Lt d agheserp AL
URL b A0 PINTERLOCK. TegDescript -1
b DASDI00Intlk 3 {.} L.} P_INTERLOCK TagDescript - | forea b . nE b Lk - gbserp Force Mask L
orce Masl b DASDI00INtEA L. PINTERLOCK. TagDescript -1 .
b DASDIOOIntk A o 1.4 PINTERLOCK TagDescript- | Ny produced Connecti Uiiled) - e £ aDescrip » Produced Connection
b DASDIOL kS {ud o o CaE: ‘ roduced Lonnection b D4SDI00Inth S [.} 1. P_INTERLOCK. TagDescript- | | b Consumed Connection
) Intlk_ X agDescript - b C d G i .
9 p ) e b DDtk E L Lt P_INTERLOGK. TegDescript -1 || » Parameter Connections {0:0}
> DASDIOD Itk 6 {. [ P_INTERLOCK TagDescript -1 | P Parameter Connections {0:0}
b ATIO0IN T [ L} PINTERLOCK. TagDescript - |
b NASNANN [mHl 7 I r B INTERI ACK TanNacrrving ot |
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For Domain user groups:
Figure 5 - PlantPAx Instruction Dialog Box
O % | @ Ao Propesties x0T o x
| e |
! |
i | |
; ) |
= | |
!.'\'. it !
Device state; 4 targes Diesclen state: 4t tarmget
Device bvwes: None % O‘ Cancel Help 1 Dedce bovuess More Caned ":ﬂﬂh "C"ﬁ

<7 Controller Tags - RA_LIB_ControlStrategies_5_00_02(controller)

Figure 6 - Add-On Instruction Extended Tag Property

Scope: ‘ [ER4_LIB_Controlt v| Show: ‘A\ITags

b DASD100_0Perm
» DASDI00_1Perm
b DASD100_2Perm
b DASD100_3Perm
b DASDI00 Itk O
b DASD100 Itk 1
b DASD100Intk_2
b DASDI00 Intlk_3
b DASDI00 Itk 4
b DASDI00Intk_S
b DASDI00 Intlk_6
b DASDI00 Itk 7

=5~ Value® Force Mask® Style Data Type

raP Dve D45D Tag

P_PERMISSIVE TagDescript -
P_PERMISSIVE TagDescript -
F_PERMISSIVE TagDescript -
P_PERMISSIVE TagDescript -
P_INTERLOCK TagDescript -
F_INTERLOCK. TagDescript -
F_INTERLOCK. TagDescript -
P_INTERLOCK TagDescript -
P_INTERLOCK. TagDescript -
F_INTERLOCK. TagDescript -
P_INTERLOCK. TagDescript -
P_INTERLOCK. TagDescript -
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[T D450 v Soope: | [3RA_LIB_Contiok + | Showw a1 Tags «[v.p4s0 v
Description Name 2]+ Value® Force Mask® Style DataType  Description || rroperties —_—
=0, Tevtendea propemes.. v [P 04spine 1. L.} =y Textended Propertes.. =
b General b D4SDT00QPerm  {ud [ P > General
4 Data b DASDIO01Perm  {u] [ P_PERMISSIVE TagDescript - | 4 Data
Value bl b DASDI00_2Perm [} L} P_PERMISSIVE TagDescript - F Value Lt
Area Systern\Area0l . Area Systernyreal?
Engineering Unie b DASDI00 IPerm  {ud = P_PERMISSIVE TagDescript - F Engineering Unit
Instruction raP_Dwe_D4SD b D45D100_Intlk_0 {} fo} P_INTERLOCK TagDescript -1 Instruction raP_Dwe_DASD
Label Discrete Device b D4SDT00Intlk_ 1 {.} L} P_INTERLOCK TagDescript - | Label Discrete Device
Library raP-5.00 b D4SD100 Itk 2 {.) L.} P_INTERLOCK TagDescript - | Library raf-5.00
URL b DASDTO0Intk 3 {ud [ P_INTERLOCK TagDescript -1 URL
Force Mask [ Force Mask [
b Produced Connection O DEIIOALS C) P_INTERLOCK TagDescript -1 R produced Connection
b Consumed Connection b DASDTO0 Itk S [ [ PINTERLOCK TagDescript -1 | b Consumed Connection
b Parameter Connections {0:0} b DASDI00_Intlk_6 1. Lo P_INTERLOCK TagDescript - | b Parameter Connections {0:0}
b DASDIOLIntk 7 {ud [ P_INTERLOCK TagDescript -1

Adding Users to Groups

Assign each user to the appropriate user group. Only FactoryTalk users need to
be added to Users. No need to add Windows-Linked Users.

With multiple process areas defined (example Areao1, Areao2), note that each
user needs to be assigned not only to the HMI_{group} (example
HMI_Operator) but also the “area” group. Operators are assigned to the
HMI_Operator group and then also to the Areao1_Basic group. This limits
operator access to only the faceplate operator controls for devices that are
assigned to Areao1. Engineers will be assigned to the HMI_Engineering group
and also to the Areao1_Advanced and Areao1_Basic groups. This allows the
engineer access to also the advanced engineering features on the faceplates for
devices that are assigned to Area_o1.

IMPORTANT  Users assigned to "Advanced” groups must also be assigned to the
corresponding “Basic” groups

1. Open the HMI application with FactoryTalk View Studio software.
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2. Select Users from the menu.

Explorer - Dev_PlantPia_5_00 » 0 X
L Legacy Recipes ~
¥ Local Messages
A Trend Templates
2 Trend Snapshots
5 TrendPro Templates

Logic and Contral
@y Derived Tags
& Events
B Macros
B Client Keys
Data Log
[fig Data Log Models
RecipePros
=, RecipePro+ Editor
e FactoryTalk Linx
= Systern
Action Groups
18 Policies
[ 25 Metworks and Devices
Users and Groups
¥ User Groups
= berto
=8 Anonyrmous Logon

o Dave

- Default
a Janet
U

 Martha

& Torys

R

Connections v

< >

3. Right-click on a user to select that user’s properties.
4. Select the Group Membership tab and select Add.

Hew FactoryTalk User

| Generl Group Membesship

Member of:
|
|

o
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5. Select the groups to assign to the user. (Multiple groups can be selected
by holding down the Ctrl key.)

Select User Group - x

#HAREAD

€7 AREADZ_ADVANCED

€7 AREADZ_BASIC
Engineers

€7 HMI_4PPROVER

ﬂ Maintenance
PLANTFAX_ADMINISTRATOR

h PLANTPE, ENGINEERING

€7 PLANTPAX_MAINTEMANCE

PLANTPA%_MAINTEMANCE_SUPERY

#P kTR LAkl AC D

£ >

Create Mew -»

Filter Users
(®) Show groups only

0k Cancel Help

Ve It's recommended that users that belong to the HMI_Engineer and

HMI_Maintenance_Supervisor group also be added to both the area01_Basic and
area01_Advanced groups.

6. Once added, the groups appear assigned to the user.

Mew FactoryTalk User *

General  Group Membership
hember of:

€5 AREAN_ADVANCED
€0 AREADT_BASIC
€7 FLANTRAX_ENGINEERING

Add. Remove...

Ok, Cancel Help

Line of Sight Based Security

The procedures for this functionality require a distributed system. This section

describes how to add a desired computer to a group (‘Computer Group’) and to
an area of the plant.

IMPORTANT  The macro ‘NavToDisplay with line of sight’ must be added to the

project and renamed ‘NavToDisplay’ to replace the existing
‘NavToDisplay'.
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1. From the FactoryTalk View Distributed application, click ‘+’ to expand
System and then click ‘+' to expand Computers and Groups.

1 Action Groups

L Palicie
(20 Computers and Groups

m S5 Metworks ar
@3 Usersand G,

P

2. Right-click Computer Groups and choose New Computer Group.
Enter the area name and click Add.

Security..,

The area name is the same name as the area name configured in the
controller. The computer area name does not have the ‘Basic’ or
‘Advanced’ suffix.

Mew Camputer Group X
General  Palicy Setting

Mame: lé«ream I |

Desciiplion: | |

embeers:

R
.

[ ok ]| cancel Hep |

4. On the Select Computer window, select Create New and
choose Computer.

Select Carmputer - ] X

B Ews
B PLANTRAMEWSLH

(TAWE

Filter Compuiters
(®) Show computers only
0K || Cancel Help
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5. Enter a desired computer name.

General  Palicy Setting

Computer: || ControlR oomiw'S 1| | |

Description: | |

Member of:

Add... Remove...

Cancel Help

6. Select the name of the desired computer.

=

B PPEWS1
B PPEWS
B PPEWS12
B PPEWS13
= PPEWS14
B PPEWS1E
B PPEWS2
B PPEWS3
B PPEWS4
B PPEWSS

[T

< >

Create Mew -»

Filter Computers

(®) Show computers only

Cancel Help

Rockwell Automation Publication PROCES-UM100C-EN-P - June 2022 87



Chapter 3 Process Automation System Server
7. To add the computer group to the area, click OK.
Mew Camputer Group X
General Palicy Setling
Narme: |Area.01 s |
Desciiplion: | \ | | o
| S@ System
i £3 Action Groups
Members: w{ Palicies
ControlRoomwS 1 =0 Computers and Groups
8 Cortrocon \_ i B:] Computer Groups
i w0 Complyers
@25 Metworks and Devices
=
£] | Cancel Hell
o o
Figure 7 - Security Example
5 (2 gystem Line of Sight Security
—D Systermn I:I Action Graups
[0 Action Groups +|:I Palicies
=3 Pnlt\[igs P =3 Computers and Groups @] Ij

88

=3 Computers and Groups
=0 Cornputer Groups

puters
LB WOR_WORKSTATION

MXR_WORKSTATION
[ows]

9,
N

Bob
[Engineer]

—D Systern
(23 Action Groups
+ [ Palicies
+ [[3 Computers and Groups
+ 2% Metworks and Devices
223 Users and Graoups
| mE User Groups

MXR_WORKSTATION General Library name:

Command source r2P-3.00

Instruction name;

Advanced
PPID

GLETP Display label:

Navigation A10-FIC-101

Computer Group

Area Based Security

: @ Alarms Area name for security:
2 D Systern

D Action Groups e Parameters (dixer )

+[0 Palicies Bob

er Group ?
Advanced

ﬁ} Mi @

!ﬁ Mixer_Basic

+D Cornputers and Grouws

Logix Instruction
@Area =(Mixey !
1. When using Domain controller
(named ‘System’)
Instruction @Area = System\Mixer
Note: Domain name does not apply to Line-
of-Sight security since computer groups are
FactoryTalk constructs and aren't used in
Windows.
. When using Domain controller
(named ‘System’)
Create User Groups = System\Mixer...
Security code = E 3. When using Domain controller
(named ‘System’)
Import user groups = System\PlantPAx...

™M
Bob
User Group ?

Basic

Role Based Security

=/ Users and Groups

N

‘Accuum

!ﬁ Mixer_Sdvanced

!ﬂ Mixer_Basic

!ﬂ Adrninistratars

€7 PlantPax Adrmin

m PlantPAx Engineering
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Define FactoryTalk System
Policies

This optional section describes how to use Remote Desktop Services (RDS) to
access FactoryTalk applications, such as thin clients.

Use Default Terminal Client

You have two server options to specify how each remote terminal will identify
itself to FactoryTalk Security: terminal client or server computer; terminal
being the default.

1. Navigate to Rockwell Software>FactoryTalk Administration Console.
2. Under System>Policies>System Policies, double-click Security Policy.

3. On the Policy Settings dialog box under Computer Policy Settings, leave
terminal client as the default for remote desktop services to be available

and select OK.
td FactoryTalk Administration Console = =] =
File View Tools Window Help
Explorer .
=1 Network (PASSE] Security Policy Properties i
=3 System Policy Settings
(2 Action Groups
=& Policies ﬂ
@ (0 Product Policies Logon session lease 1 hour ~

=] System Policies
(2] FactoryTalk Alarms and Events

pplication Authorization
ser Rights Assignment
ive Dats Policy

Health Menitoring Policy
udit Polic

ecurity Policy
w0

#& Networks and Devices

Account lockout threshold

Account lockout auto reset

Keep record of deleted accounts

Show deleted accounts in user list
El Computer Policy Setiings

Require computer accounts for all client machines

Identify terminal server clients using the name of
G Directory Protection Policy Seftings.

Support nen-secure clients

Audit non-secure client connections
Directory cache expiration

Oinvalid logon attempts
15 minutes

Disabled

Disabled

Enabled

[
Server computer

ERetes
0 hours before expiration

Select Server computer from the pull-down menu and click OK if you want external
client computers to be able to log in to the FTD without any pre-configuration. This

option, however, does not let you track specific actions from the terminal client.

Audit Security Actions

You can enable an audit to track configurations and security.
1. Navigate to Rockwell Software>FactoryTalk Administration Console.
2. Under System>Policies>System Policies, double-click Audit Policy.

3. Under Audit Policy Settings, select Enabled from the Audit security
access failures pull-down menu and select OK.

Audit Policy Properties -
Policy Settings
[CES ?ll
4 Audit Policy Settings
Audit changes to configuration and control system Enabled
Audit security access failures Enabled [v]
Audit security access successes Disabled
Audit secunty access failures
Determines whether to generate an audit message when a user attempts an action
and is denied access.
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Notes:

90 Rockwell Automation Publication PROCES-UM100C-EN-P - June 2022



Chapter ll'

Network Infrastructure

The PlantPAx® system supports several network topologies to meet your
network application requirements.

These are recommended topologies for your PlantPAx system. For experienced
users, each section summarizes a topology. For more detailed information,
follow the referenced links.

.(t\
Step 1: Redundant PRP Topology

This architecture helps prevent downtime by the duplication of infrastructure
for the most critical process operations:

NIC teaming for dual connections between PASS servers and supervisory
controllers

EIGRP (Enhanced Interior Gateway Routing Protocol) provides Layer 3
routing capabilities

HSRP provides redundant PRP ‘RedBox’ functionality
PRP provides dual connectivity between two devices

RedBox (redundancy box) connects devices without PRP technology to
both LAN A and LAN B

Cisco® Stackwise provides redundancy at core switches

For more information, see Redundant PRP Topology.

.(T\
Step 2: Resilient DLR Topology

This architecture provides a means to detect, manage, and recover from a
single fault in a ring-based network. You can use redundant gateways to
provide DLR network resiliency to the rest of the network. This architecture
also includes the following:

NIC teaming for dual connections between PASS servers and supervisory
controllers

EIGRP (Enhanced Interior Gateway Routing Protocol) provides Layer 3
routing capabilities

Redundant DLR gateway functionality
DLR is a ring topology that recovers after a single point of failure
Cisco® Stackwise provides redundancy at core switches

For more information, see Resilient DLR Topology.
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A

Step 3: Simplex-Star Topology

Prerequisites

Core, distribution, and
access switches

This architecture provides a basic network configuration. You can monitor and
control non-critical equipment.

« Nodisruptions to the network when you connect or remove devices.

« IMPORTANT: If a connecting network device fails, there’s no
redundancy and connected nodes can’t communicate on the network.

« EtherNet/IP™ backbone between devices in a STAR topology
« NIC teaming is optional.

For more information, see Simplex - Star Topology.

Following the System Workflow, design the network infrastructure. You need
to know which of the following are in your system:

« Domain controller or workgroup
« PASS or PASS-C

Before you design and implement a PlantPAx network infrastructure, we
expect the following:
« Have experience with VLAN and IP schemes.

« Have a network design that defines the requirements for the supervisory
and control networks in the PlantPAx system.

+ Be familiar with how to use the Express Setup and Device Manager
utilities to configure and configure Stratix® switches.

« Be familiar with the Cisco I0S® command-line interface (CLI).

« Verify that no fixed IP is assigned to the workstation that is being used to
configure the switch. You want the switch to manage the IP address
configuration in your computer.

For more information, see these additional resources.

Resource

Description

Stratix Managed Switches User Manual,
publication 1783-UM007

Describes how to set up, configure, and troubleshoot Stratix switches.

Converged Plantwide Ethernet (CPwE) Design and
Implementation Guide, publication ENET-TDOO1

Describes tested and validated industrial network architectures, recommendations and best practices, including
network resiliency and security.

EtherNet I/P Parallel Redundancy Protocol Application
Technique, publication ENET-ATO06

Describes how you can configure a PRP network with a compatible device or switch.

EtherNet I/P Device Level Ring Application Technique,
publication ENET-AT007

Describes DLR network operation, topologies, configuration considerations, and diagnostic methods.

Deploying a Resilient Converged Plantwide Ethernet
Architecture, Publication ENET-TDO10

Describes how to design and deploy a resilient plant-wide or site-wide LAN architectures for IACS applications.

Deploying Device Level Ring within a CPwE Architecture,
publication ENET-TD015

Describes how to design and deploy DLR technology with IACS device-level, switch-level, and mixed device/switch-
level ring topologies across OEM and plant-wide or site-wide IACS applications.

Scalable Time Distribution within a Converged Plantwide
Ethernet Architecture, publication ENET-TD016

Describes how to design and deploy Scalable Time Distribution technology throughout a plant-wide Industrial
Automation and Control System (IACS) network infrastructure.

Deploying Parallel Redundancy Protocol within a CPwE
Architecture, publication ENET-TD021

Describes how to design and deploy PRP technology with redundant network infrastructure across plant-wide or site-
wide IACS applications.
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Network Configuration Smart devices on PlantPAx system architectures communicate on the

Preparation EtherNet/IP network via Stratix and Cisco switches. These managed switches
provide a secure switching infrastructure for harsh environments. You can
connect the switches to network devices such as servers, routers, and other
switches. In industrial environments, you can connect Ethernet-enabled
industrial communication devices, including controllers, human machine
interfaces (HMIs), drives, sensors, and I/O.

The Ethernet network provides the communication backbone for the
supervisory network for the workstations, servers, and the controllers:
« Configure all communication interfaces to operate at the fastest speed

possible for your hardware configuration, full-duplex for 100/1000
network adapters. See Important for autonegotiate settings.

IMPORTANT  Use of autonegotiate settings is recommended to reduce chance of
mis-configuration and failures. However, it's desirable to operate at
the fastest speed possible at full-duplex. We recommend verifying
your switch settings during commissioning to make sure that the
system was able to autonegotiate properly. The speed and duplex
settings for the devices on the same Ethernet network must be the
same to avoid transmission errors.

« Select the cable type based on environmental conditions.

Type Details

Long distances
Near high magnetic fields, such as induction-heating processes

Fiber-optic For extreme high-noise environments
For poorly grounded systems
For outdoor applications
Shielded twisted pair « Use Category 5e, 6, or 6a cables and connectors

« Use termination sequence 568A for industrial applications

« If multiple DCOM protocols are installed and configured on a
workstation, to make sure that DCOM communication functions
correctly, and remove all protocols other than TCP/IP.

Follow these guidelines for devices on the EtherNet/IP network:

«  Make sure that an I/O module RPI is two times faster than the periodic
task that you're using.

« The number of devices can affect the CIP/TCP count differently. Never
use more than 80% of the available connections for the communication
modules.

« Consider packets per second for performance if you use many devices.

- 1/O packets per second (pps) describes an implicit message rate (Class
1). An I/O communication use approaching or above 80% can
necessitate an adjustment to the RPI.

- HMI packets per second (pps) describes an explicit message rate (Class
3). RSLinx® connections and message instructions generate CIP™
traffic. HMI traffic is TCP-based, not UDP-based.

- The combination of implicit and explicit messaging provides the total
use for a device. If you add implicit messaging (I/0), it takes
bandwidth from the HMI because it has higher priority than HMI
messaging. The combination of CIP implicit (highest priority) and CIP
explicit (second priority) can’t exceed 100% use.

« Use compatible keying on communication modules. In a validated
environment, you can use an exact match for keying.
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Recommended VLANs

Subnets segment the devices in a network into smaller groups. The IP address
and associated subnet mask are unique identifiers for the switch in a network.

The following table of recommended VLANSs segments the system and
recommends IP address ranges. Use these recommendations with the
topology worksheet to segment your system.

Knowledgebase Technote, PlantPAx System Release 5.10
Configuration and Implementation Tools, contains the recommended
topology and switch settings. Download the spreadsheet from this
public article and use the tab that is referenced in each step.

You may be asked to log in to your Rockwell Automation web account
or create an account if you do not have one. You do not need a support
contract to access the article.
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Table 5 - Descriptions for VLANs and Ethernet Address Ranges")

VLAN ID (Name) EtherNet/IP Address Range Description
1 N/A Not used
. ) Not to have any assigned IP addresses

300 (Native VLAN) NA NA Native for Control and Supervisory
172.18.0.1 Default gateway

f’r?a?]g%"emﬂ“\‘;m;k 17218.0.2 1721809 VLAN routing - switch addresses (to be utiized for Layer 3 switches)
172.18.0.10 172.18.0.253 Application - switch addresses
172.18.1.1 N/A Default gateway

501 (Control network - Default) 17218..2 1721819 VLAN routing
17278.[2...]10 17218.[..9].253 Ethernet interface between controllers and system applications.
17218.2..]1 17228.[..9]1 Default gateway

502...509 (Additional Control -

network VLANS for 10 and MCC) 17218.[2...]2 17218...9]9 VLAN routing
17218.[2...]10 17218.[..9].253 Ethernet interface between controllers, 1/0 modules, and MCCs (fixed)
172.20.0.1 N/A Default gateway

?r?a?]ggg'rf;:‘tt(f&\*,‘)s”Pe”'s‘”y 1722002 172.20.08 VLAN routing - switch addresses (to be used for Layer 3 switches)
172.20.0.10 172.20.0.253 Application - switch addresses
172.2011 N/A Default gateway
172.20.110 N/A Domain/DNS primary server

601 (HMI Control network + 172.201M N/A Domain/DNS secondary server

Supervisory network -

wired network) 172.201.12 172.20.199 Servers and workstations (DHCP)
172.201.2 1722019 VLAN routing
1722011 172.20..25 Workstation interface
172.20.21 N/A Default gateway

aliJrzel(S: sp ﬁ;\{:;g%network ) 172.20.2.2 172.20.29 VLAN routing - switch addresses (to be used fro Layer 3 switches)
172.20.210 172.20.2.253 Mobile interface

603 (External - untrusted 172.20.31 N/A Default gateway

:I?Xg?rl!}r)pm \OMZ (industral 172.20.3.2 172.20.39 VLAN routing - switch address (to be used for Layer 3 switches)

demilitarized zone) 172.20.3.10 172.20.3.253 External interface

(1) The referenced IP Addresses can be changed for your system requirements.
(2) Al networks do not use a dedicated management VLAN, but it's a good practice. Many times, a supervisory VLAN is the same VLAN as the management VLAN.

Command Line Interface (CLI)

Along with Device Manager and Logix Designer, you can use the Cisco IOS
command-line interface (CLI) to manage the switch. This interface enables
executes Cisco I0S commands by using a router console or terminal, or by
using remote access methods. You can:

« Connect directly to the switch console port
« Enable Secure Shell (SSH) or Telnet in Device Manager

For more information about how to use the CLI, see www.cisco.com.
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Redundant PRP Topology

Parallel Redundancy Protocol (PRP) is defined in international standard

IEC 62439-3 and provides high-availability in Ethernet networks. PRP
technology creates seamless redundancy by sending duplicate frames to two
independent network infrastructures, which are known as LAN A and LAN B.

A PRP network includes the following components.

Component Description

LAN Aand LAN B Redundant, active Ethernet networks that operate in parallel.

Double attached node (DAN) An end device with PRP technology that connects to both LAN A and LAN B.

. An end device without PRP technology that connects to either LAN A or LAN B.
Single attached node (SAN) A SAN does not have PRP redundancy.

Redundancy box (RedBox) /ﬁ Asb\l/vgc;r:]dwflz\ﬁ%P technology that connects devices without PRP technology to bath

Virtual double attached node {th endhdevRicg gvithout PRP technology that connects to both LAN A and LAN B
(VDAN) rough a RedBox. )
A VDAN has PRP redundancy and appears to other nodes in the network as a DAN.

Infrastructure switch A switch that connects to either LAN A or LAN B and isn't configured as a RedBox.

Redundancy uses Hot Standby Router Protocol (HSRP). HSRP lets you
configure two or more routers as standby routers, but only one router is active
atatime.

Additional Resources for PRP Topology

For more information, see these additional resources.

Resource

Description

Design Guide, Deploying Parallel Redundancy Protocol
within a CPwE Architecture, publication ENET-TDO21.

Highlights key IACS application requirements, technology, and supporting design considerations to help with
the successful design and deployment of PRP applications.

EtherNet/IP Parallel Redundancy Protocol,
publication ENET-AT006

Describes how you can configure a Parallel Redundancy Protocol (PRP) network with a compatible device or
switch.

EtherNet/IP Netwark Configuration,
publication ENET-UMOO1

Explains Logix 5000 tools that are used in EtherNet/IP topologies and network operation.

Cisco Catalyst® 9300 Series Switches

Describes the hardware installation.

Describes how to update firmware.

Lists the recommended firmware downloads.

Describes how to configure the switch.
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Switch Configuration in a

Redundant PRP Topology red match the sequential instructions below the example.

—— Supervisory Network (VLAN 601) Operator and

Control Network Default (VLAN 501) D D Engineering
————— Control Network 1/0 (VLAN 502) Workstations
. Control Network MCC (VLAN 503) '

(>]
0990

Figure 8 - Redundant PRP Topology Example

Trunk - (Native VLAN 300)

Secondary Connection
Logix Redundancy (RM)
HSRP (Configuration Redundancy)
Layer 3 Routed Point-to-Point Application Servers
(Hypervisor)
EtherChannel
RedBox (PRP)
LAN-A/LAN-B (PRP)
Cisco Stack Member
LAN A
LANB

L]

EWS/0WS

The following figure shows an example PRP topology. The numbers circled in

Knowledgebase Technote, PlantPAx System Release 5.10

Configuration and Implementation Tools, contains the recommended
topology and switch settings. Download the spreadsheet from this
public article and use the tab that is referenced in each step.

You may be asked to log in to your Rockwell Automation web account
or create an account if you do not have one. You do not need a support

contract to access the article.

WARNING: Do not connect switches together before the network is fully
configured.
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Configure the Cisco stack switches.

See the ‘1 PRP Cisco Stack Switch’ tab in the topology worksheet.xlsx.

a. Connect to distribution switches
b. Connect to application servers

For stacking guidelines and cabling considerations, see Cisco user
documentation.

Configure the HSRP distribution switches.

See the 2 PRP HSRP Switch’ tab in the topology worksheet.xlsx.

a. Connect distribution switches to the core stack
b. Configure PRP
Configure the LAN A/B access switches.

See the 3 PRP LAN A B’ tab in the topology worksheet.xlsx.
Configure the RedBox switches.

See the 4 PRP RedBox Infrastructure’ tab in the topology
worksheet.xlsx.

Add PRP devices or skids.

See the user documentation for your devices on how to configure
PRP settings.

For examples, see Figure 9.
Verify the PRP configuration.

See the ‘s PRP Verification’ tab in the topology worksheet.xlsx.
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Figure 9 - PRP Skid and MCC Lineup

PRP Skid - Simplex Connected to Either LAN A/B PRP Skid - Connected to LAN A and LAN B
LANA LANB LAN A LAN B
DCsS E E DCS
Cs6d Skids
Stratix 5400 RedBox
VDAN Support
T l SRR
- T .
= ) C
2§ PR en
PRP MCC - RedBox Connected to LAN A and LAN B PRP MCC - Connected to LAN A and LAN B with DLR Ring
LANA LANB LAN A LAN B
DCS DCs
Skid s

Stratix 5400 RedBox
VDAN Support

Stratix 5400 RedBox
VDAN Support
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Resilient DLR Topology

Device Level Ring (DLR) is an EtherNet/IP protocol that is defined by the Open
DeviceNet® Vendors’ Association (ODVA). DLR provides a means to detect,
manage, and recover from single faults in a ring-based network.

A DLR network includes the following types of ring nodes.

Node

Description

Aring supervisor provides these functions:
« Manages traffic on the DLR network

Ring supervisor « Collects diagnostic information for the network

A DLR network requires at least one node to be configured as ring supervisor.
By default, the supervisor function is disabled on supervisor-capable devices.

Ring participants

Ring participants provide these functions:

« Process data that is transmitted over the network.

« Pass on the data to the next node on the network.

« Report fault locations to the active ring supervisor.

When a fault occurs on the DLR network, ring participants reconfigure themselves
and relearn the network topology.

Redundant gateways
(optional)

Redundant gateways are multiple switches that are connected to a single DLR
network and also connected together through the rest of the network.
Redundant gateways provide DLR network resiliency to the rest of the network.

Consider the following if you choose this topology:

Depending on firmware capabilities, both devices and switches can
operate as supervisors or ring nodes on a DLR network. Only switches
can operate as redundant gateways.

Multiport EtherNet/IP devices that are equipped with DLR technology
connect directly to neighboring nodes and form a ring topology at the
end devices. If a break in the line is detected, the network provides an
alternate routing of the data to help recover the network at fast rates.

All end devices that are tightly coupled to a controller must be a part of
the same embedded switch topology. This peer-to-peer architecture
reduces the physical amount (and therefore cost) of cabling.

Enhanced diagnostics that are built into DLR-enabled products identify
the point of failure, helping to speed maintenance and reduce mean time
to restoration.

The DLR ring supervisor maintains a loop-free topology by blocking
port 2 of the embedded-switch device. If the supervisor detects a fault in
the network, it unblocks port 2 until the fault is corrected. It’s important
to remember to enable a ring supervisor before closing the DLR ring. If
the ring closed before the supervisor is enabled, a bridge loop results,
which generates a broadcast storm.

Additional Resources for DLR Topology

For more information, see these additional resources.

Resource

Description

EtherNet/IP Device Level Ring, publication ENET-AT007

Describes DLR network operation, topologies, configuration considerations, and diagnostic methods

EtherNet/IP Network Configuration, publication ENET-UM0Q1

Explains Logix 5000 tools that are used in EtherNet/IP topologies and network operation.

Figure 10 shows an example DLR topology. The numbers circled in red match
the sequential instructions below the example.
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Figure 10 - Resilient DLR Topology Example

Operators and
Engineering
Workstations

@ ———— Supervisory Network (VLAN 601)
Control Network - Default (VLAN 501)

Application Servers "—-ﬂ:H:H: m ———— Control Network - 10 (VLAN 502)

(hypervisor) [ | ! ‘ | Control Network - MCC (VLAN 503)
E- n ———— Trunk - (Native VLAN 300)

Secondary Connection

Logix Redundancy (RM)

< EtherChannel
© Cisco Stack Member
©®  DLR Gateway (redundant)

g

Knowledgebase Technote, PlantPAx System Release 5.10

Configuration and Implementation Tools, contains the recommended
topology and switch settings. Download the spreadsheet from this

public article and use the tab that is referenced in each step.

You may be asked to log in to your Rockwell Automation web account
or create an account if you do not have one. You do not need a support
contract to access the article.

WARNING: Do not connect switches together before the network is fully
configured.
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1. Configure the Cisco stack switches.

See the ‘1 DLR Cisco Stack Switch’ tab in the topology worksheet.xlsx.

a. Connect to distribution switches
b. Connect to application servers

For stacking guidelines and cabling considerations, see the Cisco user
documentation.

2. Configure the gateways.

See the 2 DLR Gateway Switch’ tab in the topology worksheet.xIsx.

3. Configure the ring access switches.

See the 3 DLR Ring Switch’ tab in the topology worksheet.xlsx.
4. Add DLR devices or skids.

See the user documentation for your devices on how to configure DLR
settings.

For examples, see Figure 11.
5. Verify the DLR configuration.

See the ‘4 DLR Verification’ tab in the topology worksheet.xlsx.

Figure 11 - DLR Skid and MCC Lineup
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DLR Skid - Simplex Connected to DLR Ring

DLR Member

DLR MCC - Simplex Connected to DLR Ring

DLR Member

DLR Skid - DCS Integration

DLR Member DLR Member

Skid access switch
is DLR member

DLR MCC - DCS Integration

DLR Member DLR Member

|
|
|
|
|
|
Ring (DLR) :
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Simplex - Star Topology

Application Servers
(hypervisor)

In a star topology, access switches serve as an uplink from the servers to the
workstations. Layer 2 switches also send information packets at the controller
level from the end devices. With multiple network levels, access switches
control the flow of information to make sure that packets are delivered to the
correct network level.

Figure 12 shows an example simplex star topology. The numbers circled in red
match the sequential instructions below the example.

Figure 12 - Simplex - Star Topology Example

—— Supervisory Network (VLAN 601)

Operator and Control Netwark [VLAN 501)
% Engineering Trunk - (Native VLAN 301)
Workstations

EWS/OWS

Consider the following if you choose this topology:

« The first switch that Rockwell Automation equipment touches must have
IGMP snooping enabled. IGMP snooping enables switches to forward
multicast packets to ports that are only part of a particular multicast

group.

Additional Resources for Simplex Star Topology

For more information, see these additional resources.

Resource

Description

Stratix Managed Switches User Manual,
publication 1783-UM007

Describes the embedded software features and tools for configuring and managing the Stratix 5410, Stratix 5400, and
the Stratix 5700 Ethernet managed switches.

Stratix Infrastructure Product Family Quick Reference

Drawing, publication IASIMP-QR029

Illustration that shows options for connecting your plant network by using standard Ethernet technology.
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Switch Configuration ina Switch configuration in a simplex topology follows the workflow shown
Simplex Topology in Figure 1.

WARNING: Do not connect switches together before the network is fully
configured.

Knowledgebase Technote, PlantPAx System Release 5.10
Configuration and Implementation Tools, contains the recommended
topology and switch settings. Download the spreadsheet from this
public article and use the tab that is referenced in each step.

You may be asked to log in to your Rockwell Automation web account
or create an account if you do not have one. You do not need a support
contract to access the article.

1. Configure the Cisco stack switch.

See the ‘1 Simplex Cisco Stack Switch’ tab in the topology
worksheet.xlsx.

For stacking guidelines and cabling considerations, see the Cisco user
documentation.

2. Configure the access switches.
See the 2 Simplex Access Switch’ tab Simplex Switches tab in the
topology worksheet.xlsx.

3. Add simplex devices.

See the user documentation for your devices on how to configure
network settings.

For examples, see Figure 13.
4. Verify the Simplex configuration.

See the ‘3 Simplex Verification’ tab in the topology worksheet.xlsx.

Figure 13 - Simplex Skid and MCC Lineup
Skid - Simplex Connected to Simplex DCS MCC - Connected to Simplex DCS

Dcs

Skid
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Perimeter Network The Perimeter Network (Microsoft®) is a buffer that enforces data security
Considerations policies between a trusted network (Industrial Zone) and an untrusted
network (Enterprise Zone).

For secure data sharing, the Perimeter Network contains assets that act as
brokers between the zones. Consider these methods:
« Use an application mirror, such as a PI-to-PI interface for
FactoryTalk® Historian
« Use Microsoft Remote Desktop Gateway services
« Use areverse proxy server

Interoperability Between The flexibility and scalability of the PlantPAx system architecture supports
Topologies multiple field device integration options and enables process communication
for ease of integration.

Interoperability tests focus on not only device testing, but also on system
testing of all components, interface devices, and tools from various suppliers.
These tests reduce startup cost and help save up to an estimated

2...4 days per device during integration.

Figure 14 - Topology Interoperability Example

HSRP Active " ’,

RedBox | B
(Layer 3)

HSRP Standby

RedBox
(Layer 3) DLR Redundant -
Gateways -

I; 0 (DAN)

ControlLogix Redundancy (DAN)
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Time Synchronization System time synchronization is important so that the internal clocks in the
controllers, workstations, and servers reference the same time for any event or
alarm that occurs. Configure the PASS, application servers, OWS, and EWS to
use a single server (for example, a domain controller) as their time reference
and keep their clocks tightly synced to it.

This chapter describes procedures for configuring time-sync applications by
using two common protocols:

« Network Time Protocol (NTP)
« Precision Time Protocol (PTP)

NTP synchronizes time over the plant floor on an Ethernet network as shown
in the following figure. NTP sources Coordinated Universal Time (UTC) as the
universal standard for current time. Typically for Windows, a domain
controller sources UTC time and becomes the Reliable Time Server for the

domain.

Operators and Engineering Workstations

....... ) External NTP
Time Server
Application Servers | A 4 |
(Hypervisor) NTP : : : . : : :
< S
- N
Firewall

Emulator

NTP/PTP clock mode
internal in switch

— (-]

Two methods are described to use UTC time in your domain:

« Viayour local network (intranet) or the Internet (previous diagram)
. ViaGPS

The Internet can introduce more propagation delays than GPS that can cause
inaccuracies in your system. Although the NTP system affords algorithms to
calculate accurate time for either method, the GPS method provides better
accuracy.

The Stratix switch is responsible for converting Network Time Protocol (NTP)
to Precision Time Protocol (PTP). This functionality is available only in the

Stratix 54x0 family.

GPS uses a global positioning system for high precision time accuracy. All
components with real-time clocks follow the same reference. However, a
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1756 HP-TIME module propagates directly to computers, controllers, and other
devices via Ethernet switches.

For more information on time synchronization and CIP Sync™, see the
Integrated Architecture® and CIP Sync Configuration manual,
publication IA-ATo03.

Considerations

Consider the following suggestions before starting this chapter:

« Decide which network time source, external NTP or GPS reference, that
you're going to use.

« To enable CIP Sync functionality in a ControlLogix® controller, select
Time Synchronization in Ethernet adapters by using Studio 5000 Logix
Designer® software.

Configure UTC Time Source urcis independent of time zones and enables NTP to be used anywhere in the

world regardless of time zone settings.

Configure Internet Time Synchronization

Use adomain This section describes how to configure the Windows Time Service (w32Time)
controller to use the Internet as a medium for sourcing a UTC time. Use the Windows
time utility from an elevated command prompt.

Complete these steps by using the domain controller that is hosting the
PDC emulator role (PADCA).

1. Open an elevated Command session and click the Windows Key.

The Start Menu appears.

2. Choose Command Prompt (admin).

3. From within this Command session, type the following while
substituting for the <pool> argument per your requirements:

w32tm /Config /ManualPeerList:<pool> /SyncFromFlags:Manual /Reliable:yes
/Update

IMPORTANT  <pool> is a place holder for the URL or URLs of multiple time servers
(for example, atomic clocks). If you can't access the Internet, those
URLs could be of your parent domain controller. You can research
UTC sources for your proximity, the following table has examples
that work for the U.S.

Example Purpose
us.pool.ntp.org,0x8 URL specifies a single server

0.us.pool.ntp.org,0x8
1.us.pool.ntp.org,0x8
1.us.pool.ntp.org,0x8
2.us.pool.ntp.org,0x8

URLSs specify the use of 4 unique servers
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There are (at least) four server pools of pool.ntp.org. But, the preferred
assignment for <pool> is the first one (us.pool.ntp.org,0x8). Windows Event
Viewer can log errors for URLs that do not respond.

The ox8 qualifier specifies Client Mode packets for server communication. For
more information, Microsoft
Knowledgebase 875424.

You can specify a list of URLs that are <space> separated and enclosed in
quotes. Make sure to append a type identifier for the URLs identifier as shown

in the previous table. For example, 0x8 (client mode).

The illustration shows an example that sources the U.S. pool.

EX Administrator: Cmd |:

icrosoft Windows [Uersion 6.3.768081
Cc» 2013 Microsoft Corporation. All rights reserved.

UWindowsssystem32>uw32tm ~Config ~ManualPeerList:us.pool.ntp.org.@x8 ~SyncFromFlags:Manual ~Reliable:yes ~Update

If your system can’t access the Internet, <pool> can be a single target such as
your parent or local Domain controller. Your domain time might not be within
tolerable differences of other domains in your enterprise.

Example Purpose
Uses the current computer (PADCA) as the time source

PADCA Specifies a network time server on your local network

4. After yowve commanded the w32tm utility by using the new
configuration in step 3, use the Net utility to stop and then start the
Windows Time Service from the same command session.

sUWindowsssystend2»net stop wi2time
he Windows Time sewrvice is stopping.
he Windows Time service was stopped successfully.

sMindowsssystend2net start wiZtime
he Windows Time service iz starting.
he Windows Time service was started successfully.
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NTP to PTP Clock Conversion

This section illustrates how to configure a Stratix 5400 to convert Network
Time Protocol (NTP) to Precision Time Protocol (PTP),

1. From the Device Manager of the switch, click Configure and
choose PTP.

2. From the Mode pull-down, select NTP-PTP Clock.
Type a priority value for Priority1 and Priorityz2.
Click Submit.

Knowledgebase Technote, PlantPAx System Release 5.10
Configuration and Implementation Tools, contains the recommended
topology and switch settings. Download the spreadsheet from this
public article and use the tab that is referenced in each step.

You may be asked to log in to your Rockwell Automation web account or
create an account if you do not have one. You do not need a support contract
to access the article.
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Chapter &4 Network Infrastructure

configure PTP Time Precision Time Protocol (PTP) enables precise synchronization of clocks in

Synchronization for Ethernet measurement and control systems. PTP generates a Master-Slave relationship

Bri dg es among the clocks in the system. Clocks, which are synchronized over the
EtherNet/IP network, derive their time from a clock that is selected as the
Grandmaster clock. The Time Sync and Motion option must be enabled for
Ethernet bridge modules to propagate time through the network via switches.

1. Inthe Architect application, right-click a controller and choose Open
Project in Designer.
# Studio 5000 Architect - PlantPAx

R - FILE EDT VIEW SYNC LIBRARY MANAGEMENT TOOLS WINDOW HELP
Use an Engineering Workstation with ;
W X oX92-C-_ x A/ OO F = ControlNet Cable -

these procedures.
Project Explorer ~ 3 ¥ § Process Area® _

4 PlantPix

4 Projects
» B Lexco
- B Laxco: | Open Project in Designer ﬂ
> B Lexco2 Browse Tags...

EWS - B Laxcos Update Project Changes...

> B Loxcos Update Changes from Online Controller... DAX
{8 PlantPAy Commit Project Changes... System

4 Devices
> B Process Properties...

2. On the General tab of the Module Properties dialog box, make sure that
‘Time Sync and Motion’ is selected for the connection.

@ Logix Designer - LGXC01 [1756-L75 31.1] - 0O x

FILE EDIT VIEW SEARCH LOGIC COMMUNICATIONS TOOLS WINDOW HELP
Tl - = [ | v % a0 Bk

Gantrollr OK |’ Path ABETHIP-11172.18. 1. 100\Backplane\0 &R e

/o OK Rem Run ﬂ! Mo Farces ¥ _ No Edits 2 Redundancy B ‘Favorites  Add-On  Safety Alarms Bt TimenCounter Input/Outp

General |Connection I RSNetWonc I Module Info | Intemet Protocal I Port Corfiguration I Time Sync |

B Controller LGXCO1

4 Tasks Type: 1756-ENZT 1756 10100 Mbps Bthemet Bridge, Twisted-Pair Media

4 Motion Groups Wendar: Rockwel Automation/Alen-Bradley

b Assets Parent: Local Ethemet Address

T, Logical Model
4 1/0 Configuration
4 B81756 Backplane, 1736-A7 Description: ~ 1P Address:
0

Name: ‘I_GXCDT ENDTA Frivate Network: 192.168.1. .

Host Name

b [1] 1736-EN2T LGXCO1ENOA

L /30-EN ALUTENUTE Module Definition

b f [4] 1756-EN2TR LGXCO1EMOZ Slat: 1
Revision: 10.001
Blectronic Keying: Compatible Module

Rack Connection: Hone

Time Sync Connection: Time Sync and Motion

Description ~
Status Running -

< w = Status: Running Boply 2D

r:: Controller Organizer mLugical Organizer

Errors [Fm] Search Results v
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12

3.

If online, select the Time Sync tab to confirm Grandmaster
clock settings.

| General I Connection | RSMetwors I Module Info I Internet Pratocal I Port Configuration I Network| Time Sync |

CIF Sync Time Synchronization:

UTC System Time:

Grandmaster Clock

Drescription:

Enabled
8/13/2018 7:01:08 PM

Local Clock

Manufacturer Mame:

Model:
Serial Mumber:
Hardware Revision:

|dentity:
Class:
Accuracy:
Wariance:
Source:
Pricrity 1:
Priority 2:

Synchronization Status: Synchronized
Rockwell Automat... |~ Offzet to Master: 1} ng
1783-HMS16TG4 . Backplane: M aster [Port 1)
FDCr 90BU0TC Ethernet: Slave [Part 2
0x5 "
IR ARSI Identity: DOODBCFFFECAA3M
243 Class: 248
254 Accuracy: 254
65535 Wariance: B5535
Dzcillator Source: Ozcill ator
126 Priority 1: 128
e Priority 2: 128

Configure PTP Time Synchronization for Controllers

A Logix controller that is CIP Sync enabled and designated the Grandmaster
clock is the real-time source for the control system. The controller
synchronizes with the PTP between the controllers and networks. Complete
these steps.

1.

Using the Logix Designer application, click the Open Controller™
Properties symbol.

@ Logix Designer - LGXCOT [1756-L75 31.1]*

FILE EDIT WMIEW SEARCH LOGIC COMMUNICATIONS TOOLS WINDOW HELP
S~ =] | v|% % 50 By
1 Run Mode

,
1 Contraller OK E |

I Energy Storage OK
/O OK Rem Run

Path: AB_ETHIP-11172.18. 1. 100'Backplans0 ®

Ev Mo Forces P No Edits . | Redundancy
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The Controller Properties dialog box appears.

o Controller Properties - LGXCO1 -
| Project I Redundancy I Monvolatile Memory | Capacity I Security I Alarm Log |
| General I Maijor Faults I Minor Faults | Date/Time | Advanced I SFC Bxecution |

(i) The Date and Time displayed here is Controller local time, not workstation local time.
Use these fields to corfigure Time attributes of the Controller.
| Set Date, Time and Zone from Workstation {4
Dste and Time:  [11/30/2017 5:30:27 PM | |Change Date and Time...|#
Tme Zone:  [(UTC+0000) v]e
[] Adiust for Daylight Saving (+01:00) w
Time Synchronize
ﬁ_ . 1. DANGER. If time synchronization is
[[] Enable Time Synchronization disabled online, active axes in any
controller in this chassis, or any other
- synchronized device, may experience
) lsthe system .tlme r.naster inexpected motion,
2 |s a synchronized time slave i GuardLogix 5560 and 5570 safety
2 Duplicate CST master detected controllers may fault if no other time master
3 CST Mastership disabled exists in the local chassis.
2 No CST master
[ ok ][ canca | Help

2. On the Date/Time tab, select Enable Time Synchronization.

IMPORTANT  Use your local time to configure the Time Zone and Adjust for

Daylight Saving.

Time Synchronize
Enable Time Synchronization

) |s the system time master

® |s a gynchronized time slave
2 Dupl CS5T master detected
O CST rship disabled

The status ‘Is a synchronized slave’ appears
when the controller is synchronized.

3
4

Select Advanced.

. Select OK on the Controller Properties dialog box.

CIP Sync Time Synchronization:

UTC Swpstem Time: 8¢

Contraller Properties - Advanced Time Sync

Enabled

13/2018 06:58:15 PM

Apply

Grandmaster Clock Local Clock
Drescription: Synchronization Status:  Synchronized
Physical Address.  F4-54-33-11-8A-81 . Offset from Master. E1 ns
Clock Type: Unknioesen Type: .
Manufacturer Mame: Rockwell Autamatio BackplneBlste el ot
Moclel: 1783-HMES16TGACGR
Serial Mumbee FOCA AnALINTC £
Identity: F45433FFFET 16480 Identity: FFFFO0071007E 7455
Class: 248 Class: 248
Accuracy: 254 Accuracy: 254
Varance: 65535 Yariance: E5535
Source: Oscillator Source: Oscillator
Priority 1: 126 Priarity 1: z [Master Owverride]
Priority 2: 127 Priority 2: 128 L (Tie Breaker]

The Grandmaster clock reference can be confirmed.
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Notes:
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The process controller is a member of the Logix 5000™ family that provides
out-of-box process functionality. Embedded PlantPAx® instructions, graphical
workflows, and tag-based alarms streamline code development for your
system.

This is the recommended workflow to develop process applications. For
experienced users, each step outlines requirements. For more detailed
information, follow the referenced links.

o

Siep 1: Develop a Project Plan

Based on the system requirements and PSE results, plan the scope of the
process application. Use a spreadsheet or other tracking tool to define the
details for each controller in the project.

Determine when and which tools to use to help with project development
« Application Code Manager software
« Studio 5000® Design software
« PlantPAx Configuration tool

For more information, see Develop a Project Plan.

A

Step 2: Develop Control Logic

The process controller is an extension of the Logix 5000 controller family that
focuses on plant-wide process control. The process controller comes
configured with a default process tasking model and dedicated PlantPAx
process instructions that are optimized for process applications and that
improve design and deployment efforts.

« Use the new features of the process controller

« Use the Controller Organizer to define the execution model
« Use the Logical Organizer to group equipment

«+ Follow guidelines to configure modules and devices.
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Q

The process controller supports PlantPAx instructions that offer enhanced
functionality, including tag-based alarms, that can simplify programming
applications.

« Build and monitor control strategies
« Define controller-to-controller communication

For more information, see Develop Control Logic.

Step 3: Integrate Field Devices

Q

Step 4: Develop Alarms

The components required to integrate field devices vary depending upon the
communication protocol and PlantPAx library version. You can integrate
devices via:

« HARTI/O modules

. EtherNet/IP™ communication modules
« PROFIBUS PA linking device

« Foundation Fieldbus linking device

For more information, see Integrate Field Devices.

O
Step 5: Create HMI Displays

Develop alarms for your system. The type of alarm depends on the control
logic:

« Logix tag-based alarms
« Server tag-based alarms (FactoryTalk® Alarms and Events)
« Logix instruction-based alarm instructions

For more information, see Alarm Types.

Use FactoryTalk® View Studio to develop HMI displays. Use the HMI template
that comes with the process library. You can:

« Import global objects and graphic framework displays from the process
library.

« Import ACM-generated displays.
« Create system-specific HMI displays.

For more information, see Create HMI Displays.

For information about graphic framework displays, see Rockwell Automation
Library of Process Objects Reference Manual, PROCES-RM200.
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j Prerequisites

l Process

Controller
EWS

i

| e¢

Following the System Workflow, develop your process application, including
graphical displays and controller logic. To develop your controller program,
you must be familiar with how to do the following:
1. Gather system requirements, such as:

« User requirement specifications

« Instrument index or database

« P&ID diagrams

« Network architecture requirements

« I/Orequirements

« Produced/consume and message requirements

« Product specifications

2. Use the PlantPAx System Estimator tool that comes with Integrated
Architecture® Builder utility, to:

« Size your PlantPAx system
« Generate a bill of materials
3. Build your PlantPAx system:

« Use the Virtual Image Templates to build system elements
(recommended)

« Install and configure process controllers (recommended)
« Make sure the HMI server and requirements are configured (required)

For more information, see these additional resources.

Resource

Description

ControlLogix® 5580 and GuardLogix® 5580
Controllers, publication 1756-UM543

Provides information about designing a system, operating a ControlLogix® 5580 or GuardLogix® 5580 controllers system, and
developing applications.

High Availability Systems Reference Manual,
HIGHAV-RM002

Provides guidelines for high availability systems, including redundant system components, networks, and other hardware and
software considerations.

CompactLogix™ 5380 and Compact GuardLogix
5380 Controllers, publication 5069-UMO01

Provides information about designing a system, operating a CompactLogix 5380 or Compact GuardLogix 5380 controllers
system, and developing applications.

Rockwell Automation Library of Process Objects
Reference Manual, publication PROCES-RM200

Describes how to build and use library components that comprise the Rockwell Automation Library of Process Objects.

Logix 5000 Controllers Produced and
Consumed Tags, publication 1756-PMO11

Details how, with a Logix 5000 controller, to produce and consume standard tags and produce a large array.

Logix 5000 Controllers Import/Export
Programming Manual, publication 1756-PM019

Describes how to import and export logic components to and from a controller project.

Application Code Manager User Manual,
publication LOGIX-UM0O3

Provides details on a modular, object-based approach to the creation of ACD controller code, FactoryTalk® View SE /ME display
content, FactoryTalk® Historian Tag and FactoryTalk® Alarms and Events (FTAE) import configuration.

Develop a Project Plan

Based on the system requirements and PSE results, start by planning the scope
of the process application. Use a spreadsheet or other tracking tool to define
the details for each controller in the project, such as:

« Controller name

« Taskname

« Program name

« Description

« I/Otype

« Control strategy name

« Minimum and maximum values and units of measure

« Alarm values (LoLo, Low, High, and HiHi)
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« HMIdisplay name

This level of detail helps you organize the actual programs and tasks in the
application. For example:

A B C D E F G H | J K L M N
1 NAME CONTROLLER TASK PROGRAM DESCRIPTION /0 Control Strategy Min _Max Unit LOLO LOW HIGH HIHI
11 |[FT0120 Water Task_D_500ms Polymer_TaskD Flow to Large Storage #2 Al P_AIn 0 10000 GPM -1.50E+38 -1.50E+38 1.50E+38 1.50E+38
12 FT200 Water Task_D_500ms Canals_TaskD Flow Offsite #1 Al P_AIn 0 100 GPM 5 10 90 99
13 |[FT201 Water Task_D_500ms Canals_TaskD Flow Offsite #2 Al P_AIn 0 100 GPM 5 10 90 99

Table 6 - Library Descriptions

Determine Which Libraries to Use

Rockwell Automation provides libraries to simplify application development.

Description

Process Library

Rockwell Automation Library of Process Objects provides sample projects, application templates, Endress + Hauser library objects,
Application Code Manager library objects, and tools and utilities.
Includes the following:

Graphics for built-in instructions

HMI images and Help files

Logix diagnostic objects

Pracess objects

Control strategies

Sequencer object

PlantPAx Configuration Tools for Tags, Alarms, and Historian
Color Change utility

Historian -- Asset Framework template and objects

/0 Device Library

Provides objects for Rockwell Automation 1756, 1769, 1734, 1794, 1738, 1732E, 1719, 5069, 5094 I/0 modules.
Provides preconfigured status and diagnostic faceplates sets for Rockwell Automation digital and analog 1/0 devices. You can use these
objects with Machine Builder, Process, and Packaged Libraries, or as standalone components.

|0-Link Device Library

Provides 10-Link master and sensor objects.
Provides preconfigured status and diagnostic faceplates.

Electrical Protection Device Library

Provides a standard to represent protection devices within your electrical distribution system

Machine Builder Libraries

Library objects for use with Application Code Manager.

Independent Cart Technology Libraries, includes ICT Libraries for iTRAK® and MagneMotion®
Studio 5000® Application Code Manager
Power Device Library, including objects for E300, ArmorStart® PowerFlex®, and Kinetix®

Network Device Library

Provides objects for Stratix® switch and Device Level Ring network objects.

Power Device Library

Provides objects for E300, ArmorStart, SMC™-50, PowerFlex, and Kinetix.

18
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Operator interface presents system information to the user.

Controllers execute application code to control the process and
communicate with the supervisory level.

Build Application Content

A control strategy encompasses all of the application code that is required to
implement a specific control function. The application code includes the I/0,
controller code, display elements, and faceplates. The process library contains
example control strategies for I/O processing, device control, and regulatory

control.

By using the control strategy model, you can estimate the following:

« Potential alarms

« Visualization tags (affecting controller and server memory)

« Controller memory usage
« Controller execution time

] PASS/Application Servers
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The Process library is key to building your process application content. In
addition to the PlantPAx instructions embedded in the process controller, the
library provides additional elements in both export and library formats.

v Process Library
hd Process Library
Control Strategies - L3X
v HMI - FactoryTalk View SE
Displays - gfx
Global Objects - ggfx
Help Files - pdf
Images - png
Language Translaticns
Macros - mecr
Studic 5000 Logix Designer Files - L3X
v Templates
Factory Talk Historian SE
FactoryTalk View SE - apb
M550L 55RS Reports
Studic 5000 Logix Designer - acd
ThingWorx
Vuforia
~ Tools & Utilities
FTView Customizticn Tooel - Coler Change Tool
Online Config
PlantPAx Configuration Tool
PlantPAx Process Library Migration Tocl

Which library elements to use depends on whether you:
« Modify an existing application
« Create a new application based on a sample template
« Import library elements into a project
« Generate library elements into code by tools

For more information about the process library, see the Rockwell Automation
Library of Process Objects Reference Manual, publication PROCES-RM200.

Your project plan can list the library elements and the software you plan to use.

Select the tool based on the current state of project development and your
programming preference.
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Project State

Tool

Description

New

Application Code Manager
software

Application Code Manager (ACM) software is an optional, productivity tool you can use to manage multiple libraries
and build these components for your control strategies.

« HMI components

+ Marms

« 1/0 assignments

ACM is best suited for new process applications or when wanting to generate or reuse modular project components
from standard and custom libraries.

ACM can use the process library to generate:
« Controller project .ACD files

« Controller program and routine .L5X files
« HMI display and alarm .XML files

« Historian point type and tag .CSV files

New or existing

Studio 5000 Logix Designer® and
FactoryTalk® View SE software

Studio 5000 Logix designer and FactoryTalk® View SE software can open templates to start new projects or import
library elements directly into existing projects. Both software products are required throughout the application
development process,

Open and import library elements:

« Controller project template .ACD files

« Controller Add-On Instruction and rung .L5X files
HMI project template .APA files

HMI global object and graphic display .GFX files
HMI image .PNG files

Existing

PlantPAx Configuration Tool for
Tags, Alarms, and Historian

The PlantPAx Configuration Tool helps define controller .ACD files with associated HMI applications. The PlantPAx
Configuration Tool is best suited for modifying the output from an ACM project, an existing controller project, or a
template project from the process library.

Use the PlantPAx Configuration Tool to:

- Organize parameter files for use the code, tags, and HMI displays into a process tree (builds the Logical
Organizer)

« Create FactoryTalk Alarms and Events alarm groups

« Create Historian Asset Framework elements

» Edit controller tag data with import and export

« Build HMI parameters for use with tag search and navigation graphics
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Application Code Manager

ACM can reduce the development time for PlantPAx applications. The process
library provides components to help create process controller projects, HMI
content for FactoryTalk View SE displays, and tags for FactoryTalk® Historian SE
applications

For more information, see Application Code Manager User Manual,
publication LOGIX-UM003.

Create a Project

Before you begin, download the libraries that you want to use and register
them in ACM software.

1. Create a new ACM project and add a process controller object from the
library.

(6 Application Code Manager (localhost\SQLACM.ACM) - u] X
FLE EDIT TOOLS VIEW HELP
nellda kb
eman T x ] Registered Libraries
v 3 it PlantPAx it Name: ProcessController ~ HiE &!l;ﬂ\::;;;ﬁlzga)
~ Gy Historian Description: D '
* B Secem = E==e B e 40 ()
s FTHistorianSE_Server Catalog Number: Process_Contraller (1.0) - Published AL ) Eoceat d (e
o~ v &, (RALIB) Frocess 5 (38)
v [ Displays Solution: (RA-LIE) Process 5 v o=l C“’"‘é“”e’ I‘a n
s FTViewSE_Server 3 ControlLogix (2)
v B Hams v &l ControlStategies (28)
= FTAamEvent_Server Perameters ik )
ool = J Discrete Moritoring and Cortrol
g8 Used Libraries Om 4| ‘ ry] | 5 Dosing (1)
~ 01 - Controller 3 Input Pracessing (4)
cr Local Procedural Cortrol (1)
Controller Preview Sl e 1 x S;m o j Requlatory Cortrol (10}
v & Controllers Contrallers Size 7 § Specialty (3)
v [o[ProcessCentroller Rl ¢} ProcessController SoftwareRevision 3 ~ 1] HardwareMontoring (1)
Controler Fault Handler | 50BS-AENZTR ( ProcessorType 1756-L85EP 7 Specly (1)
Power-Up Handler [ 506%-F8/A (20| PlantPAxTaskingModel_E True ~ i Historian (1)
Tasks 4 Organization_Foide] ~ 02 - HMI J ScanClass (1)
Motion Groups B PAIL (10} AreaPath /rea-fshorteut] ~ &l HME)
Assets [ Program (1.0} AreaPathME [shortcut] 3 FTAE (1)
~ .| 10 Corfiguration [ Task (1.0) v 03 - Historian ~ () Organization {4)
9 Backplane HistorianPath Application/Area:RSLinx Erterprise:[shortcut] ¥ Bus 3)
&g Ethemet FTLDInterfaceNa 1 % Folder (1}
04 - Operations v & Project (1)
05 - Alarm Configuration % Project (1)
05 - Alarming
06 - 10
08 - Schematics
Motion ©
ChassisName:
Library Repositories 1 x
Verson:  4.00.00 Apply Changes.. §if Libray Reposiories ‘
< >
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2. Configure the controller parameters:
« Set Controller properties and enable PlantPAx Tasking Model
+ Add HMI and Historian communication paths

« Operations - specify if Redundant, has Change Detection, has Event
Logging, or uses Organization Ownership Arbitration Propagation.

« Choose Alarm Configuration and Alarming Type

« Configure I0 — HWBus size, Skip I/O references or Generate I/O
references

« Schematics - Main Panel
« Ethernet Port1 enabled (non-redundant controllers)
« Enable and prioritize Time Synchronization
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3. Select an I/O Map Strategy base on your preference.

Value 1/0 Map Strategy Description

0 Standard Mapping in ACM Physical 10 address tied to object

1 Use Aliases for 10 Tag to Alias 10 tied to the object

2 Use 10 Mapping tags in Mapping Routines | and O routines connect the alias to the physical 10

3 Use |0 Mapping Tags and Diagnostics in Mapping Routines I and O routines connect the alias to the physical 10 plus fault detection mapping

4 Map 10 Directly in Mapping Routines I'and 0 routines connect to the physical I0 (no alias)

5 Use Program Connections (recommended) Program-scoped tags connect to the physical 10 (binding can be done now or later

when online with a controller)

; For each 10 map strategy, you can generate a different .ACD file and preview the
&/  outputin Studio 5000 Logix Designer® software.

Add Control Strategies

The ACM process library includes a comprehensive set of control strategies for
you to use in your controller projects. Follow your project plan (the spreadsheet
with your devices and tags) as you add control strategies for devices (i.e.

motors, valves, drives, and so on) to the ACM project.

Object Configuration Wizard

Select a library

Filter: | | [ Show Ml Revisions

Solution Y Libra ryType Category Cataloglumber Family ContentType
EH (RA-LIB) Process 4.1 (26 items)

B (RA-LIB) Process 5 (29 items)

(RA-LIB) Process 5 ControlStrategies  Spediality cc {(1.0) Logix Task
(RA-LIB) Process 5 ControlStrategies  Device Control D4sD (1.0) Logix Task
(RA-LIB) Process 5 HardwareMonitoring Spediality Hareware_Module_Status { 1.0) Logix Task
(RA-LIB) Process 5 ControlStrategies  Regulatory Control mMc (10) Logix Task
(RA-LIB) Process 5 ControlStrategies  Spedality MMC (1.0} Logix Task
(RA-LIB) Process 5 ControlStrategies  Device Control NPO (1.0) Logix Task
(RA-LIB) Process 5 Organization Folder Organization_Folder {1.0) Logix Task
(RA-LIB) Process 5 ControlStrategies  Input Processing PAI (1.0) Logix Task
(RA-LIB) Process 5 ControlStrategies  Device Control PAO (1.0) Logix Task
(RA-LIB) Process 5 ControlStrategies  Discrete Monitoring and Control PEL ( 1.0) Logix Task
(RA-LIB) Process 5 ControlStrategies  Regulatory Control FDBC (1.0) Logix Task
(RA-LIB) Process 5 ControlStrategies  Input Processing PDI (1.0) Logix Task

&5, Asyouadd objects to the project, enter unique names for each instance so you
&’  donot overwrite the original files.

Review all options on the parameter tab to complete the configuration of the

control strategy.

« ATrue or False option means that the item is enabled when True and ACM
modifies the code and tags to reflect your choice.
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« Many ofthe control strategies have different types to choose. For example,
the PAI strategy has Single, Dual, and Multi-channel types, under the oo -

Selection category.
Name: XT100
Description: ‘Descn’pﬁun

Catalog Number:

Selution:

PAl (1.0} - Published

(RA-LIB) Process &

FParameters

=4 B3
~ 00 - Selection ~

ACM_Type

Cfg_UsedInPIDE

~ 00.1 - Data - Common PAID{Dual_channel)
Mrea PAIM{Muli_channel)
Instruction
Instruction_D
Instruction_M
Instruction_H PAH

Label {fn_Label}

e Create one control strategy for each type and export those control strategies to

&) an Excel® file. Open the export with Excel and copy/paste additional control
strategies as needed. Then import the Excel back into ACM.
Map1/0

ACM supports several I/O map strategies. PlantPAx recommends that you use
Program Connections, where program-scoped tags are linked to I/O modules

physical addresses. Program connections are similar to alias tags, but have the
advantage of being modifiable when online with a controller.

Define the I/O module physical address in ACM, in Excel®, or in Studios000
Logix Designer.
« Enter the I/O module channel address, or leave it blank.

« Enter a name for a program-scoped tag that connects to the physical
address. ACM generates this tag.

124

Name:
Description:
Catalog Number-

Solution:

XT100

|Descnpt|on

PAl (1.0) - Published

(LI Bracess 5 Task: N *| Program: [P v

Parameters

| E R E
> 00 - Selection

01 - Options

€ v

Inp_PV
Inp_PV Connection

703710 Configuration

» 00.1 - Data - Common
» 00.2 - Data - General

02 - Device Cnnfigqlatinn

Flex5000_adapter_01_01.Al.Flex5000_adapter_01_01_00
My_Program_Scoped Tag
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Develop a Logical Organization

The ACM process library contains an Organization Folder object that is
designed to create a Logical Organizer within a Studiosooo Logix Designer
project. ACM generates the Logical Organizer based on folder and program

parent/child assignments.

Logical Organizer

& °s

a Process01
4 Areall
P L Equipment0l
4 Areal2
P L Equipment02
4 Areal3
P L Equipment03

For more information about the Logical Organizer, see Develop Control Logic.

Add the Organization Folders object to your project to build levels of

areas, as required.
To create additional folders, select the Organization Folder object and

select Add New Instance

1.

Class View 1 > || Revision History  Programs

Contrallers
[fa Process_Controller

Revision History

] 1756-EN2ZTR (2.1} Revision
S5069-4ENZTR  (21) ‘Iﬂ—
SDESHFE/A (20)

B0 Organization Folder
o Area View ’

Area
i‘ma | Add New Instance |

3. Build your folder hierarchy by assigning child folders.
4. Assign programs to the child folders.

For example:

Parameters  ChildFolders

Class View

Name  Index  ChildFolderNlame

[EF1 1 Areal2

Controllers
v [@ ProcessController
] HOBS-AENZTR (21)

Areal3

W ._:5 Organization_Folder {1.0)
w Areall

Areall2

Areal3

Process01 -~

Parameters ChildFolders

Cl=:s View

w I;_:'alOrganization_FoIder (1.0 ~

Areal2

Areall3

@ Process01

[ PAI (1.0)

v d Program (1.0}
Equipment01
Equipment02
Equipment03

Name  Index  ChildFolderllame

a Equipment01
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Add Alarm Groups

ACM can create alarm groups and you can assign alarms within control
strategies to those groups based on organization. Specify the type of alarms
that ACM generates in the controller parameters.

Parameters

=i Ee| =

v (05 - Alamming
Alam Type

Alam Type
0 = None, 1 = FTAE Instruction Based, 2 = FTAE Tag Based,

1. GotoACM System View > HMI > Alarms and add an FTAlarmEvent
object from the library.

The default name is FTAlarmEvent_Server.

System View o x
I+ Project - My PlantPAx Project
#g Historian
W HMI
[ Displays
v A Aams
Rl F T AlarmEvent_Server
Bif Used Libraries

2. Select the FTAlarmEvent_Server object to access the Alarm Group Tab
and select Add New.

Parameters  Alam Group

Hame AlarmGroupID ParentAlarmGroupID AlarmGroup SubObject Description

|Default 0 1 Default FactoryTalk Alarm Groups
Add New
Copy
Paste
Delete
Reset Grouping...

3. Add groups for your areas and assign the Parent Alarm Group ID to
represent the parent/child hierarchy.

Parameters  Alam Group
AlarmGroupID ParentAlarmGroupID AlarmGroup SubObject Description
2 1 Areall FactoryTalk Alarm Groups
Areal2_0 3 1 Areal? FactoryTalk Alarm Groups
Areal3_0 4 1 Areald FactoryTalk Alarm Groups
Process0l_1 1 1 Process01 FactoryTalk Alarm Groups

Once you have alarm groups, you can enable alarms in your control
strategies and link each alarm to the desired group.
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4. For each control strategy, access the parameters tab and expand 04 -
Alarm Configuration. Enable the alarms that you need. (such as, Hi Hij,

Hi, Lo, or Lo Lo)

5. Expand an enabled alarm (such as, Hi Hi Alarm) and select the Group

parameter (such

6. Click the ellipse button and use the Select a Reference dialog to choose

the alarm group.

as, Cfg_HiHiAlarmGroup).

Name:
Description:

Catalog Number-

XT100

| Description

FAI (1.0) - Published

Cfg_HiHiMaxShelveDuration 430
I Cfg_HiHiAlamGroup FTAlamEwvent_Server AlamiGroups. Areall1_1 I

Cfg_HiHiAlarm Setoperations True

Add HMI Graphic Displays

Solution: (RA-LIB) Process § Task: |M | Program: [P v

Parameters

=4l |E S| =

~ 4 - Alarm Configuration ~

| Cfig_HasHiHiAIm True |

Cfg_HasHifm False
Cfg_HaslLoAlm False
Cfg_HaslLoLoAlm Falze
Cfg_HasFailAlm False
AlamClass 1]
AlarmCommand Mav ToDisplay [ControlStrategies]¥T 100 x "Faceplate” "/RP"
Cfg_AlmMessgae Type False

v 04.02 - Hi Hi Alam
Cfg_HiHiDeadband 1
Cfg_HiHiOn Dy 0
Cfg_HiHiOff Dly 0
Cfg_HiHiAck Reqd True
Cfg_HiHiResetReqd False
Cfg_HiHiSeverity 750

ACM software can create graphic displays for control strategies. They're
generated in . XML format that you can import into to a FactoryTalk View SE

application.

1. GotoACM System View > HMI > Displays and add a FTViewSE object

from the process library.

The default name is FTViewSE_Server.

System View

1 x

v 71 Pmoject - My PlantPAx Project
g Historian
~ [ HMI
~ [ Displays
I FTViewS
A Alams
RBR Used Libraries

Server
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2. On the parameters tab, select a Display Template and a Batch Import
Template from the library.

Parameters  Digplays

HERE

v 01 - HMI Configuration
{RA-TPL)_ACM_2.00_HMI_Display_FTViewSE_11.0_(2.0)xml v
Batchimport Template (RA-TPL)_ACM_2.00_HMI_Display_F TViewSE_Batchimport_{1.0)xml
MaxSymbolWidth 240
MaxSymbolHeight 410

3. Onthe Display tab, add new graphics.

Parameters Displays

Name DisplayTitle DisplayLeft DisplayTop
|Motors Add New
|RA_APP_Display Copy
Paste
Delete

Reset Grouping..

Now you associated displays to your control strategies.

4. For each control strategy, access the parameters tab and expand 06 -
HMI Configuration category.

5. Choose the desired symbol style, as described in the caption.
Choose the associated displays where the object is placed.

Parameters
=4l | R =
~ 06 - HMI Configuration
SymbaolStyle 0]
AssocDisplay I FTViewSE_Server GraphicDisplays Graphic I
AssocDisplay2
AssocDisplay3
AssocDisplayd
AssocDisplayd W
Symbol Style

0 = Default,1 = Indicator,2 = Indicator with Capture,3 = Adv Indicator,4 = Adv Indicator with Capture,5 = Trend 6 = Trend1,7 =
Trend2.8 = Trend3,9 = Trend with Capture, 10 = Adv Trend, 11 = Hist Trend, 12 = Hist Trend 1,13 = Hist Trend2,14 = Hist
Trend3,15 = Hist Trend4,16 = SparklineReal 17 = SparklineReal1,18 = Lvl 1,15 = Lvl 1 Bar,20 = Lvl 1 BarS,21 = Lvl 1 Bar
with Alm 22 = Lvl 1 Bar with Alm 5,23 = Lvl 1 HBar,24 = Lvl 1 HBar with Alm,25 = Lvl 1 HBar with AlmS,26 = Lvl 1 Indicator,27
= Lwl 1 IndicatorS, 28 = Lvl 1 Hindicator, 29 = Lvl 1 HindicatorS,30 = Lvl 1 PV.31 = Lvl 1 PW1,32 = Lvl 1 Label
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Import/Export Manager

Use the Tools > Import/Export Manager to create additional devices (for

motors, valves, drives) with your configured strategies. You export the control

strategy to a .xlsx file, add additional devices to the file, and then import the
modified .xlsx file back into the control strategy.

This example creates additional Process Analog Input objects.

1. Exporta configured control strategy.

] Import Export Manager ? *
FILE TOOLS

Project : | My_PlantPAx_Base_Project

Import  E¢port  Compare  Tags Import  Tags Export  IAB / Architect
Export
O Al Projects

(® Complste Project

(O Partial

Type Controller Instance

[ Use Template

[ Show Madfied Export

[ Export Used Libraries Export and Open

Done

Caral e >

2. Open the .XLSX export file in Excel and find the tab of the object you
want to duplicate.

A complete project .XLSX file can contain many tabs of various project

components, which you can also modify.

3. To duplicate an object, locate the row and insert empty rows below for
however many new objects you need.

4. Copy the original row and select the empty rows and paste.
5. The new objects require unique names. (such as, XT100 — XT110)

Select the cell of the first row, where the names start, and hover the lower

right corner.
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7. Click the + and drag it down the column to the bottom of the new row.
Excel’s auto fill feature renames all selected names in a linear series.

AutoSave Project My PlantPAx_Base Projectxlsx -~ }3
File Home Insert Page Layout Formulas Data Review View Help 15 Share I Comments
En b Calibri o~ Text + | [ Conditional Formatting~ | EHlnsert ~ | 2 ~ 57~ §
b DE@v B F S AT P v | $~% 9 | [Erormatas Table~ B Delete ~ | @~ O~ by
aste . eas
- ¥ v e A =i $he £F 0 i Cell Styles ~ [l Format~ | &~
Clipboard [F] Fant [F] Alignment N Number N Styles Cells Editing Ideas Sensitivity ~
A5 > Je XT100 v
A B c | D E | F G H 1 K L M N o =
1 |:Library(PAl, {RA-LIB) Process 5, Major 1, Minor 0, ID 7D49CDF7-E72A-4552-9C11-725AF0246831)
2 |:0Objects
&
E = o N -
o g £ = = g
= a Z 72 o = o =2
. 5 = A | €| E| € =
= E | |2 3 ] 3 3 =
= E B = | m| B 2 2 2 i K
@ o s = 2 | 3| 8| B ®| 8 ] =
1 ‘é x ® § < |G | E| E E|l E 3 =
3 = g [ & =] n.l n.l n.‘ n.l n.‘ n.l n.l a.l n.‘ n.‘
4 |SXT100 Description PAIl(Single_channel) |AITA00 [0  |Area0l|PAI|PAID |PAIM |PAH |{fn_Label} |raP-5 00
5 [xT100 ocessController |Normal [PS_PAI |Description Published [PAI(Single_channel) |AIT400 [0 |AreaOl [PAI [PAID |PAIM [PAH [{fn_Label} [raP-5_00
6 |XT101 ocessController [Normal |PS_PAI |Description Published [PAI(Single_channel) |AITA00 [0 |Area01 [PAI |PAID |PAIM |PAH |{fn_Label} |raP-5 00
7 |XT102 rocessController [Normal |PS_PAI |Description Published |PAI(Single_channel) |AITA00 [0 |AreaOl|PAI |PAID |PAIM |PAH |{fn_Label} |raP-5 00
8§ |xT103 ocessController |Normal [PS_PAI |Description Published [PAI(Single_channel) |AIT400 [0 |AreaOl [PAI [PAID |PAIM [PAH [{fn_Label} [raP-5_00
9 |XT104 PyocessController [Normal |PS_PAI |Description Published |PAI(Single_channel) |AIT400 [0 |Area0l1|PAl|PAID |PAIM |PAH |{fn_Label} [raP-5 00
10 |[XT105 PlocessController |Normal |PS_PAI |Description Published |PAI(Single_channel) |AITA00 [0 |Area0l|PAI|PAID |PAIM |PAH |{fn_Label}|raP-5_00
11 [XT106 PlocessController |Normal |PS_PAI |Description Published |PAI(Single_channel) |AITA00 [0 |Area0l|PAI|PAID |PAIM |PAH |{fn_Label} |raP-5_00
12 |[XT107 ProcessController [Normal |PS_PAI |Description Published |PAI(Single_channel) |AITA00 [0 |Area0l1|PAl|PAID |PAIM |PAH |[{fn_Label} [raP-5 00
13 |XT108 PrpcessController [Normal |PS_PAI |Description Published |PAI(Single_channel) |AITA00 [0 |Area0l|PAI|PAID |PAIM |PAH |{fn_Label}|raP-5_00
14 |[XT109 PrpcessController [Normal |PS_PAI |Description Published |PAI(Single_channel) |AITA00 [0 |Area0l|PAI|PAID |PAIM |PAH |{fn_Label} |raP-5_00
15 |[XT110 [|PrutespController |Normal |PS_PAI |Description Published |PAI(Single_channel) |AITA00 [0 |Area01 |PAI [PAID |PAIM |PAH |{fn_Label} [raP-5 00
16 | FJ:THQ | <— Start above and drag the lower right comer down to autofill names in a linear series
i
8. Modify names in other columns as needed, such as the column for
program connections or the column to specify the I/O module channel.
9. Save the file import it back into the control strategy.
] Import Export Manager ? *
FILE TOOLS
Project : | My_PlantPAx_Base_Project

Import  Export Compare Tags Import  Tags Export  IAB / Architect
Import

() New - Create new project

(O Replace - Overwrite project

(@) Update - Merge with existing project fwill not delete existing objects) [1 Auto Continue

Excel File - ClUsers\Rockwell AutomationDesktop\Project_My_PlantPAx_Base_Project xlsx |

Open Backup Folder Backup original

Done

Cancel <« Previous Next >

Your ACM project now contains several objects, with the same control
strategy, to use throughout your project.
Generate HMI Displays

When the control strategies and displays are configured and associated,
you can generate the displays.
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1. Verify that the controller parameters contain the correct communication
path of your HMI server and device shortcut.

You create device shortcuts on the PASS using a FactoryTalk View SE
application or the FactoryTalk® Administration Console.

2. Select HMI > Displays > FTViewSE_Server and select Generate Displays >
All Displays

(6% Application Code Manager (localhost\SQLACM.ACM)
FILE EDIT TOOLS VIEW  HELP

Noda B
System View 1 x
v £ Project - My PlaniPAx Project R Name: FTViewSE_Server
€g Historian Description: FactoryTalk View SE Display
v HMI
~ [ Displays Catalog Number- FTViewSE (23) - Published
A Aams Generate Displays » || AnDisplays
o View 3 " x
e Pl : Generate RA_APP_Display display
~ Contrllas Extract Attached Files Generate Graphic display
[&@ Process_Contro Delete Generate Motors display
Copy : =
0 2]
Refresh

3. Browse to where you want to save the generated. XML file.

ACM generates one batch import XML file and all individual displays
XML files.

The graphic displays are now ready to be imported into a FactoryTalk View SE
application.
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Develop Historian Tags

The process library objects reference multiple Historian digital sets. Digital
points can be used to enumerate the process states, thus creating a
relationship between the value and the text state name. For example: 1= Good.
1. Add a Historian object to your ACM project.
2. Got to Historian > ScanClass and select Add.

Systemn View i
v 4t Project - My PlantPAx Project
v 4§ Historian
=] Scanflzee
I Hmi Add
HEE Used Libn Paste Special
Paste

3. Use the Object Configuration Wizard to select and create the desired
Historian digital sets.

Object Configuration Wizard ? *
Name: ‘ FTHistorianSE_Server |
Description: ‘FactoryTaIk Historian SE Scan Classes |
Catalog Number: FTHistorianSE {22 ) - Published
Solution: (RA-LIB) ACM 2.00

Parameters  Point Type

EIFE]
w D01 - Historian Configuration

HistorianTags Template (RA-TPL)_ACM_2.00_Historian_ScanClass_FTHistorianSE_5.01_{1.0).csv ~ |
|

Cancel << Previous Next > Finish

The ScanClass now contains the FTHistorianSE_Server object.

(8% Application Code Manager (localhost\SOLACM.ACM)

FILE EDIT TOOLS WIEW HELP

halola k

System View

v gt Project - My PlantPAx Project Name: FTHistorianSE_Server

v O Historian Description: |FacmryTalk Historian SE Scan Classes
~ B ScanClass
Gl F T HistorianSE_Server Catalog Number: FTHistorianSE  {1.0) - Published

[ HMI
BE Used Libraries Solution: (RA-LIB) Process 5

Controller Pre...

Parameters  Point Type

v Controllers v Controllers

~ [@ ProcessController » [ ProcessCortrollel] 55 % | = ‘ =
[P:::t:lﬁr F::: i s i
Tasks B HistorianTags Template (RA-TPL)_ACM_2.00_Historian_ScanClass_FTHistorianSE_5.01_(1.0)csv
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4. Select the Point Type tab to view the available digital sets.

Name:

Description:

Catalog Number:

FTHistorianSE_Server

|FactoryTaIk Historian SE Scan Classes

FTHistorianSE (1.0} - Published

Selution: (RA-LIB) Process 5
Parameters  Point Type
Name ScanClassiio ExcDev ExcDevPercent ExcMax ExcMin CompDev CompDevPercent CompMax
1 1] o] 600 o] 1] [u] 23300
Float32 1 0.25 0.25 600 o] 0.5 0.5 28300
P_AIn V... 1 0 [v] 600 o] o o] 28800
P_AQut_... 1 1] o] 600 o] 0 a] 28300
P_AQut_... 1 1] o] 600 0 "] 0 28300
PB45D ... (1 1] o] 600 o] 1] 0 23300
EBdsn ... (1 1] o] 600 o] 1] 0 28300
P_DIn_V... 1 1] o] 600 o] 1] [u] 23300
Generate Historian Tags

Use ACM to generate the Historian tags to a .CSV file that corresponds to the
configured control strategy.

1.

2. Save the Historian tags .CSV file to the computer that has the PI Builder

Go to ACM System View > Historian > Scan Class >

FTHistorianSE_Server and select to Generate Historian

System View

~ &g Historian
~ B ScanClass

I HwW
BiE Used Libraries

v 3t Proiect - My PlantPAx Prroject

Generate Historian

Extract Attached Files

Delete
Copy

Rename

Refresh

All Controllers

CLX0

Add-in for Microsoft® Excel.
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Studio 5000 Logix Designer
I and FactoryTalk View SE
Software

Controller Organizer +

& e

The processlibraryincludes templates of controller and HMI applications.
These templates are designed to get you started if you aren’t using ACM
software or do not have an existing project.

Logix Designer Templates

Controller templates have the library instructions and task model already
defined. They also have a basic IO configuration that you can modify according
to your project plan.

<« RA_Process_Library_w4.10.01 » Templates » Logix Templates

Mame
E33 :
|| RSL3k_18_Template_nolib.ACD

d RSL5k_18_Template_ProcLib_4_10_01_allACD

d R5L3k_18_Template_Proclib_4_10_01_bas.ACD

| | RSL3k_20_Template_ProcLib_4_10_01_all.ACD

[7] 55kLD_24_Template_ProcLib_4_10_01_all.ACD

[7] 55kLD_31_Template_ProcLib_4_10_01_all.ACD

ds

nts

Open a Logix Designer project and browse to the template directory and select
the template to open.

f|Qq

abed| 2] abe. -

b

3 Controller 55kLD_31_Ternplate_Proclib_4_10_01_all ~

4 Tasks
4 (B Task_A_50ms (50 ms)
4 L Task_A_MainProgram
<7 Parameters and Local Tags
b (&) Task_B_100ms (100 ms)
P (B Task_C_250ms (250 mns)
b () Task_D_500ms (500 ms)
P (B Task_E_1s (1000 ms)
b (E) Task_F_2s (2000 ms)
P (B Task_G_5s (5000 ms)
b (&) Task_H_10s (10000 ms)
P (B _Controller_Status (250 ms)
Unscheduled
b Meation Groups
4 Assets
4 Add-On Instructions
3 1_1715IF16_FW3
4 1_17150F8I_FW3
b 1_1718_1719_Al4H
4 1_1718_1719_AC4H
3 1_1734sclE2CH

134

This rung monito

I and provides information on the Task
and an Alarm if the Tas

cution Time exce Plan™ threshold.
Logix Tazk Monitor

L_TaskMon

L_TaskMon L_TaskMonitor[1] [...
Inp_Reset D4
Val_Rate 00w
\fal_Priority O
Val LastExecT 004
Val_MaxExecT 004
Val_OverlapC O
al_WatchdogT 004

For more information, see Develop Control Logic.
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FactoryTalk View SE templates

HMI templates contain pre-defined components such as, Displays, Global
Objects, Libraries, Images, Macros, and basic configurations for FactoryTalk
View SE applications.

<« RA_Process_Library w4.10.01 » Templates » FTView Templates

~
MName

55
| | FTVME_10_0_Template_ProcessLib_4_10_01.apa

|| FTVME_10_0_Template_Sequencer_4_10_01.apa
|| FTVSE_10_0_P2fCuickStart_4_10_01.apa

s | | FTVSE_10_0_Ternplate_ProcessLib_4_10_01.apa
| | FTWSE_10_0_Template_Sequencer_4_10_01.apa

ds

If you have already an HMI project, on your PASS, you can:

« Use the template application as a new HMI, then recreate your Areas,
HMI server, data server and alarms and events server, such as you do
when you configure a PASS.

« Use the existing HMI application, on the PASS, and add library
components into the application.

You need to restore the template so you can access the application and its
components.

1. Goto the FactoryTalk View SE Application Manager and select to restore
alocal station archive.

2. Browse to the .APB file in the templates folder in the process library and
open the application.

- Ifyou choose to make this template your new HMI application, see
Chapter 3, Process Automation System Server for how to create areas
and servers.

- Ifyou choose to maintain your existing HMI application, export the
Displays, Global Objects, Libraries, Images, Macros from the template
and import them into your application.

You can use the Add Components in Application method to add Displays,
Global Objects, Libraries, Images, directly from the library.

Rockwell Automation Publication PROCES-UM100C-EN-P - June 2022 135



Chapter 5

Process Applications

1. Inyour application, select the component (such as Displays) and select
Add Component in Application.

ﬂ FactoryTalk View Studio - View Site Edition (Local Station] - [Untitled

File Edit View Settings Objects Arrange Animation 1
A8 0= O L BOE:» = YT

Explorer - Template_ProcessLib - I

=08 Local (PASSOT)
Eli'@' Termplate_ProcessLib
i.mo Runtime Security
LT Scripts
E]EEI Termplate_ProcessLib
E| System
- LB Command Line

Graphics

Bl ispa
B (F ey
-B F Add Component into Application..,
p pp
S if Mews Folder
LB 0F
B EF Delete
LB Remaowe
B Import and Export..,
- B (RA-BAS)L_laskMon-Summary
- B (RA-BAS) Logix-Faceplate

2. Browse to the .GFX files in the library folders and select those to open.

PlantPAx Configuration Tool The process library includes the PlantPAx Configuration Tool. This tool performs

1 for Tags' Alarms, and various functions to help you create or modify an existing PlantPAx project. To
. . use this tool you must have a controller project ((ACD) file, which can be:
Historian
« Generated from ACM
. Existing controller project
« Sample controller project from the process library
For more information, see the quick start guide that comes with the tool.
B8l PlantPAx Configuration Tools for Tags, Alarms, and Historian [PlantPAx] .
File View Tools Windows Help
DM
=-f Logix Controllers [ '—Ell B Quickstart.pdf X I + v = (m] >
=4 RA_LIB_L85EP
=i Associated HMI Application = &« > 0O @ D | filey//C:Program%20Files320(x86)/Rockwell%20A = Low
~-® FactoryTalk View SE Local
LB HMI Server Name = HMI Server 4 ofes | = P - 4+ 9 m A L BB B R
i~y Data Server Name = RSLinx Enterprise
4y Data Server Device Shortcut Name = CLX01
HMI Alarm Servers
M TagAlarms and Events ROCkwe“
----- % RA_LIB_ 85EP ]
é B Historian Servers A“foma‘llon

136

=B Historian SE
----- % RA_LIB_L8SEP

Table of Contents

Software License Agre 2
Table of Content: 4
Software Overview T
o Software. 5
‘Quick Start — Create Project 9
Add Controllers to Project. 9
Enter FactoryTalk View HMI Information 9
Save Projec 0
Contaxt Sensitive Popup Menu 1
Quick Start — Process Tree Organizer 12
Controllers & HMI prgcess Tree Adding Folders

HMI Server = HMI Server

Rockwell Automation Publication PROCES-UM100C-EN-P - June 2022



Chapter 5 Process Applications

With the PlantPAx Configuration Tool, you can:

Task

Details

| Editan existing project

« Define a project that has multiple controller .ACD files and associated FactoryTalk® View HMI applications.

« Organize controller logic, tags, and HMI displays in a Process Tree organizer. You can then use the tree structure to create FactoryTalk Alarms
and Events alarm groups and Historian Asset Framework elements.

« Edit tags and data in offline controller .ACD files.

« Export and import tag data to and from text files.

« Create Microsoft Excel workbooks for online OPC tag data reads and writes.

« Create FactoryTalk Alarms and Events . XML import files using tag data from controller files.

Develop displays

Two utilities help build specially formatted FactoryTalk View SE parameter files.

One utility builds a parameter file containing a list of controller tags with associated HMI faceplate displays. Users can search for tags using tag
names and tag descriptions. The user can open tag faceplates from the returned search results.

The other utility creates a navigation tree from the project Process Tree structure.

Develop Historian tags

Bulk configure 0SI PI Asset Framework (AF) databases with Logix tag AF elements. This includes automatic configuration of related Pl points in
the FactoryTalk® Historian data server (Pl data server).

For systems without Asset Framewaork, a separate utility provides bulk configuration of Pl points in the Historian data server. The utility provides
the option of generating a bulk import file, or adding the PI points directly if a Historian data server connection is available. The bulk import file
can be used with the Pl Point Builder Excel AddIn to create points in the data server.

For more information about Historian tags, see Chapter 7, Historical Data

I Process Controller PlantPAx system release 5.0 added process controllers to the Logix 5000 family of

controllers. The process controllers offer additional capabilities that are targeted for

DCS applications.

Controller Catalog Numbers

« 1756-L81EP
ControlLogix 5580 process controller « 1756-L83EP
« 1756-L85EP

- 5069-L320ERP
« 5069-L340ERP

CompactLogix™ 5380 pracess controller

For standard use information, see:

« ControlLogix 5580 and GuardLogix 5580 Controllers,
publication 1756-UM543

« CompactLogix 5380 and Compact GuardLogix 5380 Controllers,
publication 5069-UMoo1
To best use controller resources:

« Use periodic tasks only, with minimum number of tasks that are used to
define execution speed, faster tasks getting higher priority (lower
number).

« Usethe L_CPU Add-On Instruction to monitor controller use.

Configure Controller Properties

Use Studiosooo Logix Designer software to configure the controller.

1. From the Controller Properties dialog box, click the PlantPAx tab.

B Controller Properties - PlantPAx X

General Major Faults Minor Faults Date/Time Advanced SFC Execution Project
Nonvolatile Memory Capacity Intemet Pratocol Part Configuration Secuty ~ Alamlog  PlantPAx

Use PlantP Ax Tasking Model

View number of PlantPAx Objects pertask:

Instruction Usage
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2. Ifyou’re using a process controller, leave the check for Use PlantPAx
Tasking Model box (checked by default).
3. Click the Date/Time tab and check the Enable Time
Synchronization box.
4. Enable Automatic Diagnostics on the Advanced tab.
Automatic Diagnostics is a mechanism to detect and present device
descriptive events with no programming required. Diagnostics based
on the device definition (such as fault or open wire) are sent to the
HMI and displayed on the Automatic Diagnostic Event Summary
object.
© @ U & Nofiter 1YY Pu
‘ State | Assess. Event Time - Area Device Name Catalog Message
=all= O|<all= Of-<all= P <al= P <al= P <al= P <al= jel
A [x] 10/1/2020 4:16:16 PM  /RSLEArea [CLXOM]EN2TR_PPAX 1756-EN2TR  Connection Lost with Device
PlantPAx Task Model

The Task folder contains a project structure that consists of four pre-defined
periodic tasks.

b Il Controller PlantPAx

4 Tasks
4 (B Fast (100 ms)
b L FastProgram
4 (B Normal (250 ms)
b 4 MormalProgram
4 (® Slow (500 ms)
b L SlowProgram
4 (B System (1000 ms)
b L SystemProgram

P TR R g |

4 Motion Groups
3 Alarm Manager
3 Assets
e Logical Model
3 1/0 Configuration

Logic is placed in the appropriate task to ensure that it meets the process
requirements. These tasks are:

Fast (100 ms) - For control fast loops, such as liquid pressure with related
transmitters and pump drives

Normal (250 ms) - For discrete control, such as motors, pumps,
and valves

Slow (500 ms) - For level, temperature, analysis loops, phases, and batch
sequencing

System (1000 ms) — For slow change temperature control and general
controller operations, such as messaging or status

The ControlLogix 5580 and CompactLogix 5380 controllers (including the
process controllers) have simplified task management from previous
controllers. The controller runs control, communication, and packet
processing on separate cores within the controller. You no longer have to
reserve CPU time for communication or overhead.
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Create the Logical Organizer

The Logical Organizer is a graphical representation of the organization of the
configuration logic that is aligned to the process being controlled, called the
logic model. It enables you to create and organize hierarchies of the programs
and folders in your project, independent of the execution model.

A process controller contains tasks that execute at various rates. Each task
contains programs of code that is required to execute at the selected task’s rate
of execution. The Logical Organizer helps create an understandable
organization, based on process functional requirements.

« Server-based alarms and Logix tag-based alarms are often based on area
organization within the Logical Organizer and built using the PlantPAx
configuration tool.

« Organize batch applications following the ISA-S88 physical model.

IMPORTANT  Several components in a PlantPAx system depend on the
organization and hierarchy of the system:

« HMI application

« Alarms

« User roles and responsibility
« Security

You can generate the Logical Organizer from an ACM project or create the
Logical Organizer directly in the Logix Designer project.

This example shows the same controller project that is viewed from the
Controller Organizer and its associated Logical Organizer. The Controller
Organizer is used to ensure that the logic is executed at a rate suitable for the
process. The Logical Organizer can be used to create folders aligned with the
application (a folder for each HMI display) and allows dragging the associated
programs into the appropriate folders. This enables accurate alarm rollups and
breadcrumbs on the Navigation bars to assist the operator in troubleshooting
abnormal conditions. (See PROCES-RM200 Chapters 2 and 3 for more detail).

Contraller Organizer » B X Logicl Organizer - 0 X
4 o=
4 . Controller Dig1_3 - | 4 Wlogicel Model Dig3 |
A B DG

& Controller Tags

Fl DiG1
Contraoller Fault Handler P D1_COCK
Parwrer-Up Horedler P L Mormal D1_CK
4wl Tasks b L Sow D1.CK
@ Fast (100 m3) & D _KNOTCK
a (& Mormal (250 ms) b & Hormal D1_KNT_CK
b & Mormal D1_CK b L, Slow D1_KNT.CE
B4 Mormal D2 CK a D
%, Norrmal_D3_CK 4 1§ D2 CO0K
4, Morrmal D1_KNT_CK b L Mol 02CK

b & Slow DZ.CK
F D2_KMNOTCK
b L Mornasl D2_KNT CK

L Mermal_D2_ENT_CE
L Morrmal_D3_KNT_CK

Y
veve@eeew

ey b L Sow DI_KNT_CE
L Sow D1_CK o+ i D63
b How 02_CK 4 1 D_COOK
b Slow D3_CK B & Morrnal D3_CK
L Slow D1 _ENT CK b L Sow DICK
B L Slow D2 KNTCK 4 1 D3_KNOTCK
P L Slow D3 KNTCK b & Hormal D3_KNT_CE
4 (T Systern (1000 ms) b L Slow D3 KMNT_CK
P L SystemPragram 4 Sg.f:r;m1 .
- Ig -

[ Systgmﬂrcgr;m
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Add Modules and Devices to the Controller Organizer

All Logix 5000 controllers require module connections (analog,
communication, digital, specialty) to be defined in the I/O Configuration list.

Follow these guidelines for I/O module properties in a PlantPAx system.

Table 7 - Guidelines for Module Configuration

Item Description
Electronic Keying reduces the passibility that you use the wrong device in a control system. It compares the
device that is defined in your project to the installed device. If keying fails, a fault occurs.
+ Use Exact Match for keying in a validated environment. This makes sure that only the same series and
Electronic keying revision device can be used.

« Use Compatible Module for keying in environments where a newer series or revision device can be used
without requiring changes to the definition.

For more detailed information on Electronic Keying, see Electronic Keying in Logix 5000 Control Systems

Application Technique, publication LOGIXATOO1.

I Requested Packet Interval (RPI)

The RPI value is the rate at which the controller attempts to communicate with the module. RPI is often defined
by the inherent properties of the signal being measured. For example, a temperature measurement changes
slower than pressure, so a larger RPI could be used to a device that measures the temperature.

We recommend that you specify an RPI that is two times faster than task period. For example:

« A device that is used within a 250 ms task requires a 125 ms RPI.

« A device that is used within a 100 ms task requires a 50 ms RPI.

Use NONE for the Connection Format to remote communication modules used as bridged adapters.

For modules that support Precision Time Protocol (PTP) synchronization, it's recommended to use Time Sync
and Motion.

Connection tab options

« Ifinhibited, the controller does not attempt to make a connection. This is used as placeholder for a device
that is not yet implemented or installed.

« Major Fault On Contraoller If Connection Fails While in Run Mode. This is used on critical connections, where
controller execution can't continue if a problem is detected.

| Integrated HART device connection

FLEX 5000™ I/0 with 5094 HART modules support two device connections types. The PlantPAx data format is

recommended and is pre-defined for the PAH instruction.

« PlantPAx Data: Input data includes basic input from the HART device that is used by PlantPAx for the four
dynamic variables and semi static data. Also includes the configured device variables and commands.

« Data: Input data includes basic input from the HART device for the dynamic and device variables that are
configured plus the configured commands.

140

FLEX 5000 I/O HART integration lets you directly add field devices to the I/O
Configuration list.

Controller Organizer * 1 X

Controller PlantPAx
Tasks
Motion Groups
Alarm Manager
Assets
T Logical Model
4 1/0 Configuration
P B3 5069 Backplane
4 £ A1, Fthernet
[f2 5069-L340ERP PlantPAx
4 g 5094-AEN2TR/A Ethernet_Adapter
4 B3 5094 Backplane
“‘ [0] 5094-AEN2TR/A Ethernet_Adapter
4 [ [1] 5094-IF8IH/A Analog_In_HART_S01
4 &5 HART
¥ O0HART-Device-268A Tank01
b £z A2 Fthernet

v Vv ww
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Configure the variables and commands for the HART devices within the
Module Definition. You can add HART EDD files if additional device
descriptions are required.

Meadule Definition™

- General®

i Variables
Commands

Define Module, Electronic Keying and Connection
Add HART EDD...
Revision: 1 v ool -5
Electronic Keying: Compatible Module w
|Connection: [PlantPAx Data ™ |

The PlantPAx Data connection creates a PAX_HART DEVICE:I:o structure
that is formatted for direct use in the Process Analog HART (PAH)

instruction.
PAH
PAH_O1
0.0
val HARTRV [
vy
VaLHARTSV D> '
Val_HARTTV c:
Val HARTOV cl"

Develop Control Logic

Wal_HARTLoopCurrent
Ref_HARTData Tank01 L{A:D evice

R=f_DiagTable Tag Element: TankD1:1.PAxDevice
Elemnent Data Type: PAX_HART_DEVICELD
Ref_UnitsTable Tag Data Type: AB:3000_HART_PAX:L0

Tag Scope: Controller

Process controllers support an exclusive set of embedded PlantPAx process

objects, which are listed as PlantPAx instructions.

= @ @ @ S

PCHD FOO RIM FPE /) PUL
FAH FAI FRID PAIM FPRO PBEL ‘gpr PDBC PDI PDO 'op7 FFO PHLS %y FLLS PMTR 'gr FRID PFTC FEI FRT PTET PWLV ‘o PYSD

=T

T

p Favorites  Add-On Pri =
Analog Input
PAI

i Alarms  Bit Timer/Counter Compare Compute/Math Move/Logical Program

o fof 1

PS_PAI

Esheet 1

Analog Input
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The PlantPAx instructions offer enhanced functionality, including tag-base
alarms, and can reduce the number of steps to configure control strategies. For
more information about the instructions, see:

« Studio 5000 Logix Designer online help

« Logix 5000 Advanced Process Control and Drives and Equipment Phase
and Sequence Instructions Reference Manual, 1756-RMo06

Each PlantPAx instruction features an intuitive design-time configuration
interface. It’s based on the SAMA (Scientific Apparatus Makers Association)
diagram interface, which focuses on the flow of information.

The example shows the PAI - Process Analog Input Object.

& PAl Properties - XT100 I,\\) - m] X

General RV chmping [imitx 200 mA DC
PV fail check High: | 1.50000000e+038| % Scaling:
Advanced w3
M1 Low: | -1.50000000e+038| %
Alarns PV quality
Parameters Use input value . Replace PV value:
Tag Last good PV value

Device

Virtual PV value:
.
Maintenance substitution
Use substitute PV | € " Substitute PV value:
Filter order: 0
None i
(o] .
Cutoff frequency:
M 1000 %
T Min -33333332 %
I %ls
R + PV deviation
300| % > 0.0 %
Device state: PV good
Device i : High high

This interface improves upon prior releases of the process library, in where the
underlying elements of an Add-On Instruction can be viewed but do not
illustrate how it functions.

The blue animation line adjusts depending on the instruction execution. In the

previous example, see the Maintenance substitution option. If you select ‘Use
substitute PV,” the blue animation line shows a new execution path.
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Import Add-On Instructions

There are additional libraries of Add-On Instructions that you can use to
supplement the PlantPAx embedded instructions. Studio 5000 Logix Designer
can import a single Add-On Instruction or a Program/Routine containing
multiple Add-On Instructions, such as a control strategy generated with ACM

software.

Add-On Instructions are used when the following functionality is required:

Feature Description

Organization, ownership, and arbitration

« Allows the organization of devices into groups from HMI
« Manages and prioritizes ownership of equipment groups
« Propagates command and status through equipment groups

Process Instructions from prior libraries

Non-process controllers use the Add-On Instructions from the process library, release 4.1 or earlier

Device Add-On Instructions for supported network
devices

The purpose of device Add-0n Instructions is to reshape the data structure of similar but disparate equipment
to a common structure that can be used by a single comman PlantPAx instruction.

For example, a device Add-On Instruction for a Variable Speed Drive (VSD) is used to reshape the disparate
VSD source data so that a common PlantPAx instruction (PVSD) can also mean that a common control strategy
can be used to control all those same VSDs

Controller-to-Controller Communication

There are two main options to communicate among controllers:

Produced and Consumed Tag

Message (MSG) Instruction

Consumed tag data is automatically received from a producer controller, at a
requested packet interval (RPI), without the need for logic programming.

Read or Write messages are programmatically initiated on condition (False to True
transition).

Ideal for exchanging critical data that changes frequently; use for higher priority
communication.

Ideal for exchanging non-critical data that changes less frequently; use for lower priority
communication.

Data is constantly sent regardless of change of state. This does not impact the
scan of the controller, but it can impact network bandwidth.

Communication and network resources that are used when needed only, however, a delay
can occur if controller resources aren't available when needed.

Tag size is limited to 500 bytes over the backplane and 480 bytes over a network.

Supports larger data payloads, up to 32,767 elements, using multiple data packets.

Supports tags of mixed data types (UDT).

CIP™ Generic messages to third-party devices.

You can't modify or create produced/consumed tags online in Run mode.

You can modify and create MSG instruction online in Run mode.

Routing of traffic across subnets depends upon the transmission type (Unicast or
Multicast).

Message traffic can be routed across subnets and across slots of a 1756 chassis.

For more information on controller communication options, see Logix 5000
Controllers Design Considerations Manual, publication 1756-RM094.
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Configure Produced and Consumed Tags

Group produced and consumed tags as members in user-defined structures.
This technique helps monitor connection status between controllers without
increasing execution time, such as using a GSV instruction to detect status.

1. In Logix Designer, define a user-defined structure of a tag to be used in
all controllers.

MM LY ganiser v v om
B MRETRCMDCONTROL
5 MMETRCOILARRAY i
B MNETRCONTROL
2 MNETRDATA LRI
2 MNETREVENTCMD
B MNETRIPADDRESS
B MNETRMOOULEDEF
B MNETRPASSTHRL
= MNETRSTATUS
2 MRETRUTIL
B MNETSTATS
B MNETSTATUS Mams ICIuI'J'l:me Ii'sde IDH:nphcr [Eﬂem ACTREE
2 MNETUTHL Shehus CONNECTION_STATUS [ [Peadiveia
=] PAR_MACHINE DT DIMTI20) Decmal Fugad vl
B PAR_MACHINE_INTGR SHT SINTTIE] [Docmal | Pt ey
B PAR_ MACHINE_REAL NT T |Decmal P Feany
B PAR_MACHINE_STRNG REAL REALRZN |Fieet } |l Piviem
] T BO0LSE] [Becmal | ) | P
B Prompt_StringData ] I I |

Froducedimemy

Mamian Dt Type Sice: 252 byta(s]

1
g

2. Name the first member Status and a data type of
CONNECTION_STATUS.

This data type provides two BOOL bits (RunMode &
ConnectionFaulted) in the Status member for each controller
consuming the tag.

MyTag.Connection_Status.RunMode

- Value of 1 when Producer is in Run mode.
- Value of o when Producer is in Program mode.

MyTag.Connection_Status.ConnectionFaulted

- Value of o when Producer connection is good, regardless of mode.
- Value of 1 when Producer Connection is broken.

3. Once the UDT is finished, create a tag of that UDT type to be either
Produced or Consumed.

4. It'srecommended to add a common prefix to each tag instance of the
UDT, so you more easily search for those tags.

Scope: IMGRAN v} Show: ‘h'lterpmcessor_Comms v|| .
[ [hame Value € | Force Mask € | Style Data Type Descnption
[+ COMMs_from_BMS9275 e [aual Interprocessor_Comms | Granulation Dryer BMS P2P Comms
[+/-COMMs_from_DISP ! | Haeml) Interprocessor Comms | Dispatch P2P Comms [
+/ COMMs_GRAN_Produced M ] Tiaia Interprocessor_Comms  [Granulation Produced Data

5. Create a Produced tag by simply changing the tag property from base to
produced and setting the max number of consumers.

6. Create a Consumed tag by changing the tag property from base to
consumed. The Producer controller is selected from the I/O
configuration list and the remote data (exact name of produced tag) is
entered.

7. Select the RPI rate in which the produce tag is consumed.
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For bidirectional P/C tags between two controllers, both consuming
controllers have each producer controller in its I/O configuration list.

Multiple consumers can receive the same data from a single producer.

IMPORTANT  When adding the Producer controller to the I/0 configuration list of
the Consumer controller, the firmware revision does not have to
match. However, the rack size and slot number must be correct.

Data arrives asynchronous to program scan. Some applications may

require a programmatic handshake. Buffering data to or from P/C tags

helps to make sure that the user logic executes on that same data

before it changes.

8. Create logic that writes values to the Produce tag elements.

s TR LUV
| =& G_TRF_F_BERTH Produced Mapping for IVC - IVC_PMO1
| 0% G_TRF_F_REF
| ®CPG_TRF.OIVB {noP }—
505 G_TRF.O_IVC
| EUBLTRFREF = ASBIEMVO01
| ®5% )_TRF_F_SAPREF I Intemodal Produce
| wCR)_TRF.OIVE Tag Puﬂ'am C:rn;mand Iralnk_ X701 q:ias
| - ) 1o Acquire Valve solation - in Alarm
#1°% Diesel TFR Sequencing ipSE1EMVO01_PCmd_Acq VG_PMO1 BOOLIO)
03 Gasoline_TFR_Sequencing 1 IE
# % Jet_TFR_Sequencing
® Utility ASGIEMVO0T
= 58 Communications Intemodal Produce
ke Tag Program Command
& program Tags to Close Valve Produced Mapging
i MainRoutine ipS61EMVO01_PCmd_Close VC_PMD1.BOOL[1]
B C_IVB_PMOL 2 J E
BChe ASBIEMVO0T
B cve pnos Imermodal Produce
-B C_IVB_PM04 Tag Program Command
Bl Data_Compression _ to Open Vi Produced Mapging
B Explicit Messaging ; iPS1EMVO01_PCmd_Open VC_PM01.800L(2]
B Monitoring i
B p_vc_PMOL
9. Add corresponding consume tags to each controller that consumes
the data.
Note that UDT structures can be exported to. LsX format and
imported into the other controllers.
10. Use Consume tag elements to write to variables in the Consuming
controller.
ontroller Organizer ~ x|y B B E] & a v w
5% D_TRF_OIVC .
! % G TRF F BERTH Consumed Mapping from IVB - IVB_PM01
409 G_TRF_F_REF .
0% G_TRF_O_IVB o [hOP }—

0% G_TRF_O_IVC
5 ) TRF_F_REF
OB J_TRF_F_SAPREF N
G ) TRF_O_IVB
28 Diesel_TFR_Sequencing
iil= Gasoline_TFR_Sequencing
[i2 % Jet_TFR_Sequencing
B Utility
=58 Communications
B Program Tags
b MainRoutine
B C_vs_PMOL
B _vs_PM02
-8 C_IVB_PMO3
~B ¢ Ive_PMO4

1]

NWEB_PMO1.Status Runbode  IVB_PMOD1 Status ConnectionFaulted

VB_PMO1_CommsOk

T E 1,
1 4.k J/E

Isolation of X618

ASB1EMVO01T
Intemodal Consume

WB_PM0O1.BOOL[1] WB_PMO1_CommsOk
i B e

fram Diasel Ref
rundown lines - in Tag Status Vahe in
Alarm Alarm
WE_FMO1BOOLD]  IVB_PMO1_CommsOk ieBE1EMVOD1_Sts_Alm
: e TE

ASE1EMVO01
Intemodal Consume
Tag Status Vake
Available
ieSE1EMVO01_Sts_Asailable

3 il J
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PlantPAx Guidelines for Produced and Consumed Tags

Produced and consumed (P/C) tags can be a single tag structure or a
user-defined structure (UDT) of mixed data types. For example, a UDT
tag can contain members up to 120 REALs or 100 REALs and 640 BOOLs.

Group data in produced and consumed tags into a UDT to reduce the
total number of connections.

Make the first member of the UDT a data type of
CONNECTION_STATUS for connection status.

Export/Import the same P/C UDT data type among controllers to
confirm they match exactly.

Make sure the number of consumers configured, for a produced tag, is
the actual number of controllers consuming it to reduce the number of
connections to the controller.

Always use a handshake when transferring data between controllers
through health data or manually configured diagnostic.

We recommend unicast traffic when possible, because it transmits only
to an intended destination, which reduces bandwidth. However,
redundant controllers require multicast traffic to consume data.

PlantPAx Guidelines for Message Instructions

The MSG instruction asynchronously reads or writes a block of data to another
module on a network.

ControlLogix 5580 and CompactLogix 5380 support up to 256
connections. If you want to enable more than 256 MSGs at one time, use
some type of management strategy.

Use the cached option when the message connection needs to
be maintained.

Use message Reads, instead of Writes. This makes it easier to
troubleshoot code by knowing where the incoming data is coming from.

When messaging between Logix 5000 controllers, use a DINT data type
where possible for maximum efficiency.

Use MSG status flags, such as the. DN and .ER bits for handling
fault conditions.

Data arrives asynchronous to program scan (use a programmatic
handshake or insert between a UID/UIE instruction pair for higher
priority)

Use the unconnected option for CIP Generic messages

PlantPAx systems use specialized field devices that operate on various
communication protocols, such as HART, EtherNet/IP™, PROFIBUS PA, and
Foundation Fieldbus.

Depending on the controller type and process library version, you need
different elements to integrate a field device. These elements use Logix
Designer for device control to the corresponding object in FactoryTalk View SE
for HMI faceplates.

Most field device integrations require that you instantiate one Add-On module
Profile (AOP) and two Add-On Instructions (AOI) per device for end-to-end
control and monitoring.
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« Module or Device specific AOP for Logix Designer software to create the
item or device tags in the I/O Configuration list.

« Device specific AOI to access device tags and prepare the data for use
within the controller project.

« Generic AOI to access device data, along with custom-made device
diagnostics and unit tables, to enable visibility on an HMI faceplate
within the PlantPAx system.

Rockwell Automation Publication PROCES-UM100C-EN-P - June 2022 147



Chapter 5 Process Applications

HART Integration

Highly integrated HART provides a PlantPAx data type in the process

controller for use with FLEX 5000 modules:

« Configuration of devices within the I/O Configuration tree (no Add-On
Instruction needed)

« Device diagnostics automatically propagate to the controller project

Figure 15 - PlantPAx 5.0 Library and FLEX 5000™ Highly Integrated HART 1/0 Modules

1 2

3

| Native Process Objects (Library 5.0)

Add-On Profile (AOP)

PAl (Process Analog Input),
PAD (Process Analog Output)

10 HART Module ‘
(5094-1F8IH, 5094-0F8IH, PAH (Process Analog HART)
5094-IF8IHXT, 5094-0F8IHXT)

* Detailed diagnostic tables

available for Endress+Hauser devices

4 5

:: ola E 4: ..w::r
o

8292 ? : ;]

Global Object Faceplate

Element Description

The HART I/0 module is added to the I/0 Configuration. If necessary, import the Add-On Profile for the

1 module being used. Then the HART device is added to the 1/0 Configuration on the "HART" network
under the module.

2 Use the PAH instruction to process HART data, from the module input assembly.

3 Use the PAl instruction to process the analog input, from the module input assembly.

4 Use the HMI global object for the analog input on HMI displays.

5 Clicking the global object calls up the PAI faceplate, which has navigation to the PAH faceplate for HART

data.

Figure 16 - PlantPAx 5.0 Library and 1756, 1794, 1718, 1719, 1734, 1769 or 1715 HART I/0 Modules

1 2
Library 4.1 HART I/0 Module Nat

3 4
ive Process Objects (Library 5.0) [ |

(I-17561F8IH, ...)

LyvseFien

I Add-On_Instruction (AOI)
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raP_Tec_HARTCharDatn_to_PAH
Fil2_502 HARTChanData to Pak

[Z]] Ref_DiagTable

PAI {Process Analog Input)

PAl (Process Analog Input),
PAQ (Process Analog Qutput)

Analog HART)

Add-On Profile (AOP)g - 4p Tec_HARTChanDatato_PAH | ~
10 Module Add-on Instruction (AOI) PAH (Beocess
(1756-x, 1794-x...)
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Element Description

1 The HART I/0 module is added to the I/0 Configuration. If necessary, import the Add-On Profile
for the module being used.

Use a PlantPAx Library 4.1 HART module Add-On Instruction to retrieve HART data from the

9 module. Then use the raP_Tec_HARTChanData_to_PAH Add-On Instruction from PlantPAx
Library 5.0 to take the HART data from the HARTChanData (Library 4.1) structure into the new

structure used by the Library 5.0 PAH instruction.

3 Use the PAH instruction to process HART data associated with the analog input

4 Use the PAl instruction to process the analog input.

5 Use the HMI global object for the analog input on HMI displays.

6 Clicking the glabal object calls up the PAI faceplate, which has navigation to the PAH faceplate
for HART data.

Figure 17 - PlantPAx Library 4.1 and 1756, 1794, 1718, 1719, 1734, 1769 or 1715 HART I/0 Module
1 2 3 4 5

== = O ——
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s *[z7_Ref_DagTatle ] i L
Add-On_Instruction (AQI) - -
Add-On Profile (AOP) 10 HART Module Add-On_Instruction (A0I) Global Object Faceplate
10 Module (11756, 1_179%4...) For Faceplates
(1756-x, 1794-x...) P_AINHART
P_AQutHART * Detailed diagnostic tables available for Endress+Hauser devices

Element Description

1 The HART 1/0 module is added to the I/0 Configuration. If necessary, import the Add-On Profile
for the module being used.

9 Use a PlantPAx Library 4.1 HART module Add-On Instruction to retrieve HART data from all the
channels on the module.

3 Use the PlantPAx Library 4.1 P_AInHART Add-On Instruction to process the analog input and
HART data for one channel.

4 Use the HMI glabal object for the analog input on HMI displays.

5 Clicking the glabal object calls up the P_AInHART faceplate, which displays the analog and
HART data.

Rockwell Automation Publication PROCES-UM100C-EN-P - June 2022 149



Chapter 5 Process Applications
Ethernet/IP Integration via Custom Add-On Profile
Figure 18 - PlantPAx Library 4.1 or 5.0 and EtherNet/IP device with Custom AOP (For
Example, Endress+Hauser)
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EtherNet/IP Device Add-On_Instruction (AQI) Global Object Faceplate

EtherNet/IP Device
(Promag, Liquiline ...)

Ethern'et/IP

I EDS Add-On Profile (AGP)

150

(I_Promag, |_Promassx .. For Faceplates |_EH_Flowmeter - Faceplate
|_EH_Flowmeter I_EH_Sensor - Faceplate
I_EH_Sensor * Detailed diagnostic tables available for Endress+Hauser devices
Element | Description

1 Endress+Hauser EtherNet/IP device is added to the I/0 Configuration tree
Add-on Profile for device creation and configuration, such as ProMag or Liquiline

9 Add-on Instruction accesses device tags, such as |_Promagx or |_Promassx for use with
application logic / control strategies

3 Add-on Instruction for diagnostics and control to the HMI global abject

4 Process library HMI global object supports faceplates

5 Process library |_EH_FlowMeter and |_EH_Sensor faceplates

Ethernet/IP Integration via Electronic Data Sheet Add-On Profile

Figure 19 - PlantPAx Library 5.0 and EtherNet/IP device with EDS AOP
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| EDS Add-On Profile (AQP)

Chapter 5 Process Applications
Element | Description

EtherNet/IP device is added to the 1/0 Configuration tree
1 Add-on Profile, created via Electronic Data Sheet (EDS) file, for device creation and

configuration
2 PlantPAx instructions for application logic/control strategies/alarms
3 Process library HMI global object supports faceplates
A Process library PAI faceplate

Figure 20 - PlantPAx System Release 4.6 and EtherNet/IP device with EDS AOP
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Element Description

EtherNet/IP device is added to the I/0 Configuration tree
1 Add-on Profile, created via Electronic Data Sheet (EDS) file, for device creation and
configuration

2 Add-on Profile for HMI faceplates, such as P_Aln and P_AQut

3 Process library HMI global object supports faceplates

A Process library P_Aln and P_AQut faceplates

PROFIBUS PA Integration (1788-EN2PAR Linking Device)

Figure 21 - PlantPAx Library 4.1 or 5.0 and 1788-EN2PAR Linking Device
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Chapter 5 Process Applications

Element | Description

—_

Device is nat added to the I/0 Configuration tree
Add-on Profile for 1788 linking device
PROFIBUS PA netwark configuration

Add-on Instruction for HMI Faceplates, such as P_AInPAR

Pracess library HMI global object supports faceplates

o g B~ NN

Process library P_AInPAR faceplate

Foundation Fieldbus Integration (1788-ENFFR Linking Device)

Figure 22 - PlantPAx Library 4.1 or 5.0 and 1788-ENFR Linking Device

F (= =

Element | Description

—_

Device is not added to the I/0 Configuration tree
Add-on Profile for 1788 linking device

Foundation Fieldbus network configuration

Add-on Instruction for HMI Faceplates, such as P_AInFFR

Process library HMI global object supports faceplates

D | g B NN

Process library P_AInFFR faceplate

Electrical Protection Devices Integration (IEC 61850)

See Rockwell Automation Library of Electrical Protection Devices, publication
PROCES-RMoi1 for more information about integrating electrical protection
devices (IEC 61850).

Alarm Types Alarms are a critical function of a distributed control system. Alarms monitor
conditions that need response, such as a temperature or pressure signal out of
range, or device failures such as drives and motors.

The FactoryTalk Alarms and Events server provides a common, consistent view
of alarms and events throughout a PlantPAx system. Language-switching
alarm messages are also available. When an alarm condition is received, the
FTAE server publishes the information to a subscribing Operator workstation
via FactoryTalk Alarm and Event services.

« For information on how to configure the FTAE server on a PASS, see
Chapter 3, Process Automation System Server.
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« For information on how to configure and monitor FTAE alarm
components, see the FactoryTalk Alarms and Events System
Configuration Guide, publication FTAE-RMoo1.

The Alarm Banner resides on the Header display.

1A0M995 45650 P

July 13, 2020 111041955 4:56:50 PM
51416 PM L\ BiB2020 24327 PM
4 .

Eim_HiHi EME, Testbed FT222 HiHi
Alm_HiHi LBSER Testhed FT555 HiHi Q y
Alm_Hi EMEA, Testhed FT222 Hi <

An effective alarm system directs the attention of an operator to improve the
productivity, safety, and environment of a process plant.
« A PlantPAx system can use device-level and server-level alarm methods.

« Recommendations are based on the controller type and supported
functionality.

Table 8 - Alarm Types Based on Instructions and Add-0n Instructions

If You Have

You Have This Alarm Type | Description

PlantPAx 5.0 library

Logix Tag-based

Device level, tag-based alarms monitor a tag value to determine the alarm condition. Tag-based alarms
aren't part of the logic program and do not increase the scan time for a project. The controller caches
information, such as timestamps, alarm states, and associated tag values in a 1000 KB buffer. The
controller transmits the information to subscribing FactoryTalk® Alarms and Event servers.
Recommended: PlantPAx system release 5.0 or later.

Requires: ControlLogix 5580 controller, CompactLogix 5380 controller.

PlantPAx 4.1 library or earlier

A FactoryTalk Alarm and Event server monitors controllers for alarm conditions through data servers and
publishes event information that can be displayed and logged.

Server Tag-based Recommended: PlantPAx system release 4.6 and earlier.

Server-based alarm monitoring offers the equivalent of HMI tag alarm monitoring, but with an expanded
feature set of the FactoryTalk Alarm and Event server.

ALMA or ALMD controller instructions

Logix Instruction-based

These device-level alarm instructions can consume a larger portion of controller memory and increase

scan time when executed. When an alarm is detected, it's time stamped and buffered until it's transmitted

to subscribing FactoryTalk Alarms and Events servers.

Not Recommended in large deployments due to added controller overhead.

Requires: ControlLogix 5570, CompactLogix 5370, ControlLogix 5580, CompactLogix 5380 controller.

Device level, Logix instruction-based alarms are programmed within the controller program and

integrated to the FactoryTalk Alarm and Event server.

« The Digital Alarm (ALMD) instruction detects alarms that are based on Boolean (true/false) conditions.

« The Analog Alarm (ALMA) instruction detects alarms that are based on the level or rate of change of
analog values.

Guidelines for Logix Tag-based Alarms

In a PlantPAx 5.0 or later system, we recommend no more than 7500 in-use
Logix tag-based alarms per controller.

Create Logix tag-based alarms to send alerts about specific events or
conditions. A tag-based alarm is similar to a digital alarm because both
monitor a tag value to determine an alarm condition. However, a tag-based
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Controller Organizer

alarm isn’t part of the logic program and does not increase the scan time for a

project.

v 3 X IJ’J.Alarms-. RA_LIB_ProcessStrategies

~ I

al "= State Use  Owner MName Type Input Expression Limit Message
D 1l Controller RA_LIB_ProcessStrategies, KT540 Alm_Hi TRIP XT540.5ts_Hi =1 /7540 %.@Descriptic
b 5 Tasks XT540 Alm_Lo TRIP XT540.5ts Lo =1 /*5:0 %.@Descriptic
b 7 Motion Groups XT540 Alm_HiHi | TRIP XT540.5ts_HiHi =1 /*5:0 % @Descriptic
4 | Alarm Manager = XT100 Alm_HiHi | TRIP XT100.5ts_HiHi =1 /*5:0 %.@Descriptic

I\ Alarms a

(TS0 TR XT5405ts_LoLo =4 /°5:0 %.@Descripti
b Assets n, Unacknowledged Alm_LoDev [TRIP XT540.5ts_LoDev =5 /*5:0 %.@Descriptic
H. Logical Model XT540 Alm_Fail | TRIP XT540.5ts_Fail =5 /7510 %.@Descriptic
P i /O Configuration XT540 Alm_HiRoC |TRIP XT540.5ts_HiRoC =1 /*5:0 %.@Descriptic
XT540 Alm_HiDev |TRIP XT540.5tc_HiDev =1 /75:0 %.@Descriptic
1 [wtioo Alm_HiHi | TRIP WT100.5ts_HiHi =1 /7510 %6 @Descriptic
1 [wrioo Alm_Hi TRIP WT100.5ts_Hi =1 /75:0 %.@Descriptic

Tag-based alarms do not require an FTAE server. A controller's subscription to
the HMI can be serviced using a FactoryTalk® Linx data server. See Add a Data
Server (FactoryTalk Linx) on page 67 to confirm that FactoryTalk Linx is
configured for Logix Tag-based alarms. PlantPAx recommends a limit of
15,000 Logix Tag-based alarms per instance of FactoryTalk Linx. A PASS can
host up to two instances of FactoryTalk Linx for a total of 30,000 Logix Tag-
based alarms per PASS.

An alarm definition is associated with an Add-On Instruction (AOI) or a
defined data type. When a tag is created using a data type or an AOI that has
alarm definitions, alarms are created automatically based on the alarm
definitions.
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Embedded Tag-based Alarms in PlantPAx Instructions

The PlantPAx instructions have embedded tag-based alarms. Configure the
states as needed and simply enable the alarms that you want to use.

Use the Alarms tab on the instruction properties to assign settings to all pre-
defined alarms. There’s an option to propagate specified Class/Group settings to all
alarms in the instruction.

& PDIProperties - Storage P_DInD1* N = S
Genersl Use Alarm .
=
= Target disagree D

Alarms™

Parameters Settings for all alarms

Tag Apply following settings to all alarms

Class:

[ |

Alarm group:

[Area0t |

FactoryTalk View command:

Allow operator to shelve alarm

Allow maintenance to disable alarm

Device state: PV good

Device issues: None |‘ oK ‘” Cancel || Aply H help

Alarm settings are also accessible via the Alarm Manager.

Controller Organizer + & X  flips paj-x7100 [PARENETNES B . pjarm Definitions:
4 .| Alarm Manager A Show: | All
.Q.Alarms State Use Owner MName Type Input Expression Limit Message
L1 Alarm Definiti
2 eta"” e = XT100 Alm_HiHi | TRIP XT100.5ts_HiHi =1 /*5:0 %.@Description
SSELS
w XT100 Alm_Hi TRIP XT100.5ts_Hi =1 /*5:0 %.@Description

Guidelines for Server Tag-based Alarms (FactoryTalk Alarms
and Events)

An FTAE server is required for server tag-based alarms. The server puts these
alarm tags on scan, just as it does all other tags it polls for the HMI and
Historian. In a PlantPAx 5.0 or later system, we recommend you limit the
number of server tag-based alarms to 20,000 per FTAE Server. A PASS can host
a single instance of the FTAE server for Server tag-based alarms. There are no
hard-coded limitations, however you could experience longer recovery time
during system restoration if you exceed the recommendation.

Use the PlantPAx System Estimator (PSE) for sizing the number of alarm
instructions for a more accurate limit that is based on your specific
configuration. Be sure to add for additional memory that is required to
maintain the alarm subscription as it isn’t accounted for in the PSE memory
calculations.
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Use alarm groups to organize alarms by operator role.

Use alarm expressions against user groups to provide rolled up
indication of alarms by role or display. For example,
AE_InAlmUnackCount('T1*') returns a count of unacknowledged alarms
within groups that start with T1.

For more information on alarm expressions, see the FactoryTalk View
Site Edition User's Guide, publication VIEWSE-UMOo06.

Use an alarm class to identify alarms that share common management
requirements (for example, testing, training, monitoring, and audit
requirements). Do not use alarm class to identify alarms by operator role
or display because you can’t retrieve an alarm count by class by using

alarm expressions in FactoryTalk® View software. However, you can
filter by class on the alarm displays.

« Use the alarm builder feature in the PlantPAx Configuration Tool to help

build server tag-based alarms.

Guidelines for Logix Instruction-based Alarms

The process library does not provide support for Logix instruction-based
alarms. Note that the instruction-based alarms can impact controller
performance.

Controller scan time and memory usage are variable with the use of the ALMA
or ALMD instructions, depending on the states of the controller. Large alarm

bursts can have a significant impact on controller CPU utilization. For
example: Controller memory used for buffering by each subscriber (topic in
the data server) =100 KB.

Example execution times:

- ALMD in a 1756-L73 controller with no alarm state changes: 7 us
- ALMD in a 1756-L73 controller with alarm state changes: 16 s

In redundant controller configurations, cross loading of redundancy can add

up to 70 ps per ALMD instruction.

Reserve the use of ALMA and ALMD instructions for the most critical alarms.

Although there are no hard-coded limitations, we recommend limiting the
number of instructions to the following:

- 250 per redundant controller
- 2000 per simplex controller
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Create HMI Displays

Monitor Alarms

You can use the alarm status explorer in FactoryTalk View SE to browse all of
your configured alarms on a server or the entire system. Alarms also are
filtered by the Shelved, Suppressed, and Disabled options. The alarm explorer
can be preconfigured as a Shelved alarm display to let operators view a list of
alarms.

ISA 18.2 provides alarm performance metrics and example target values. Some
key metrics include the following:
« Alarm rates: annunciated alarms per operator:
- <150..300 alarms per day
- Average of 6...12 per hour
- Average 1...2 per 10 minutes

« Contribution of the top 10 most frequent alarms to the overall alarm load:
~<1...5% maximum, with action plans to address deficiencies

« Number of alarms that remain in effect continuously for more than
24 hours (stale alarms): Less than 5, with plans to address

You can use FactoryTalk® VantagePoint® software to generate reports based
on these metrics:
« Hourly Alarms Report (active count of alarms over 1- hour samples)

« Alarm Distribution Report (percentage contribution of top 10 most
frequent alarms)

« Alarm Frequency Report (top 10 most frequent alarms)
- Standing Alarms Report (top 10 currently active alarms by duration)
« Alarm Duration Report (top 10 alarms by duration)

For more information, see Knowledgebase Technote FactoryTalk VantagePoint
Reporting for FactoryTalk Alarms and Events.

The Process Automation System Server (PASS) is a required system element for
the PlantPAx system. The PASS hosts the HMI server, which stores the HMI
project components, such as graphic displays, and provides these components
to an Operator Workstations (OWS) client upon request.

For more information on how to configure these servers, see Chapter 3,
Process Automation System Server.

Follow these guidelines:

« Use FactoryTalk® View Studio software on the EWS to access the
application.

« Configure the FactoryTalk View SE servers to start automatically on
startup on the PASS. Let the servers fully start up before starting the
client computers.

« Do not use more displays than your license allows. If you exceed the
license, displays can fail when requested.

« FactoryTalk View SE displays contain expressions for each customized
animation that holds simple or complex calculations to accomplish the
animations. Each expression consumes memory and requires processing
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time to execute. Too many expressions can make the screen animate
sluggishly and affect system performance.

Use global objects to display the status of a control module or device
when the information to be displayed is stored in a tag structure within
Logix (for example, UDT or Add-On Instruction) and there are many
identical instances. A global object is a display element that is created
once and can be referenced multiple times on multiple displays in an
application. When changes are made to the original (base) object, the
instantiated copies (reference objects) are automatically updated.

- Base global objects are stored in FactoryTalk View in displays (.ggfx
files). If you have a large number of base global objects defined, do not
put them all in a single display. Limit the number of global object
instances on a single display to 60 or less.

- As global objects can be instantiated multiple times, the performance
impact of their design is amplified by their number of instances.
Therefore, design global objects carefully to reduce the number of
oEjects, expressions, and animations that are used within the base
object.

Use ‘Replace’ display types. This display type closes the currently
displayed screen when a new screen opens. ‘Overlay’ display types must
be managed because multiple screens open at once consumes memory
and CPU resources.

Only use Cache After Displaying and Always Updating for displays
frequently accessed by the operator and not applied generally. Used
sparingly on these displays, these settings improve display call-up time
for important displays. When displays are cached and always updating,
the additional memory load of this display on the view client is persistent
after call-up regardless of whether the display remains visible. This
action affects system load and can affect system performance.

We do not recommend the use of data logs. If necessary, use data logs for
short-term data retention only.

Do not create derived tags that depend on the results of other derived
tags. Derived tag processing is not sequential.

Avoid use of VBA when possible. VBA runs as a single-threaded process
so it’s possible the application that is written in VB does not allow the
HMI to perform predictably.

Use FactoryTalk View Studio software to create or import any system specific
graphic displays that your PlantPAx system requires.

For PlantPAx common graphics, you can use ACM-generated displays or
graphic framework displays (from the process library).
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Graphic Framework Displays

The process library download contains the following files to use as a starting
point to utilize the PlantPAx Graphic Framework:

« FTVSE_12_o_Template_{version}.APB

« FTVSE_13_o_Template_{version}.APB

Restore the provided Local Station project templates (.LAPA) by using
the FactoryTalk View SE Application Manager.

« FTVSE_12_o_Template_{version}.zip
« FTVSE_13_o_Template_{version}.zip

Create your own project and import the HMI server or individual files
as needed.

For more information on how to develop displays, see the Rockwell

Automation Library of Process Objects Reference Manual, publication
PROCES-RM200.

ACM Generated Displays

IMPORTANT  The process library uses Global Objects. They must be imported into
the FactoryTalk View SE application before the displays.

ACM generated displays can be imported into your HMI application by using
FactoryTalk View Studio software.

1. In FactoryTalk View SE Studio, import the ACM generated graphics
(.XML).

.21 FactoryTalk Wiew Studio - View Site Edition (Network Distributed)
File View Settings Tools Window Help

imAe he ks 0P #nE
Explorer - HMI Server *+ 0 X

2§ PlantPAx HMI ~
w-. Runtime Security
D' Scripts
i DATA
B FTAE
B iE HMI
E B HMI Server
E| System
. LB Command Line
HMI Tags

LI I ) =

& Tags
4 Graphics
[Ezle 3] Displays,
=[] Global C New
-l Symbel Add Component into Application...
[ Libraries N Fakl
- F Images
. [#] Paramet R
- Legacy | Remove
4= Local M Import and Export...
A Trend Temnlates
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2. Use the Graphics Import Export Wizard to import either a single global
object or batch of multiple global objects from an .XML file.

Page

Selection

Select the operation to perform

Import graphic information into displays

Do you want to backup the displays that will be modified by the import? | No

Select the type of file to import

Multiple displays batch import file

Select the multiple display batch import file

Browse to your batch import file (Example: My_PlantPAx_Project_FTViewSE_Server_Batchimport.xml)

When importing

Create new objects on the display

160

3. Verify that the displays were created successfully.

Explorer - HMI Server » 0 X
B E HMI ~
S fE HMI Server
E System
{.EJ Command Line
2 HMI Tags
L& Tags
E Graphics

-[B RA_APP_Display
[ Global Objects

PlantPAx Configuration Tool Displays

Organize the FactoryTalk View SE HMI displays under process tree folders.

1. Goto Logix Controllers > Open FactoryTalk View SE Displays List... and
select the Process Tree tab.

2. Dragadisplay file from the SE display files window and drop it into the
Process Tree folder.

$- 3 Areal i
=3 Mosquito o' FactoryTalk View SE Display Files

= Pipeline — :
= Valves = jos_MainLine
| B Mos_MainLinel_test

# [ HandOperatedvahes
¥ £3 MotorOperatedValves B Mos_MainLine2
&3 Pumps B Mos_PigSequence-Faceplate

+ &% Logix Code B Mos_PowerMonitor
563 B Mos_Simulation
43 Levell B Mos_StartConfirm

B Mos_Station

B Mos_StationinterlocksPermissive
B Mos_Sump

= Mos_UPS

& PO Admin

B PO Alarm-Summary

Bt PO Home
Controllers & HMI| Process Tree « m

Optimize Runtime Performance

PlantPAx guidelines recommend using global objects to display the status of a
control module or device when there are multiple, identical instances. Global
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objects offer consistency; and changes to a global object propagate to all the
affected displays.

FactoryTalk View Studio has an Enable Global Object Runtime Optimization
feature that improves runtime performance.

1. After you modify graphics that contain global objects, select Global
Object Compilation Required

21 FactoryTalk View Studio - View Site Edition [Network Distributed)

File Edit View Settings Objects Arrange Animation Tools Window Help

EHe b= 0L MOERrs X IaaE R AEER Q]
Explorer - HMI5erver0l
Bfe PlantPAxDCS
.m0 Runtime Security

- LT Scripts

B FTAEArea

E| E HMIServerirea

=@ HMIServer01

System

EJ Command Line
HMI Tans

1"{, Global Object Compilation Required
Global Object Compilation Required

2. Select Compile Global Objects to optimize the changes for the runtime
system.

x
Options
General Glabal Object

The rurtime peformance of applications that leverage a large quantity of global
objects can be impacted. By enabling this feature. the runtime performance can be
optimized for the FactoryTalk View Site Edition Client.

Enable Global Object Rurtime Optimization

| Compile Global Objects |

i_"f, Global Object Compilation Reguried. There are pending changes in the
system that require optimization for runtime

After modifying graphic display’s containing Global Objects, click the
! Compile Global Objects button to optimize these changes forthe runtime
system.

The first time that you compile global objects, the process can take an extended
amount of time, depending on the number of displays in the application.

Subsequent compiles require less time as they only process changes to
displays.
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Optimize HMI Redundancy

For HMI redundancy, change these settings to optimize the fail over speed to
achieve proper visibility on the HMI clients.

1. InFactoryTalk View Studio, go to System > Policies > System Policies and
select Health Monitoring Policy.

_—_. Iystem
Action Groups
= Policies
Product Palicies

Systern Policies
-0 FactoryTalk &larms and Events
Badge Authorization
Spplication Authorization
User Rights &ssignment
Live Data Policy
Health Monitaring Palicy
Sudit Policy
Security Policy

2. Change the following settings:
- Network failure detection interval: From 2 seconds to 1
- Maximum network glitch: From 5 seconds to 1 second

Health Monitaring Palicy Properties X

Policy Settings

25 41 |
v Rates
Computer detection interyal 2 seconds
MNetwork. failure detection interval 1 second
I aximum network glitch 1 second ~
M awimum delay before server is active 2 minutes

M aximum network glich

Sets the maximum duration of a network. disruption before the health monitoring
service determines that communications have Failed

Cancel Apply Help
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Asset Management

FactoryTalk® AssetCentre software is a centralized tool that helps:
« Maintain inventory assets in the system
« Manage version control to track program changes
« Collect audit logs to track user and system activity
« Schedule backups and verify program integrity

This is the recommended workflow to configure and implement a FactoryTalk

AssetCentre application. For experienced users, each step outlines
requirements. For more detailed information, follow the referenced links.

A

Step 1: Inventory Plant Assets

FactoryTalk AssetCentre software provides a centralized tool to manage and
track asset information as well as protect assets. You can:

« Scan the network for existing devices to create an inventory.
« Manually add individual assets.

Regardless of method, we recommend that you add asset types for controller
project, HMI, engineering workstation, and servers.

For more information, see Inventory Plant Assets.
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O
Step 2: Configure Audit Logs

o

There are multiple logs that can be generated to capture asset data. Select the
one that you want:

« Audit Log monitors FactoryTalk-enabled software products and logs user
actions. For example, who was the last user to change a program.

« Diagnostic Log to monitor system health.

- Event Log to track FactoryTalk AssetCentre events, such as when a
backup starts and who generates a report.

Audit data is stored in the SQL server and displayed in the FactoryTalk
AssetCentre logs. Information that is collected includes:

« Useractions
« Program changes
- Security events

For more information, see Configure Audit Logs.

Step 3: Schedule System Backups

FactoryTalk AssetCentre software stores backup data on an SQL server.

The Disaster Recovery function creates backup files from the running asset on
the plant floor. The backup file is compared to the original and archived to a
Master version. The Agent service performs these comparisons and can be
scheduled to operate at specific times and intervals

For more information, see Schedule System Backups.
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Example Asset Data Flow

Safe, IT-Managed Location

Backup

Data
Backup

Alarm and Event
FactoryTalk AssetCentre
Data

- Asset Framework Configuration

Asset Framework Events

Data Backup

. )

FactoryTalk Historian Additional
Server Server

Prerequisites

Application
Servers

Asset Backups
AppServ-Info (SOL)
- AppServ-Asset =i
E}
= K =
E = 3
(aa] (- o
PASS FactoryTalk 2 ‘;3 FactoryTalk
Directory I baab Batch

Following the System Workflow, configure application servers.

An asset management server (AppServ-Asset) supports maintenance and plant
operations to the system with FactoryTalk AssetCentre software.

In most PlantPAx® systems, the AppServ-Asset server is on a separate
computer and requires these components local or distributed on remote

servers:
« FactoryTalk® Directory
« FactoryTalk® Activation server
FactoryTalk® SQL server (can be on the same computer as the AppServ-
Asset server or on 1ts own computer)

Install FactoryTalk AssetCentre Client software on the FactoryTalk
AssetCentre server, the EWS, and the OWS.

If you plan to use the FactoryTalk AssetCentre virtual images, see
configuration procedures in 9528-UMoO1.

For more information, see these additional resources.

Resource

Description

FactoryTalk AssetCentre Installation Guide, publication FTAC-INOG5.

How to install the FactoryTalk AssetCentre system.

FactoryTalk AssetCentre Getting Results Guide publication FTAC-GR002

How to get started with the FactoryTalk AssetCentre system.

FactoryTalk AssetCentre Utilities User Manual, publication FTAC-UMOO1

How to use FactoryTalk AssetCentre utilities.
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FactoryTalk AssetCentre

Inventory Plant Assets
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For Rockwell Automation tutorials, see these YouTube videos.

« Introduction to Asset Management

« Using the Inventory Agent in FactoryTalk AssetCentre

« Getting Started with FactoryTalk AssetCentre

« Introduction to FactoryTalk AssetCentre Disaster Recovery

« FactoryTalk AssetCentre Disaster Recovery to Backup and Compare a
FactoryTalk View SE Application

FactoryTalk AssetCentre provides a centralized tool to manage and track asset
information and protect assets.

To help protect your automated control system, we recommend that you
develop a strategy for archiving application data and determine recovery
plans. For a tutorial, see the YouTube video ‘Introduction to Asset
Management'.

If you plan to configure the FactoryTalk AssetCentre virtual image, see the
procedures in the Template User Manual, publication 9528-UMooi1.

An asset inventory lists the connected devices and computers on the network
and stores unique identification information about the hardware, firmware,
and software in the system.

There are multiple ways to build your inventory list of assets with FactoryTalk
AssetCentre software tools.

Scan the System for Assets

Drag-and-drop an Asset Inventory asset type into the FactoryTalk AssetCentre
tree and scan for device information.

For a tutorial, see the YouTube video ‘Using the Inventory Agent in FactoryTalk
AssetCentre’.
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1. Inthe FactoryTalk AssetCentre window in Design mode, move the Asset
Inventory item into your asset tree.

Asset View (Design) ax

P Add To Assets

Catalog ~
=} Device ltems
 apoo

Asset Inventory

I SR i v o
¥ FacioryTalk Directory
] FANUC Robot (Use Generic

2. Open the Asset Inventory Properties and select Scanning Configuration
to define how to scan the system.

peneric FT | =

Dialog Box

Action

Scanning Configuration

Select a type of scan from the following options:

Scan devices using CIP™: Common Industrial Protocol (CIP) scanning browses the network by using FactoryTalk® Linx drivers to return
Rockwell Automation® Asset Management Program™.

Scan devices using SNMP: Simple Network Management Protocol (SNMP) scanning browses the network for SNMP-enabled devices
with a specified IP address range or IP subnet. If a device responds, the FactoryTalk AssetCentre service requests available SNMP
information.

Scan software using WMI: Windows® Management Instrumentation (WMI) scanning browses the network within the specified IP
address range or IP subnet, and returns software installed on a Windows host.

When you've selected a scan type, select Advanced Settings.
IMPORTANT: Leave the default Unlimited scanning box checked to scan the entire network.

Advanced Settings

Select Community String.

Scanning Configuration -
Scan devices using CIP
Start scanning with this device: |EWSGT | I:l
Maximum scanning depth: 1 & Unlimited scanning

Scan devices using SNMP

Scan within: (®) |P address range O IP subnet
Start |P address: 172 . 18 . 0 5 1
End IP address: 172 18 0 100
Maximum number of hops: 1 L Unlimited hops

Scan software using WMI

Scan type: ® Changes only O Full scan

Scan within: @) |P address range O IP subnet
Start |P address: 172 . 18 . 1 . 1

End IP address: 72 . 18 . 1 . 254
Maximum number of hops: 1 5 Unlimited hops

Login: |SYSTEM'Mm\nistm1Dr |

Password:

3. Select a device.
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The device must have communication paths to any devices that you want to
return when the Inventory Agent runs.
4. Select Schedules and create a schedule for the Asset Inventory item.
When the schedule runs, an inventory list is generated.
Q FactoryTalk AssetCentre [-T=0

Asset View (Design)

BT p
& Design [ | 38| | B 44

Eile Edit Mjew Tasks Tools Windows Help

FES DO XS Ases

QF AgentGroups () Archive 4 Assetslifecycle R Calibration @ DTM View &F Logg () Schedules |3 Searches | [# @

AssetCentre > PlantPAx Inventory

L, AssetCentre
§ excnm

@ New.. 8 | | B RunNow [

() Al Schedules (@ Filter by Schedules which include 'PlantPAx Inventory'

Completion &

|— P inventory Schedule AsseiCentre/PlantPAx  Backup Disabled

@ Add To Assets

An inventory has a list of devices and a list of software.

asl

Asset Inventory == -

}:’ﬁearch @Qolumns # Undo & Checkln %Expor‘t [& Add €3 Update eﬂelp

Start Time:  1/26/2018 2:49:08 PM
End Time:  1/26/2018 4:56:47 PM
Result: Succeed

I Devices Eoﬂware

SNMP_172.] gz
SNMP_172.

Asset Inventory NE |

1 SNMP_172.

168

SNMP_1721 | M Search | [¥] Columns

Devices : Software |

® add O Update Collzpse Al
Device Name Device... Product..  Product.. Preduct. Revi. Vendo. Commissio. Additional .. Additional .. Additional ..

=) 0 017262018

L] SNMP_17218.01 1721801 0 017262012

[]  SNMP_172.120.10 17218010 0 017262018

] SNMP_172.12020 17218020 0 017262012

] SNMP_172.12.021 17218021 0 017262012

] SNMP_172.12022 17218022 0 017262012

] SNMP_17218022 17218022 0 017262012

] SNMP_172.120.30 17218030 0 017262012

[l  SNMP_172.12.0.31 17218031 0O 01/26/2018

]

]

]

i

Start Time:  1/26/2018 2:45:08 PM
End Time:  1/26/2018 4:56:47 PM
i l Result: Succeed

A Undo & ChecklIn ngpor‘t [& Add # Update & Help

Name

PADCA System.PlantPfx local
PADCB.System.PlantPfx local
PASS01.System. PlantPAx local
PASS024 System. PlantPAx local
PASS02B.System. PlantPAx local
ASNMO3.System. PlantPAx local
ASCG03.System. PlantPAx local
EwS01.System.PlantPAx. local
ASIHO1A.System. PlantPAx.local
ASIHO1B.System. PlantPAx. local
ASIS01.System. PlantPAx local
ASND1.System. PlantPAx local
asaml1.System. PlantPAux local
ASIHOZ System.PlantPAoc local
ACPO01.System. PlantPAx local
ASCG01.System. PlantPAx local
ASCG02.System. PlantPAx. local

Install Date Vendor Version
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Manually Add Individual

Assets

You can manually add assets.

For a tutorial, see the YouTube video ‘Getting Started with FactoryTalk®
AssetCentre’.

1.

While in Design mode, drag-and-drop the asset into your

FactoryTalk AssetCentre project.

9

File Edit View Tasks Tools Windows Help
@ Agent Group

PHS B E XS s

2|7

P Add Legix5000 Controller
- Catalog ~
- Device ltems
;7] ABB Robot (Use Gfneric
W Custom Device
7] FANUC Robot (Uge Gene |~
General DTM ce
Generic Device

" [Coaix5000 Controller

"7 Motoman Robot

An FactoryTalk AssetCentre dialog box appears for the asset that you

are adding.

2. Select the asset to configure details.

Add a Logix5000 Controller to AssetCentre

For example, add an .ACD file for a controller.

(Parent)
Description

4 2 Hardware Information

AssetCentre

Name Logix5000 Cortroller

Addressing Info
Catalog Information
Change Detect Capable
No fie selef
Device Name
Firmware Revisicn
Hardware Revision
Hardware Type
Manufacturer
3.Asset Information
Agent Group

Asset Number
Location

Serial Number

Roclowel A

[N

System D

Configuration Data
Configuration data for the device

Configuration Data Browser: Logix5000 Controller | = |9

----- W, AsseiCentre

A [ Logib000 Controller

& TT01001

Configuration Data Browser: Logix5000 Controller

BE |

W, AssetCentre
~§ Logix5000 Controller
=gy TT01001

Filter: |RSLogix §

i

3.

Filter: [RSLogix 5000 fles (" acd) v]

Lok J[ Gorcol [ oo |

For a controller, select a path to the controller by using the Addressing
Info Browser (‘...” ellipsis) button.
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Configure Audit Logs
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4. Name the asset.

We recommend that you use the steps to add each of these asset types

from the catalog to your inventory:

« Controller project

« HMI

« Engineering workstation
« Servers

There are multiple logs that can be generated to capture asset data.

« Audit Log monitors FactoryTalk-enabled software products and logs user

actions. For example, who was the last user to change a program.
« Diagnostic Log to monitor system health.

- Event Log to track FactoryTalk AssetCentre events, such as when a

backup starts and who generates a report.

Security Audit Logs

Microsoft Windows® OS captures security audit records locally for every
PlantPAx server and workstation. We recommend that you make sure the log
is sized adequately to capture sufficient records to satisfy your retention
policy. In Windows Event Viewer adjust the configuration of the security log

according to your system requirements.

& Event Viewer
File Action View Help
w= == B
{2 Event Viewer (Local) Log Properties - Security (Type: Administrative) =7
4 | Custom Views
b [ Server Roles General
“F Administrative Events
Full Name: Security
Log path: FeSystemRoot e\ System 32\ Winevt\Logs\ Security.evix
;_—| Systemn Log size: 128.00 MB(134,221,824 bytes)
B Forwarded Events Created Thursday, February 4, 2016 4:10:13 PM
I [) Applications and Services Lo L i A o
=1 Subscriptions Modified: Thursday, June 7, 2018 &:53:02 AM
Accessed: Thursday, February 4, 2016 4:10:13 PM
Enable logging
Maximum log size (KB J: 1310725
When maximum event log size is reached:
® OQverwrite events as needed (oldest events first)
(O Archive the log when full, do not overwrite events
() Do not overwrite events ( Clear logs manually )

For information about how to configure secure audit logs, see Configure
System Security Features User Manual, publication SECURE-UMoo1.
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Schedule System Backups

Once assets have been added to your system, the assets can be configured from
the Archive tab. From the Archive view, you can do the following:

« View the archive of current and previous versions of programs
and assets.

« Seta personal working folder to hold Checked-Out files.
« Promote a specific program version to be the master.

2 FactoryTalk AssetCentre =508
File Edit View Tasks Tocls Windows Help
@ B S P BB X B Ases ‘;Zr Agent Groups|  AssetsLifecycle B Calibration @ DM View &P Logs () Schedules ki
Asset View (Design) X Archive x
@ Design | o | 36 |53 | #A CheckOut @) Checkln Jg] UndoCheckOut [8) Get | ® Newlabel g Remove Label Export for PCDC
P
1, AssetCentre
= § Lexcon QQ AssetCentre
£y TTO1001
Description |
Working folder: |{nnne set) Set...
Name User Check Out Location
5 Browse For Folder -
Set Working Folders i
System working folder for this asset (set by administrator):
| 8 Videos -
I = Floppy Disk Drive (&)
Personal warking folder for this asset (overrides system working folder if set): 4 & Local Disk (C:)
P Add L
| | F— | I . Hiprom Software S
Catalog B . inetpub =
= Devit =
K 4 MS50Cache
fa qued on these settings. and those for assets further up the hierarchy:. files for | Perflogs Versic
this asset will be stored at:
g . PlantPix ern
- [ | = [ b B8 PlantPAx Utilities —
[ b [, Program Files -
L' I8 o Eilac 1051 el
& QK Cancel Help
Il |I| | | | Make New Folder OK Cancel
ey rrerorogmeT T
W MobileView w
< m > < m b4
Ready & SYSTEMVADMINISTRATOR 33 Connected 2. Agents 1 4

Rockwell Automation Publication PROCES-UM100C-EN-P - June 2022

Create a Backup Schedule

1. From the main menu of the FactoryTalk AssetCentre client dialog box,
select Schedules.

2. Select New and follow the Wizard instructions at the top of the
dialog boxes.

Configure Disaster Recovery

The Disaster Recovery function creates backup files from the running asset on
the plant floor. The backup file is compared to the original and archived to a
Master version. The Agent service performs these comparisons and can be
scheduled to operate at specific times and intervals.

The Agent service can be co-located with the FactoryTalk AssetCentre server, or
it can be located with another server. The Agent service performs the
background actions of uploading and comparing program files and versions.
For more information about FactoryTalk AssetCentre Agents, see the resources

that are listed in the table on page 165.

m
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Maintenance Strategy
Recommendations

Maintenance Type Recommendations

For a tutorial, see the YouTube video ‘Introduction to FactoryTalk AssetCentre
Disaster Recovery'.

We suggest that you develop a plan to back up your control system
configuration and process data on a regular schedule. Consider involving your
IT department to develop this plan. An effective backup plan can help protect
you from loss of resources and revenue.

IMPORTANT  We recommend that you verify operating system or software
updates on a non-production system or when the affected system
components are not-active. These precautions help to prevent
unexpected results.

For equipment monitoring and safety, we recommend that you
follow the procedures of the manufacturer

The following table summarizes the types of backups and updates for routine
and annual maintenance. The time frames are examples and can be modified
based on the attributes and risk factors in your plant.

Backups

Why? When? What?

Controllers
PASS servers

« FactoryTalk Directory

Application configuration - See page 173 Roll back or file protection Periodic « HMI FactoryTalk® Lin data servers
« FactoryTalk® Alarms and Events servers
Network switches
FactoryTalk® Historian

Data - See page 174 Archive or praject protection Periodic and on-demand | FactoryTalk® Batch

FactoryTalk AssetCentre

172

The PlantPAx system can be configured to back up control system
configuration data automatically. FactoryTalk AssetCentre software stores
datain a SQL server. The server stores an Archived copy of both the master
files and previous file revisions in a protected database. The Archived files are
available if there’s a failure.

Database backups for FactoryTalk software packages (Historian, FactoryTalk
AssetCentre) can occur anytime without system operation impact. We
recommend that process backups be routinely scheduled so that data loss is
minimized if computer issues occur.

FactoryTalk® Batch uses a SQL server for archiving journal data, storing
master recipes, and material database.

Application configurations for PlantPAx system servers and workstations are
to be backed up separately and more regularly. The frequent backups mitigate
the risk of configuration and application information loss between PlantPAx
system backups. Frequent backups simplify the process of restoring only a
portion of your application, if needed.
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The following table shows examples of project files that are to be backed up
regularly. Some files contain configuration scripts and collected data.

Recommended Configuration Backup

Configuration Host Environment Tool Files Backed Up
Controller project file Studio 5000° application FactoryTalk AssetCentre Disaster Recovery .ACD
FactoryTalk Directory FactoryTalk® Administration Console
Distributed Application Manager .APB
PASS servers FactoryTalk® View Studio software
Network switches System network User choice .TXT (based)

AppServ-Asset

AppServ-Asset

FactoryTalk Directory

AppServ-Asset

PASS

Controller Project File

Use FactoryTalk AssetCentre software on your AppServ-Asset server to back up
Logix 5000™ software and Studio 5000 Logix Designer® application project
files (LACD). Logix 5000 assets are created in the FactoryTalk AssetCentre
project tree for each controller and project files can be associated with those
assets and checked into FactoryTalk AssetCentre software.

A schedule can be created to back up the project files at regular intervals. Use
an EWS to perform check-out and check-in features to make modifications to
the project file.

FactoryTalk AssetCentre software is integrated with the Logix Designer
application to let you access files in the Archive without leaving the design
environment. Use change tracking on project files to audit modifications.

FactoryTalk Directory

Our recommendation is to back up the FactoryTalk® Directory regularly. The
backup includes any FactoryTalk® Security, users, and computers, among
other configurations.

The backup is contained in the output .APB file of the Distributed Application
Manager, which is installed on the PASS with the FactoryTalk® View software,
version 8.1 and later.

PASS Servers

The core servers in the FactoryTalk View application need to be backed up
regularly whenever changes are made. The core servers on the PASS consist of
the HMI, Data, and Alarm and Event servers.

IMPORTANT  FactoryTalk AssetCentre software, version 9, includes an asset for
FactoryTalk View SE version 11and later. This new asset can be
created to support disaster recovery for a FactoryTalk View SE
application. For details see the YouTube video ‘Use FactoryTalk
AssetCentre Disaster Recovery to Backup & Compare a FactoryTalk
View SE application’.
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AppServ-Asset

Network Switch

A FactoryTalk AssetCentre custom asset can be created by following the
procedure in Knowledgebase Answer ID 818741 ‘Building Custom Device assets
for FactoryTalk Distributed Application Disaster Recovery’. The project servers
store the output .APB file to the FactoryTalk AssetCentre server. Schedule the
custom asset to run regularly.

Network Switches

If using an older version of FactoryTalk AssetCentre software, back up the
network switch configuration to retain the network architecture by using a
custom asset. An export of the switch configuration can be generated by using
various tools, including the following:

« Studio 5000 Logix Designer

application software
« Third-party applications, for example the Cisco® Network Assistant Tool
« Command-line interface

« Other desired methods of your IT department

The custom asset pulls the contents of the backup into the FactoryTalk
AssetCentre server. You specify the file location in the custom asset
configuration. Schedule the FactoryTalk AssetCentre software to back up the
exported switch configuration regularly.

For more details about the custom device plug-in for FactoryTalk AssetCentre,
see the Knowledgebase Answer ID 634595 Building Custom Devices for use
with FactoryTalk AssetCentre Disaster Recovery.

Server Back up and system FactoryTalk® Historian and FactoryTalk® Batch servers produce process

Restore system data to document historical production data. The software
configurations, which create the system data, must be protected along with the
data.

Recommended Data Backup

Configuration Host Environment Tool Files Backed Up
Historian configuration and data FactoryTalk® Historian software Pibackup.bat Backup folder contents
Batch configuration and data FactoryTalk® Batch software Batch system files System folder contents
FactoryTalk AssetCentre data AssetCentre.BAK

SOL server SOL Management Studio
SOL server data [DBName].BAK

174

Consider the following when using FactoryTalk AssetCentre software:

« No single asset (verification or custom asset) is to exceed 1 GB.

« The system is not to exceed 100 assets that are scheduled in a 12-hour
period for one Agent only. Increasing the number of Agents can increase
the load capacity of your system.
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Safe, IT-Managed Location

Historian Server

Safe, IT-Managed Location

FactoryTalk Batch Server

SOL Server

FactoryTalk
AssetCentre Server

Historian Configuration and Data

The FactoryTalk Historian server contains historian points, configurations,
and data that need to be regularly backed up. As a part of the Historian
standard installation, a script file pibackup.bat is installed on the Historian
server. This script is used to back up the Historian server.

The output of this tool is a folder hierarchy that contains all components
necessary to back up and recover the Historian server. We suggest that you
consider separating the historical data from the configuration for scheduling
purposes.

The historical backup data, which is generated by FactoryTalk Historian, is
stored on the Historian server. Consult with your IT department to determine
the appropriate location to move and store these files outside of the AppServ-
Info (Historian) server.

Batch Configuration and Data

There are multiple components of a FactoryTalk Batch system that require a
backup plan depending on the implementation of your system. See
Knowledgebase Answer ID 538578 ‘FactoryTalk Batch: How to backup and
restore a Batch configuration to a new computer’. Included are files that are to
be backed up for each of the following components of a batch system:

« Batch server files
« Batch client files
« eProcedure® files
« Material manager files

The file contents of the various Batch system components need to be separated
into two groups: (1) configuration or system files and (2) data files.

The configuration files are all files that comprise the Batch project, such as
area models and recipes. The data files are the batch journals that are
constantly created by a running Batch server.

The configuration files and data can be backed up at different intervals to a
safe, IT-managed location outside of your AppServ-Batch server.

FactoryTalk AssetCentre Data

FactoryTalk AssetCentre software manages the information that is produced
by each of its assets and processes the data into a SQL server. When
performing a backup of FactoryTalk AssetCentre software, nothing must be
done within FactoryTalk AssetCentre. To back up the FactoryTalk AssetCentre
configuration and data, back up the FactoryTalk AssetCentre database in your
SQL server.
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Retention Policy
Considerations

176

For guidelines on how to back up your FactoryTalk AssetCentre database in
SQL, see the Knowledgebase Answer ID 59541 Backing up and Restoring
FactoryTalk AssetCentre with Microsoft® SQL Server.

SOL Server Data

The FactoryTalk Alarm and Event History software is configured to log to a
SQL database.

These databases include the following:

« For FactoryTalk Alarm and Event database, go to FactoryTalk®
Administration Console and expand System>Connections>Databases.
Select the database to view the information on the Alarm and Event
Historian Database Properties dialog box.

. For FactoryTalk Historian Asset Framework, the SQL Database ‘PIFD’
contains the Asset Framework data and configuration content.

Backup Verification

We recommend that your system use a dedicated, non-production
environment that is capable of accepting and validating backups. You need a
strategy for how frequently the backups are validated.

System Restore

We recommend that you consider a strategy for recovering and restoring your
PlantPAx system to a known secure state after a disruption or failure.

System recovery and restore to a known secure state means that all system
parameters (either default or configurable) are set to secure values. If any
security-critical information, such as patches, is installed after the last backup,
the information must be reinstalled. For example:

« Security-related configuration settings re-established
« System documentation and operating procedures available

« Application and system software that is reinstalled and configured
with secure settings

« Information from the most recent, known secure backup is loaded and
the system that is fully tested and functional.

There are two ways to retain data: archived records and a detailed backup
policy. While archiving provides historical records, backups are typically not
useful unless you can access the data for a restore. You must take the time to
design a retention policy for the reuse of dated materials.

For example, a backed up .ACD file from the Studio 5000 Logix Designer
application could possibly not be saved in the most current version of Studio
5000 environment. Accessing the contents of this .ACD file could be
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System Operating Assumptions

problematic. But an archived printout of the logic that is stored in PDF format
could help restore a system project.

Secure archived data and make sure that you can search for the data if
requested. There are numerous reasons to archive data, including, but not
limited to, the following:

« Compliance with government regulations
+ Retention of production knowledge
« Reduction of backup storage footprint

Consider the following when developing a backup retention policy:

« Location — Backup information is only worthwhile if retrievable for a
restore. To mitigate risk, duplicate the backup contents to an off-site
location if an 'Act of God' renders the on-site copy unusable.

« Storage —The type of storage medium that is used to backup data can
affect how quickly you’re able to restore data. Cloud storage provides
scalable backup potential and requires the least amount of on-site
hardware. But, the cloud requires additional steps if the process facility
isn’t connected to the enterprise cloud servers. Disk mirroring can
provide the fastest time to restore and smaller data loss intervals. This
process can cost more than periodic backups to a hard disk drive.

+ Security — The confidentiality and importance of backup information
must be carefully evaluated. Limit access to the retained backup storage
devices and locations to help reduce the risk of threats. Password
protection and encryption can improve risk mitigation.

« Cost—The cost of backing up a process system can be justified with one
application configuration restore. The time alone to re-engineer a
process configuration can justify the cost of physical media and IT
infrastructure. Automated backup policies can reduce time and money
for IT to complete regular backups.

System Storage Rates

The following tables provide an estimate of storage usage for a PlantPAx
system. Evaluate your system size and adjust appropriately according to your
corporate policy.

Description Small Medium®@ Large®
Marms SQL database

(alarms/min according to the ISA 18.2 peak alarm rate) 20 50 100
FactoryTalk Historian Event Frames SQL database

(event frames per hour) 250 500 1000
FactoryTalk AssetCentre SOL database 9 5 10
(commands/min per PlantPAx audit log guidelines)

FactoryTalk Historian points 5000 10,000 20,000

(1) 3000 I/0 points and 10 operator workstations
(2) 3000 I/0 points and 25 operator workstations
(3) 5000 I/0 points and 50 operator workstations
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Storage Rates

Description Small Medium®@ Large®
Microsoft SQL server 4 GB/month 5 GB/month 9 GB/month
FactoryTalk Historian server 2 GB/month 3 GB/month 6 GB/month

(1) 3000 I/0 points and 10 operator workstations
(2) 3000 I/0 points and 25 operator workstations
(3) 5000 I/0 points and 50 operator workstations

178
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FactoryTalk® Historian SE software captures data for reports to help maximize
plant-floor objectives and productivity. The software collects historical points
in the system to produce analytical data. Analytical data includes process
variables, trends, estimations, and statistical reporting.

For a PlantPAx® system, it's recommended to implement more than one
historian server to create a collective of historian servers. A collective provides
higher availability with continuous access to data during planned and
unplanned outages. Adding redundant node interfaces is also recommended
to send time-series data to all servers in the collective.

To streamline the FactoryTalk® Historian SE software configuration, follow
this quick start. For experienced users, each step outlines requirements. For
more detailed information, follow the referenced links.

A

Step 1: Configure Servers for a Collective

A collective is a group of historian servers that pool their data resources for
high availability.

« You need two or more historian servers for a collective.

« There are requirements for initial configuration, such as the firewall,
trusted connections (certificate), and security settings

« Configure PI SDK connections to the historian server on all computers
that access historian data.

For more information, see Configure Servers for a Collective.

A

Step 2: Configure Redundant Node Interfaces

The FactoryTalk® Administration Console contains configuration for server
connections and node interfaces.

« A Historian server connection specifies the name of a Historian server or
Collective.

« Adata collection interface is then created to collect data from an end
device.

« Anodeinterface is defined by selecting the type and computer (PASS02A
in the example) hosting the interface.
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« Create a common folder, on the PASS (PASSo1 in the example) with the
FactoryTalk® Directory, for synchronization of redundant node
interfaces.

« Configure the connection between the Node Interface and the Historian
server

« Configure the FactoryTalk® Live Data interfaces between the PASS
servers and the Historian servers.

For more information, see Configure Redundant Node Interfaces.

O

Step 3: Enable Performance Monitor

An interface (PIPerfMon) is available to log system resources for health and
performance.

« Create a PIPerfMon system ‘user’ on the domain controller.

« Configure the PIPerfMon interface after initiating on the FactoryTalk
Directory.

« Create and verify interface health points.
« Enable communication paths.

For more information, see Configure PI Performance Monitor.

O
Step 4: Configure Pl Buffering

PI Buffering helps protect data in the event a client loses connection to the
Collective.

« For added security, configure a user account on the domain controller to
run the PI Buffer Subsystem service.

« Configure security mappings specifically for the user account.

For more information, see Configure PI Buffering.
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A

Step 5: Configure Data Collection

Prerequisites

Application
Servers

FactoryTalk Historian software uses historical points (tags) in the system to

produce analytical data for reporting.
« Create or Import Digital States.
« Create Historian Points.
« Define digital historical points.
« Configure Asset Framework.
« Finds system faults.
« Generate reports in PI Builder.
« Configure tags with the PlantPAx® Configuration Tool.

For more information, see Configure Historian Data Collection.

Following the System Workflow, configure application servers.

A historian application in a PlantPAx system requires:
« Domain controller

« Process Automation System Server (PASS) hosting the FactoryTalk®
Directory (PASSo1)

« Process Automation System Servers (PASS) for node interfaces
(PASS02A, PASS02B)

« Engineering Workstation (EWS)

« Operator Workstation (OWS)

« SQLstandard or SQL Express database server
. Asset Framework server

When you deploy a FactoryTalk Historian application in a PlantPAx system:

« Install FactoryTalk Historian servers as a collective.
« Configure a Performance Monitor interface.

The following software must be available:
« FactoryTalk Historian SE Server
« FactoryTalk Historian Asset Framework Server
« FactoryTalk Historian Asset Framework SQL database
«  PIBuilder Excel® add-in

Your must be familiar with the following utilities:

« PISDK-An object-oriented library that is designed for customizing
applications

« Powershell - Command-line shell and scripting language.

For more information, see this additional resource.

Resource

Description

FactoryTalk Historian SE 7.00 Installation and Configuration Guide,

publication HSE-IN025

Installation, configuration, and troubleshooting of FactoryTalk Historian Site Edition software.
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Required PlantPAx Elements

Configuring historical data collection requires access to the following
equipment. All equipment must be physically installed before using this

document.
L ] [ ]
[T T
Engineering Workstation (EWS) Operator Workstation (OWS) Domain PASSO1
Controller FactoryTalk Directory
LD SEnEn I F :
Senssssmmsnsenn
T
PASSO2A PASS02B s AppServ-Info Historian  AppServ-Info Historian
FactoryTalk® Live Data Server FactoryTalk Live Data Server (ASIHOT) (ASIH02)
Primary Node Interface Secondary Node Interface Primary Secondary
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Historical Data In a PlantPAx system, the FactoryTalk Historian SE software collects, stores,
and manages data. The software includes these hardware and software
components:

« Data Sources - Plant floor devices and instruments that generate data,
typically controllers. Other Data Sources can include external databases.

- Historian SE Interfaces - The FactoryTalk Historian node interface
enables process data to be passed between a FactoryTalk® Live Data
Interface (for example, FactoryTalk® Linx) and a FactoryTalk Historian
server. Each instance of the interface can provide data to a single
FactoryTalk Historian server or collective.

 Historian SE Server - Compresses and stores the collected data and acts
as a data server for Microsoft® Windows-based clients applications. It’s
also possible to use the Historian SE server to interact with data that is
stored in external systems.

 Historian SE Clients - Microsoft Windows-based applications that are
used by plant personnel to visualize the Historian SE data.

« Historian Asset Framework - Asset Framework replaces the Historian
module database (MDB) with a Microsoft SQL server database for
improved scripting and reporting.

Configure Servers for a A collective is a configuration of multiple servers that act as a logical server in

Collective your Historian database to provide high availability (HA), disaster recovery,
load distribution, and increased scalability. Each server in a collective is called
a member of the collective. When the primary member in a collective becomes
unavailable, a secondary collective member continues to collect and provide
data access to your Historian clients.

Create Firewall Rule for Historian Servers

To create a server collective on computers that have the Windows® Firewall
turned on, you must manually open the TCP 445 port between the two
HEHEA % % computers. Perform this section on both the primary and secondary Historian
: servers.
ASIHOY 1. Goto Control Panel > Windows Firewall settings on the Historian Server.
ASHO2 2. Inthe Advanced Settings, select Inbound Rules and create a New Rule.

For the new rule, specify the following:

On This Page Configure

Rule Type Select Port

Protacol and Ports Configure Specific Lacal TCP Port as 445

Action Allow the connection

Profile Apply the rule to the Domain, Private, and Public

Name Type a name for this rule (Collective Connection in the example)
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Change the Historian Server Identification

IMPORTANT  When planning to use a collection of Historian servers, serverlDs
must be unique. You must change the serverlD on any additional
servers, particularly if the server is cloned or sourced from a virtual

AaTTet IR % template.

A2 To change a server ID, complete these steps.

1. Goto c:\Program Files\Rockwell Software®\FactoryTalk Historian
\Server\adm

2. Enter ‘emd’ in the address bar to open a command prompt window in
this directory.

3. Enter the following commands.

Command Purpose
: ; Open the command-line administration tool for the Pl Data
piconfig Afchive
tabl e piserver Open the piserver table
node edit Set the required mode of operation to edit
istr nane, serverlD Allows you to edit the hostname and serverlD

Specify the new server name.
<host nane>, <new server| D> | <hostname> = hostname of the Historian server
<new server/D> = new server ID

@xit Saves the information and exits the tool

The serverID is a unique identifier (UID), a 32-character string
representing each Historian server identification. You can make up
your own arbitrary string.

EX Administratar Cornmand Prompt - m] X

di f -azbhRfdfhag7

Records Edited

C:\Program FilesiRockwell SoftwareiFactoryTalk Historian\Serweradm:

4. The next time you access the secondary Historian server, a Server ID
mismatch prompt appears. Select 'Accept the New ID' to continue.

Set Initial Security Settings

For any Historian server that is going to join a Collective, security settings
— | must be considered for each initial connection. To simplify the connection
= % % process, reduce the security levels of both the primary and secondary Historian
servers. After the initial connection, the security levels can be modified as

ASIHOT needed.

ASIH02

184 Rockwell Automation Publication PROCES-UM100C-EN-P - June 2022



Chapter 7 Historical Data

1. Go to Rockwell Software > FactoryTalk Historian SE > System
Management Tools.

2. Select the server in the Collectives and Servers section.

3. Inthe System Management Tools section, select Security > Security
Settings.

4. Set the slider to its lowest point and click Save.

T Security Settings - Pl Systern Management Toals (Administrator) = m] *

File  Wiew Tools  Help

Servers A | £ | @
Sgarch yel
Server - ASIHOT
SErVeErs

| 1= 5% Disable £P1 trusts
| — % Disable SOK trusts
% Dizable explicit login

% Dizable explicit login for piadmin
% Disable blank passwords

System Management Toals E Save
Y

Alarms

Batch

Data

Interfaces

IT Paints

Operation

Faints

~ Security

Database Security
Firewall
Identities, Users, & Groups
Mappings & Trusts

Session Record

ASIHOWAdministrator | piadmin

5. Repeat the settings for the secondary server.
6. For the security setting changes to take effect, restart the servers.

Create Connections Between Historian Servers

The PI SDK Utility is used to create the connection between the Historian

servers. This action is required on both servers before creating a collective.

Historian SE System > PISDK Utility.

M— % E 1. Goto Rockwell Software > FactoryTalk Historian SE > FactoryTalk
: 2. Select Connections and then right-click on the empty area next to

ASIHOT the servers.
ASIHO2
Select Add Server.
@@ PlsDK Utility (Administrator) — [m] *®
File  Buffering Tools  Connections  Help
=@ PISDK L] ® ssiHn Network Hods: ASIHDT
@ Ahout PISDE
Port Mumber: 5450 ~
o Mo EE
&1, Snapshot Taal Profoltino bl piadrin
) C +
D4 Tools onnee 10 Seconds
8] Message Log Connect . ] Seconds
;i Support Data Disconnect
@ Error Lookup
= Refresh F5
B Tracing Setup sres 13
© KST Cleanup | | 2dd Server,,, ins i ‘ 3ad66708-4a10-42ba-BfdE-c05c9.
Remowe selected Server  Del

Conrected User.
IP Address:
Pl Wersion

Operating System:

Save

Default Server: ASIHO1

4. Enter the server name in the Network Path dialog box and accept the rest

of the default settings.

Rockwell Automation Publication PROCES-UM100C-EN-P - June 2022

185



Chapter 7 Historical Data

Create the Historian
Collective

186

ASIHO1

5. Remove any servers that aren’t necessary.

6. To verify the connections, go to Security Settings > PI System
Management Tools (Administrator.)

This example shows servers ASTHo1 and ASIHo2.

T Security Settings - Pl System Management Toals {Adrministrator) - m] X
File  “iew Tools Help
Servers # | @
Search jel i
Servi Server - ASIHOT
ervers
ASIHOT m 52 Disable AP tusts
ASIHOZ = 54 Dissble GDK. musts
~= % Dizable explicit login
% Digable explicit login for piadmin
% Dizable blank passwaords
System Management Tools B G
Search 2
Alarms
Batch Server - 451HD2
Data qh 32 Disable API trusts
Interfaces
1T Paints ;:__:-2 32 Disable SDK tsts
Operation — % Dizable explicit login
Proints % Dizable explicit login for piadmin
~ Security
Database Security % Disable blank passwords
Firewall
|dentities, Users, & Groups = iz w
[ & Trust
e Session Record
Security Settings
ASIHOWAdministrator | piadmin

Now that the servers are configured, you can create a Collective by using the PI
Collective Manager.

Go to Rockwell Software > FactoryTalk Historian SE> FactoryTalk Historian
SE System > PI Collective Manager and complete these steps:

On this Dialog Box Action

« Select | have verified my backups are valid

Create New Collective Initial Page « Select | have verified my Pl interface servers configuration

Create New Collective - Existing or New
Primary

Select anewly installed Pl server

Create New Collective - Select Primary

and Collective name Select the Collective Primary server and define the properties.

Create New Collective - Select Secondary

Servers Select the Collective Primary server and define the properties.

« Accept the default number of archives to be copies

Create New Collective - Select Archives « Accept the default location for the temporary backup

Create New Collective - Verify Selections | Verify the information

Create New Collective - Conversion

Progress Verify the conversion progress is completed

Server ID Mismatch

Select Accept the new 1D

Create New Collective - Finished

Acknowledge the creation of the collective
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Delete the Default Security Certificate

Historian Collectives support certificate-based authentication for each server.

To verify the system uses a valid security certificate, start by deleting the
default or cloned certificate on the Primary Historian server. This is a required
step if the server was cloned or sourced from a virtual template.

TERaR s haa R pe—
CETTTTTITITLT | —
-—

: b d

ASIHO1

1. To access Certificate Manager, click Start and type certim.msc in the
search field.

2. Click Enter.

3. Expand the Certificates folder > OSIsoft LLC Certificates > Certificates.
4. Delete the default certificate.

| Untrusted Certificates
| Third-Party Root Certification Autho)
| Trusted People
7| Client Authentication lssuers
| Preview Build Roots
v ] DSlsoft LLC Certificates
| Rernote Desktop
| Smart Card Trusted Roots
7| Trusted Devices
| Web Hosting
| Windows Live 1D Token lssuer

< > €

Froperties

Help

Deletes the current selection,

BR Consolel - [Console Root\Certificates (Local Computer®OSlsoft LLC Certificates\Certificates] — [m] *
P
File  Action ‘“iew Favorites  Window  Help -2 %
e nF FRIXER BE
=
- Cansole Root Issued Ta Issued By Expiration Date  Intended Purpases Fr|| Actions

v & Cz.ert\ﬁcates (LazalGaraptsr) = Bries e T T TS T | | Certificates -
_| Personal Open
| Trusted Roaot Certification Sutharitie: hare Actions 3
| Enterprise Trust Al Tasks » e i L
| Intermediate Certification Authoritie: i e
| Trusted Publishers Mare Actions »

Copy
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Generate a New Security Certificate

Code that is provided by OSIsoft generates a new security certificate, that
afterwards is to be imported on all other Historian servers in the collective to
authenticate.

IMPORTANT  Due to the electronic formatting of this user manual, the code may
require format corrections if copied from here. Also note the
<PlantPAx AppServ-HIST Virtual Template 5.0 VL> virtual template
contains properly formatted code on the user desktop.

1. On the Primary Historian server, copy the script as shown and paste
into Notepad.

$CertStorePathName = "Cert:\LocalMachine\OSlsoft LLC Certificates"
if((Test-Path $CertStorePathName))

{
New-Item -Path $CertStorePathName

}
if( (Get-ChildItem -Path $CertStorePathName | measure).count -eq 0)

{
SmyFQDN=(Get-WmiObject win32_computersystem).DNSHostName+""+(Get-WmiObject win32_computersystem).Domain

SDNSName = @(SmyFQDN)

#SNewCert = New-SelfSignedCertificate -CertStoreLocation Cert:\LocalMachine\My -FriendlyName $myFQDN $DNSName -Provider "Microsoft Enhanced RSA and AES
Cryptographic Provider" -HashAlgorithm "SHA256"

$SNewCert = New-SelfSignedCertificate -CertStoreLocation Cert:\LocalMachine\My -DnsName $DNSName -NotAfter $(Get-Date).AddYears(100)

Move-Item $NewCert.PSPath -Destination $CertStorePathName
else

Write-Host("Invalid number of certs detected in OSIsoft LLC certificate store - please ensure there are no certificates already configured in " + $CertStorePathName)

2. Use Notepad to remove any new lines, where contiguous code is
wrapped.

You can backspace new lines to rejoin the prior code statements.
For example:

et =Micrcsaft Enhanced RSA and ALS Cryptographic Provider™ -Hashilgeriths "SIEAZS¢"

3. After the scripting code is realigned, launch an administrative
PowerShell window.

Copy the script from Notepad and paste into PowerShell.
5. Click Enter to generate a security certificate.

188 Rockwell Automation Publication PROCES-UM100C-EN-P - June 2022



Chapter 7 Historical Data

6. Return to the MMC window and refresh the window. To verify that the
OSIsoft certificate was recreated. The name should represent the
computer name and domain.

Export the Security Certificate

To transfer the new security certificate to all other Historian servers in the
AR N — Collective, the certificate must be exported as a PFX file.

-_—
-]

1. While still on the Primary Historian server, in the MMC window, select
ASIHOT the certificate that you've generated and select All Tasks > Export.

certlm - [Certificates - Local ComputeryOSlsoft LLC Certificate s\Certificates] — [m] *
File  Action  \iew Help
e | 2FE 4B XERHE
Cll Certificates - Local Computer
| Persanal
| Trusted Root Certification &u

_| Enterprise Trust
| Intermediate Certification &u

=
ed To lssued By Expiration Date  Intended Purposes Friendly Name

1,4

42072720 Client Authenticati,  <Mone>

QOpen
All Tasks » Open

| Trusted Publishers Cut Export..
| Untrusted Certificates
_| Third-Party Root Certificatior|
| Trusted People
| Client Authentication |ssuers
| Preview Build Roots
| Local ManRemaowable Certific Help
w || DSlsoft LLC Certificates

| Certificates
_| Remaote Desktop
_| Certificate Enrollment Reque;
| Srnart Card Trusted Roots
| Trusted Devices
_| Web Hosting
| Windaws Live ID Taken |ssuel

Copy
Delete

Properties

< IR 2>

Export a certificate

2. From the Certificate Export Wizard, complete these steps.

On these Wizard Boxes Action

« Select Next
Welcome window « Select Yes, export the private key and select Next
+ Leave defaults, and click Next

Security « Type a password, confirm, and click Next

« Click Browse and type a name for the storage location on your computer
File to Export « Click Next
« Select a file name and click Finish
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Import the Security Certificate

The new security certificate must be imported on all other Historian servers in
T — the Collective before it can synchronize. The import can be done using either
. the PI Collective Manager software or the Windows Certificate Manager.

:;':3; For each Historian server, you must copy the new security certificate PFX file
first before using one of the following procedures. From the PI Collective
Manager:

1. Select the Historian server and select Import Certificate.
4 Pl Collective Manager (Administrator) — O x
File  Edit Help
Collectives Collective Name:  [A5IHO1 Collective 1D:
3 aSIH Bt I:| [ba2a7EEdTr-A164 2l 2837001 .
Last Configuration Status:
Change Time: | 21:Jul-202013:44:27 | [Good |
+ &8 |
Force Sync
Reinitialize Server...
Add Server.,
Rernowve Server A5IHOZ 2
Refresh
Impatt Certificate. |
Fix Certificate lssues.., B e
2. Browse for your PFX file.
3. Open the certificate and provide the password for this certificate to
import the certificate.
Reinitialize the Secondary Server
Perform this task from the Primary server to synchronize the certificates of
any other Historian servers in the collective.
R .
: - 1. From the Collective Manager, select the Secondary server.
: s . ee qs
N 2. Select Reinitialize Server.
ASIHO1
% PI Collective Manager (Sdministratar) — [m] *
File  Edit Help
Callectives Callective Mame:  |45/HO1 Callective ID:
<L A5IHO1 Bret 424783347741 6d-aaaf-28370007 bfc -
Last Configuration Status:
Changs Time: | 27-4pr2020082411 | [Good |
8@
o
ASIHO Force Sync
Reinitialize Server.. || |
= ar Add Server,
ﬁl £ Remove Senser
v Attril A
MNamq [#  Refresh A5IH02
Desc
Colles Impaort Certificate.., S5IHO
FaD| Fix Certificate lssues..
Fiole Secondam
CommPeriod =1
SyncPeriod 10
+ Connection Status o
Mame
The member server computer hostname.
Save Close
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oW

From the Archives window, click Next.
Verify the backup location and click Next.
When the sync process completes, click Finish.

If servers show green check boxes, skip step 8, and proceed to Connect
another Computer to Historian Server.

If the synchronization fails, verify all firewall settings, certificates, and
matched server or collective IDs. Then, try again.

If sync problems remain, contact Technical Support.

Client to Server Connections ror all servers and workstations that require access to Historian data, use the
PI SDK Utility to add a connection to a Historian server or Collective of
servers. This includes the PASS servers (PASSo1, PASS02A & PASS02B), EWS,
and OWS workstations.

Domain

Controller PASSOT

D!D!
s

PASS02A
PASS028B

—_— —_—
-] -]

ASIHOT
ASIH02

Connect another Computer to Historian Server

For each computer that requires a connection to the collective, complete
these steps:

1.

Go to Rockwell Software > FactoryTalk Historian SE > FactoryTalk
Historian SE System > PISDKUtility.

Select Connections and then right-click on the empty area next to the
servers to add a new server.

Maintain the default connection name of 'Production Historian' for
library object reference, then select the Server or Collective Name and
click Test Server Connection.

@) Mewr Historian Server Connection e

M ame:
e —
I| Production Histarian I

Drescription:

Histarian for the production area of the plan]

Server or Collective Mame:

[4sIHOT -

Test Server Connection

@ < Back Mext > || Cancel |

If you're using a collective, enter the primary server.
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4. Select the box next to the new server.

The server appears in the middle of the utility for a successful

connection.
]
File  Buffering Tools Connections  Help
E‘@; B 5 ASIHOT Hetwork Nods A v
About PISDE

§ o a Port Number: 5450
& Connections
<& Snapshot Tool Default User Name:

5. Remove any server connections that aren’t necessary.

Historian to FactoryTaIk Use the FactoryTalk® Administration Console to add the FactoryTalk Historian
Directory Connection server connection to the FactoryTalk Directory.

1. Go to Rockwell Software > FactoryTalk Administration Console and
select ‘Network’ for the directory you want to use.

2. Go to Network > System > Connections > Historical Data and select New
Historian Server Connection.

EWS
E! File View Tools Window Help
- &=

Explarer n

=145 Metwork (PASS0T)
&}; FTViewDemo
&}; InstantFizz
BD Systemn
(2 Action Groups
D Palicies
D Computers and Groups
-.595 Metworks and Devices
D Users and Groups
BD Connections
(Z1 Databases
i |
H N | Histor\cI_New Historian Server Connectian...,
{20 Permissior

Security..,

|
3. Select the Server or Collective Name and click Test Server Connection.

If the connection is good, a green check mark appears along with the
text 'Server Found.'

Server or Collective Name:

[asiHm v

Test Server Connection o Server found

4. In the FactoryTalk Administration Console, go to Network > System >
Connections > Historical Data > Production Historian and

choose Properties.
5. Select the Licensing tab and enter how many licenses are stored
on the server.
« Ifonelicense is stored locally in each collective server, enter '1' in the
Assigned column.
« Ifboth activation licenses are on the activation server, enter 2’ in the
Assigned column
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EWS

L]

Create a Data Collection Interface

A data collection interface is used to collect data (tags) from data sources, such
as Logix 5000™ controllers, and pass it to the FactoryTalk Historian server or

collective.

The FactoryTalk Administration Console is used to create and configure the
data collection interface.

1. Using an EWS, launch the FactoryTalk Administration Console and
expand Historian server connection.

When a new FactoryTalk Historian server is added, a default node
interface is created along with a name FTLD and ID 1 (FTLD1).
2. Delete the default node interface FTLD1.

Select the Historian server connection and select New Data Collection
Interface.

W FactonyTalk Administration Console - m] X
File Wiew Tools Window Help
1=

Explorer n
(=15 Network (PASSOT)

[ fdm FTViewDemo

[ InstantFiz

=0 Systern
-0 Action Groups
{1 Palicies
[0 Corputers and Groups
25 Metwarks and Devices
{230 Users and Groups
=] Connectians
+[1] Datahases
=/ Historical Data

Delete

L[] Historical Data b
-0 Permissian Sets I Mews Data Collection Interface.., I

Secutity...

4. Select the Interface Type: (FactoryTalk Live Data), Name: FTLD and
ID: 1 and choose the computer hosting the interface.

For example (PASS02A) where the remote FactoryTalk® Linx data
server runs.

@ Data Collection Interface Properties *

General  Scan Classes

Interface Type: Marne; 10

FactoryT alk Live Data ~ [FTLD 1 =

Description:

Default FTLD interface created by the FTH configure wizard.

Cornputer hosting the interface:

| 7]

FactaryT alk Historiak Server Conkection:
Praduction Historian on

Service Status

Mew

Startup Type: | Autamatic ~

Launch Interface Configuration Utilty.

@ Cancel Apply

IMPORTANT  When redundant node interfaces exist (PASSO2A & PASS02B), only
one data collection interface is required, and it references the
primary (PASS02A) node interface.
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Create a Synchronization Path for Redundant Node Interfaces

PASSO1
A common folder is used for files that are used for handshaking and

E redundancy. This folder is created on the PASS server that hosts the

FactoryTalk Directory.
FTD P—
Synchronization PASS02A
Folder
o)
PASSO1 .
==
ASIHO1 PASS02B

1. Onthe PASSo1, create a folder on Local Disk (C:) named FTHSE_Failover.
2. Specify these properties for the folder.

From this Location Configure
Sharing Tab Advanced Sharing
Advanced Sharing « Select Share this folder

« Select Permissions

Permissions for FTHSE _Failover Add the group Everyone

Select Users, Computers, Service Accounts, or Groups | Select Object Types

Object Types Select Computers
Enter the PASS servers used as Node Interfaces as the
object names to select
Select Users or Groups x
Select this object type:
‘Usevs, Groups, or Builn secuily principals ‘ Object Types.
Select Users, Computers, Service Accounts, or Groups Fram s et
|PrrtPas Rockwellutomation com | | Locations
Enter the object names to select (examples):
PASS024; PASS0ZE Check Names
Advanced Cancel

Allow Full Control, Change, and Read permissions for all

Permissions for FTHSE _Failover Node Interface servers
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Configure Redundant Node

Interfaces

A FactoryTalk Historian node interface enables process data to be passed
between a FactoryTalk Live Data server and a FactoryTalk Historian server.

Synchronization Folder

PASSO1 H

n PASS02A

ASIHO1 PASS02B

A PlantPAx system with redundant data servers requires configuration of the
node interface on the primary and secondary servers (PASS02A and PASS02.B).

The PI Configuration Utility (PI ICU) is an application that aids in system
management by consolidating the setup and configuration options of each
node interface. PI ICU allows you to:

« Configure all interface parameters

« Manage, start and stop interface service

« View and configure interface service dependencies
« Configure and run buffering

« Configures the Universal Interface (Unilnt)

Unilnt provides generic functions that are required by most interfaces, such as
establishing a connection to the Historian Server node and monitoring the
Historian Point Database for changes. To minimize data loss during a single
point of failure within a system, Unilnt provides two failover schemas: (1)
synchronization through the data source (Phase 1) and (2) synchronization
through a shared file (Phase 2).

Phase 1 Unilnt Failover uses the data source itself to synchronize failover
operations and provides a hot failover, no data loss solution when a single
point of failure occurs.

Phase 2 Unilnt Failover uses a shared file to synchronize failover operations
and provides for hot, warm, or cold failover. The Phase 2 hot failover
configuration provides a no data loss solution for a single point of failure
similar to Phase 1.

IMPORTANT In this section, only Phase 2 Unilnt Failover is addressed.

The Unilnt failover scheme requires the data source to be able to communicate
and service data to two interfaces simultaneously. Additionally, the failover
configuration requires that the interface supports outputs. A redundant
solution requires two separate interface nodes communicating with the data
source.

In a hot failover configuration, the interface copy that is in a backup role
collects and queues data in parallel to the interface that is in the primary role.
The interface in the backup role does not send the data that is collected to the
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Historian server. However, if a failover occurs, the interface immediately
sends its data to the Historian server.

Configure a FactoryTalk Live Data Primary Interface

The primary interface goes on PASS02A and connects data servers to the
historian database.

s 1. Goto Rockwell Software > FactoryTalk Historian SE > Interface
Configuration Utility and select the interface.

el ||

PASS02A
For example, select 'FTLDint1 (FTLDInt1)->ASIHo1.'

2. Ifthe Interface ID isn’t already ‘1, change it to ‘1.

EA Plinterface Configuration Utility - FTLDInt1 - - m] *
Interface  Tools  Help
NE X 4 B fa @
|
Interface: ] j Rename
Type: |FTLD\nt ﬂ Fioskwel FactonTalk Live Diata Pl Data server Cannection Status
Desciplion: [Default FTLD intetface created by the FTH corfigure wizard 7 PRI Rl
W wWiriteable
Yersions: |FTLDInl exe version 4.6.0.60 Unilnt version 4.6.0.60
General General Pl Host Information
;T L0l Point Source:  [FTLD | || Sewver/Colective: [B5THOT
ervice e
i FTLD J SDK Member:  [asihi =
Eh API Hostname: — [ASIHOT PlartPAs Rockwell_+
- Performance Counters | Interface 1D: u User. piadmin | FTHAdministuators | FTH
Performance Paints [—
- Pl SDE Scan Classes Tvpe: ey (K
- Disoonnected Startup %] 4| & Wersion: 344151188
Deh =
=10 Scan Frequency ‘ ScanClass t A Fott 5450
10 Rate 73
Interface Status il i
~ 005 2
i 3 Interface Installation Path
‘{' 025 4 ‘C:\F‘rogram Files [86)\R ockwell SoftwaresFact:
ﬁ 2.5 : Interface Batch Filename
> o [FTLDInt1 bat
Ready Stopped FTLDInt1 - Installed

3. Select Service and do one of the following:

« If prompted, select Yes. The PI ICU sets the PIBufss service to be a
dependency of FTLDint1.

« Ifyouaren’t prompted, you must scroll down the Services list and set
the PIBufss service to be a dependency of FTLDint1.

4. Go to Unilnit > Failover and select the following:

Location Action
Unilnit Failover Select Enable Unilnit Failover and Phase 2
UFO Type HOT

Path = Network > pass01> FTHSE _Failover directory (that was

Synchronization File Path created in the previous section)
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£ Plinterface Configuration Utility - FTLDInt1 * — [m] X
Interface  Tools  Help
NEX|H| P B R @

Interface:  [FTLD1 FTLDInt1] > ASIHOT ~|  Rename
Type: FTLDIrk ~| Rockwel FactoryTak Live Data Pl Data server Connection Status
Description: |Defau|l FTLD interface created by the FTH configure wizard. J’ ASIHO1. PlantPé: Rock
Wersions: |FTLDInt.exe version 4.6.0.60 |Uni|nt wversion 4.6.0.60 v wesbe

= C e

o Falover ID# forthisinstance: [T [WPABSOZANFTLDIAN

ilover Failover ID# of the other instance: |2 | Browse

ealth Paints [ Do not failover when both interfaces loze connection to Pl

erfomance Counters [ Failover control tagz are unsolicited [not scan based)
P;agngnance Foints Fiate at which the heartbeat point iz updated/checked:  |5000 millizeconds
izconnected Startup UFO Type: Synchronization File Path:
i Debug HaT | j | | Browse I
10 Rt
Inter:a:e Shatus Shatus | Tag | Endesc | PointSource A
Mat Created ASIHOT-FTLDInt_1_FTLD_UFDZ_ActivelD [UFD2_ActivelD] FTLD

Mat Created ASIHO1-FTLDIR_1_FTLD_UFOZ2_Heartbeat_1 [UFO2_Heartbeat:1]  FTLD
Mt Created ASIHOT-FTIDIRE 1 FTID LIFNZ? Heatheat 2 MIFN2? Heathrat?1  FTIN
<

Ready Stopped FTLDInt - Installed

5. Right-click the tag area and select 'Create UFO_State Digital Set on
Server ASIHor1'.
UFO Type: Spnchranization File Path:

[HaT | [WPASSO1\FTHSE_FaloverFTLDIn_FTLD_1 dat Browse

| Exdesc | PaintSouce ~

Tag

i TL| " |
Mot Created A5IHO1-FTLDIR Create UFO_State Digital Set on Server ASIHOT.., |

Mnt Crpated ASIHNT-FTI Dint
<

v
Create all paints (UFO Phase 2)

The active ID value is located o Delete all poirts (UFQ Phase 2) Py

The primary interface active 1D v
e e e din s ke Correct all points (UFC Phase 2) &

6. Inthe tagarea, select ‘Create all points (UFO Phase 2)

7. When the status for FTLDInt1_UFO2_ActionID tags changes to 'Created’,
select Apply.

The 'Unilnt Failover’ configuration isn’t complete until the 'Other’
interface is selected' message appears.
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Configure a FactoryTalk Live Data Secondary Interface

The secondary interface goes on PASS02B and connects data servers to the
historian database. The configuration is provided in a .BAT file.

1. Goto Rockwell Software > FactoryTalk Historian SE > Interface

Configuration Utility.

2. Select the folder symbol to create an interface instance from a .BAT file

and enter this information.

From Location

Action

Open Interface Configuration File Dialog Box

Select the LDInterface folder

Interfaces > LDInterface directory

Select C:\Program Files (x86)\Rockwell Software\FactoryTalk
Historian\PIPC\Interfaces\LDInterface\ directory

The Select Host Pl Data server/collective dialog
box

Select the hose PI Data server/collective and the collective
member

Service > Service Configuration >Display name

Enter FTLD1

General > General > Interface 1D

Enter 1

Unilnit > Failover > Unilnit Failover

Select Enable Unilnit Failover
Select Phase 2

Unilnit > Failover > UFO Type

Select HOT

Unilnit > Failover > Synchronization File Path

Path = Network > pass01 > FTHSE _Failover

Unilnit > Failover > Unilnit Failover > Failover ID #
for this instance

Enter 2

Unilnit > Failover > Unilnit Failover > Failover ID #
for the other instance

Enter1
Select the interface file (FTLDInt_FTLD.bat.bak) on the secondary
server

Synchronize UFO settings dialog box

Select yes to synchronize the UFO settings

3. The failover and synchronization information appears in the respective

fields.
Unilnt Failover
¥ Enable Unilnt Failaver " Phase 1 * Phase 2
Failover ID# for this instance: [z [WPaSS02BNFTLDIN

Failover ID# of the otherinstance: 1 [WWPASSO2ANFTLDING

I Da not failover when bath interfaces lose cannection to Pl
I Failaver control tags are unsolicited (not scan based)

Fiate at which the heartbeat paint is updated/checked: |5000 millizeconds

UFD Type: Synchionization File Path:
~| [WPASS01\FTHSE_FalloversFTLDINFTLD_T dat Browse

4. In the PI Interface Configuration Utility window, select Apply.
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PASS02A

Return to the Primary PASS (PASS024A)

1. Select the interface path for the second interface.
Unilnt Failower
¥ Enable Unilnt Failover " Phase1 & Phase 2
Failaver I for this instance: [t [\wPASSD2AWTLDIN
Failover ID# of the other instance: |2 [\WPASSOZESFTLDINN x| Brawse

I Da not failover when bath interfaces lose cannection to Pl
I Failaver control tags are unsolicited (not scan based)

Fiate at which the heartbeat paint is updated/checked: |5000 millizeconds

UFD Type: Synchronization File Path:

[HoT | [*ipase0TFTHSE_FailoversFTLDIM_FTLD 1.dat Browse
Status | Tag | Exdesc | PointSource A
Not Created  ASIHOT-FTLDInt_1_FTLD_LIFO2_ActivelD [UFO2_ActivelD] FTLD
Mot Created ASIHOT-FTLDInt_1_FTLD_UFOZ2_Heartbeat_1 [UFOZ_Heartbeat1]  FTLD
Mt Created ASIHI-FTIDIRE 1 FTID HFA? Heartheat 2 MMFA2? Heartheat 21 FTID e
< >

2. Goto Control Panel > Administration Tools > Services and select
Properties for FTLD1.

. Services (Local)
FILD1 Name - Description Staus  StatupType A
X &) FactaryTalk WiewPoint Adm... FactoryTalk ViewPaint Administrat.. Running  Autornatic
Stop the service &) FactoryTalk WiewPoint &lar,,  Passes alarm data to ViewPoint Running  Automatic
Pause the service .y " 4 :
Restart the service \,(.;FacmryTalk WiewPoint Histo.., Integrates FTWiew Datalogging an..  Running  Automatic
(£} FactaryTalk WiewPoint Reci..  FactoryTalk ViewPaint Recipe Servi.. Running  Butornatic
5 & FactoryTalk WiewPoint Strin.,  FactoryTalk ViewPoint String Service  Running  Automatic
Description: = 1
OSlsoft FTLDInt1 Interface Service Start
(Default FTLD interface created by the ‘wr) TLDIntAgent Running  Automatic
FTH configure wizard.) S5 FTSysDiagSveHe Stop Diagnostic Servicesf.,  Running  Automatic
{,‘Q;FTV\EW Shared £ Pause 3l directories and rem...  Running  Autoratic
L FTViewServiceH Resume Running  Automatic
£} Function Discow Restart T service hosts the Fu... Marual
&} Function Discow 5 computer and resou.., Manual
\Q;Genlncatmn Ser All Tasks ? nonitors the current L. Running  Manual (Trig...
£} Group Palicy Cli Refresh responsible forappl..  Running  Automatic (T..
& Harmony Manual
& Human Interfat maintains the use of.. Manual (Trig...
ChHY Host Service Help aterface for the Hype.., Manual (Trig...
Ef Hyper-V Data Ex_.ocoge oo cevieee = chanism to exchang.., Manual (Trig...
&k Hyper-V Guest Service Inter...  Provides an interface for the Hype... Manual (Trig...
Ch Hyper-V Guest Shutdown 5., Provides a mechanism to shut do... Manual (Trig...
&} Hyper-V Heartbeat Service Monitors the state of this vitual m.. Manual (Trig.., ¥
< >

3. From the Log On tab, Select Log on as Local System Account.
4. Inthe PI Interface Configuration Utility window, select Apply and Play

P to start the primary service (if not already running).

W Pl Interface Canfiguration Utility - FTLDInt1 = O x

Interface  Tools  Help

e x| d[] BRlEe

Interface:  [FTLDT [FTLDINET] > ASIHOT =] Rename

Type: FTLDInt | Rockwel FactonTalk Live Data Pl Data server Connection Status

Description: |Dsfau\l FTLD interface created by the FTH configure wizard. ! ASIHOT FlantPés Rockw
W Wileable

Versions:  [FTLDInt ewe version 4.6.0.60 |Urilnt version 4.6.0.60

5. Select Yes if asked 'Would you like ICU to start this service for you?"
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Return to the Secondary PASS (PASS02B).

1. Select the Interface that was created earlier and click Play P to start the

secondary service.
W Pl Interface Canfiguration Utility - FTLDInt1 = O x
Interface  Tools  Help
NE X » 2R @
Interface:  [FTLDT [FTLDINET] > ASIHOT =] Rename
Type: FTLDInt | Rockwel FactonTalk Live Data Pl Data server Connection Status
Description: |Dsfau\l FTLD interface created by the FTH configure wizard. 7 ASIHOT.PlantPé Rockw

¥ Wilteable

Versions:  [FTLDInt ewe version 4.6.0.60 |Urilnt version 4.6.0.60

2. Select Yes if asked 'Would you like ICU to start this service for you?

Confirm Unit Failover Diagnostics

From an EWS, test and confirm the failover diagnostics from the
Historian server.

1. Go to Rockwell Software > FactoryTalk Historian SE > System
Management Tools.

2. Select Data > Current Values and select the Tag Search & icon.

VR Current\falues - Pl System Management Toals (Adrministrator) - [m] K

File  Wiew Tools  Help

Servers _ (7]
Search 2
Tag Mame Server Collective  Timestamp Walue Engneerng Units  Descriptor

Collective: ASIHOT
asihl  Primary
[ A5IHO2  Secondany

< >

System Management
Search jel
Alarms
Batch
v Data
Archive Editar
Stale and Bad Poir
Interfaces
IT Points
Operation
Puints
Security

Session Record

PASS0MVAdrministrator | piadmin, FTHAdministrators, ..

From Location Action
Tag Mask field Enter *FTLD*
Tag Search Dialog Box Select all tags
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Configure Pl Performance

Monitor

Domain Controller

3. Select Play » to see the online status.

% Current Values - Pl Systern Management Tools (Administrator) - [m] *
File  View Tools Help
Servers @ & m BE @
Search L0 .
Tag Mame Server Callective  Walue Timest: ™
Collective: ASIHO1
ASIHOT-FTLDIRt_1_FTLD_UFOZ_ActivelD asih01 ASIHOT 2 544720
ashll — Primaty 1 ol FTLDIn1_FTLD_UFDZ_DeviceStatus_1 a@hol  ASHOT 0 54420
LI ASIHO2 - Secondany | agiun £TLDIN_T_FTLD_UFO2_DeviceStatus_2 ah0l  ASHOL O 54720
ASIHOTFTLDIRt_1_FTLD_UFDZ2_Heartbeat_1 asih01 ASIHOT 15 544720
ASIHOT-FTLDInt_1_FTLD_UFOZ2_Heartbeat_2 asih01 ASIHOT 8 544720
ASIHOTFTLDIN_1_FTLD_UFOZ_State 1 asih01 ASIHOT  Backup 544720
< > s FTLDInt_1_FTLD_UFD2 State 2 asih01 ASIHOT  Primary 544720
System Management sp.st PASSOT FTLDIN Device Status asih 01 ASIHO Good Bi4s20
Search 2| spstPASSOFTLDIN . Heartbeat asih01 ASIHO 158 844/20
Alarms A | anst PASSOT.FTLDIN Interface Paint Count asih01 ASIHO o 544,20
Batch sp.st PASSOT FTLDINE IO Rate asih01 ASIHOT O 5/4/20
w Data gyt PAS501.FTLDIN . Message Count asih01 ASIHO 42 844/20
Archive Editor .5t PASSOTFTLDInE . Output Bad Yalue Rate asih01 ASIHOT  NoResult  5/4/20
Current Values sy st PASSOT FTLDIRE Output Fate asih01 ASIHOT  NoPResult  5/4/20
Slale andBad | gy st PASSM FTLDING . Soan Class Bad Yalue Fatescl  ash0l  ASIHOT  MoResut 604720
Interfaces < 3
IT Poirks
Operation Session Record
Praints
Serrity o
PASSOT\Adrministratar | piadmin, FTHAdministratars, ..

The Windows Performance Monitor (PerfMon) is a powerful operating system
tool to monitor the health of resource usage and processes on a computer.

The PI Interface for Performance Monitor (PIPerfMon) collects performance
counter data from Windows performance data providers, local and remote,
and sends this data to the Historian server. It’s recommended to use
PIPerfMon in a PlantPAx system.

Create Domain User for PIPerfMon Service

The PIPerfMon service defaults to running in a local account. For PlantPAx
systems with a domain, it’s recommended running the PIPerfMon service in a
domain account. This enhances security and provides access to obtain data for
a performance capture among other domain computers.

The domain user account for PIPerfMon service must be created on the
domain controller. It’s a user account with privileges to run the service on
other computers within the domain.

1. From the Server Manager utility on the domain controller, select Tools >
Active Directory Users and Computers.
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2. Add a new user to the Managed Service Accounts.

] Active Directory Users and Computers s [m] *
File Action View Help
= = B al [ oy e =
e n@ B|Ed=H RelETER
: Active Directory Users and Compu|| Name Type Description
~| Saved Queries
v 3 PlantPAx RockwellAutomation. Delegate Control... 10 items to show in this view.
| Builtin Move...
| Computers Find...
2 Domain Controllers
"\ ForeignSecurityPrincipals * Computer
| Managed Service Accounts Al Tasks ¥ Contact
~ [2] PlantPix
= A Refresh oty
2] Areas
InetOrgPerson
3] Roles View >
m s msD5-ShadewPrincipalContainer
Users Arrange lcons > mslmaging-P5Ps
Line up lcons MSMC Queue Alias
Properties Organizational Unit
Help Printer
< »|| € User >
Create a new chject... Shared Folder

3. Specify these properties for the User.

Item Description
First name Type a name for the‘PI PerfMon service.
IMPORTANT: The ‘PI' preface is the name of the 0SISoft product.
Initials Optional
Full name Type the same name for the Pl PerfMon service.
User login name Zzly;i tﬂ;li 3331: n?;nm?o{gg rthe Pl PerfMon service and click the pull-down to

IMPORTANT  The logon password creates a service user, not a person. The

service user grants access
into memory (buffer).

to system computers for placing data

4. Create a password with the following conditions:

« User cannot change password
« Password never expires

]

] Active Directory Users and Computers - O
Fle Action View Help
# . T TER =1
Lk A1 N RIENCHES Rl R YR 2R Y
T Active Directory Users and Compul| Name N Type Descript
| Saved Queries
v 5 PlantPAcRockwellAutomation Delegate Control... 10 tems to show in this view.
| Bulin Move...
| Computers Find..
21 Domain Controllers
| ForeignSecurityPrincipals New > Computer
| Managed Service Accounts| All Tasks. Y Contact
v (2] PlantPAx
S hre Refesh S
= InetOrgPerson
21 Roles View N
= e msDS-ShadowPrincipalContainer
7 Users Anange lcons > mimaging-PSPs
Line up lcons MSMQ Queue Alias
Propertes Orgarizationsl Unit
Hep Pinter
< >|[€ User
Createanew object.. Shared Folder

202

Mew Object - User

"]

Createin:  PlantPAx RockwellAutomation com./Plant P Ac/Us

2

Password

Corfim password: |u-u-u-

[] User must change password at next logon
User cannot change password

Password never expires

[] Account is disabled

Mew Object - User

3

Createin:  PlantPAx RockwellAutomation.com./Plant P Ax/Users

When you click Finish, the following object will be created:

Full name: PPerfMan
User logon name: PIPerfMon@Plant P Ax. RockwellAutomation.com

The user cannot change the password
The password never expires.

< Back Next >

< Back

Cancel
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5. Assign the PIPerfMon profile as a member of Performance Monitor User.

PiPerfMon Properties ? e
Remote control Remote Desktop Services Profile Dialdin
General Member Of Prafile Environment Sessions
Member of:
M Performance Monitor Users

Configure the PIPerfMon Interface

To use PIPerfMon, you must configure an interface name and a points value
within the FactoryTalk Directory. The points are the limit that the interface
uses based on the number of computers in your system. Each variable - CPU
usage, RAM, disk space —is one point. You can use the number of points up to
20% of your FactoryTalk Historian SE software license.

Configure the interface on the primary historian server.

1. Go to Rockwell Software > FactoryTalk Administration Console and

TRTENT TS e select ‘Network’ for the directory you want to use.
— . . . .
= 2. Goto System > Connections > Historical Data folders > Production
ASHOT Historian and select properties.

IMPORTANT  Be patient because this dialog box could take a few minutes to appear.

3. On the Point Sources tab, type an interface name (such as PerfMon) and
avalue for the points limit.

&) Production Historian - Histarian Server Connection Properties *®
General Licensing  Point Sources
Interface Type Points in Use Lirnit
Rackwel 177 45000
General i] 10000
Interface Type Allocation Puints in Use Limit
FTLD 177 24500 | A
PERFMON 00
v
Delete
@ Exrea] [

The value is the expected number of performance points in the system.
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ASIHO1
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4. Goto Rockwell Software > FactoryTalk Historian SE > Interface

Configuration Utility. and select New Windows Interface Instance from

BAT file.
EA Pl interface Configuration Ltility - FTLDInt1 - m] X
Interface  Tools  Help
Mewe Windaws Interface Instance from EXE... Chrl+N
I Mewy Windows Interface Instance from BAT File.., I Ctrl+l

ﬂ Rename

Meww NGRS Interface Instance..,
Pl Data server Connection Status

5. Select the PiPerMon.bat_new file from C:\Program Files (x86)\Rockwell
Software\FactoryTalk Historian\PIPC\Interfaces\PIPerfMon directory.

6. Select the FactoryTalk Historian server as the host PI Data server/
collective.

7. Enter a Point Source name and an Interface ID number.

£ Pl Interface Canfiguratian Utility - PIPerfivian - O x

Interface  Tools  Help

b =] a6 @

Intertace:  [PIPerfbon - ASIHOT »|  Rename
Type: PlPerftan - | Pl Performance Monitor Pl Data server Connection Stats
Description: ‘ F ASIHO1 PlantPas Rockw
3 ¢ Wileable

Wersions: | PIPerfMan.exe version 2.1.0.83 |Unilnt version 4.6.0.60
m General Pl Host Information

?PEIIIMEH Point Source:  |PERFMON J Server/Collective: |451HO1

ervice

Unilrt PERFMON 2] || Sk Member.  [ahan -

- Falover

- Healh Peints APl Hostname: | asih(1 =

- Performance Counters Interface 10 2 User: piadmin | FTHAdministrators | FTH

- Performance Paints N

L PISDK Scan Classes L= o Sl

i Dissonnected Starup " e ¥ Yersion: 3.4.415.1188

i- Db —————

S Scan Frequency | ScanClass | Par: 5450
10 Rate B
Interface Status LU0 U
" 00:01:00 2

nterface Installation Path

|C “Program Files [«861\Rockwell SoftwareFact:
Interface Batch Filename
|PiPerhan bat

Close

Ready Running PIPerftdon - Installed

IMPORTANT  The Point Source name must match the interface name that you
typed in the Historian Production dialog box in step 3 on page 203.

The Interface ID number must be unique in the system.

8. Restart the interface service.

Create PIPerfMon Diagnostic Health Points

For diagnostics, associate the PIPerfMon interface with the health tags that
monitor a device heartbeat. The heartbeat count helps to determine if the

system is working efficiently. If there’s a stoppage, you can analyze what
prompted the fault or device error.

1. Goto Rockwell Software > FactoryTalk Historian SE > Interface
Configuration Utility and select the PIPerfMon for the interface.
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2. Create the Health Points for PIPerfMon.DeviceStatus.
i Piinterface Configuration Utility - PIPerflian - m] X
Interface  Tools  Help
il =) o BR Ee
Interface:  [PIPerfian -» ASIHI ~|  Rename
Type PiPerfhion ~| Pl Performance Moritar Pl Data server Connection Status
Diescription: | # ASIHOT.FlantPax Rocke
¥ ‘Wiiteable
Wersions: |F‘IPerFMon exe version 2.1.0.68 Unilrit version 4.6.0.60
General Unilnt Interface Health Manitoring Points
PIPerftdon Status | Tagname [ Type | 5cem
Service Mot Created 5.5t 45IHO1.PIPerfton Interface Point Count [UI_POIMNTCOUNT] 0
Unilnt Mot Created _sy.st45IH01 PIPerftdon Heartheat [UI_HEARTBEAT] 0
Lo peveran [0 |
Mok Lreal 5p.3LA erftdon.acan Llass In a
Perloimance Cointér Mot Created  sy.stASIHO1.PIPerfon 10 Rate 0
Mot Created  sy.st.ASIHO1.PIPerfhdon.Message Count Create All 1)
Peiloimance Points Mot Created  sy.stASIHO1.PIPerfon Dutput Fiate 0
FISDK Mot Created sy stASIHO1 PIPerfan Dutput Bad Walue Rate Delete 1}
Discornected Startup | | Mot Created  sy.st.ASIHO1.PIPerfon. Trigger Rate Delete All 0
t.Debug Mot Created  sy.st ASIHO1.PIPerfbdon. Trigger Bad Walue Rat 0
10 Rate Mot Created  sy.st45IHO1.PIPerfMon Scan Class 10 Rate.sc Cata 1}
Interfacs Status Mot Created  sy.st.ASIHO1.PIPerfhdon.Scan Class Bad Value 1)
Mot Created  sy.5t ASIHO1.PIPerfidon.Scan Class Scan Cour Carrect &)1 0
Mot Created  sy.stASIH01.PIPerfdon Scan Class Scars Skir o v
< Rename >
Refresh Snapshots
Refresh Table
To create, delete, conect, or rename a Unilnt Interface Health .
Clase
Ready Running PlPerfMon - Installed

3. Create the Health Points for PIPerfMon.Heartbeat.
4. Goto Service and complete the following information.

From this Section

Action

Installed Services

Move pibufss to Dependencies

Service Configuration

Select Log on as: Domain\Username

UserName

Enter the same user name and password that you initially

Password

created for the service. See Create Domain User for PIPerfMon
Service on page 201

M Pl Interface Configurati

ion Litility - PIPerflvion * - O
Interface  Tools  Help
NE X | d a6 @
Interface: ‘F“PEI'MEH -+ ASIHO
Type: PlPerftan «| Pl Performance Monitor

j Rename

Fl Data server Connection Status

Description: ‘PlantPAx

# ASIHOT.PlantPas Rocke

¥ whiteable
Versions:  [PIPeriMon exe version 2.1.0.88 [irilnt version 4.6.0 60
General Service Configuration
PIPeiftdan Service name: [PIPeritan 1D:[ Sl U e RawEe
i * Auto
M Drisplay nane: ‘F‘I Pertormance Moritor (full version) " Manual
Failover o " NT Service\PIPerftion ' Disabled
Health Paints g i
® [Domain\]UseMame

Performance Counters

Pesfomance Pairts Userhame: [SSTEM\PIPerfmon

Pl SDK P

Disconnected Startup -

Debug Lorirmpassactd Installed services:

10 Rate Dependencies tepi FIBaGen ~
Interface Status q pibasess
pibatch
3 pibufss
PIDirectaryPublisher v
< >
Pl Buffer Subzystem
Close
Ready Running PIPerftdon - Installed

5. Go to Control Panel > Administrative Tools > Services.
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6. Select PI Buffer Subsystem, and set the Startup type to Automatic.

7. Restart the interface service from the dialog box.

. Services (Local)

Pl Buffer Subsystem

Start the service

Harme Description

Status

Startup Type

Log On s

ElNetwark Setup Service
“Ek Netwark Stare Interface
L Offline Files

3 Gereral LogOn  Recovery  Dependencies

&k OpcEnum

&k Optimize drives Service name: pibufss

Ll Performance Counter [J Display name:
&) Performance Logs 8 4
&:Phone Service Deseription

: Pl Message Subsystern Path to executable:

%Pl Metwark Manager

&
e
g
%
L PI-Buffer Server Startup type:
G Pl-Buffer Server x64
ELPIPC Log Server
CLPIPC Log Server =64
ElPlug and Play

Service status:  Stopped

&k Portable Device Enume
L Power
&) Print Spooler

&k Printer BExtensions and ficwnifisie

Start Stop

Pl Buffer Subsystem

Pl Buffer Subsystern Properties (Local Cormputer)

Fause

"'C:M\Program Files\Rackwell SaftwarehFactoryT alk Histariant PIPCYbintpibul

Fesume

You can specify the start parameters that apply when vou start the service

Ll Problern Reports and S Start parameters: ‘

“&):Program Compatibility|
£k Quality Windows Sudi

E1 Badin hansnarnant Sa

\ Extended /(Standard

Cancel

Apply

[<

Test the PIPerfMon Interface

From the primary Historian sever, verify that the PIPerfMon interface has a
good working status.

1.

ASIHO1

W

Go to Rockwell Software > FactoryTalk Historian SE > System
Management Tools.

In the left, top pane, select the appropriate server with the interface.

In the lower, left pane, go to Data folder > Current Values.

After you search for tags you need, the Value category displays the

health state of the interface and the number of seconds between the
heartbeat counts.

File  Wiew  Tools

Servers

Collective: ASIHOT
asihl  Primary
[ A5IHO2  Secondany

< >

System Management

Alarms ~
Batch
v Data

Archive Edito
Stale and Bad |

Interfaces

IT Points

Operation

Puints

S X

Search 2

Search jel

VR Current\falues - Pl System Management Toals (Adrministrator)

Help

X% roBE @

Tag Mame Server
ASIHOT-FTLDING_1_FTLD_UFO2_ActivelD gzl
ASIHOT-FTLDIn_1_FTLD_UFO2_DeviceStatus_1 asihl
ASIHOT-FTLDIn_1_FTLD_UFD2_DeviceStatus 2 asihil
ASIHOT-FTLDIN_1_FTLD_UFO2_Heartbeat_1 asihll
ASIHOT-FTLDIn_1_FTLD_UFO2 Heartbeat_2 asihll
ASIHOT-FTLDInt_1_FTLD_UFD2_State_1 asihl
ASIHOT-FTLDIN_1_FTLD_UFO2_State_2 gzl
2.5t PASSOT.FTLDIn .Device Status asih0l
sy.3t PASS01. FTLDInH Heartbeat ashll
5.5t PASS0T.FTLDINK Interface Point Count asihil
2.5t PASSOT.FTLDIALIO Rate asih0l
sy.3t PASS01.FTLDInN Message Count ashll
5.stPASS0T.FTLDINN . Dutput Bad Value R ate asihil
2.5t PASSOT.FTLDIAH . Output Rate asih0l
sy.3t PASS01.FTLDInN Scan Class Bad Value Rate.sc0 ashl

<

Collective
ASIHOT
ASIHOT
ASIHOT
ASIHOT
ASIHOT
ASIHOT
ASIHOT
ASIHOT
ASIHOT
ASIHOT
ASIHOT
ASIHOT
ASIHOT
ASIHOT
ASIHOT

Value

2z

0

0

15

9

Backup
PFrimary
Good

15

0

0

42

Mo Result
Mo Result
Mo Result

Timest: *
5/4/20
5/4/20
B/4/20
5/4/20
5/4/20
B/4/20
54720
5/4/20
B/4/20
54720
5/4/20
B/4/20
5/4/20
5/4/20
B/4420 w
>

Session Record

PASSO1VAdmministrator | piadmin, FTHAdministrators, ...
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Enable the PIPerfMon Interface on other Computers

After the PIPerfMon interface is verified to work correctly on the Historian
server, you can configure the other servers and workstations that you're
collecting data. This requires the domain account to allow PIPerfMon to be
added, create a Windows Firewall rule for access and enable the Performance

Counter DLL Host service.

1. Goto Control Panel > User Accounts and define this information.

Action

Select Manage User Accounts

Select Add

Domain
Controller  PASSO1
= From this Page
D D i ? Control Panel\User Accounts
- User Accounts
||I I\I ||| |I X =

- -
_?‘ 7 Add a User

PASS02A
PASS02B

ASIHO1
ASIH02

Enter the same user name and Domain that you did to grant
system access for the PerfMon service. See step 4 on page 205

What level of access do you want to grant this
user?

Select Other and choose Performance Monitor Users from the
drop-down.

2. Go to the Control Panel > Windows Firewall and define

this information.

From this Page

Action

Control Panel\Windows Firewall

Select Advanced settings

Advanced Settings

Create a new inbound rule.

@& WWindaws Firewall with Advanced Security
File  Action  View Help

o= 75 =2 HE

G Windowes Firewall weith Sdwarnce B i =63
&3 Inbound Rula< ———
&Y Outbound F Mews Rule..,

LT i .
<m Connection - Profile > |

B Manitaring

New Inbound Rule Wizard: File Type

Select Port

New Inbound Rule Wizard: Protocol and Ports

Select TCP and enter the Specific local ports: 135 and 445

New Inbound Rule Wizard: Action

Select Allow the connection

New Inbound Rule Wizard: Profile

The rule applies to Domain, Private, and Public.

New Inbound Rule Wizard: Name

Enter a name for the rule.
For example, Perfmon Connection

3. Go to Control Panel > Administrative Tools > Services and find
Performance Counter DLL Host.
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4. Right-click Performance Counter DLL Host and select Properties.

2 Services (Local)
Performance Counter DLL Host Marne Description Status Startup Type Log On &s 2

£} Offline Files
&} 0pcEnum

Start the service Performance Counter DLL Host Properties (Local Computer) x

Cs Optimize drives

General LogOn Recovery  Dependencies
Description:
Enables remote users and 64-bit
processes to query performance

Gk Performance Logs & Alert: Service name: PerfHost
‘& Phone Service

counters provided by 32-bit DLLs. If Display name: Pertaimance Counter DLL Host
this service is stopped, only local {54 P Buffer Subsystern -
users and 32-bit processes will be €1 PI Message Subsystem Description Enables remate users and 64-bit processes to query A

b e peiformance counters provided by 32-bit DLLs. IF
able to query performance counters 5Pl Metwark Manager

provided by 32-bit DLLs.

£ Pl-Buffer Server Path to executable:

£ PI-Buffer Server x64 C:Awfindows\Sysiw/owBd\perfhost. exe

‘£ PIPC Log Server

bt Startup type: -Autumallc s
CHPIPC Log ServerxBd

&4 Plug and Play

‘&h Portable Device Enumerat

ShPower Service status:  Stopped

gk

S Print Spooler Start Stop Pause Fiesume

&k Printer Extensions and Mot
S Problem Reports and Salu “You can specify the start parameters that apply when you start the service

&} Program Compatibility &3 from hefe,

& Quality Windows Audio Vi Start parameters:

£} Radio Management Servic
% Remaote Access Auto Con
4 Darnnta firracs Conmackio sl =

5. Select Automatic as the Startup type.

PI Buffering helps to protect local data in the event a client loses connection to
the Collective.

Create Domain User for Pl Buffer Service

The PI Buffer service defaults to running in a local account. For PlantPAx
systems with a domain, it’s recommended running the PI Buffer service in a
domain account. This enhances security and provides access among other
domain computers.

The domain user account for PI Buffer service must be created on the domain
controller. It’s a user account with privileges to run the service on other
computers within the domain.

1. From the Server Manager, click Tools and choose Active Directory Users
and Computers.

2. Expand your domain folder, right-click Managed Service Accounts and
choose New>User.
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3. Complete the User text boxes.
File Action Wiew Help
=2 am S0/ XOEBmtataTa%
: Active Directory Users and Computers [H| name v Type Description
| Saved Queries
v 24 PlantPAx RockwellAutomation.com hew Qtyect= e
| Builtin
| Computers 1 _
=1 Domain Controllers o Createin:  skwellAutomation com/Managed Service Accounts
~| ForeignSecurityPrincipals
| Managed Service Accounts 2 .
v B PlantPAx First name: ‘PIEuﬂerSarwce | Initials ‘ |
o Areas Last name: ‘ |
5| Roles
5] Users Full name: |PiBuferService |
= Users
User logon name
@PlantP Ax RocknellAutomatior
User logon name {pre-Windows 2000):
‘PLANTPAX\ | |p|buﬁ‘ersew|ce |
£ 2] < Back Next > Cancel | [
Item Description
First name Type a name for the Pl buffering service.
IMPORTANT: The ‘PI' preface is the name of the OSISoft product.
Initials Optional; you can leave blank.
Full name Type the same name for the Pl buffering service.

User login name

and click the pull-down menu to select your
domain folder.

Type the same name for the PI buffering service

User logon name (pre-Windows 2000)

buffering service.

Use the SYSTEM\ default and type the same name for the PI

IMPORTANT The logon password creates a service user, not a person. The

service user grants access to system computers for placing data
into memory (buffer).

4. Type your password twice.

Mew Object - User

; Create in:

&

PlanitP Ax Rockwell Automation.com/Managed Serv

Password

Corfim password:

User cannot change password

Password never expires
[ Account is disabled

[[] User must change password at next logon

< Back

Next > Cancel

5. Make sure that the following boxes are checked:

« User cannot change password
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« Password never expires (indefinite service for system access)

New Object - User X

.;_} Createin:  PlantPAx RockwellAutomation.com/Managed Service Acc
!

When you click Finish, the following object wil be created:

Full name: P|BufferService
User logon name: pibufferservice @Plant P Ax Rockwell Automation .com

The user cannet change the password.
The password never expires

< Back Cancel

Create Security Mappings

On the Historian server, associate the service user identity with the Historian
mapping and trusts.

1. Go to Rockwell Software>FactoryTalk Historian SE>System
Management Tools.

The PI System Management Tools window appears.

3 PI System Management Tools (Administrator) = I
File  View Tools Help
|Servers }i X & ERl=EC]
Seardh gl
Servers appings | Trusts
ASIHOT Mapping Server Collective Description Pl ldentity Enabled
2 Add New Mapping -
sysem oot Windovs hccoun
2 S s I~
I Alams
I Batch Description:
I Data
I Interfaces
b IT Points Server: ASIHD1 v
g Pldrs
poous fentity: equirex E|
Digital States [ Mapping is disabled
Performance Equations
Paint Builder Cancel
Foint Classes
Foint Source Table
Totalizers
4 Security
Database Security
Firewall

Session Record

| SYSTEM\Administrator || piadmin

2. Do the following:

« Under Servers, check the server that you want to set the
security settings

« Under System Management Tools, choose Mappings & Trusts
« Click Add Mapping icon

« From the Add New Mapping dialog box (right pane), click
Browse (ellipsis '...")
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3. Select the PIBufferService user that you created earlier.

Select Users, Computers, Service Accounts, or Groups x
Select this object type:
|User5, Groups, or Builtin security principals | Object Types...
From this location
[PlantP Roclavel utomation com || Locatons..
PlBufferService pibufferservice @PlantP A Rockwel Automation com Checlk MNames
Advanced... Cancel

4.

from the Type pull-down menu.
5. Select a desired identity.

g Add New Mapping

‘windows Account: |SYSTEM\pierf'ferser\ric:e

| [

[5-1-5:21-3778824255-40441222

W

‘windows SID:

Diescription:

Server [astHO1
Pl Identity: | Required

["] Mapping is disabled

edte Cancel

6. Click Create.

Your security mapping should look similar to the example.

Select Pl Identitiy, Pl Group, or Pl User

Select from server ASIHO1

Type

Defining against a Pl Group is not the preferred methed of configuring a Pl
Mapping. Instead, define against 2 Pl Identity where possible.

Mame Description

8 FTHAdministrators  The administrative Pl Group fomerty named “piadmin”
4 FTHENgineers

1 FTHOperators

B piusers

The generic Pl Group formerly named "piuser”

I o

l[_cance

On the Add New Mapping dialog box, click Browse and select a group

Search jel

Collective: ASIHO1
asih0l  Primary
[ #481H02  Secondary

System Management Tools
T
Alarms
Batch
Data
Interfaces
IT Poinks
Operation
Praints
~ Security
Database Security
Firewal
|dentities, Users, & Groups
Mappings & Trusts
Security Settings

/] Mappings & Trusts - Pl Systern Management Tools (Administratar) = m]
File  View Tools  Help
Servers

3 X B4 E e

Mappings  Trusts

X

Mapping
& SY¥YSTEM'\pibufferingservice

Server
asihll

Collective Description Pl Identity  Enabled

ASIHD piuzers Tiue

<

Session Record

| ASIHOT\Adrministrator | piadmin, FTHAdministrators, . |
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Configure the Buffering Interface

Configure buffering for the server that you're connected, such as PASSo2A

and PASS02B.

1. Goto Rockwell Software>FactoryTalk Historian SE>Interface

Configuration Utility.

The PI Interface Configuration Utility dialog box appears.

2. From the Tools menu, choose Options.

3. Click 'Load interfaces from a selected list of PI Data servers'.

ER options
Loading Load Interfaces from these Pl Servers/Collectives
Marning Canventions " Load interfaces from default Pl Data server only
Eehug B " _Load interfaces fiom all known Pl Data servers
eserved Point Sources
# Load interfaces from a selected list of Pl Data servers
Service
BAT Files
W arnings

*

ok | Cancel

Apply

Ready

Select a server box.
From the Tools menu, choose Buffering.
Message windows appear.

N o oH

Buffering Manager wizard.
8. Complete the Buffering Manager wizard.

Click Yes, and then 'Continue with configuration' to initiate the

Item Description

Detected P! Interfaces

Select the Pl interfaces that you're buffering and click Next.

Pl Data Archive security

Click Change, and enter the user name and password that you
created earlier. Click Next.

Click Next twice, and then ‘Exit new installation wizard'.

Buffering Manager message windows

Click Yes and OK to confirm PI ICU dependency.

9. From the PI Interface Configuration Utility dialog box, click Tools menu

and choose Buffering.
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10. Verify that your information matches the dialog box example.

@ Buffering Manager

P 0 events in queue

Logical Servers

(L
\_®

ASIHO

= O X
File View Help
Buffering Manager
Configuration, monitoring, and troubleshooting of buffe
Global
b @ Global Buffering Status Pl messages
There are no reported issues -

p 10.1 months estimated buffer capacity

queued events for all sen

B 2803 total events sent (2

ted time until data loss

11. Close the Buffering Manager dialog box.

12. From the PI Interface Configuration Utility dialog box, click Tools menu
and choose Options.

13. From the Options dialog box, check 'Load interfaces from a selected list
of PI servers' and make sure that the server is checked.

Configure the Pl Buffer Service Logon

The following procedure applies only if the Change Option wasn’t available on
the New Install Wizard dialog box.

1. On the PASS server, right-click Start menu and choose Computer

Management.

2. Complete the New Install Wizard dialog box.

Item

Description

Local User and Group (left pane)

Open Local Users and Groups, right-click Groups and choose Administrators.

Add name

Click Add and type
SYSTEM\pibufferservice.

Click Check Names, and click OK.

Assign log on service account

From the Start menu, click Programs and choose Administrative Tools>Services.

Right-click PIBuffer Subsystem and choose Properties.

On the Log On tab, click Browse.

Click Locations, choose ‘Entire Directory’, and click OK.

Enter SYSTEM\pibufferservice and click Check Names.

Click OK.
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The procedures in this section use the 'System Management Tool' and PI
System Explorer within FactoryTalk Historian software. The tool is available
for Historian Asset Framework management computers, such as server, node
interface, and EWS.

Microsoft® Excel® software is required to enable the bulk editing capability. An
additional license is required to use PI Datalink.

We also document how to manually create Historian tags, digital states, and

C

Asset Framework. We recommend using the section “Configure Asset
Framework Databases with the PlantPAx Configuration Tool” on page 230 for

creating bulk tags for large process systems.

Create Digital States

Historian points can be defined as analog or digital. Digital points can be used
to enumerate the process states, thus creating a relationship between the value
and the text state name. For example: 1= Good.
1. Go to Rockwell Software > FactoryTalk Historian SE > System
Management Tools and select Points > Digital States

2. Add a Digital State Set to the server.

i Digital States - Pl Systern Management Toals (Adrministratar) - m] X

File  Wiew Tools  Help

Servers 7 @ 2 B&EE A @
’ﬁ‘ v glh[l'l State State Name

Collective: ASIHOT
asihl  Primary
[J A5IHO2  Secondany

q InterfaceParametel
[ InterfaceParametel

System Management Toals

Search R Y Modes
Alarms [(Y Phases
Batch |?. pialarm33
Data [y pislameontrol
Interfaces |E pisqealarm
IT Paints [GY SvsSTEM
Operation 5 UFO_State

~ Puints

Digital States

Perfarmance Equations
Paint Builder Session Record
Point Classes
Paint Source Table
Totalizers
Security

ASIHOAdministrator | piadmin, FTHAdministratars, ...
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ASIHO1

Source Quality Data Examples

Parameter | Data Type | Description
Final PV source and quality.
GOOD 0=1/0Olive and confirmed good quality
1=1/0 live and assumed good quality
2 = No feedback configured, assumed good quality
TEST 8= Device simulated
9 = Device loopback simulation
10 = Manually entered value
UNCERTAIN 16 = Live input, off-specification
SrcQ SINT 17 = Value substituted at device/bus
18 = Value substituted by maintenance (Has and not Use)
19 = Shed, using last good value
20 = Shed, using replacement value
BAD 32 = Signal failure (out-of-range, NaN, invalid combination)
33 =1/0O channel fault
34 =1/0 module fault
35 = Bad I/O configuration (for example, scaling
parameters)
?ﬁ Digital States - PI Systern Management Tools (Administraton - [m] *
File  View Tools Help
Servers ua By > & D = B4EE @ Murnber of states: 3
SE:T T Al & asih0l Gtate State Name
ollective: 9 Batchact |
S A Ir:;laczParamelel 1] 140 I!va and confirmed good qua.hly
[ #8IH0Z  Secondary M IntertaceParameter | 1 140 live and assumed good quality
1] InterlaceParameter | 2 Mo feedback configured, assumed good quality
System Management Tools ‘ {otetose R —
S:Sf(fl S ] mlue‘jl:;asceStatus 'W‘
Alarms I ) ¥ Delete State  Chrl+X
Batch 4 Phases
Data 24 pialarm33
Interfaces -8 pialarmeantral
IT Points Y pisqalaim
Operation 8 SYETEM
~ Paints 8 UFD_State
Performance Equations
Point Builder Session Fecord
Faint Classes
Pairt Source Table
Totalizers
Security
AZIHIT\Adrministratar | piadmin, FTHAministrators, ...

Import Digital Sets and States

To save time entering common Digital Sets and States, templates are available

to import.

A Process Objects Digital Set is available from the PlantPAx Process Library.
After downloading the library, the Templates folder contains Historian files.

The PIPermon Digital States are available from a local template in the
installation directory.

1. Goto Rockwell Software > FactoryTalk Historian SE > System
Management Tools and select Points > Digital States
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2. Select Import.

B Digital States
File  Wiew Tools  Help
Servers (o) ) : 2 BEER @
Search Pl "
1B asih0l i
Collective: ASIHOT [y Batchact R Import Digftal Sext) = *
asih0l  Primamy 1 InterfaceParan £omma delimited file with sets and states:
[] ASIHDZ  Secondary Inieiface el =
Y InterfacePara
q InterfaceParan  Fila Preview
System Management Tools Y InterfaceStatu|  &arg in fle:
Search b Y Modes
Alarms q Srcl Set
Batch Y Phases
Data Y pialarm33
Interfaces 5 pialarmcontrol
IT Paints Y pisqealarm
Operation 5 SYSTEM Owenprite Options
~ Points 8 UF0_State (®) Do ot ovenarite existing sets
Digital States () Impott set with a different name if set already exists
Performance Equations () Prompt before avenariting existing sets
Faint Builder Session Record (O Automatically ovensrite existing sets
Point Classes
Point Source Tahle Import set{s] to server: | asih01 i
Totalizers
Secuity Create Setls) Close
ASIHOAdministrator | piadmin, FTHAdministrators, ...

3. Select the PI_PIperfmon_DS.csv file for the Comma delimited file with
sets and states. The file is located in C:\Program Files (x86)\Rockwell
Software\FactoryTalk Historian\PIPC\Interfaces\PIPerfMon.

4. Select Create the Set(s).

A minimum number of the recommended Digital Sets is created. This
procedure does not create the basic Digital Set file for all Process
Objects digital states.

P Impart Digital Set(s) m] X

Comma defimited file with sets and states:
|E “Program Files [x86Fockwell 5 oftware\Factory T alk Hlstuﬂl

File Preview
Setsin file: 1

Set State 0 State 1 State 2
P\F‘erfMon NOT INITIALIZED  OFFLINE  NO ACCESE

< >

Overwite Options

@ Do not ovenwite existing sets

() Impart set with a different name if set alieady exists
() Prompt before avenwriting existing sets

() dutomatically ovensite existing sets

Import set(s) to server: | asih0l ~

Create Setfs) Close
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EWS

L]

S Rmw i n
TEESTIOIT OO0,

.

ASIHO1

Create Individual Historian Poi

nts

You can create historian points by using the FactoryTalk® Administration
Console. Define these points from an engineering workstation or an Historian
server. The following is one example.

1. Go to Rockwell Automation
Console and select the netw

Software > FactoryTalk Administration
ork for the type of FactoryTalk directory.

2. Inthe Explorer pane, select an application (PlantPAx is our example) and
choose Add Individual Historian Points.

Explarer

=45 Network (PASSOT)
&; FTviewDemo
&; InstantFizz

Backup...
Resource Editor..,
Security..,

Properties...

o o (TN
[ Delete
=@ Syst
@ & Mew Area..,
e Add Mew Server
[:l C Discover Historian Paints...
s b I Add Individual Historian Points,., I
=@y
m Lagical Name
=T

" Application [ Communications |

3. Onthe Add Historian Points dialog box, select Browse Tags.

4. Inthe Tag Browser window,

select an object tag (TTo1001 in the example)

in the Folders pane on the left side of the window.

& Tag Browser X
Select Tag(s)
Folders Cantents of Asea/Dala:LGXCO1/Onine/” 101001
%1 PFDC_FaultCodi~ | Name Access Rights Deccription
-] Program:fireall .f Val ReadQnly
' : Program:Diagnc e Val_Fault ReadOnly
w0 Pregram:Task A || & yal Wikilim  ReadOnly
i 51 gfﬂgfﬂ”“;“t-i & Val_HiLim ReadOnly
b= pmgram T“k’E @”Val_\npw ReadOnly
wid P"‘-‘g""‘“jr“k-E & Vsl lolim  ReadOnly
- Program:Task | & Vsl lololim  ReadOnly
% (£ Program:Task_F
K= - & Val_Mode ReadOnly
£3 I Program:Task_C ts?'\" 1 Noti ReadOnl
#-_] Program:Task_k- ? ST Fadhnly
- SMC50_FaultCo Val_Owner ReadOnly
o encEim Faute || & VALPVEUMax  ReadOnly
H _ @g’ Val_PYVEUMin  ReadOnly
i et | & Vel PYMaxC... ReadOnly
v | & valPvMinC... ReadOnly
Refresh All Folders Taqg filter: ‘ ~ ‘ Add Tagls) to List
Selected tag(s]
frea/Data:[LEXCOTTON001 Va8l
Mameansss i Remove Clear
Cancel Help

5. Inthe pane on the right side
tag to configure as a Histori

of the Tag Browser window, double-click the
an Point.

Val (Process Variable Value) is the example.

Select Add Tags to List and OK to accept the tags in the list.

Go to Rockwell Software > F
Management Tools.
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8. Inthe Servers Pane (or the Servers and Collectives pane if you've a
collective), select the historian server.

9. Select Point Builder and search for tags.

m Paint Builder - PI Systern Management Tools (Sdministrator) — [m] *
File  View Tools Help
Servers &k B @ Qpoints
Search 2
Collective: ASIHOT Server NstaIuss Point Source  Foint Type  Point Class  Descriptor
asih0l  Primary
[JAsiH02  Secondary Gereral  Archive Classic Security  Spstem
: R . -
System Management Tools L l:l GRS Sewver |0l
Search 2| Descriptor |
';{:S‘S StoredValues. | FAealimedala | Poirt Source Point Class: | classic ~
Data Paint Type: Float32 ~| Digital Set:
Interfaces
IT Paints Eng Units: [ Display Digits:
Operation
i Exdesc: | |
Digital States Source Tag: | | @
Performance Equations
Paint Builder
Faint Classes
Pairt Source Table Session Record
Totalizers
Security

| ASIHOTYAdministrator | piadmin, FTHAministrators, ... |

10. In the Tag Search window, type the Tag Mask and select Search.

You can use an asterisk (*) for a wildcard. The point name and enti
path appear on the Point Builder window.

11. Select the tag and select OK.
12. Select the tag and select Rename.

13. Enter a new name in the Rename PI Point dialog box.
The name must be modified as OPCTopic.Backingtag.parameter in
order to populate a historical trend in the PlantPAx faceplate. In the
following example it isLGXCo1.TTo1001.Val.

14. Inthe General tab of the Point Builder dialog box, enter a tag description

and engineering units.

General f Archive | Classic | Security | System |

re

Name: LGXCO1.TTO1001.Val | [Rename | Fi server:
I Poin scurce:
Foint type: Digital set:

I Eng Uinits: |C I | Display digits:
Exdesc: | |
Source tag: | |
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15. In the Archive tab, configure the range (Zero and Span), typical value,
and all exception and compression data for the historical point.

| Genemll Archive I Classic I Security I System |

| Typical value: | 85| Zero: | -2DD| Span: 1050 |
Scan Archiving Step Shutdown Compressing
®0n ® 0n 2 on ® 0n ® 0n
Ooff Oof ®off Oof Oof

Exception Deviation

Compression Deviation

| 0.25] [Eng. Units |

| D.5| |Eng. Units v

Day H  Min Sec

Min. Time: ] mmm

Day H  Min

Min. Time: mm

w
@
3]

Mox Tne: [0 o 1] 0] MacTme:[ 0] 3]

IMPORTANT  Usually, Minimum Range Value = Zero, Span = Maximum Range Value
minus Minimum Range Value. The Typical Value is between the
Minimum Range Value and the Maximum Range Value.

16. Select the Classic tab, to view the historical tag path (instrument tag) that
includes the Data server name.

This example shows the FactoryTalk® Linx name, PlantPAx_DAT.
The historical point link is broken if any change is made to the FactoryTalk
Linx application name.

| General I Archive || Classic N Security I System |

Location1: Conversion factor: Userlnt1: Ijl
Location2: Ijl Fiter code: Ijl Userlnt2: Ijl
Location3: Square root code: Ijl UserReal1: Ijl
Locationd: Total code: Ijl UserReal2: Ijl

Location5: ljl

Instrument tag: | PlantP A« Area/Data:Plart P Ax_DAT:[LGXCO1TTO1001.Val |

Monitor Historical Data

From the primary Historian server, use the PI System Management Tool to
verify Historical data has good values.
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1. Go to Rockwell Software > FactoryTalk Historian SE > System
Management Tools and select Current Values and select the search

button.

R Current Values - Pl System Management Tools (Administrator) — [m] *®

File  Wiew Tools  Help

Servers X% b o |5 @ @

Coll ASIHOT Tag Mame Server Collective  Value Engineering Units T
Sl T el ashDl  ASIHDI 2239998 E
asih0l  Primam

[ 45IH02  Secondary

Sustem Management Tools
Search 2
Alarms
Batch
~ Data
Archive Editar
Stale and Bad Points
Interfaces
IT Paints
Operation
Faints
Security Session Recard

< >

ASIHONAdministrator | piadmin, FTHAdministrators, ..,

2. Enter atag mask or an asterisk (*) for all tags.
3. Select any tags that you wish to monitor.

4. To see values change as they periodically refresh, select the Play #
button.
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Historian Asset Framework

Define Digital Historical Points

The digital set is available only to a digital points type. The FactoryTalk
Administration Console automatically creates a Float32 (Real) point type for
each new point.

1. Goto Rockwell Software > FactoryTalk Historian SE > System
Management Tools

2. To be able to change the digital set, select Digital for the Point type and
then select a Digital Set (SrcQ in the example).

m Point Builder - Pl Systern Management Tools (Administrator) [m] X
File  Wiew Tools  Help

Servers @ &8 € e 2 points

Search P Server  Point Point Source ~ Point Type  Point Class  Descriptor  Point Secy
Collective: ASIHOT ashDl  TTO1001.5rcQ@ FTLD Float32 classic piadmin: Af

asih01  Primany asih1  TTO1001.Val FTLD Foat32 classic piadmin: Al

[ 45IH02  Secondary

Sustem Management Tools
Search 2
Archive Editor ~
Current Values
Stale and Bad Points
Interfaces

IT Paints < >
Operation
v Puaints ‘ General |Nchive | Classic | Security I System |
pidiel Stalen Name.  [TTOT001Sw@ | [Rerame | i Server. [zsn0i %
Perfarmance Equations
Faint Builder Descriptor: |Tempemlure 0o
Point Classes
Point Saurce Table Point class: |classic Point source: |[FTLD
K TD.EE‘IZEW w | Point type: |E_ Diagital set:

P_DoseFM_Val_Fault
ASIHONAdministrator | piadmin, FTHAdministrators, .., P_DoseFM_Val_Sts
i ¥ e arer i

3. Select the Save | icon to store the Historian point.

Use the FactoryTalk Historian Asset Framework to build and deliver model-
driven analysis and reporting solutions.

Configure the Connections to the Servers

When a Historian Collective is used, the Asset Framework server and PI
Analysis Service must be installed on a separate computer, such as a dedicated
SQL server via the AppServ-SQL virtual template.
1. Goto Rockwell Software > FactoryTalk Historian SE > System Explorer
(64-bit) and select File to choose Connections.

2. Select the data collective (ASIHo1) and choose Properties.

Servers O X
) Add Asset Server @ Add Data Server @ Connect © Setas Default 25 Properties @ Buffering Manager =
Fiter g
Mame Hast User Buffer Status Description Type Default Datab...
9 ASTHL ASTHOL Iot Configured &
S ASIHOY Add Data Server Asset Server FlantP i
B Add Bsset Server
S Connect
®  Connect s,
©  Connectto Primary
©  Connect to Collective Member..,
[#] Refresh
> Remaove..
Buffer stal 22 | Properties I Close
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3. Rename or configure this connection as necessary for your system.

5F Pl Data Archive Properties [m] *
General | Collective
Hame: [astHo1 | Rename
Description: ‘ |
Host: ‘asihUl.PIantPAx.RuckwellAutumatiUn.cUm ‘ Fort: |545El |
Connection Timeout: ‘ID | seconds
Data Timeout: 60 | seconds
ol [b4247633-Fd77-4164-aaal-26370007Fbfc |
Time Zone: ‘(UTC-US:UU) Eastern Time (US & Canada) |
versian; [34415.1188 |
Aliases: ASIHDZ2 e
x
Connect
Cancel Apply

4. Select the Asset Server (ASISo1) and choose Properties.

Servers O X
i Add Asset Server @ Add Data Server © Connect o Setas Default 25 Properties @ Buffering Manager

Fiter

Mame Host User Buffer Status Description Type

@ asiHol §  Add Data Server fisset Server PlantPax
B Add Asset Server
©  Connect

B Connectés..,

©  Connectto Primary

©  Connectto Collective Member..,
[#] Refresh

> Remove..

Buffer stal [§ Properties | Close

5. Rename or configure this connection as necessary for your system.

7 PIAF Server Properties [m] x

General  PlugIns  Libraties Identities  Mappings  Counts

Hame: [asmot | Rename
Descripkion: | |
Host: |Inca\hﬂst | Port: |5457 |
Account; |admimstratnr | Timeaut: |SDD | seconds
I |e75fd041-a530-4745-bSFe-Fob197d07 062 |

Time Zone: |(UTC-EIS:UU) Eastern Time {US & Canada) |

Yersion: |EENEF:2‘9.5.EEEE] Database:2,9.5.8363 |

Aliases: localhost 2

x

Extended Properties (0} Security

Configure Active Directory Access for Contacts

Conneck

Cancel Anply
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Import Asset Framework Templates

An asset framework provides a means to organize your process equipment
assets. Asset Framework Templates are provided in the process library. This
download is available online from the Product Comparability and Download
Center (PCDOQO).

1. Goto Programs > Rockwell Software > FactoryTalk Historian SE >
System Explorer (64-bit).

IMPORTANT  Steps 2 and 3 are only performed the first time that you name the
database.

2. Select Yes from the Create Database dialog box to create a user database.
Enter the name of the user database.

Select Library in the lower, left pane, select the database name and
choose Import from File.

@ W ASIHOT\PlantPAx - Pl Systerm Explarer (Sdministratary m] *
File  ‘iew Go Tools Help
@ Database [F Queny Date ~ © & | O back H, CheckIn %3 o [#]Refresh @) New Template ~
Counts
[#] Refresh
[Plantpax |
L Import fram File... I | |
. -
~[{EL  ExparttoFile..
e [asmo1 | =
H, Checkin Extended Properties (0 Security
k) Unda Check Out

Renarne

Audit Trail Events..,
5 Security.,

= Properties
(3 Elements

== Event Frames

| Library

e Unit of Measure

42 Contacts

PlantPAx Modified:3/12/2020 7:1%:58 AM OwnerASIHOTAdministrator

5. Browse in your system files to the
(RA-LIB) AssetFramework_Templates .xml file and open the file.

Q@

File  Wiew Go Tools  Help
@ Database [T Query Date ~ © & O back H, CheckIn <3 v [#] Refresh | @ New Template -

Library |PIantPAx
&8 Plantpax —
= Templates - =

[~ [ Element Templaty
EA% Event Frame Ten  File: |\DownIoads\PIantPAforocesstlbrary\Tools & Ukilities\Histarian ‘I I

- Model Templates

- ¥ Transfer Templat Open %
- [y Enumeration Sets

W S R errie Tories « v <« Tools & Utilities » Historian v O Search Histarian -l
Tables T

- ) Table Connections Organize v Mew folder =~ [ 0

(=5 Cl Cateqgories e -~

- (@] Analysis Categar Mame Date modified Type

L (21 abbvib ke Cabean st Quick access
2>

lj (RA-LIB) AssetFrarmework_Termplates w1, /2272019 2:28 1 ML Dac

5 PO [ Desktop

( Elements l- Downloads

WT || Documents

1 Library =1 Dichirac e BC >
wn Unit of Measure File name: | (RA-LIB) AssetFramewark_Templa V‘ sl files (*.ml) ~

&4 Contacts Cancel

PlantPAx Modified:2/12/2020 7:1

There are these template files:

- Base Asset Framework Template File for standard Asset Framework
functionality for the process library, release 4.1 and 5.0.
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- Advanced Asset Framework Template File for use with SQL Server

Reporting Services reports. These objects use the base template, with

additional parameters to enable reporting functionality. For more
information, see PlantPAx SQL Process Object and Alarm Reports.
6. Accept the default import options.

The database now contains the Library object templates.

H, CheckIn <3

o ] Refresh | @@ Mew Ternplate ~

Elernent Templates
Group by [] Cateqory
Filter 2~
Mame | Description Category Typé@ | ()
@ C_Perfmon_ASIH | Historian Computer Perfomance Monitor Computer Element.
[ C_Perfman_ASIS SGL Server Computer Perfomance Monitar Cormpuker Element
[ C_Perfmon_PASS | PASS Computer Perfomance Monitor Camputer Element
HL_crU Processor Utilization iZontroller Element.
(% L_shorteut RSLinx Enterprise Sharkout Computer Element
B P_AIn Simple Analog Input 10 Processing Element
(G P_AInAdy Analog Input Advanced 10 Processing Element.
(G P_AInDual Dual Analog Input 10 Processing Element
[ P_AInkult IMulti Analog Input 10 Processing Element
[ P_A0ut Analog Oubput 10 Processing Element:
[ P_D45D Discrete Control 4 States Walves Element
& P_DBC Deadband Contral Regulatary Ca... Element
&P _n Digital Input 10 Processing Element.
(G P_DInAdy Digital Input Advanced 10 Processing Element
(B P _Dose Dasing Contral Procedural Co... Element | o

D WASIHOT\PlantPi - PI Systern Explarer (Administratar)
File  Wiew Go  Toals Help
@ Database [H] Query Date ~ © & O back
Library
&8 Plantpax ~
gl =Y
| iFempi
- (g Element Templates
-~ [ C_Interface FTLD
- (G C_Interface_Perfmon
C_Perfmon
-~ [y C_Perfmon_ASamM
- ([ C_Perfmon_ASIH
C_Perfmon_ASIS
-~ [y C_Perfmon_PASS
- G L CPU = Dbjects
L_shorteut
e (i P_AIN
- (G P_AINAdy
P_aInDual
- () P_AINMl
- (T P_AQut he
(7 Elements
= Event Frames
|| Library
ez Unit of Measure
84 Contacts
C_Interface_FTLD Modified:5/12/2020 7:51:16 &AM OwnerASIHOVAdministrator

Configure Asset Framework Elements

Associate the tags with historian elements, which are the Process object

templates

The term ‘element’ is used in the Asset Framework software. For PlantPAx

system purposes, ‘element’ can be considered synonymous with ‘objects’ in the

process library.

1. Goto Programs > Rockwell Software > FactoryTalk Historian SE >
System Explorer (64-bit).
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2. Select Elements in the lower, left pane, select Element and create a New
Element.

(@) WASIHOT\PlantPax - PI System Explorer (Administrator) - O x

File  Search Wiew Go  Tools  Help
@ Datobase ¥ Queny Date + (D ﬁ @eBack () H Checkln ¥ [#]Refresh | (3 Mew Element -

Elements Elements
5W Group by: [ Category [ Template
1F  Mew Element
£, Ele ‘ Search Jeln g
@] Mew Model
Ej K44l Elerment Reference (B Name < Description Category Type Template @ ‘
There are no elements configured For this database. Elements are the fundamental
Arrange By » organizational and object block of AF, typically used to represent an asset or group of assets,
[# Refresh Tew Element
Tew Mode|
,  Paste

Aidd Element Reference
Paste Reference

|5E
Impart from File..,
& Security.,

() Elements

= Event Frames
i Library

ez Unit of Measure

&4 Contacts

QElements

3. Select P_AlIn in the Choose Element Template dialog box.
Type the tag name that is being assigned to the object and check it in.

@ WASIHOT\P IantPAx - PI System Explorer (&dministrator) - m} X
File  Search ‘iew Go  Tools  Help
@ Dstabase ¥ Queny Date ~ (0 @ @Back 0 B, CheckIn %) « 2] Refresh |3 MewElement ~

Elements P_AIn1
5Elaments Genetal  Child Elements  Attributes Ports  Analyses  Motification Rules  Wersion
e P_AINL

(3, Element Searches Narne: ‘TTUIUUI |

Description: ‘S\mpls Analog Input |

(7 Elements 2 .
Categories: IO Pracessing (@] Default Attribute; | <Nones

== Event Frames
5 Library

e Unit of Measure

Extended Properties (00 Annotations (0} Location  Security

Find: Parents Children  Event Frames

Models  Lavers  Connections

5. Confirm the settings and Check In again to complete the check in
process.

6. The current historical value is accessed by selecting the Attributes tab
and refreshing.

Rockwell Automation Publication PROCES-UM100C-EN-P - June 2022 225



Chapter 7 Historical Data

Search Event Frames

You can search for event frames, for example, if you want to find abnormal
conditions that triggered an event.

1. Go to Programs > Rockwell Software > FactoryTalk Historian SE >
System Explorer (64-bit)

2. Select Elements in the lower, left pane of the PI System Explorer dialog
box and then select the Analyses tab.

(@) WASIHOT\PlantPax - PI System Explorer (Administrator) - O X
File  Search Wiew Go  Tools  Help
@ Datobase ¥ Queny Date + (D O Back H, CheckIn ¥ v [2] Refresh | |3 Mew Element ~
Elements TT01001
& Elements General Child Elements  Attributes Ports  Analyses  potification Rules  Yersion
- (G TTO1001 z
(£, Element Searches il L] R Bai
e = @ Backfilling pecipko
@ = Categories:
Expression
L O Analysis Type: i
Event Frame Ge
7 Elements
= Event Frames
] Library
e Unit of Measure
&4 Contacts eaisb Event-Triggered @ Periodic Advanced..
% Manage ment Period: 00h 05m 00s
TTO00 Madified:5/12/2020 8:08:44 AW OwnerASIHOTAdrministrator Version: 1/1/1970 12:00:00 AM, Rewision 1

Finding Faults for Analysis

You can also search event frames to assess faults.

1. Go to Programs > Rockwell Software > FactoryTalk Historian SE >
System Explorer (64-bit)

2. Select Event Frames in the lower, left pane, select Event Frame Searches
and choose New Search.

@ WASIHOTYPlantPas - PI Systern Explarer (ddministrator) - m} X
File  Search  View Go Tools  Help
@ Database P Query Date ~ (U O Back H, Checkln %) « [#]Refresh | — New Event Frame

Event Frames HEvent Frame Searches
k3 rter o~
[ fog) Everll 0 Mew Search

-0 MName Query
2 Tlansfsr Mew Attribute Search
=7 Transl

[ Event Frame Search 1 Max:1000 Search:'Active Between' Start*-30d End:*+1d AlDes. .,
Mew Event Frame

Refresh

=

[ Elements

|~ Event Frames
1] Library

ez Unit of Measure

84 Contacts

% Management

3. Select the desired search criteria and any filters.
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The search results for the selected criteria appear at the bottom of the
dialog box.

Event Frarne Search x

K - Search

Criteria "\

Search: Starking Before w | [ InProgress

Search start: |5/12/2020 11326 P |[F]| v | 4] All Descendants

Mame:

Analysis Name:

Element Marne:

Cateqory: I Processing Pl

3Ee e iae e

Template: <All=

£

Sy mdd Criteria ¥

Resulks

[%]

Mame 5f... [086:28:34.6732025] 5/... Duration & ||~

1| Fault Analysis 2017-05-30 08:12:27.907 | H 0:03:44.035

== Fault Analysis 2017-05-30 08:23:53.940 |—| 1:40:13.181

== Fault Analysis 2017-05-30 14:25:30.249 H 0:03:35.346
The search found 4 Event Frames matching the search criteria.

I OK | Cancel Reset

4. Toview elements (tags) that are associated with the fault for the selected
search criteria, double-click a fault.

5. Select the Referenced Elements tab.

Each tag (and description) that is assigned to the element appears.

D WASIHOT\PlantPi - PI Systern Explarer (Administratar) - [m] X
File  Search View Go  Tools  Help

aDatabase [ Query Date + © ﬁ @Back 0 H Checkln % « [#] Refresh | —f Mew Event Frame

Fault Analysis 2017-03-30 14;

Event Frames

ient Frame Searches

3] Event Frame Search 1

- p= Fault Analysis 2017-05-30 14:25:30.249
= Fault Analysis 2017-05-30 03:23:58.940 ‘ Fiter

{ Referenced Elements |l tributes

- = Fault Analysis 2017-05-30 08:12:27.507 || [ @ rvame | pescription Category Type Template
- = Fault Analysis 2017-05-30 08:02:30.923 T T
ansfer Searches LI ﬁ TT01001  iSimple Analog ... |10 Processing  MNone P_AIn

'y Transfer Searchy [T T

6. Toview a description of the abnormal condition, select the
Attributes tab.
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Tools for Creating Historian
Tags

Depending upon how far along you are in your process application build, these
can help create tags and other bulk code:

« Application Code Manager software
« PlantPAx Configuration tool
«  PIBuilder Add-in for Microsoft Excel

Application Code Manager

Application Code Manager (ACM) software supports a historian library to
assist with creating historian tags.

Use ACM to create the historian tags when your control strategies in ACM are
in the final stages and ready to generate a Logix 5000 Controller .ACD file.

See Chapter 5, Process Applications for specific details on ACM.
After ACM generates historian tags, the .CSV file needs to be copied to the

computer that has PI Builder Add-in for Microsoft Excel installed to publish
the tags into the historian database.

IMPORTANT  If additional control strategies are created using Logix Designer
software, then ACM won't be able to generate the new historian tags.
In this scenario, the PlantPAx Configuration Tool may be considered
to create the historian tags.

Pl Builder Add-in for Microsoft Excel

PI Builder is a Microsoft Excel add-in that lets you use Excel to create, view and
modify PI points and Asset Framework objects in your Historian database.
With PI Builder you can make bulk tag edits by importing and exporting your
spreadsheet.

All functionality of the prior PI Tag Configurator has been replaced with PI
Builder, which is included with the PI SMT and PI Data Archive setup kits (as
part of the PI AF Client installer).

IMPORTANT Microsoft Excel 32-bit software must be installed for these
procedures.

This section uses Microsoft Excel 2013. Your version could be
different.

If Microsoft Excel was installed after the Historian software, the PI AF Services
will need to be modified to include the PI Builder feature.

1. To start the modification, run file named <PI-AF-Services_2017-
R2A_.exe>located in the \Redist\PIAFSetup)\ directory of the Historian
SE software installation media.

A maintenance dialog prompts to modify, repair, or uninstall the PI AF
Services 2017 R2 installation.

2. Choose to Modify the installation and click Next.
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3. Select PI Builder from the list of Features and click Next.

@ Pl AF Services 20017 B2 {Adrministrator) x

Feature Selection

Select the features to install,

Maintenance

Features: Feature Description:
Feature Selection
Festure Rul Shared Features “ An Excel add-in that provides
eature Rules ] i
4 [ Pl System Explarer configuration and access to

Installaticn Progress the Pl Data Archive and AF

ol ment Plug-In

Pl Builde: ~ Prerequisites for selected features:

| selectAll | | UnselectAll | | Reset |

Complete

Installation directory: C\Program Files\Rockwell Software\FactoryTal|

Installation directory (286} |C\Program Files (x86)\Rockwell Software\Fact{|

| < Back I| Mext » |I| Cancel |

4. Restart the computer after the installation is complete.

To retrieve and publish PI AF objects, PI Builder must connect to a PI AF
database and for PI points a PI Data Archiver server.

1. Open your version of Microsoft Excel and click the PI Builder tab.

2. Inthe Connections group on the upper left corner. Select your Data
Server, Asset Server, and Database as available.

Bookl - Excel P Search :
File Horne Insert Page Layout Formulas Data Review Wiew Help Pl Builder 13 Share H Comments
Diata Server: @ ASIHOT ~ Eﬁ ) Select A1l ,\}‘ % & EI [ p Sham Values in Rows [ Headers () About
H e
Asset Server QASIHm @ € ) Deselect &l s Showevalues in Columns El Settings @ Help
Publish s PlPoints | Library Elements  Ewent Security  Retriewe
Database; aplantPAx* @ Resetto Template ~ - - Frarmes « - $ (£) Ferdback
Connections Build [l Retrieve [F] Attribute Data References Resources ~
Al - Fe v
A B € o] E F G H ! ) K L M N =] F qQ -
1
| "
2
3

For information on how to publish your historian tags to the historian
database, see the PI Builder add-on Help section.
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Configure Asset Framework Databases with the PlantPAx Configuration
Tool

Use the PlantPAx Configuration tool to configure Asset Framework databases
with Logix tag elements. This includes the automatic configuration of related
PI points in the FactoryTalk Historian data server (PI data server).

This procedure assumes that the controller, HMI server, and the alarm server
are configured for using the PlantPAx Configuration Tool.
1. Open the PlantPAx Configuration Tool.

2. Add the Historian Server.
adl PlantPAx Configuration Tools for Tag

File View Tools Windows Help
iDEHE|

= Logix Controllers
= LGXCo1
2 Assaciated HMI Application = PlantPAs

. B FactoryTalk View SE Network
LB HMI Server Name = PlantPAx_HMI
LB HMI Server Area Name = Area
iy Data Server Area Name = Area/Dat
iy Data Server Name = PlantPAx_DAT
4y Data Server Device Shortcut Name

= M HMI Alarm Servers

oM PlantPAx_AES

@& Lexcot

Add Historian Server...

From this Page Action

Add Historian Server Type the name of the historian server.

Enter the server collective name and select the

Select Contraollers for Building Data Points in Historian Server applicable controllers.

Select Controllers for Building Data Points in Historian Server -
Name: Production Historian
Description:
FTLD Interface Number. [T |
Server or Collective Name: I‘ASIHO] |I

Point Source Name: FTLD

Select Controllers and Enter Data Server Information

Select Controller Application Data Area Full Path Data Server Name Device Shortcul
Name Name
LGXCO1 PlantPAx Area/Data PlantPAx_DAT LGXC01

FactoryTalk Application Name, Data Server Name and Device Shortcut Name must be provided when using FTLD point source.
Data Server Name is not required when point source is not FTLD

The default data server name used by FactoryTalk is "RSLinx Enterprise”

(Data Area Full Path example: "NorthPlanyDatal")

o] e
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3. Select the Historian server that you just created (Production Historian in
our example), and select to Import to Asset Framework (AF) Database

L= PlantPAx Configuration Tools for Tags. Alarms. and Historian [PlantPAx] = [ -
File Wiew Tools Windows Help

DEH

=4 Logix Controllers
- LGXCO01
-2 Associated HMI Application = PlantPAs
i FactoryTalk View SE Network
HMI Server Name = PlantP Ax_HMI
HMI Server Area Name = Area
3y Data Server Area Name = Area/Dat
'3y Data Server Name = PlantPAx_DAT
.3y Data Server Device Shortcut Name
=3 HMI Alarm Servers
=M PlantPAx_AES
-~ LGxXcm
=--® Historian Servers
g

- LGXC Change Controllers Associated with Historian Server...

Rename Historian Server...

Remaove Historian Server

| Import to Asset Framework (AF) Database
Buid PTPomnts or mpoE File..

From this Location Action

Build Tags: Setup Tab Select Connect

Connect dialog Box Set the Pl Server, AF Server, and AF Database

0K Connected dialog box Zﬁgfxglbfgtgggsrs connected to the PI Server, AF Server,
Build Tags: Setup Tab Select PI Point Builder Options

FactoryTalk Historian Import File Builder Options dialog Use the controller name as a prefix to Historian tags. For
box: Naming tab example, LGXCO1.<tagname>

Build Tags: Information Tab Review and verify the information

Build Tags: Build Tab Select Build

Setup | Information | Build |

Status:

|000c2951dd44"
FIC01002

|Action='SubObjectChange'. Identity-'Element, UniquelD=2¢2530b6-6996-1126-80cic-000¢2951dd44', ParentD="24263bb3-699b-11e8-80dc-
|000c2951dd44"

Eaquipment01 Abort Build
|AFDatabase change event

|Action='SubObjectChange" Ideniity='Element. UniquelD=24253bb3-639b-11e6-80cic-000c2951dd44' ParentD="24253bb0-699b-118-80dc-

1000c295 1444

\Areall

|AFDatabase change event
\Action="SubObjectChange’, Identity="Els d44', ParentD="00000000-0000-0000-0000-

|000000000000'
Process0l Completed adding Logix elements to AFDatabase.
|AFDatabase change event

\Action="DirtyCleared" I oK I
PlantPAx

AFDatabase change event

\Action="SubObjectChange', Identity='Element’, UniquelD="242b3bad-699b-1128-80d¢-000c2951dd44', ParentlD='00000000-0000-0000-0000-
|000000000000!

16/6/2013 11:06:11 AM Exited Adding AFElements to AFDatabase PlantPAx
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Verify Asset Framework Library and Elements

After using the PlantPAx Configuration Tool, you must verify that the asset
framework library and elements are properly imported into the Asset
Framework database.

1. Goto Programs > Rockwell Software > FactoryTalk Historian SE >
System Explorer (64-bit).

2. Select Library in the bottom left of the system explorer and verify the
contents of the library.

€D WASIHOT\PlantPAx - PI System Explorer (Administratar) — O X
File  View Go Tools Help
atabase uery Date = ) Bac eck In 2] Refres ew Ternplate =
Datab Query D v Back H, Check | « | £] Refresh New Templ
Library Element Templates
e PlantPax Py Group by: [] Category
=™ @ Templates Fiter o~
- (@ Element Templates
- (G C_Interface_FTLD Name 4| Description Category Typeld} | o)
e g E_lpnteFrFace_Perfmn (f C_Perfmon_aSIH  Historian Computer Perfomance Monitor Computer Element
_Perfmon
- (@ C_Perfmon_ASAM (% C_Perfmon_ASIS  SQL Server Computer Perfomance Monitar Computer Element
[ C_Perfmon_ASTH (f C_Perfmon_PASS  PASS Computer Petfomance Manitor Computer Element
-~ [ C_Perfmon_ASIS ™
-~ G C_Perfoon_PASS HL_CPU Processor Utilization Controller Element
- (LU (& L_Shortcut RSLinx Enterprise Shortcut Computer Element
- (G L_Shortcut R P_AIn Simple Analog Input 10 Processing Element
- P_AIn
. g P:AinAdv & P_AInAdv Analog Input Advanced 10 Processing Element
- (G P_AInDual (% P_AInDual Dual Analog Input IO Processing Element
- G P_AInMult P_AInMui Muti Analog Input IO Processing | Element
- (. P_AOut v || P skl g
R P_AOUL Analog Output 10 Processing Element
El t
i Bements (& P_D4sD Discrete Control 4 States Valves Element
={ Event Frames % P_DBC Deadband Control Regulatory Co... Element
Library & P_DIn Digital Input 10 Processing Element
== Unit of Measure (% P_DInAdy Digital Input Advanced 10 Processing  Element
84 Contacts (& P_Dose Dosing Control Procedural Co,., Element | o

C_Interface_FTLD Modified:5/12/2020 7:51:16 &M OwnenASIHOT Administrator

3. Select Elements in the bottom left of the system explorer and verify the
elements.

D WASIHOT\PlantPi - PI Systern Explarer (Administratar) - O X
File  Search View Go  Tools  Help
a Database [B]Query Date + (© ﬁ @Back 0 H Checkin %2« [#] Refresh |3 Mew Element ~

Elements P_AIn1
& Elements General  Child Elements  Attributes  Ports  Analyses  Notification Rules  Yersion

il P_AINL

(T3, Element Searches MName: |TTDlﬂﬂl |

Diescription: |Simp\e Analag Input |

Elements
= Categaries: |10 Processing Default Attribute:  <hone s

= Event Frames
] Library

ez Unit of Measure

Extended Properties (0 Annotations (03 Location  Security

Find: Parents Chidren Event Frames
Models Lavers  Connections
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Historian Tags in This section shows how to import FactoryTalk Historian data tags. Data from

FactoryTaIk Vantagepoint multiple Historian SE servers can be brought together into a single decision
support system by using FactoryTalk® VantagePoint® as the information
reporting software.

IMPORTANT  for installation and configuration steps, refer to the FactoryTalk
VantagePoint Getting Results Guide, available on the FactoryTalk
VantagePoint installation DVD.

This document assumes that the FactoryTalk VantagePoint server is
installed on its own computer. If you have a small application and
you want to install the VantagePoint server on the same computer
as the Historian SE server, refer to the FactoryTalk Historian SE
Installation and Configuration Guide, publication HSE-INO25.

1. Goto Rockwell Software>FactoryTalk VantagePoint>Manager.

2. Inthe VantagePoint Manager directory tree, expand Sources, right-click
FactoryTalk and choose New>Item.

The New FactoryTalk Connector dialog box appears.

New FactoryTalk Connector -

Connector Information
A FactoryTalk connector gives you access to various FactoryTalk data sources.

FactoryTalk directory
VantagePoint will connect to the FactoryTalk directory on this machine:

Directory host: pass01

FactoryTalk user

VantagePoint can create a new, dedicated FactoryTalk user account that it can use
to access FactoryTalk resources. Enter a user name and password for this new account:

User name: VantagePoint |

password: t ====== o I |

[] This is an existing account, Use it as the FactoryTalk user instead.

Connector description {optional)

Enter a description for the new FactoryTalk connector:

3. Type the VantagePoint user password and click Next.
4. Select 'Yes, please’.

The FactoryTalk Import dialog box appears.
FactoryTalk Import -

Import Choices
You can choose to import data from various FactoryTalk systems.

What would you like to import?

O I would like to import FactoryTalk Live Data tags

I@ I would like to import FactoryTalk Historian tags I

O 1 would like to import FactoryTalk Alarms and Events information

5. Click 'I would like to import FactoryTalk Historian tags'.

Rockwell Automation Publication PROCES-UM100C-EN-P - June 2022 233


https://literature.rockwellautomation.com/idc/groups/literature/documents/in/hse-in025_-en-e.pdf

Chapter 7

Historical Data

234

The FactoryTalk Import dialog box reappears.
FactoryTalk Import -

Historian Import
Importing historian tags allows history retrieval via imported, historized Live Data tags.

Select one or more FactoryTalk historians from which to import tags:

Historian Last Imported  Tag Count ~ Description
ruducﬁun Historian ~ Never 0 Historian for the production area of the plant

| < Badk Il Next > I‘ Cancel

Check the Historian that you want to use.
If you aren’t using an ME connector, click Finish.

When the 'Import successfully completed’ dialog box appears.

8. To confirm the import, go to System > Sources > FactoryTalk > passo1 >
Historians > <Production Historian> and look for 'Tags'

For example Server = passo1 and Historian = Production.

—LJ Sources
-3k b
—ﬁ FactoryTalk
—’3 pass01
+-[ Applications
"3 Historians
—’3 Production Historian
ngineering Units

ortcutToController
+|j: AlarmsAndEvents
+-44% System
+ ﬂ FactoryTalkEnergyMetrix
+’3: FactoryTalkHistorian
<. . FartnruTalkMatrice
BeeL.

Items (160) Description ~
¥ BA:ACTIVE. 1 Batch Active Reg
@ BA:CONC. 1 Concentration Ry
4 BA:LEVEL. 1 Level Reactor 1

2 BA:PHASE. 1 Phase Reactor 1
@ BATEMP. 1 Temperature Re;
|2 bae9cf24-c8b3-46c0-ad5d-a64df...  PIBatch storage
@ CDEP 158 Light Maphtha Er
< m ¥

EooEmarEs E|

¥ Server: Http:- -Ic-:elh05t-In-:l.lii;'-

IMPORTANT  Adding new Historian paints in the system requires a
synchronization action. Synchronizing lets you update the
VantagePoint references.

9. To synchronize the Historian, select System > Sources > FactoryTalk >
<server> > Historians > <yourHistorian> and choose Synchronize.
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Other Reporting and Analytics Options

Third-party reporting packages can connect to FactoryTalk Historian SE via
the OLE-DB connector.

For more information, see the Knowledgebase Technote FactoryTalk Historian

SE and the OSIsoft P OLEDB Providers.

Rockwell Automation Publication PROCES-UM100C-EN-P - June 2022 235


https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/65354
https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/65354

Chapter 7 Historical Data

Notes:
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Batch Management

PlantPAx® systems support scalable options for batch management that are
based on ISA88 standards and can help:

« Automate sequences to reduce time-to-market

« Manage recipes and procedures to focus on yield, throughput, and

quality

« Provide models to improve traceability, reporting, and approval controls.

The following options exist for batch management in your PlantPAx system.
Controller-based solutions are typically for smaller systems; larger systems
require FactoryTalk® Batch applications. The reference links provide more
details for each option. Not all controller firmware revisions support all batch

solutions.

Step 1: Select the Batch Solution

Scalable offerings and tools range from controller-based to enterprise-wide

solutions.
Feature h‘:f‘i:gi?tch & Sequence SequenceManager FactoryTalk Batch
Deployment Logix controller code Firmware-based controller feature | Server-based application
ControlLogix® 5580 ) ControlLogix 5580
Compact o S Copact g S0
CompactLogix 5370 CompactLogix 5370
Units Single unit recipes Single unit recipes Multiple unit recipes
Phase construction PhaseManager™ programs PhaseManager programs PhaseManager programs

Phase interface

Phase and bit logic

Pull-down menu

Pull-down menu

Max recipes/steps/phases 32 Limited by memary or resources Limited by memory or resources
Max input/report parameters 4 No max No max
Parameter expressions No Yes Yes
BOOL BOOL BOOL
Parameter data types REAL INT, INT, DINT SINT, INT, DINT
REAL REAL
Sequential Sequential
Sequential Concurrent Concurrent
Procedural structure Concurrent Divergent Divergent
Recurrent Recurrent
Recipe design Tabular HMI configured SFC like SFC like
Recipe editing Runtime via HMI Import only at runtime Runtime editing via Recipe Editor
HMI integration Faceplates 3 Active X mmive X
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Feature Iﬁ';?::gi‘:tch & Sequence SequenceManager FactoryTalk Batch

Batch reporting Queue controller services Event client and archive services Event client and archive services
FactoryTalk Batch integration No Yes -

Dynamic unit binding No No Yes

Unit arbitration No No Yes

O

Step 2: Logix Batch and SequenceManager Requirements

The Logix Batch and SequenceManager™ option consists of controller code
and visualization elements. You need:

« Logix 5000™ controller
« FactoryTalk® View Studio software
« Logix Batch and Sequence Manager files

For more information, see Logix Batch and Sequence Manager.

O

Step 3: FactoryTalk Batch Requirements

SequenceManager controls direct PhaseManager programs in this controller-
based option. You need:

« Logix 5000 controller
« FactoryTalk® View Studio software
« SequenceManager software

For more information, see SequenceManager Controls.

O

Siep 4: FactoryTalk Batch Requirements

A FactoryTalk Batch application is a server-based option.

AppServ-Batch application server with:
« FactoryTalk Batch server
« FactoryTalk® eProcedure® server
« FactoryTalk® Event Archiver database

AppServ-Info SQL server with:
« SQLserver
« FactoryTalk Batch Material server
« Master Recipe storage

For more information, see Factory Talk Batch Application.
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The batch solutions work with each other to provide a comprehensive solution.

[ |

FactoryTalk® Batch

Logix Controller

‘ LBSM SequenceManager“‘ | Other
— = Third-
[ Loglcl PhaseManager™ ] [ PLI .Contr?:ﬁ::

For more information, see these additional resources.

Resource

Description

PlantPAx Logix Batch and Sequence Manager Reference
Manual, publication PROCES-RM007

Provides procedures on how to use LBSM to store recipes and sequences equipment and phases to make products.

SequenceManager Controller Reference Manual,
publication 1756-RM101

Describes how to install, configure, and run SequenceManager Contrals.

FactoryTalk Batch User Manual, publication BATCH-UMO1I

Contains instructions for configuring security and services, and implementing components, such as the FactoryTalk
Batch server, simulator, and performance chart.

PlantPAx Batch Design Considerations Reference Manual,
publication PROCES-RM008

Provides guidance on selected batch implementation topics in a PlantPAx system.

Batch Application Toolkit Quick Start,
publication IASIMP-0S042

Provides a framework for how to use the tasks to complete the components of the Toolkit.

PhaseManager User Manual, publication LOGIX-UMOO1

Provides instructions on how ta configure and use a Logix 5000 controller with equipment phases.

FactoryTalk Batch PhaseManager User Manual, BATCHX-
UMON

Provide instructions on how to use phase logic to integrate FactoryTalk Batch software with a Logix Designer
application.
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Logix Batch and Sequence
Manager

The Logix Batch and Sequence Manager application is controller logic that
provides basic batch management for single-unit or multiple-independent
unit operations.

Premix - Product A

@ Idle

Product A
Product Code
Garfield1-2323
Version:

4.0-00 BETA

Version Date

8/31/2018 12:00
Authar: Scale Factor
+ l T Marvin Gardens

@ Premix - Product A

Runnin Active Sequence: Current Step uID:
O g Product A 3. Reaction Temp 10007037 9

n n n

N2 ¥4 5068 8 010 1101 43 14 15
O
Wit O O O

Add Ingredient A D
Add Ingredient B D

Add Ingredient C D
Agitate 00 Oooooo
> Dispense
() [Heat Vessel DDDDDDDDD
O

012 304 K 6T 8 909011 42 4314 15

H:

Pause at next

m m Seale Factor ’
No es 100.00 G
Auto Pauss o
n . No C_T )Yes 0 U / @

An LBSM application is best for:

« Single-unit batch processes, with 5...10 recipes, that can be defined with
four real and four Boolean parameters per phase

« Processes that need frequent recipe changes

« Systems where recipe changes must be made through an HMI
« Process skids

« Pilot plants

LBSM Details

The LBSM application provides controller logic and HMI objects.

An LBSM application supports:

« PhaseManager programs and custom sequences

«  Maximum of 32 recipes per controller

« Maximum of 32 steps per recipe

« Maximum of 4 real and 4 Boolean Parameters/phase
« Recipe changes are made from the HMI

For more information, see PlantPAx Logix Batch and Sequence Manager
Reference Manual, publication PROCES-RMo007.
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Sequencel‘lanager Controls  sequenceManager is a firmware-based feature controls direct PhaseManager

programs inside a Logix 5000 controller in an ordered sequence.

Editor - Logix Designer application Operator— FTView SE Data Collection & Reporting Services
Define a procedural sequence that Monitor and interact with a running Generate events used to produce
coordinates the execution of procedural sequence in the HMI batch reports and procedural analysis
equipment phases C e W O i~ —

A SequenceManager application is best for:

« Small batch systems (single unit)
« Systems with no server connectivity
« Process skids

« Modular systems connected into larger FactoryTalk Batch processes
« Fastprocesses

SequenceManager Details

The Logix controller must have firmware support to implement a
SequenceManager application. Not all controllers support the
SequenceManager application.

Use the SequenceManager to model and execute sequential manufacturing
processes using the ControlLogix features described in the following tasks:

« Configure the coordination of Equipment Phase execution using the
Equipment Sequence Editor.

« Execute Equipment Sequence programs using ControlLogix.

« Monitor and manage running Equipment Sequences using the Logix
Designer application.

« Enable operators to monitor and manage running Equipment Sequences
and Equipment Phases by adding SequenceManager ActiveX controls to
FactoryTalk® View SE displays.

« Subscribe and collect generated sequence events using
SequenceManager Event Client Service and SequenceManager Event
Archiving Service.

For more information, see SequenceManager Quick Start Guide, publication

1756-QS109.
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Factory Talk Batch A FactoryTalk Batch application is a server-based, comprehensive approach to
Application batch management.

« Handles complex unit coordination, resource arbitration, and
optimization of routes

« Manages recipes including formulations, scaling, secure approvals, and
versioning
« Includes integrated visualization and reporting

Rockwell
Automation

(03 | |Fu_srer our 1 AECRC TRANSFER PRENDIMOCE

A FactoryTalk Batch application is best for:
«  Multi-unit batch control
« Integration of process skids
« Integration with third-party systems
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FactoryTalk Batch Details

A maximum of 10 FactoryTalk Batch servers can exist in a PlantPAx DCS.
Follow these guidelines when you install FactoryTalk Batch on the AppServ-
Batch server:

« Install the FactoryTalk® eProcedure® server on the same computer as the
FactoryTalk Batch server.

« Install the FactoryTalk Batch Material server on a computer with the
SQL server. The computer must be different than the computer that
hosts the FactoryTalk Batch server.

« Install the FactoryTalk Event Archiver Database and Management Tool
on another server from the FactoryTalk Batch server.

Example FactoryTalk Batch Network

oo
9 =l ~—
I )
!.'_'}‘Wt ''''' ] = -_';.E*Mn_
=) ] |
Q 0 )
®
o
K:} = /0 ©®
—L S
= | | i =ji
L — _] ]
®

No. | Description No. | Description
1 Site level 8 FactoryTalk eProcedure clients
2 FactoryTalk Batch Material Manager clients 9 FactoryTalk Batch server (1...10) and FactoryTalk eProcedure server
3,14 | FactoryTalk Batch Material server; FactoryTalk Event Archiver database 10 FactoryTalk Batch server connects to SQL server for Master Recipe storage
4 SOL server 1 FactoryTalk Batch clients
5 FactoryTalk Batch clients 12 Proprietary netwark
6 TCP/IP 13 Process-connected device
7 Plant floor

For more information, see:

« PlantPAx Batch Design Considerations Reference Manual, publication
PROCES-RMoo8

« FactoryTalk Batch User Guide, publication BATCH-UMo11
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FactoryTalk Batch Server
with Redundant Controllers

Using a FactoryTalk Batch server with redundant controllers requires an
understanding of the batch server hold/failure propagation behaviors.

Redundant ControlLogix 5580 controllers do not support ControlNet®
communications. This means a FactoryTalk Batch application with active
phases isn’t a bumpless event when a switchover from primary to secondary
controllers occurs.

The phases switch over and remain in their respective state and code executes
as expected, but the FactoryTalk Batch server observes a brief momentary
communication loss over the EtherNet/IP™ network.

This communication loss is enough for the batch server to issue Hold
propagation on all recipes with phase actively running in the controller than
switched over. In this circumstance, the transitions in the recipe Held while
the phases in the controller are still running.

Hold Propagation

The Hold Propagation area lets you indicate the hold propagation type to use
when the FactoryTalk Batch server detects a failure that is caused by a
watchdog timeout, a handshake timeout, or a phase failure (PHASE_F > 0).

Hold propagation is a configurable selection that defines how the batch server
reacts to failures that affect an active control recipe. Configure the selection in
the Equipment Editor, which stores the value in the BATCHSVR.INI.

Server Options *
Cross Invocation Descriptors and Defaults Hyperink Descriptors and Defaults Material Policies
Project Settings Restart Cortrol Batch Reporting Archiver Evert Fiters Batch Server

Hold Propagation Miscellaneous

() None Maximum Log File Size 1000000| Bytes
Fh

O hase Miimum Disk Space 1000000] Bytes

(O Operation

() Unit Default Batch ID [BATCH_ID

@

[] Enable Evert Joumal Signatures

OPC Communications Timeout

Period {msec) 10000
Allowable Failures
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A Hold command that is associated with a failure propagates up through the
recipe hierarchy as high as the mode and selected option allows.

Hold Propagation Option Description

The batch server does not issue a Hold command to any level of the running procedure for any phase failure.

None Therefore, the phase logic is solely responsible for putting a failed phase into Hold.

The batch server issues a Hold command to only the phase in which the phase failure occurred. This includes
only the active step within the operation that experienced the failure, and not the active transition that belongs
to the operation. Therefore, only the failed phase is commanded to Hold by the batch server and any other level
of the batch remains unaffected such as, any running phase, operation, unit procedure, and the procedure itself

Phase

The batch server issues a Hold command to the running operation in which the phase failure occurred. This
includes all active steps and transitions within the operation level of the batch. Therefore, all running phases
Operation within this operation, and the active operation transitions are commanded to Hold by the batch server. Any
other running operation, unit procedure, and the procedure itself aren't affected by the Hold command; the
batch server does not propagate the Hold command to these other levels of the batch.

The batch server issues a Hold command to the running unit procedure in which the phase failure occurred. Al
running phases and operations within this unit procedure, and the unit procedure itself, are commanded to Hold
Unit by the batch server. This includes all active steps and transitions within these specific levels of the batch
operations and the unit procedure. Any other running unit procedure and procedure itself aren't affected by the
Hold propagation; the batch server does nat propagate the Hold command to these other levels of the batch.

The batch server issues a Hold command to the entire running pracedure in which the phase failure accurred.
Batch All running phases, operations, unit procedures, and the procedure itself, are commanded to Hold. This includes
all active steps and transitions within all levels of the batch.

The most common event to trigger Hold propagation is an abnormal process
condition being continually monitored by the controller.

When an abnormal process event occurs in the system, the controller logic sets
phase failure for the appropriate phases actively running in the unit, or units.
As aresult, the phase failure tags are set with a value greater than zero value by
the controller logic. The value corresponds with a known failure condition in
the process. The batch server can display the failure to the operators and
record the appropriate phase failure event.

State Composite Evaluation

The Hold propagation configuration determines the highest procedure level
within the running recipe for which the Hold command from the batch server
is issued when a failure is detected.

The state of each batch level (such as procedure, unit procedure, operation) is
continually evaluated by the batch server. Each batch level state is based on the
composite states of its underlying steps and transitions.

+ Inthe case of an operation, the composite state is based on the state of all
active phases and the state of their underlying active phases transitions.

« Inthe case of the unit procedure, the composite state is based on the
state of all active operation steps and the state of their underlying active
operation transitions.
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« Inthe case of the procedure, the composite state is based on the state of
all active unit procedure steps and the state of their underlying active

unit procedure transitions.

Order of Precedence for Batch States

State Element Type Priority
RESTARTING Step’ 12 (highest)
HOLDING Step il
ABORTING Step

RUNNING Step 9

ARMING Transition 9

ARMED Transition 9

FIRING Transition 9
STARTING Step 8
STOPPING Step 8

HELD Step 6

HELD Transition 6

IDLE Step 5
ABORTED Transition 4
ABORTED Transition 4
STOPPED Step 3
STOPPED Transition 3
COMPLETE Step 2
NOTCONNECTED Step 1
UNKNOWN Step 0 (lowest)

If the owner of the step (a phase) is EXTERNAL, then the step isn’t considered
in the calculation.

The determining state for any procedure level (procedure, unit procedure, or
operation) is based on the states of the active recipe elements it contains —
both, steps and transitions. All these S88 procedure levels are virtual to the PC
memory in the batch server, except for SequenceManager operations which
reside in the controller, much like most phases.

When a procedure level of a control recipe is connected and commanded by
the batch server, the state of each of its procedure levels is derived by a
composite state analysis to determine a final state for each procedure level. As
the path of recipe execution proceeds through a control recipe, the state of
each recipe element object is dynamic, and is continuously updated. The state
with the highest priority becomes the state of the procedure level for an
operation, unit procedure or procedure.

« Inthe case of an Operation procedure level, the composite state is based
on the state of all active phases e active transitions within the operation.

« Inthe case of the Unit Procedure level, the composite state is based on
the state of all active operation steps and active transitions within the
unit procedure.

« Inthe case of the Procedure level, the composite state is based on the
state of all active unit procedure steps and active transitions in the
procedure.
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Types of Failures

The batch server translates a phase failure value to an enumeration string that
presents an actionable string of text to the operators for the type of failure. A
phase failure is the most common type of failure. Other types of failures may
occur in the batch system such as, a parameter download failure, a report
upload failure, a failed phase request, a request timeout, a command timeout,
a quality tag status other than good, a watchdog failure, or a communication
failure.

In most cases, the batch server reacts to these failures just as it does for the
phase failure event with Hold propagation. An exception occurs whenever the
batch server experiences a communication failure to a controller, a data server,
or a phase.

When communication to the controller or phase is compromised, the Hold
propagation only acts on the components of the control recipe that are without
risk, or internal to the batch server memory (procedure, unit procedure,
operation). In this case, the risk pertains to those components where the
phases or SequenceManager operations reside, so Hold propagation isn’t
executed to the phase level or SequenceManager operations.

If communications are restored quickly so the watchdog in the controller does
not time out and place the running phases into a Held state, running phases
stay running as if nothing occurred. If communications are restored quickly
and the controller phases aren’t configured to Hold upon communication loss,
then running phases also stay running as if nothing occurred.

This momentary communication blip where phases remain running can cause
a dynamic when all other levels (procedure, unit procedure, operation) are sent
Hold commands upon failure according to the Hold propagation
configuration. As a result, these procedure levels are Held but the composite
state of a running phase and Held transition is running state for the operation.
This traverses up the control recipe where a running operation step and a Held
unit procedure transition evaluates as a running state for the unit procedure,
and so on one more level to the procedure. With transitions Held, the recipe
can’t move transition to other steps, and the recipe could act to an untrained
operator as though it’s hung, or unresponsive. One solution is to issue a Hold
command to the control recipe, then a restart to the control recipe to get all
steps and transitions in an active and running state as expected.

In the case of redundant systems with newer ControlLogix firmware revisions
that do not use ControlNet communication, the switchover of the controllers
where active phases are being run by the FactoryTalk Batch application isn’t a
bumpless event. The phases switch over and remain in their perspective state
and code executes as expected, but the FactoryTalk batch server observes a
brief momentary communication loss. This loss is enough for the batch server
to issue Hold propagation on all recipes with phase actively running in the
controller than switched over. In this circumstance, you can find transitions in
the recipe Held while the phases in the controller are still running.
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Notes:
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Step 1: Device Level Options

Analytics

Analytics is the discovery, interpretation, and communication of meaningful
patterns in data. Analytics relies on the application of statistics, computer
programming, and operations research to quantify performance.

Analytics are the methods that we use to measure our performance and then
provide feedback for continuous improvement. Analytics drive business value,
regardless of the industry, by helping to:

« bring a product to market faster

« lower the total cost of ownership because of more effective maintenance
« improve asset utilization by maximizing the throughput

« provide enterprise risk management

The following options exist for analytics applications in your PlantPAx®
system. The reference links provide more details for each option.

Allen-Bradley®
products have device-

level diagnostics that
are built in, such as Process Variable Speed Drives  Mistor Contral Centers

fault and alarm codes —
for use in fault routines. ¥ !

Other products provide (" Local, Distributed, and Intelligest V0
predictive and  Feoc -
prescriptive analytics at 3 4 R
the device-level of the

architecture.

In your overall solution,

you can add these
additional products to
gather device-level analytics:

« FactoryTalk® Analytics™ for Devices
« FactoryTalk® Analytics™ LogixAI®
« PlantPAx® MPC

For more information, see Device Level Analytics
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Q

Step 2: System Level Options

FactoryTalk® products that

add system-level analytics s
include: ™
« Paviliong® =
. Engineering/Application
« FactoryTalk®Analytics™ | Swesa/ververe

Edge Gateway - -

« FactoryTalk®Analytics
DataView

« FactoryTalk®
TeamONE™

For more information, see System Level Analytics

Q

Step 3: Enterprise-Level Options

FactoryTalk products that

add enterprise-level analytics
include: -
. Big Data
« FactoryTalk®Analytics™

Edge ML Goud
« FactoryTalk Analytics e
DataView PR,

c:]

DBs & Historians
At the Industrial Internet of

Things (II0T) level, you can
add:

« Vuforia® Augmented Reality
«  ThingWorx® Industrial IoT platform

For more information, see Enterprise-Level Analytics
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Analytics

Information Enables

Outcomes

Basic Analytics

«—

———3 Advanced Analytics

DESCRIPTIVE

Which facility
performed the best?

Is Line 1
running ok?

DIAGNOSTIC

.n:@l.&

Why is Site A throughput
behind plan?

il -

Why is Line 1
quality poor?

Am | running ok?

PREDICTIVE
Pt

] ’ A
- 4

| predict that Site A will be
behind plan soon

£

| predict that Line 1
quality is moving out
of tolerance

Why did a fault
happen?

(Og1R0 !

| predict a fault will
happen soon.

PRESCRIPTIVE

D

What action should | take to
avoid Site A from falling
behind plan?

=8

What action should the
operator take to avoid
poor quality?

&4l

What action should be
taken to avoid the fault?
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Device Level Analytics

The ControlLogix® and CompactLogix™ process controllers display alarm and

troubleshooting details for the embedded process instructions on the property
pages for the process instructions.

In your control strategy, you can use:

« Tag-based alarms
« Alarm faceplates

« Automatic device descriptive analysis (firmware revision 33 and greater)
to display device fault conditions in applications and client devices that
are supported by FactoryTalk® Alarms and Events.

Device-level analytics provide:
+ Streaming analysis
« Runtime deployment
« Device data generation

Option

Description

FactoryTalk Analytics for Devices

Embedded analytics software that lets you implement device level,
descriptive, and diagnostics analytics to improve maintenance and
engineering reliability.

Automated device health diagnostics provides data to an information
platform with or without cloud connectivity

PlantPAx specific content:

« Advanced Process Controller action card
« E+H device support

« Robust HART diagnastic information

Type: Descriptive, Diagnostic

Environment: Appliance on EtherNet/IP™ network
Available via the subscription portal

Requirements:
« 6200PC-FTA4DTTIM FactoryTalk Analytics for Devices appliance

FactoryTalk Analytics LogixAl

Embedded analytics software that enables controls engineers to
apply models to make predictions in ControlLogix applications.
Automated modeling capabilities that enable predictive capabilities
in the controller.

Type: Diagnostic, Predictive

Environment: ControlLogix chassis
Available via the subscription portal

Requirements:
« 1756M-FTALGXAIT1IM FactoryTalk Analytics LogixAl appliance

Model Predictive Control embedded in ControlLogix systems
« Multi-variable in and multi-variable out

Type: Predictive, Prescriptive

Environment: ControlLogix chassis

PlantPAx MPC -
« Predictive control .
« Reduction in variability Requirements:
« 1756-PPMPC or 9529-PPMPCENM module
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System Level Analytlcs System-level analytics provide:
« Data management, transformation, and harmonization
« Model training and deployment
« Pattern extractions
Option Description
Provides closed-loop, prescriptive analytics to R -
continuously maximize process performance in quality, | 1YPe: Predictive, Prescriptive
throughput, and efficiency. Environment: Server based
Pavilion8® « Model-based advanced, dynamic control drives :
stable performance Requi .
. equirements:
+ Integrated MPC, calculation, and soft sensor . Fl’]avilionB software
visualization and performance reporting
Type: Predictive
A machine-learning application that provides expert-
driven data analytics within the plant, where low latency | Environment: Server based
is a requirement. Part of the FactoryTalk Analytics; available via the
FactoryTalk Analytics Edge ML - Helps make decisions as close as possible to the data | subscription portal
(also applicable at enterprise-level) « Reduce loads on controllers by off-loading data .
preprocessing Requirements:
« Reduces deployment time costs « FactoryTalk Analytics Edge ML base bundle
« Out-of-box connectivity reduces design time or
« FactoryTalk Analytics Platform base bundle
An analytics visualization tool that lets you access and | 1YPe: Descriptive, Diagnostic
transform data through storyboards. Gain a business . :
understanding of data to pinpaint opportunities for Environment: Serverbased
improvement. Part of FactoryTalk Analytics; available via the
(anlctoryTal[k At?lalyttlcs Pata\."e‘ﬁ ) « Reduces time to value by reducing the dependence subscription portal
also appiicable at enterprise-leve on data architects and data scientists Requirements:
« Enables self-service analytics 9 S ;
- . « FactoryTalk Analytics DataView base bundle
+ Eliminates the need for expensive infrastructure that | o
is associated with traditional warehousing « FactoryTalk Analytics Platform base bundle
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Enterprise-Level Analytics

Enterprise-level analytics provide:
« Datavisualization
. Datamining
- Enterprise resource planning
« Model training
« Model operationalization
« Pattern extraction

Option

Description

FactoryTalk Analytics Edge ML
(also applicable at system-level)

Provides data capture, transformation and analytical capabilities, including
predictive machine learning, right on the edge.

« Pull structured and unstructured data from multiple sources

« Access data in intelligent devices

« Preprocess data for analytics

« Enable bidirectional, transactional type data

« Execute closed-loop, Edge-level machine learning

« Develop custom applications and connectors

Type: Predictive

Environment: Server based
Part of FactoryTalk Analytics; available via the
subscription portal

Requirements:

« FactoryTalk Analytics Edge ML base bundle
or

« FactoryTalk Analytics Platform base bundle

FactoryTalk Analytics DataView
(also applicable at system-level)

An analytics visualization tool that lets you access and transform data through

storyboards. Gain a business understanding of data to pinpoint opportunities for

improvement.

« Reduces time to value by reducing the dependence on data architects and
data scientists

« Enables self-service analytics

- Eliminates the need for expensive infrastructure that is associated with
traditional warehousing

Type: Descriptive, Diagnostic

Environment: Server based
Part of FactoryTalk Analytics; available via the
subscription portal

Requirements:

« FactoryTalk Analytics DataView base bundle
or

« FactoryTalk Analytics Platform base bundle

Vuforia® Augmented Reality

An industrial augmented reality platform that can improve workforce efficiency

and customer satisfaction with real-time, step-by-step work instructions and

data.

« Work instructions become handsfree and are delivered in real time where
assembly or field service take place.

« Tribal knowledge of experienced workers is captured and shared with new
workers and service technicians.

- Remote expertise can be delivered to workers no matter where they are in the
world.

PlantPAx specific content:

« Process strategy experience templates provide users with faceplate-like
features within an AR experience. The templates enable users to build
additional functionality around the PlantPAx information.

Type: Descriptive, Diagnostic

Environment: Cloud-based
Part of the FactoryTalk® InnovationSuite
Bulletin 95057C; available via the subscription portal

Requirements:

» Vuforia Engine software

» Vuforia Studio software

« Vuforia Chalk software

« Vuforia Expert Capture software

ThingWorx® Industrial loT
platform

An integrated, secure solution to minimize risk, reduce IT burden, and maximize
value from the software investment.

ThingWorx industrial connectivity provides data access for client applications
such as MES and SCADA and loT and Big Data analytics software. It leverages OPC
and IT-centric communication protocals to provide a single source of industrial
data. Supported protocols include proprietary protocols (including GE NIO,
SuiteLink/FastDDE, and Splunk), IT protocols (including MQTT, REST, ODBC, and
SNMP), and flow measurement export to common Oil & Gas industry formats.
ThingWorx industrial connectivity provides a single solution to collect, aggregate,
and securely access industrial operations data. Connect, manage, monitor, and
control diverse automation devices and software applications through one
intuitive user interface

PlantPAx specific content:

« Process strategy Thing templates replicate structure and functionality within
ThingWorx, which enable users to create an analysis of the objects with Live
and Historical Data

« ThingWorx mashup templates provide the ability to investigate alarms by area,
priority, and other critical alarming criteria. Advanced alarm analysis includes
fleeting, chattering, and stale alarm insights. Similar dashboard functionality is
also provided for SOL server reporting services.

Type: Descriptive, Diagnostic, Predictive, Prescriptive

Environment: Cloud-based
Part of the FactoryTalk Innovation Suite
Bulletin 95057C; available via the subscription portal

Requirements:

ThingWorx platform software
« Asset Advisor

« Operator Advisor

« Production Advisor

« ControlAdvisor

ThingWorx Industrial Connectivity software
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PlantPAx SQL Process Object The process library includes standard reports via SQL Server Report Services

and Alarm Reports

that support basic and advanced alarm and event reports, along with per

process object reporting.

The standard reports use data that is collected via FactoryTalk® AssetCentre,
FactoryTalk® Alarms and Events, and FactoryTalk® Historian SE. An SQL Asset
Framework processes the data from the system historian and consolidates the

data into a central database, based on a reporting schedule.

The PlantPAx reports include:

Category Reports

« Analog In (PAI)

Base « Analog Output (PAQ)

+ Digital In (PDI)

« Digital Out (PDO)
« Totalizer(PDOSE)

« Deadband Controller (PDBC) - PID Controller (PPID)

Area Based:
Alarm History
Alarm Top
Marming
Chattering
Fleeting
Stale

Maintenance (Dashboard) - Narm Object History

Audit All Data

Traceability Object Events

System Audit

Audit Sequence of Events

Top Logger

Top Logger Detailed
Database Status

« Shift Setup

System

For more information on how to deploy and utilize the reports, See
Knowledgebase Technote, PlantPAx System Release 5.10

Configuration and Implementation Tools. Download the PlantPAx SQL

Process Object and Alarm Reports file from this public article.

You may be asked to log in to your Rockwell Automation web account
or create an account if you do not have one. You do not need a support

contract to access the article.
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Notes:
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Appendix A

PlantPAx Security Certification

The PlantPAx® architecture supports IEC-62443-3-3 SL1 security requirements.
To help meet these requirements, reference these publications:

For this information

See

Guidance on how to conduct security assessments, implement Rockwell Automation

products in a secure system, harden the control system, manage user access, and | System Security Design Guidelines Reference Manual, SECURE-RM001

dispose of equipment.

Network architecture recommendations

Converged Plantwide Ethernet (CPwE) Design and Implementation Guide, publication
ENET-TDOO1

Windows® infrastructure recommendations
How to configure and use these Rockwell Automation products:

« FactoryTalk® Directory

« FactoryTalk® Activation Manager
« FactoryTalk® Security

« FactoryTalk® AssetCentre

Security Configuration User Manual, publication SECURE-UMOO1.

How to configure and use CIP Security™ with Rockwell Automation products to CIP Security™ with Rockwell Automation Products Application Technique,

improve the security of your industrial automation system

publication SECURE-AT001

PlantPAx Security
Architecture

Integrating industrial automation and control systems (IACS) with enterprise-
level systems enables better visibility and collaboration, which helps improve
efficiency, production, and profitability. But greater connectivity also exposes
control systems to additional cybersecurity risks. Availability is the most
crucial aspect of a secure IACS. To meet the needs of industrial environments,
Rockwell Automation aligns PlantPAx systems that are developed on our
technology with the international standard ISA-99/IEC 62443-3-3. This
standard 1s designed specifically for Industrial Automation and Control
Systems and defines procedures to implement an electronically secure system.

ISA-99/1EC 62443 is based on seven foundational requirements that cover a
defense-in-depth approach that is suited for an IACS. These foundational
requirements are:

« FR1: Identification and authentication control (IAC)
« FR2: Use control (UC)

« FR3: System integrity (SI)

« FR4: Data confidentiality (DC)

« FRs: Restricted data flow (RDF)

« FRé: Timely response to events (TRE)

« FR7: Resource availability (RA)

The guidelines and checklists in this appendix present the collective strategy to
meet the ISA-99/1EC 62443-3-3 SL1 requirements in conformant PlantPAx
systems. The intent of a certified architecture is to demonstrate security
competency, as well as to provide a standard, prescriptive reference design.
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The certified PlantPAx architecture relies on zones to segment the system.

Enterprise
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Zone Description
An IDMZ is required to connect to the corporate network. This zone contains a firewall stack, a pivot host, SEP
DMz Server and WSUS host. Additional hosts can be added, as needed.

Configure the IDMZ to separate untrusted (public) zones from the trusted (private) zones. Communication outside
of the IDMZ is considered untrusted.

Application Server

The Application Server zone houses all application servers. Each server is deployed on a separate VM. The
following mandatory nodes must be deployed:

« FactoryTalk Directory server

« FactoryTalk® View SE HMI server

« FactoryTalk View Data server

Other optional servers include:

« FactoryTalk® Historian server

« FactoryTalk® AssetCentre server

« FactoryTalk® VantagePoint® server

« SOL server

EWS/OWS

This zone contains the engineering workstations to provide programmer access and the operator workstations
to provide operator access.

Each workstation has the necessary software to program or interact with the system. Workstations can be
virtualized or they can be ThinManager® clients.

Each EWS has:

« Studio 5000° environment

« FactoryTalk View Enterprise Edition
« RSLinx® Classic

« FactoryTalk AssetCentre client

Additional software includes:

« Studio 5000 Application Code Manager,
« Microsoft® Office

o PUTTY

Each OWS has the FactoryTalk View runtime client.
Additional software includes:

« FactoryTalk Historian client

« FactoryTalk AssetCentre client

« Microsoft Office

PRP

DLR

Simplex

The control system is segmented into process areas. Each process area contains the hardware necessary to run
and operate that area. The topology of each area can be:

« PRP

« DLR

« Simplex

Trusted Zones

ISA-99/1EC 62443-3-3 SL1 requires the capability to separate trusted and
untrusted zones. You can use a standard firewall implementation to separate
trusted traffic and untrusted traffic. Standard implementation creates two
basic security zones that are known as inside and outside. The inside, or
trusted zone, is also referred to as the private zone. The outside, or untrusted
zone, is also known as the public zone. The public zone is outside the control of
an organization and can be thought of as simply the public Internet.

Rockwell Automation recommends a risk assessment for network security
zoning. Your risk assessment and risk posture help determine the trust level of
each zone. You can have multiple levels of trust on inside zones with different
types of access. For further guidance on risk assessments, see the ISA-99/IEC
62443-3-2 standard.

Certificate Authority

A trusted certificate authority, also known as a commercial certificate
authority, is a third-party entity that issues certificates for organizations that
request them. They aren’t controlled in any way by the person or organization
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System Security Feature
Checklists

that requests a certificate from them. A trusted CA issues publicly trusted
digital certificates that meet at least the minimum regulatory standards
(baseline requirements) that are outlined by the CA/Browser Forum (CA/
B Forum).

A private certificate authority, also known as private PKI, is an internal CA that
exists within a larger organization (typically an enterprise) that issues its own
certificates.

+ A private CA functions like its public counterparts, but a private CA’s
certificates are trusted only by its internal users, clients, and IT systems.

« Aprivate CA issues certificates that restrict access to a select group
of users.

« You must configure and host the private CA yourself.
For more information about CAs, see Microsoft Server Certificate Deployment

Planning information or the Microsoft documentation for your operating
system.

Use the following checklists to secure your system.

Identify and authenticate all users.

| Requirements for Identification and Authentication Control

v Product

Required to Meet IEC- .
62443-3-3 SL 1 Details

Windows® infrastructure

Configure and use the following:

Create Active Directory groups and unique users for each zone
Enable 802.1X authentication on all switchports

Implement encryption algorithms for wireless access (such as WPA2 Enterprise,
TLS, or IPSEC)

Implement public key infrastructure (PKI) certificates
Authenticate Group membership via a RADIUS server

Enable system notifications

Configure Kerberos

Configure an interactive login policy

Monitor unsuccessful login attempts

Yes

For more information, see:

« Configure System Security Features User Manual, SECURE-UMOO1

« System Security Design Guidelines Reference Manual, SECURE-RM001

« Deploying 802.11 Wireless LAN Technology within a Converged Plantwide Ethernet
Architecture Design and Implementation Guide, ENET-TD006

« Deploying Identity and Mobility Services within a Converged Plantwide Ethernet
Architecture Design and Implementation Guide, ENET-TD008

« Site-to-Site VPN to a Converged Plantwide Ethernet Architecture Design and
Implementation Guide, ENET-TD012

Password strength and
recommendations

Follow standard guidelines for password strength and recommendations

For more information, see:

« NIST Special Publication 800-63B Digital |dentity Guidelines

« Configure System Security Features User Manual, SECURE-UMOO1

« System Security Design Guidelines Reference Manual, SECURE-RM001

Yes

Windows domain

Configure the PlantPAx domain controller.

Configure all operating system clients as domain members
Enable multi-factor authentication on the domain controller
Create and manage all accounts in the Active Directory

Require administrative credentials to manage account activities

Yes

For more information, see:

« Chapter 2 Domain or Workgroup
« System Security Design Guidelines Reference Manual, SECURE-RM001
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Requirements for Identification and Authentication Control

v

Product

Required to Meet IEC-
62443-3-3SL 1

Details

FactoryTalk Directory software
FactoryTalk Security software

Yes

Configure appropriate:
« Users, groups, roles
« Security policies

For more information, see:
« Configure System Security Features User Manual, SECURE-UMOQ1.
« System Security Design Guidelines Reference Manual, SECURE-RMO01

Wireless access

Optional

Configure and use the following:

« Implement encryption algorithms for wireless access (such as WPA2 Enterprise,
AES Encryption TLS, or IPSEC)

« Obtain access to the IACS from an untrusted network through the IDMZ with multi-
factor authentication and certification-base authentication

« Use encryption tunnels (such as VPN and IPSEC) between VLANS

« Allow remote access only when necessary to authorized users in the Active
Directory

Important: Hardwired connections are always preferred. Never use wireless
connections for safety functions.

For more information, see:
« System Security Design Guidelines Reference Manual, SECURE-RM001

FactoryTalk Secure Remote Access

Optional
(Required if access via
untrusted networks is
desired)

Configure appropriate:
« Users, groups, roles
« Security policies

« Logging

By default,
MFA is enforced for all users
Traffic is encrypted

For more information, see:
« Stratix 4300 Remote Access Routers user manual, 1783-UMO14A-EN-P

Requirements for Use Control

Define control policies to control the use between users and assets.

v

Product

Required to Meet IEC-
62443-3-3SL 1

Details

Windows infrastructure

Yes

Configure and use the following:

« Active Directory Groups for each zone

« Group membership authentication via RADIUS server
« 802.1X authentication on all switchports

» Session lock

« Remote session termination

« Concurrent session control

« Interactive login policy

« Notifications for unsuccessful login attempts

For more information, see:

« Configure System Security Features User Manual, SECURE-UMOQ1

« System Security Design Guidelines Reference Manual, SECURE-RM001

« Deploying 802.11 Wireless LAN Technology within a Converged Plantwide Ethernet
Architecture Design and Implementation Guide, ENET-TD006

« Deploying Identity and Mobility Services within a Converged Plantwide Ethernet
Architecture Design and Implementation Guide, ENET-TD008

Windows domain

Yes

Configure all operating system clients as domain members

For more information, see:
« Chapter 2 Domain or Workgroup

FactoryTalk Directory software
FactoryTalk Security software

Yes

Configure appropriate
User Groups in each Area to support the segregation of duties and least privilege

For more information, see:
« Configure System Security Features User Manual, SECURE-UMOQ1.
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Requirements for Use Control

v

Product

Required to Meet IEC-
62443-3-3SL 1

Details

ThinManager software

Recommended

Manage mobile and portable device access via a ThinManager server and route
through the IDMZ. The ThinManager server limits mobile applications to view only.

For more information, see”
« ThinManager and FactoryTalk View SE Deployment Guide, TM-AT0Q1
« ThinManager User Manual, TM-UM0O1

FactoryTalk AssetCentre software

Yes

Configure and use the following:
« Auditable events

« Audit storage capacity

« Diagnostics and health log

For more information, see:
« System Security Design Guidelines Reference Manual, SECURE-RMOO1

Requirements for System Integrity

Protect the integrity of transmitted data. Recognize changes to information
during communication.

v Product g;ﬂ:gf;_;osﬁe' IEC- Details

Configure and use the Active Directory and domain structure to handle authorization.

Windows infrastructure Yes For more information, see:
« System Security Design Guidelines Reference Manual, SECURE-RM001
Configure the Industrial Demilitarized Zone (IDMZ) with appropriate firewalls.

Con\(erq ed Plantwide Ethernet Vs Use TCP/IP connections between zones.

architecture (CPwE) For more information, see:
Converged Plantwide Ethernet (CPwE) Design and Implementation Guide, ENET-TDOO1
Use antivirus and anti-malware software to harden workstations.

Antivirus software Yes Important: Confirm that antivirus software does not affect control system processing.
For more information, see:
« System Security Design Guidelines Reference Manual, SECURE-RM001
Use FactoryTalk® Policy Manager software (installed on the FactoryTalk Directory Server) to
define communication between zones.

CIP Security™ Recommended For more information, see:
« CIP Security with Rockwell Automation Products Application Technique, SECURE-AT001
« Deploying CIP Security within a Converged Plantwide Ethernet Architecture, ENET-TD022
« FactoryTalk Policy Manager Getting Results Guide, FTALK-GROO1
Configure and use the following:
« Change detection and reporting
« Scheduled backups

FactoryTalk AssetCentre software Yes
For more information, see:
« Configure System Security Features User Manual, SECURE-UMOO1
« System Security Design Guidelines Reference Manual, SECURE-RMO01
The process instructions and library objects are designed to work with Rockwell Automation
products to provide:

PlantPA . . d + Input validation

antPAx process instructions an Recommended « Deterministic output

object library .
« Alarms and error handling
For more information, see PROCES-RM200
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Requirements for Data Confidentiality

Protect the confidentiality of communication and data to help prevent
unauthorized disclosure.

v

Product

Required to Meet IEC-
62443-3-3 SL1

Details

Converged Plantwide Ethernet
architecture (CPwE)

Yes

Segment the network into the required zones and use firewalls.

Use conduits to zone-to-zone connections.

Use encrypted hard disk drives in computers.

If necessary, use cryptographic algorithms according to industry practices.

For more information, see:

« Converged Plantwide Ethernet (CPwE) Design and Implementation Guide, ENET-TDO01

« Deploying Industrial Firewalls within a Converged Plantwide Ethernet Architecture, ENET-
10002

CIP Security

Recommended

Use FactoryTalk Policy Manager software (installed on the FactoryTalk Directory Server) to
define communication between zones.

Note: Integrity only does not provide confidentiality. Use CIP Security confidentiality profile if
confidentiality is desired.

For more information, see:

« CIP Security with Rockwell Automation Products Application Technique, SECURE-AT001

« Deploying CIP Security within a Converged Plantwide Ethernet Architecture, ENET-TD022
« FactoryTalk Policy Manager Getting Results Guide, FTALK-GROO1

Wireless access

Recommended

Configure and use the following:

« Implement encryption algorithms for wireless access (such as WPA2 Enterprise, AES
Encryption TLS, or IPSEC)
« Implement the PKI infrastructure to aid device authentication

For more information, see:
« System Security Design Guidelines Reference Manual, SECURE-RM001

Requirements for Restricted Data Flow

Segment the network into zones and conduits to manage the flow of data.

v Product g;zzgfg_?sﬁet IEC- Details
Segment the network into the required zones.
« Use a separate VLAN for each zone.
Converged Plantuide Ethernet s « Firewalls provide additional protection
architecture (CPE) For more information, see:
« Converged Plantwide Ethernet (CPwE) Design and Implementation Guide, ENET-TDO01
« System Security Design Guidelines Reference Manual, SECURE-RMOO1
PlantPAx uses virtual templates to support partitioning data.
Virtualization Recommended For more information, see:
+ Virtualization on page 264.
Use FactoryTalk Policy Manager software (installed on the FactoryTalk Directory Server) to
define conduits.
CIP Security Recommended For more information, see:
« CIP Security with Rockwell Automation Products Application Technique, SECURE-AT001
« Deploying CIP Security within a Converged Plantwide Ethernet Architecture, ENET-TD022
« FactoryTalk Policy Manager Getting Results Guide, FTALK-GROO1
Use Network Attached Storage (NAS) in a segmented location to store backups of virtual
Network Attached Storage (NAS) Recommended images, system documentation, and related files where a FactoryTalk AssetCentre application
isn't appropriate.

Rockwell Automation Publication PROCES-UM100C-EN-P - June 2022 263


https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td002_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td002_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/at/secure-at001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/secure-rm001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/secure-rm001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/at/secure-at001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td022_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/gr/ftalk-gr001_-en-e.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/enet-td022_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/gr/ftalk-gr001_-en-e.pdf

Appendix A PlantPAx Security Certification

Collect and access security logs.
Requirements for Timely Response to Events

v Product g;zzlé'_e;_gosl;l-t:et IEC- Details
Configure and use the following:
« Audit log accessibility
« Continuous monitoring
FactoryTalk AssetCentre software Yes
For more information, see:
« Configure System Security Features User Manual, SECURE-UMQO1.
« System Security Design Guidelines Reference Manual, SECURE-RM001
Optional
FactoryTalk Secure Remote Access (Required if access via . .
Software untrusted networks is For more information, see Remote Access on page 266
desired)
Protect the internally stored audit logs in individual products in the system.
Configure the FactoryTalk AssetCentre audit log to collect these individual audit
Individual products in the system Yes logs.
For more information, see the user documentation for the individual products.

Maintain the availability of the system against the denial-of-service events.
Requirements for Resource Availability

Required to Meet IEC- .
62443-3-3 SL 1 Details

Configure the operating system to priaritize control system functionality over
antivirus checks and patching.

Network redundancy is highly recommended.

Configure virtualization software to manage service limitation.

Download software patches from trusted sources.

v Product

Windows infrastructure Yes

For more information, see:
« System Security Design Guidelines Reference Manual, SECURE-RM001

Configure managed switches for both distribution and access functions.
Use QoS and ACLs to configure proper segmentation.

Managed switches Yes For more information, see:
« Chapter 4 Network Infrastructure

« Converged Plantwide Ethernet (CPwE) Design and Implementation Guide, ENET-
10001

Configure and use the following:
« Asset inventory

« Control system backup
FactoryTalk AssetCentre software Yes « Disaster recovery

For more information, see Configure System Security Features User Manual,
SECURE-UMOQ!.

Provide your own UPS with separate battery unit and redundant power supplies.
UPS Yes Size the UPS so that is correctly supports the system and provides enough power to
properly shut down servers and workstations.

Virtualization The PlantPAx architecture uses virtual templates, VLANS, and zones to
support partitioning data, applications, and services. Virtualization is
preferred for all server and client operating systems. The VMware platform
works with all Rockwell Automation products in the PlantPAx architecture.

The VMware ESXi hypervisor is on each physical server and configured for
management by a central vCenter Standard edition server.

In your VMware implementation, make sure:

. Ifyou support remote access, the asset owner can terminate any remote
connections.

« The control system continues normal operation during a backup.
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VLAN Recommendations

To maintain audit logs of all backup and restore activities.

Table9 -
Zone VLAN IP Address Gateway Subnet Mask
Management 500 192.168 10.0/26 192.168.10.1 255.255.255 192
PRP Controller 501 192.168 10.64/26 192.168.10.65 255.255.255 192
Operator 510 192.168 10.128/26 192.168.10.129 255.255.255 192
Engineering 5N 192,168 10.192/36 192.168.10.193 255.255.255 192
Management 400 192.168 11.0/26 192.168.11.1 255.255.255 192
OLR Controller 401 192.168 11.64/26 192.168.11.65 255.255.255 192
Operator 410 192.168 11.128/26 192.168.11.129 255.255.255 192
Engineering 41 192.168 11.192/36 192.168.11.193 255.255.255 192
Management 300 192168 12.0/26 192.168.12.1 255.255.255 192
Simplex Controller 30 192.168 12.64/26 192.168.12.65 255.255.255 192
Operator 310 192,168 12.128/26 192.168.12.129 255.255.255 192
Engineering 3n 192168 12.192/36 192.168.12.193 255.255.255 192
Server Management 600 192.168 53.0/24 192.168 53.1 255.255.255 0
Application 601 192.168 52.0/24 192.168 52.1 255.255.255 0
OWS/EWS ows 610 192.168 50.0/24 192168 50.1 255.255.255 0
EWS 611 192.168 51.0/24 192.168 511 255.255.255 0
Management 700 192.168 105.0/24 192168 105.1 255.255.255 0
Wireless 702 192,168 104.0/24 192,168 104.1 255.255.255 0
DMz DMz 703 192.168 100.0/24 192168 100.1 255.255.255 0
IDMZ 104 192.168 101.0/24 192.168 1011 255.255.255 0
IDMZ 705 192.168 102.0/24 192.168 102.1 255.255.255 0
IDMZ 706 192168 103.0/24 192,168 103.1 255.255.255 0
Management 200 192.168.13.0/27 192.168.13.1 255.255.255 224
Rapid Mix 201 192.168.13.96/27 192.168.13.97 255.255.255 224
OEM 202 192.168.13.128/27 192.168.13.129 255.255.255 224
. Blend Fill 203 192.168.13.160/27 192.168.13.161 255.255.255 224
CIP Security Zones
Clean Place 204 192.168.13.192/27 192.168.13.193 255.255.255 224
Safety 205 192.168.13.224/27 192.168.13.225 255.255.255 224
Operator 210 192.168.13.32/27 192.168.13.33 255.255.255 224
Engineering M 192.168.13.64/27 192.168.13.65 255.255.255 224

Network Devices first 10 IP addresses start at .2
Host IP addresses start at .12

PRP zone devices (10.2...10.11) and hosts (10.12...10.63)
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Remote Access Follow the best practices referred to in Stratix 4300 Remote Access Routers,
Publication 1783-umoi4.

It’s required that the following setting be implemented:
« Log all connection operations

It's recommended to require a comment when a device connection ends.

These settings can be enabled by:
1. Login to the FactoryTalk Remote Access service (via FT Hub)
2. Navigate to Settings > Options >
3. Select the settings and save

Options

Explorer

Domain view

Require a comment when a device connections ends

Devices view .
Log all connection operations

Map view O send email notifications of account information @

Settings
Options

Audit
Operations
Connections

Tools

VPN settings

Device setup

Download
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CIP Security

DEM Zone Vian 202
1756175 with 1756 ENATR

Shal
owE

4oos Secure Communication

[3 Permitted Communication

Blend ar;d Fill Zone A Vian 203

CIP Security™ is a standard, open-source communication mechanism that
helps to provide a secure data transport across an EtherNet/IP™ network. CIP
Security lets CIP™-connected devices authenticate each other before
transmitting and receiving data.

CIP Security uses the following security properties to help devices protect
themselves from malicious communication:

« Device Identity and Authentication
« Data Integrity and Authentication
« Data Confidentiality

Rockwell Automation uses the following products to implement CIP Security:

« FactoryTalk® Policy Manager software (includes FactoryTalk System
Services, version 6.20 or later)

« FactoryTalk Linx software, version 6.11 or later (lets workstation software
communicate securely using CIP Security)

+ Studio 5000 Logix Designer® application, version 31.00.00 or later

This application is required to interface with CIP Security-enabled Logix
controllers. The minimum application version varies by controller
product family.

For more information on CIP Security, for example, a list of CIP Security-
capable products and publications that describe how to use the products,
including limitations and considerations, see the following:

« https://www.rockwellautomation.com/en-us/capabilities/industrial-
security/security-products/cip-security.html

«  CIP Security with Rockwell Automation Products Application Technique,
publication SECURE-ATo01

CIP Security Architecture
[ - ‘ [ - " Rapid Mix Zone Vian 201 -
(I
Voo

Safery Zone Vian 205
1756-L735 w 1756-ENATR

Blend @rnd Fill Zone B Vian 203 Clean and Place Zone Vian 204
\No Controller (RIO) 1756-L75 w 1 756-ENATR

[
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I Notes:
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Firewall Configurations

Common Ports Table 10 shows the most common ports that must be considered during the
firewall configuration.

Table 10 - Common Firewall Port Descriptions

Port Type Usage

25 TCP SMTP mail

80 TCP Standard WWW port

123 ubp Network Time Protocol

135 TCP Remote process calls

137 uoP

138 ubp File and printer sharing

139 TCP

445 TCP Use in the Collective configuration and file and print sharing
1433 TCP Communication to SQL server

1434 UDP Browsing for SQL server

;}8;0 EEE Rockwell Automation® trace diagnostics

Rockwell Automation TCP/  Table 11 shows the TCP/UDP ports for Rockwell Automation® firmware and
UDP Ports software products.
For periodic updates, see the Knowledgebase Answer ID 29402

at http://www.rockwellautomation.custhelp.com.
Table 11 - TCP/UDP Port Descriptions

Port Type Protocol Products Comments
®
23 TCP Telnet I\&”Ds\}gﬁce@, before release 1.3 Diagnostic command-line interface (see also 55555)

1769-L35E, 1763-L32E1756-ENBT,
1756-EN2T,1756-EWEB,1768-ENBT,
25 TCP SMTP 1768-EWEB,1788-ENBT,1763-L16x Outbound email only
1766-L32x,FactoryTalk® AssetCentre, FactoryTalk®
Transaction Manager, FactoryTalk® Integrator

1756-ENET,1756-ENBT,1756-EWEB,
1756-EN2T,1794-AENT1734-AENT,
1769-L.35E, 1769- L32E,1788-ENBT, )
67...68 uoP DHCP/BOQTP T761-NET-EN|1785-LXXE T785-ENET Client only
1791ES,1763-L16x,1766-L.32%, PowerFlex® Drives,
PowerMonitor™ 3000, PanelView™

69 uop TFTP 5820-EI For binary download, used in conjunction with BOOTP

1756-ENET,1756-ENBT,1756-EWEB,
1794-AENT,1734-AENT,1769-L35E,
80 ToP HTTP };g%-_ﬁ%(%1]77%85'2%%?177%_'&;)( ENI FactoryTalk ViewPoint and VantagePoint EMI server can
1763-L16x,1766-L32x, PowerFlex Drives, PowerMonitor [ |S¢ @Y other custom assigned port

3000, PanelView, FactoryTalk® View SE, FactoryTalk®
VantagePaint®, FactoryTalk® ViewPoint

123 UppP NTP PowerMonitor 3000, AADvance Network Time Protocol
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Table 11 - TCP/UDP Port Descriptions

Port Type Protocol Products Comments
135 TCP RPC/Endpoint Mapper |FactoryTalk, RSMACC™ DCOM endpoint mapper
1756-ENET,1756-ENBT,1794-AENT,
1734-AENT, 1763-L35E, 1769-L32E,
1788-ENBT, 1761-NET-ENI, 1785~ LXXE,
161 uop SNHP T785-ENET 1747-L55x 1766- L32x,
5820-El, PowerFlex Drives, PowerMonitor 3000,
PanelView
300...400 uopP Proprietary PowerMonitor 3000 Master/slave configuration
. Transaction manager, compression server,
400...402 TCP RPC FactoryTalk Transaction Manager and configuration server
443 TCP HTTPS FactoryTalk ViewPoint When using web server with secure certificate
Master or slave (AADvance),
502 TCP ModbusTCP AADvance, Trusted® Slave only (Trusted)
1001..1009 upp Proprietary 1426 PowerMonitor 5000 Waveform synchronized broadcast
Dynami .
(1%%2?1%5535 4) TCP DCOM FactoryTalk DCOM dynamic ports
1089 ff-annunc
1090 TCP/UDP ff-fmx 1788-EN2FFR FOUNDATION Fieldbus
1091 ff-sm
Safety Network Control Protocol, used by OPC,
132 e SNCP AADvance workbench debugger, and binding networks
1330 TCP rnaprpc FactoryTalk Object RPC
1331 TCP rnaserv FactoryTalk Service control
1332 TCP rnaserveping FactoryTalk Server health
FactoryTalk® AssetCentre (server), I
1433 TCP N/A FactoryTalk VantagePoint RSMACC SOL server communication (default port)
Recommended static destination port for MSSOL to
134 UDP N/A FactoryTalk AssetCentre (server), minimize the number of ports open on a firewall
FactoryTalk VantagePoint See the Knowledgebase Answer ID 287932 at http:/
www.rockwellautomation.custhelp.com
Windows® Service installed by Sentinel USB HASP driver.
. . This service isn't required for USB dongle to function.
1947 TCP/UDP N/A SafeNet Sentinel Local License Manager See the Knowledgebase Answer ID 570831 at http://
www.rockwellautomation.custhelp.com
AADvance (Slave only), Trusted (Master or slave, used | RTU packaged in serial stream. Other ports can
2000 Tce Modbus RTU for OPC and SOE) be assigned
. Used to configure systems. The tool sends broadcast to
2010...20M ubp Discover tool AADvance 2010 and systems reply to port 2011
1756-ENBT,1794-AENT1734-AENT, /0 communication that is used by products that only
2 UDP EtherNet/IP™ 1769-L35E, 1769-L32E 1783-ENBT support /0 over EtherNet/IP
1785-Lxxe,1785-ENET,1771-DMC(x),
2222 TCP CspP T747-L55%,5820-E1, PowerMonitor I, This is the source port for connections
RSLinx® Classic
3060 TCP rnadirft FactoryTalk Directory server file transfer
3622 TCP/UDP ff-Ir-port 1788-EN2FFR FOUNDATION Fieldbus
4000 upp Peer-to-peer Trusted Original simplex protocol
4120 Production server
Al Server manager
4122 | PlantMetrics™ server
TCP RPC RSBizWare™
4123 Task manager
4124 Scheduler server
4125 Scheduler CTP server
; . See the Knowledgebase Answer ID 68260 at http:/
4446 TCP TCP/IP FactoryTalk® Diagnostics (CPR SR3) www.rockwellautomation.custhelp.com
5000 upop Peer-to-peer Trusted, AADvance Enhanced (new) protocol
5241 ToP TCP/IP FactoryTalk Diagnostics (CPR9 SR4 and greater) See the Knowledgebase Answer [D 68260 at hitp./

www.rockwellautomation.custhelp.com
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Table 11 - TCP/UDP Port Descriptions

Port Type Protocol Products Comments
5450 Pl network manager
5454 .
Analysis Framework v1.x
5455
5456 TCP FactoryTalk® Historian Site Edition ACE 2 scheduler
5457 Asset Framework server
5458 Pl notifications
5459 Asset Framework to OLEDB Enterprise
6000 TCP Workbench Trusted Online debugger
6543 TCP rnaalarming FactoryTalk Marming server
7002...7004 TCP FactoryTalk AssetCentre (default) FactoryTalk AssetCentre services
7600 Event multiplexor
7100 TCP FactoryTalk Event server
70 Directory server
7120 HMI server
Z?z TCP FactoryTalk® View SE i;rlvaeg;\::;:;wmk
7123 Historical Data Log reader
8080 . Production server, reports
TCP HTTP RSBizWare
8081 Server manager
8083 TCP HTTP CTP Server
27000..27009 CP TCP/P e Lol LY., b e nowe tlir;éjbtaossrau/?nzbixrsl\[/]R%% p
184922 at http:/www.rockwellautomation.custhelp.com
1756-ENET,1756-ENBT,1756-EWEB,
1794-AENT,1734-AENT,1769-L35E, )
1763-L16x,1766-L32x, PowerMonitor3000, PanelView,
RSLinx Classic, FactoryTalk Linx
49281 Tcp TCP/P Fgg:gm::llﬁlil;\\;/es[éaﬁ?‘il tag server HMl tag server
55555 TCP Telnet AADvance from release 1.3 Diagnostic command-line interface
60093 TCP TCP/IP FactoryTalk Diagnostics (CPRI SR2 and earlier) a/?/:/gvst/hr% Em:ﬂgﬂgﬁggi&mﬁg&%o at hitp:i/
65207 TCP TCP/IP FactoryTalk VantagePoint Incuity® server advertiser
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Notes:
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PlantPAx Deployment Recommendations and
Verification Tool

The PlantPAx® verification tool is a Microsoft® Excel® spreadsheet (.xIsx) that
helps verify that functionality complies with PlantPAx deployment
recommendations.

Knowledgebase Technote, PlantPAx System Release 5.10
Configuration and Implementation Tools, contains the PlantPAx
checklist spreadsheet. Download the spreadsheet from this public
article and use the tab that is referenced in each step.

You may be asked to log in to your Rockwell Automation web account
or create an account if you do not have one. You do not need a support
contract to access the article.

Use the spreadsheet (.xIsx) file as is. There are formulas that correspond to
recommended PlantPAx settings. Any edits that you make can affect the
validity of the results.

Each section in this appendix contains a checklist that corresponds to a tab in
the verification tool. Each item (row) in a checklist corresponds to a row in the
verification tool.

Checklist Description

Design Recommendations Tab System design considerations and best practices

System Infrastructure Tab System infrastructure elements that are shared across all servers and workstations
Server or Workstation Tab Loading and configuration of each individual server and workstation

System Architecture Tab Design and configuration of your system components

PASS Tab Design and configuration of the applications that PASS servers host

Controller 5x80 Tab Application and load on a ControlLogix® 5580 or CompactLogix™ 5380 controller
Controller 5x70 Tab Application and load on a ControlLogix 5570 or CompactLogix 5370 controller
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Design Recommendations

The Design Recommendations tab lists best practices to follow when you

Tab design a PlantPAx system.
System ID
Design Recommendation Tab: Overall Considerations
Row Guidelines Description
4 PlantPAx Core Software bundle Catalog number of the PlantPAx Core Software bundle
The System Integrator generated the .raai file via the FactoryTalk® AssetCentre inventory agent
° Inventory agent The .raai file contains the System ID serial number There could be multiple .raai files, for example, one for
each subnet accessible by the FactoryTalk AssetCentre server
6 MyEquipment portal ggftglystem Integrator registered to the system, and provided directions on how to access the MyEquipment

274

The PlantPAx System ID is a unique identifier that helps simplify the
management of your application over its lifecycle. The System ID creates a
record of the installed hardware and software in the system and provides a
dashboard that shows the hardware lifecycle status, notifications of updates
and patches, and compatibility information.

The System Integrator uses an Asset Inventory Agent in a FactoryTalk
AssetCentre project to generate the System ID and .raai file. The System
Integrator registers your System ID with Rockwell Automation and provides
you directions on how to access your MyEquipment portal.

Knowledgebase Technote, PlantPAx System Release 5.10
Configuration and Implementation Tools, contains the System ID
instructions for System Integrators only to generate and register a
PlantPAx System ID.

You may be asked to log in to your Rockwell Automation web account
or create an account if you do not have one. You do not need a support
contract to access the article.

Rockwell Automation Publication PROCES-UM100C-EN-P - June 2022


https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/1128051
https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/1128051

Appendix C PlantPAx Deployment Recommendations and Verification Tool

Controller Considerations

Design Recommendation Tab: Controller Considerations

Row Guidelines Description

Keep the shortcut, ACD file name, and controller name similar (intuitive).
7 Controller name Follow a systematic naming structure to help identify each controller in all system components.
Inconsistent naming can create confusion in a production environment.

Follow ISA standards for control strategy and instrument naming schemes.

Keep in mind devices that are already labeled in the field and the wire/cable numbers that are in place.

8 Routine / Tag Names Existing names can mean less flexibility for future field device names.

ISA tag naming is an industry standard which design firms often follow when developing P&IDs. Link tags in
the controller to the P&IDs to help link the process (P&IDs) to the programming within the control system.

Organize control programs to contain logic based on required execution rates.
Organize code in a program within the desired task that aligns with the process area. If code for a given
I 9 process area must execute at different rates, create multiple programs in different tasks that are related to
the same process area. Program names should be the same in the different tasks but with an indication
that is embedded within the program name that indicates the task. This helps identify which task the
program resides in when the programs are organized in the Logical Organizer.

Controller Organizer

In the Logical Organizer, folder names should be the same as the primary graphic display names.

The Logical Organizer contains folders which contain the programs for specific process areas. Each folder
contains the code that supports the HMI display for a single process area and is aligned with alarm groups.
10 Logical Organizer The alarm groups provide navigation to identify which HMI displays contain active alarms.

The folders in the Logical Organizer should match the graphical hierarchy (L1, L2 & L3) so that the alarm
builder tool creates alarms in the appropriate alarm groups and populates the navigation bars correctly.

Have one routine per device to help ensure that online edits only affect that specific device.

Name each routine the same as the device name to help identify routines and their devices in the Controller
Organizer.

11..34 | Controller Routines Each device (such as motor, valve, PID) should use a standard PlantPAx control strategy that is
programmed in function block diagram.

Keep supervisory or device control logic external to the device control strategies. This reduces variability
among strategies and minimizes the risk of replicating modified control strategies.

Align programs with graphic displays (typically L3 displays) so that the routines in a program have the
same primary HMI display.

« Alarm annunciation breadcrumbs highlight the associated navigation bar button.

« If you add a device to a display, the device is also added to the associated program and alarm group.

15 Controller Programs

Library Considerations

Design Recommendation Tab: Library Considerations

Row Guidelines Description

16 Process Library Objects Do not modify process library Add-On Instructions or graphic objects.

Alarm Considerations

Design Recommendation Tab: Alarm Considerations

Row Guidelines Description

17 Standards Follow ISA 18.2 standards for alarm management

Avoid extensive use of ALMA and ALMD instructions. These instructions provide a high-resolution time
stamp, but they also use considerable data server bandwidth. Minimize ALMA and ALMD use to only those
alarms that require high-resolution time stamps.

Instead use tag-based alarms and FactoryTalk® Alarms and Events alarms.

18 ALMA / ALMD Alarm Instructions
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Design Recommendation Tab: I/0 Considerations

1/0 Considerations

Row Guidelines

Description

19 RPI

Ideally, the I/0 RPI equals half of the task execution time (0.5 * associated task period).
The 1/0 update sampling frequency should be twice the frequency of the logic execution. More frequent
sampling over uses I/0 communication bandwidth. Less frequent I/0 sampling can result in poor control.

20 Consistent 1/0 Methodology

Select an 1/0 connection method: I/0 mapping, direct I/0 connection, aliasing, or program parameters.
Choose a method that works best for your installation and consistently apply this method throughout your
application.

Design Recommendation Tab: HMI Considerations

HMI Considerations

Row Guidelines

Description

2 Graphical Framework

Use the Graphic Framework that comes with the process library. This framework helps achieve a consistent
delivery of HMI displays.

22 Follow ISA 101 Style Guide

The standards help achieve a consistent delivery of HMI displays. The standards also help draw attention to
information that requires attention.

23 Naming Conventions

The naming of graphic displays follows the Logical Organizer hierarchy. This alignment helps locate
associated programming for future additions and changes.

24 Design for the Future

Name applications and Areas with future development in mind.

System Infrastructure Tab

System Infrastructure Tab

The System Infrastructure checklist assumes:

Your PlantPAx system is operable (for example, the HMI application is
running and the latest operating system patches are installed).

Your system infrastructure has been configured such that:

You've defined a range of IP addresses for the DHCP server in the
domain, if applicable for your system.

You have created groups and assigned users in the domain controller.

If you're using virtualization, the VMware vSphere Client software is
installed and connected to a vCenter server or ESXi (hypervisor) host.

Row Guidelines

Description

BIOS Power-Saving Options Disabled?

4 Hardware From the computer BIOS, specify whether the BIOS power-saving options are disabled. Power-saving
options reduce computer resources for your system elements.
Using Virtualization? S

5 Virtualization Specify whether your system uses virtualization.

We recommend use of VMware due to the extensive testing and development of PlantPAx virtual templates.
VMware also simplifies maintenance, backup, and disaster recovery.
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System Infrastructure Tab

Row Guidelines Description

If you're using virtualization, enter the percentage of CPU use and memory use for each computer.
« CPU use recommended to be within 50% of resources
« Memory use recommended to be within 50% of resources

From the web browser (Firefox recommended), enter the IP address of the vCenter server and log into the
web client.

If a group of ESXi hosts is available in the selected context, select the host or group of hosts from the Source
list to generate an HTML output. Print the output and store with the verification tool.

| @
T CrestePegister v | [Jig Shutdown  [Bg Rebool | & Retush AcSons
— eru rnge. 377 aiis
Wer sion 650 update 1 g
URED: 30 Ghe CAPARITY 418 04e
Saln Hormal
= § Ustine: 137 SSdme wEmaRr FREE 88 08
= =
2 = sy CARAGITY 4390 00
5|
b s10kace s s
: —
uiEe 103 T8 capaiTe T TH
6-13 Hypervisors E
Bl [~ raroware
s | |- contguation
| | = Sywiom Information
a
e = Parfofmance summany [ast houor
| oy
jiae L] R0
toa
(1]
‘ g
z® 50 H
] 5
i 5w « £
H 1 s
E ) L
) | |-
w 0
4 3
o 0| i g
e ...
1ho n 1321 1330 1230 1248 1355 1z
Timie

All servers and workstations are in the same domain
Specify whether all servers and workstations are on a Windows® Domain.

On the domain contraller, go to Server Manager > Tools > DNS and verify that all servers and workstations
are listed in the DNS Manager dialog box.

£ DNS Manager - m} x
File Action View Help

o= HEXEcz Bzl 8@

£ DNs Name Type Data
v B s Bl et
~ [ Fomwerd Lookup Zones Tt
> (6] _mads.PlantPAs RockwellAutomation com | =7~
» (2] PlantpAxRocknellAutomation.com Tote
» ] Reverse Lookup Zones -
n Domain » B8] Trust Points gDomamDn;Zones
5 [7] Conditional Forwarders CForestbnsZones

[El(same as parent folder) Start of Authority (SOA)  [121], padca.plantpax.rock.
[Elsame as parent folder) Namme Server (NS) padcb.plantpacrackwella...
[Elisame as parent folder) Name Server (NS) padca plantpaxrockwella...
[El(same as parent folden Host (4) 172.20.1.10
[El(same as parent folder) Host (4) 17220111
Elpader Host () 17220110
[Flpadea Host (4) 172.201.10
[Elpancs Host (4) 17220111
[Elpasso Host (4) 172201110
[Flpassoz Host (4) 172201111
i asiHo1 Host (8) 172.20.1.101
ElasiHoz Host (4) 172201102

< P IR 4 >

In the Notes, document any clients that aren't in the domain and why.
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System Infrastructure Tab: Network

Network

To collect the network data, collect the network data manually from the
webpages of each switch.

See Chapter 4, Network Infrastructure for details.

Row Guidelines Description

15 Bandwidth Utilization % Verify bandwidth < 50%.

16 Packet Error Rate Verify that there are no packet errors.

17 Temperature 0K Verify that all devices aren't reporting high temperature readings.
18 CPU Utilization % Verify CPU use < 50%.

19 Memory Utilization % Verify memory use < 50%.

Server or Workstation Tab

278

Servers and Workstations

List the following for each server and workstation in the system (rows 20...93).
The Server or Workstation tab is where you record data regarding each server
and workstation:

« Computer name
« System role (select from pull-down)

The Server or Workstation Name checklist assumes:

«  Your PlantPAx system is operable (for example, the HMI application is
running and the latest operating system patches are installed).

« The Performance Monitor (PerfMon) utility is connected to the servers
and workstations that are being verified

IMPORTANT  Make a copy of this worksheet for each computer (server or
workstation) in your system.
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Operating System

Verify these operating system requirements.
Server or Workstation Tab: Operating System

Row Guidelines Description

Specify whether the Windows firewall is enabled.
For each computer, go to Control Panel > Windows Firewall > Advanced Settings.

0 Windows Firewall — a X
« « 4 @ <« System and Security > Windows Firewall v @ | Search Control Panel p
p i P Help protect your PC with Windows Firewall

Windows Firewall can help prevent hackers or malicious software from gaining access to
your PC through the Internet or a network,
) Change notification settings

l v Domain networks
) Turn Windows Firewall on or

off Networks at a workplace that are attached to a domain

Allow an app or feature
through Windows Firewall

Connected |

9 Restore defaults

| Advanced settings

Troubleshoot my network

IWinduws Firewall state: On I

Incoming connections: Block all connections to apps that are not

on the list of allowed apps

Inbound rules allow or block inbiound network traffic. Verify that Rockwell Automation software is allowed so that data
and information isn't blocked between application servers.

4 Windows Firewall Being Used

@ Windows Firewall with Advanced Security - m] bl
File Action View Help
b ol ARl s (NESN 7

* AUNE LA I USRS Inbound Rules  Filtered by: Domain Profile Actions
&3 Inbound Rules

~
Name Profile Action

>

Inbound Rules -
Outbound Rules

¥y Connection Security Rules 9 RSLinxNG.exe Domain  Allow
0 RSLinxNG.exe Domain  Allow
0 RSLinxNGO2.exe Domain  Allow
0 RSLinxNGD2.exe Domain  Allow
@ RSLinxShortcutAOAe..  Domain  Allow
@ RSLinxShortcutAQAe..  Domain  Allow
@ RsvcHost.exe Domain  Allow

New Rule...
B Monitoring Filter by Profile  »
Filter by State 3
Filter by Group ¥

Clear All Filters

P

View 3
0 RsvcHost.exe Domain  Allow

Wi CamoarFrmmmaminrl ave Plrmazin Allnans €1 Refresh
Specify whether the server or workstation operating system that you're using matches PlantPAx system
recommendations.

See the PlantPAx Distributed Control System Selection Guide, PROCES-SGOO1.

5 Operating System Valid

Specify whether you installed the latest software patches for the Rackwell Automation software that is in the PlantPAx
system.

All servers and clients in the system must have the same FactoryTalk® patch updates to avoid unexpected results.

6 Rockwell Software® Patches Applied

Specify whether you disabled power-saving for the Network Interface Card (NIC).\
For each computer, go to Control Panel > Network and Sharing Center > Properties > Power Management.

Make sure the ‘Allow the computer to turn off this device to save power’ is disabled (no check mark).

[ Corp Properties >

Intel(R) B2574L Gigabit Network Connection Properties x
Networking  Sharing

Genersl Advanced Driver Details Events Power Managsmant
Connect using:

NIC Power-Saving Options Disabled

@ Intel(R) 82574L Gigabit Network Connection

This connsction uses the following tems

Client for Microsoft Netwarks -
" File and Frinter Sharing for Microsoft Networks

IEQOS Packet Scheduler

4 Intemet Protocol Version 4 {TCP/IPv4)

[0 4 Microsoft Network Adapter Multiplexor Protocol

4 Microsoft LLDP Protocol Driver

4 Intemet Protocol Version 6 {TCP/IPv6) v
< >
Install Uninstall Properties
Description
Alows your computer to access resounces on a Microsoft
network.

OK Cancel

@] Intel(R) 82574L Gigabit Network Connection

Ij Allow the computer to tum off this devics to save pnwerl
Allow this device to wake the computer

Only allow 3 magic packet to wake the computer

Cancel
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Server or Workstation Tab: Operating System

Row Guidelines Description
Specify whether you disabled power-saving for the Windows operating system.
For each computer, go to Control Panel > Power Options and verify the Change when computer sleeps field is set to
Never.
E Control Panel\System and Security\Power Options\Edit Plan Settings — O
= v E <« Pow.. » EditPlan Set... v O Search Control Panel el
8 Windows Power-saving Options Disabled Change settings for the plan: Balanced
Choose the sleep and display settings that you want your computer to use,
[ Turn off the display: Mever ™
% Putthe computer to sleep: || Never w
Windows Server 2016 and newer have Remote Desktop Server (RDS) functionality that is enabled by default.
9 Desktop Experience Enabled in RDS Servers Windows Server 2012 and prior, RDS is disabled by default and you need to enable the functionality. For each
computer, go to Server Manager > Local Server and review the Roles and Features listings.
Specify whether Windows settings are enabled for best performance.
When Adjust for Best Performance is selected, enhanced features that aren't used are turned off, which yields more
memory and performance for the system.
For each computer, go to Control Panel >System > Advanced System Settings > Advanced tab > Settings and on the
Visual Effects tab, make sure Adjust for best performance is enabled.
Performance Options X
. Visual Effects  adh d DataE ition Pr ti
10 Adjust for Best Performance Is Selected voneed el meatonrEventen
Select the settings you want to use for the appearance and
performance of Windows on this computer,
(O Let Windows choose what's best for my computer
(O Adjust for best appearance
(O Custom:
[ Animate controls and elements inside windows
[ Animate windews when minimizing and maximizing
| R P S S S
Specify whether Data Execution Prevention is enabled for essential Windows programs and services.
For each computer, go to Control Panel > System > Advanced System Settings > Advanced tab > Settings and on the
Data Execution Prevention tab, make sure ‘Turn on DEP ...is enabled.
Performance Options *
. . . Visual Effects Advanced Data Execution Prevention
1l Data Execution Prevention Windows Only
o Data Execution Prevention (DEP) helps protect against
'_J darnage frorm viruses and other security threats. o
Hoes itworkd
| (® Turn on DEP for essential Windows programs and services only
() Turn an DEP far all programs and services except those | select:
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Server or Workstation Tab: Operating System

Row Guidelines

Description

Specify whether a user is never notified by the User Account Control.
For each computer, open the User Account Control settings and make sure Never Notify is enabled.

& User Account Control Settings — El b4
"
Choose when to be notified about changes to your computer
User Account Control helps prevent potentially harmful programs from making changes to your

computer.
Tell me mere shout User Account Control settings

Always notify

= Never notify me when:
12 User Account Control Never Notify « Apps try to instal software or make changes to my

computer
- T ®  |make changes to Windows settings
o @ ot recommended.
v
[ ®ok || cancel

13 This step is for computers that are not internally managed by a Windows System Update Server (WSUS).

Windows Automatic Update Is Disabled

Verify that Windows automatic update is disabled. Disabling this functionality helps prevent updates that haven't
been qualified by Rockwell Automation from being installed on the workstation or server.

For Windows 10, Windows Server 2016, Windows Server 2019 operating systems:
1. Open the Run command (Win + R) and enter: services. msc

2. Select the Windows Update service from the Services list.

3. On the General tab and change the Startup Type to Disabled.

4. Restart the computer.

For Windows Server 2012 and prior:
1. For each computer, go to Control Panel > Windows Update and make sure that the update option is disabled.
2. Restart the computer.

B0 |

g ipetai i e b v sl s ricrars: aly

Ty gorrgte; gkeng b ki sprron Syt e

o ol yoae B wed o piarded waen by eaield apeden
E

s o i pslaley

14

Event Viewer Is Not Presenting Errors

Verify that the Event Viewer is not showing errors in the logs.
For each computer, go to Administrative Tools > Event Viewer and verify that each log does not contain errors.

] Event Viewer - m]
File  Action  Wiew Help
@ 2w
@ Event Viewer (Local) FactoryTalk Diagnostics  Mumber of Actions
o Custorn Views
v [ Windows Logs ¥ Filtered: Log: FTDiag; Lewel: Information; Source: . Nurnber of events: 1,147 Factory..,
& Application Level Date and Tirme Source EventlD Tasha | |5 0P
g—ll ZEE“”W (@ Information 5/1/20208:34:36 4 FactoryTalk Service 1001 Ope ¥ o
= SE lt": (D) Information S/1/2020 827:20 &M FactoryTalk Lirne OPCServer 1001 Ope o
| System
E.—| Firwarded Eidhits @Information 8/27/2020 3:46:15 PM FactoryTalk Wiew Studio 1001 (3 el
= K o @Infurmatlun 8/27/2020 3:46:13 PM FactoryTalk Wiew Studio 1001 (%)
w L Applications and Services Lofll = ¢ g g F Filt..
= CrowdStike (i) Information  8/27/2020 3:46:11 PM  FactoryTalk Wiew Studio 1001 (3) %
£ 7 1 Information Ag; actoryTal Tewy Studio
] FactoryTalk Diagnastics | () Information  8/27/2020 3:6:11 PM  FactoryTalk View Studi 1001 (3 cl
f&] Hardware Events (D Information 8/27/2020 3:46:11 PM  FactoryTalk Wiew Studio 1001 (3) D Pr...
] Internet Explorer (@) Infarmation  8/27/2020 3:4611 PM  FactoryTalk Wiew Studio 1001 (3) @ Fin
Kew hdanagement Se i @Information 8/27/2020 3:46:11 PM - FactoryTalk Wiew Studio 1001 (3 w i

Rockwell Automation Publication PROCES-UM100C-EN-P - June 2022

281



Appendix C

PlantPAx Deployment Recommendations and Verification Tool

Server or Workstation Tab: Operating System

Row Guidelines Description
Verify the mappings of IP addresses to host names
EX Command Prompt = x
15 NSLookup Resolved
Performance
The Windows Performance Monitor (PerfMon) utility provides a snapshot of
the current performance of a computer. To generate a performance report, do
the following for each server and workstation:
1. From the Performance Monitor utility, go to Data Collector Sets > System
> System Diagnostics and select Start.
(&) Perfarrnance Monitor - m} *
ié‘i'i' File  Action  Miew Window Help -]
o= | 7@ XE = H= P &l
l?_‘Eﬁ] Performance MName Type Outp »
vl Mﬂonitoring jloals . L] NT Kernel Trace
= B Performance Manitor “| Cperating System Configuration
. D]ata Collect.or ety IPracessor Configuration
&, User Defined 3 _ ;
= Systern Services Configuration
v L Systermn . n n s :
) By Dliage Logical Disk Dirty Test Conf!guratfon
¥ System Perfor Start I Configuration
1) Bvent Trace Sessia Stap Configuration
(_ Startup Event Trac Save Template.. Configuration
[ Reports Configuration
Data Manager.. Confiquration
The system diagnostics procedure takes about 1 minute.
282
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2. Toview the report, go to Reports > System > System Diagnostics.

Server or Workstation Tab: Basic System Checks

() Performance Manitor - El X
@‘J File  Action  View SWindow Help -8
e p@E Xmd B EEC
() Performance [Basic System Checks
v [ Monitaring Taals — A
X Tests Result Description
B8 Performance Maonitor o
v _:'5 Data Collector Sets 05 Checks e Checks for attributes of the operating system
3_, User Defined Y
v [ Systemn Disk Checks Pasced Checks for disk status
- System Diagnastics Checks for state of Securi
- . ty Center related
¥ Systern Perfarmance Security Center Tests Passed  information.
) Event Trace Sessions
i Startup Event Trace Sessions System Service Checks B Checks for state of system services
N |] Reports & Hardware Device and (v} Survey of Windows Management Infrastructure
ﬁ User Defined Driver Checks Passed  supported devices.
v & System
~ L Systern Diagnostics Performance ()
Iﬁ PASS01_20200901-000001 I
0 Systern Performance Resource Overview
Component Status Utilization Details
CPU Q ide 17% Low CPU load. v
Network @ Ide 0% Busiest network adapter is less than 15%. &
Basic System Checks

Use the performance report from the Performance Monitor utility to verify the
basic system checks.

Row Guidelines Description

7| prting s s syt e e b s st Lo s,
8 Disk Checks Verify the status of the disks in the operating system.

19 Security Center Tests Verify system security-related information.

20 System Service Checks Verify the state of system services.

2 Hardware Device Driver Checks Verify the Windows management of supported devices in your PlantPAx system.

Resource Overview

Use the performance report from the Performance Monitor utility to verify the

resources.
Server or Workstation Tab: Resource Overview
Row Guidelines Description
9 cPU (%) Verify that the CPU load complies with PlantPAx system recommendations. ]
In a virtual system, the chip set on the hast machine (server) can affect CPU capacity.
23 Network (%) Verify that the busiest network adapter is < 50%.
24 Disk (/sec) Verify the operations per second performed by the hard disk drive.
25 Memory (%) Verify the memory capacity of the server or workstation.
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System Architecture Tab

Data Servers

AMarm Server (if used)

HMI Server

284

The System Architecture checklist assumes:

«  Your PlantPAx system was based on sizing recommendations from a

PlantPAx System Estimator project.
See Chapter 1, System Workflow.

« Your PlantPAx system is operable (for example, the HMI application is

running and the latest operating system patches are installed).

«  You have configured the following FactoryTalk software that you need

for your application servers.

FactoryTalk View Application Design

To verify these attributes, use the FactoryTalk® Administration Console or the

FactoryTalk® View Studio software.

F, FactoryTalk Administration Console - [ X
File View Tools Window Help
‘Aalz

Explorer - I
=08 Metwork {THIS COMPUTER)

Fa FTviewDemo
Fa

= E Server 1
E.! FactoryTalk Linx Instance 01
= E Server?
E-. FactoryTalk Linx Instance 02
= E FTAE
= §* TagAlarm and Events
* 2 Alarm and Event Setup
=-HE HMI
2 HMI Server
= System
Action Groups
Policies

Computers and Groups
&5 Metworks and Devices
Users and Groups

Connections
Perrnission Sets

Application e he GE

Server segregation helps optimize performance. To help prevent unpredictable

search results, do not insert a server into the application root path.

IMPORTANT  Each server must be in its own area. This creates a unique path for
each server so that clients don't need to examine every server.

Design the system with of future growth in mind. Future growth can affect

area names and how you segregate server by controllers within an area.

To improve performance, place:

. Data servers, alarm servers (if used), and Historian interface connectors

on the same image
« HMI and other application servers on separate images
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System Architecture Tab: FactoryTalk View Application Design

Row Guidelines Description
The system supports 10 HMI servers, whether they're redundant or not (you can have 10 redundant pairs).
The number of servers and how they're configured can impact the speed of system communication. Use
4 Number of HMI Servers the application tree in the FactoryTalk Administration Console and select the project to be analyzed.
« Reference, identify, and count all HMI servers in your system.
« If a server is secondary, do net add the secondary HMI server to the count.
The system supports 10 Tag Alarm and Event servers, whether they're redundant or not (you can have 10
5 Number of Alarms Servers redundant pairs).
Use the application tree in the FactoryTalk Administration Console and select the project to be analyzed.
« Reference, identify, and count all Tag Alarm and Event servers in your system.
The system supports 10 data servers, whether they're redundant or not (you can have 10 redundant pairs).
6 Number of Data Servers Both FactoryTalk Linx and OPC UA data servers count towards the limit.
umber Of Uata oerve Use the application tree in the FactoryTalk Administration Console and select the project to be analyzed.
« Reference, identify, and count all FactoryTalk Linx and OPC UA data servers in your system.
Each server must be in its own area. This creates a unique path for each server so that clients don't need to
examine every server before they find the data they need.
Server segregation helps optimize performance. To help prevent unpredictable search results, do not
insert a server into the application root path.
rd FactoryTalk View Studio - View Site Edition (Metwork Distributed)
File View Settings Tools Window Help
mHe neE o/ e anEir ey
=8 Network (LOCALHOST)
£ PlantPax HMI
w- Runtime Security
i Each Server Is In Its Own Area S0E Serverl
E = FactoryTalk Linx Instance 01
20 E Server
(o B= FactoryTalk Link Instance 02
[EE e
= F* Tag Alarm and Events
L. /5] Alarm and Event Setup
=B HMI
=-1= HMI Server
[ B System
[ 85 HMI Tags
[ 1 Graphics
[#- 1 Logic and Contral
[ 1 Data Log
[#- 7 RecipePro+
System
For more information see, Knowledgebase Technote FactoryTalk View SE Area Best Practices.
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FactoryTalk View HMI Servers

Verify that the HMI servers on the PASS comply with system
recommendations.

System Architecture Tab: FactoryTalk View HMI Servers (PASS)

Row Guidelines Description

We recommend the use of FactoryTalk® Historian software rather than FactoryTalk View SE data logs to
collect and analyze system data.

To check if data logs are used in a FactoryTalk View SE project, open a Data Log folder in the HMI server.
Verify the data log model is empty.

.’21 FactoryTalk View 5tudio - View 5ite Edition
File = View Settings Tools Window
imEHEs he O R A
Explorer - HMI Server + o X

B-EEI Metiork (LOCALHOET)
8 Uses Data Logging BB PlantP A HMI

L me Runtirme Security

E FTAE
£ HMI
EEE HMI Server
System
G 15 HMI Tags
D Graphics

8

Logic and Control

Data Log
B o

You can have only THMI server per computer.

In FactoryTalk® View Studio software, open Properties for each server and confirm the computer host

name.
Explorer - HMI Server > o x Hil Server Praperties *®
E1TE Netwark (LOCALHOST)
s PlantPax HMI Genetal Redundancy Components
i.wo Runtime Security
i 5 Mame;
cripts
E DATA HMI Server
E FTAE Destriptian:
= H
B HM| Server
Systerm
9 Dedicated Servers Compuker hosting the ssrver
[ Passnz |

Startup Type
(O on demand (Redundancy will be disabled)

(®) Load and run skartup components when operating system initializes

Project Fils (relative bo server computer):

‘ C:\Users\PUbliciDocuments\RSView EnterpriselSEWMI ProjectsiHMI Server ‘

Mumber of displays: 3 Licensed maximum: 250

Cancel Aipply Help
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System Architecture Tab: FactoryTalk View HMI Servers (PASS)

Row

Guidelines

Description

Redundancy Status

In the FactoryTalk Administration Console, select the HMI server > Server Status.

Server Status - PlantPAx_HMIHMIHMI Server -

Server status
Primary server: PASS02

Primary status: I| Active I ‘

Secondary server: PASS03

—
Secondary status: I| Standby I |

Switchover options

ontinue using the secondary server even when the primary server becomes available again

(®) Switch over to the primary server when it becomes available

Server switchover

Click the Switchover button to switch the Active server. The server thatis currently on
standby will become the Active server and the Active server will become the Standby server.

Switchover

In the verification tool:

« |f the status for one server is ‘Active’ and the other server is ‘Standby’, record Synched.
- Ifyou have different results, choose ‘Not Synched’ and identify the servers that are ‘Not Synched' in the

Notes.
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FactoryTalk Alarm and Event Servers

Verify that the alarm servers on the PASS comply with system
recommendations.

System Architecture Tab: FactoryTalk Alarm and Event Servers (PASS)

Row Guidelines Description

You can have only Talarm server per computer.

L Dedicated Servers In FactoryTalk View Studio software, open Properties for each server and confirm the computer host name.

Use the FactoryTalk Administration Console to select the alarm server > Server Status.
In the verification tool:
12 Redundancy Status « |f the status for one server is ‘Active’ and the other server is ‘Standby’, record Synched.

« If you have different results, choose ‘Not Synched’ and identify the servers that are ‘Not Synched' in the
Notes

In the FactoryTalk Administration Console, open the Properties for the alarm server and check Enable
History to log alarm history.

Tag Alarm and Events Properties X

General Redundancy Friorties and History

Friorities
Enable server-assigned priorties

Severity Range
Priority Low High

Medium

Low

13 Alarm & Event History

Alarm and Event History

Enable history

Database definition

| Production Alamms v

Computer name: PASS01

Database name: Production Alams

Cache file path:

|C:'.Progmm Data\Rockwell\Alarms ‘

Log languages
[ Engich (United States), envUS “]

Coos ey Hep
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FactoryTalk View Data Servers

Verify that the data servers on the PASS comply with system
recommendations.

System Architecture Tab: FactoryTalk View Data Servers

Row Guidelines Description
. FactoryTalk Linx supports 2 data server instances on one computer.
t Max Number of FTLinx Instances on any PASS In FactoryTalk View Studio software, open Properties for each server and confirm the computer host name.
. UPC UA data servers should be hosted on a dedicated computer. No additional Data, Alarm or HMI servers
E Dedicated Server for OPC UA should be hosted on the same computer with an OPC UA data server.
Use the FactoryTalk Administration Console to select the data server > Server Status. For OPC UA, select
Properties > Redundancy.
% Redund Stat In the verification tool:
edundancy status « |f the status for one server is ‘Active’ and the other server is ‘Standby’, record Synched.
« If you have different results, choose ‘Not Synched' and identify the servers that are ‘Not Synched' in the
Notes
In the FactoryTalk Administration Console, open the Properties for the data server and check Enable History
to log alarm history.
FactoryTalk Linx Server Properties X
General Redundancy  Alams and Events
/8 FIEnable slarm and event support
Priorities
EJEnable servarassianed priniies
Severity Rangs
Friority Low High
Urgent
High
Medium
Low
Alarm and Event Histary
Enable kistory
Database definition:
FTAE ~
Computer name: 510501
Database name:  PlantPax
Cache file path:
|c ProgiamD ataFiockwelllarms |
Log languages
[ Engiish (ited tates), en 5 v
7 Alarm & Event History Corce |1 foeh teb

o gt Lo

3 Cancel

FactoryTalk AssetCentre Configuration
As arule, do not to exceed 100 assets over a 12-hour period per agent.
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To verify the FactoryTalk AssetCentre configuration:
1. On the AssetCentre menu bar, select Help > About.

g FactoryTalk AssetCentre - I:'-
File Edit View Tasks Tools WindDwslm
B E S b E @ KB As  Contents Brchive &
AssetView 1 X & Show Help F1
& Design e Installation Guide
%, ssetCentre ! Quick Start
[:]

2. Inthe Components box, select FactoryTalk AssetCentre Server Features.

About FactoryTalk AssetCentre -

) FactoryTalk AssetCentre ‘Waming: This computer program is protected by copyright law and
\ v. B.00.00.199 intemational treaties. Unautherized reproduction or distribution of
this program, or any portion of it, may result in severe civil and
(c) 2018 Rockwell Automation Inc. criminal penatties, and will be prosecuted to the maximum extent
possible underthe law.

Components:
Contact Information
actoniTalk AesatCanire Clie

‘Compenent details:

~ | Licensed Asset Capactty: Unlimited
Agent Groups Irformation Asset licenses inuse: 0
FactoryTalk AssetCertre Server = | Total system assets: 1

Disaster Recovery - Rockwell

Disaster Recovery - Motoman

Disaster Recovery - Fanuc

Calibration Management

Calibration Management - Remote workstation
Calihratinn Mananement - Fluke handheld

< m >

Server Licensed tor

Windows User

System Architecture Tab: FactoryTalk AssetCentre (AppServ-Asset Mgmt)
Row Guidelines Description
18 Number of Assets Licensing determines the allowable number of assets. A base license includes 10 assets.

From the Details pane of the FactoryTalk AssetCentre dialog box, verify the number of total system assets.

Specify the number of controllers that are configured for Disaster Recovery (requires a Disaster Recovery
19 Number of Disaster Recovery (DR) Assets license).

Select Disaster Recovery - Rockwell in the FactoryTalk AssetCentre dialog box.

Agents are programs that communicate with the FactoryTalk AssetCentre server and perform server tasks,
such as disaster recovery.

By using agents, work is distributed and shared among computers to help spread processing load. View the
2 Number of Agents number of agents in the bottom-right corner of the FactoryTalk AssetCentre dialog box.

& SYSTEMADMINISTRATOR 33 Connected ‘
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System Architecture Tab: FactoryTalk AssetCentre (AppServ-Asset Mgmt)

Row Guidelines Description

Determine the frequency that the assets are scheduled to upload.
Enter the number of days between asset uploads from the Schedules > Timing properties dialog box.

FactoryTalk AssetCentre
G @ e A Ctvier @ v 3 Lo [B i @8 snes 2 @
=
- Loai5000 PlantP A Timing Propstiss o -
. evepdya 1108 |
21 How Often DR Assets Configured to Upload =]
EEEET

® Wby Locsion ) ViewDpass T

Siset i LoghECCE PeriPie
0 Losesnn Pl Lo 500

FactoryTalk Historian SE Configuration

Verify that the following FactoryTalk View Historian SE design attributes
comply with system recommendations.

System Architecture Tab: FactoryTalk Historian SE (AppServ-Info)

Row Guidelines Description

Verify the number of paints that are in use.
To view the number of points on the FactoryTalk Administration Console dialog box, go to System >
Connections > Historical Data and select the Historian SE server.

- FactoryTalk Administration Console
, TonlNindbas FiEID,
E
Explorer !J Production Histerian - Historian Server Connection Properties -
. = Metwark (PASSOT)
2 Points In Use e Genmal ] Lmnsng| Pt Sovcer
= System Intedace Type Painis inLUse Linuk

(3 Action Groups

w21 Policies gm"’:‘“' 7 0
#1(Z) Computers and Groups e 1] ]
q
g 'Q”” Py Irtedace Type Allocaticn Poiris inLise Linit
# C) Users and Groups s ‘ - :

=23 Connections
# 0 Databases
=20 Historicsl Dsta
% B Production Historian
&5 FTLD

The limit depends on the points in use and the license limit.
23 Points Limit This value sets a benchmark that can be compared to future server results. The comparison can identify a
potential issue with too many points per license.
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System Architecture Tab: FactoryTalk Historian SE (AppServ-Info)

Row

Guidelines

Description

24

Fastest Scan Class

Verify the scan rate that is used in FactoryTalk Live Data to send controller information to the Historian
server. This information can be viewed with Paint Builder in PI System Management Tools or using the
FactoryTalk Historian SE Excel Add-in tool.

From Excel, on the Pl Builder tab, select PI Points > All Points and select all columns.
The column labeled Location 4 is an integer used by many interfaces to specify the scan class of the PI
Point.

[ (e —— " Sacatient fecationt Io-‘mqlhlnhm\-n.lln

1]
i
i
1
'
L
1]
1
i
1
1
1
1]
1
I
1
1
1
1]
1
1
1
1
1
1]
i
1

The Pl Interface Configuration Utility defines time period of each class number. For example, the FTLD1
interface contains 10 scan classes in terms of seconds.

d(raoRE Ae

iedwn [T PTG FRESE
] Pt itk e D

sy Tirrng LG -]

Typically, a scan class of 1second is sufficient. Some tags can require a scan class of 0.5 seconds.
Exception reporting and compression reporting for tuning parameters are important for data collection and
server loading.

Number of Interfaces

Specify the number of FactoryTalk Live Data interfaces in your Historian configuration.

292
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System Architecture Tab: FactoryTalk Historian SE (AppServ-Info)

Row Guidelines Description
Buffering is recommended to maintain data collection in the event the connection to the server is lost.
@ 1ager - O
File View Help
Buffering Manager
Configuration, monitoring, and troubleshooting of buffering
Global
b @ Global Buffering Status Pl messages
26 Buffering Enabled and Running There ateonported e i
P 0.0 seconds estimated buffer capacity
f all connections are severed, estimated time until data loss
P 0 events in queue
Total queued events for all servers
B 0 total events sent
Total queued events sent for all servers
Logical Servers
Select a server below for more detailed information
On the Interface Configuration Utility, verify that failover is configured properly.
[V Enable Unilnt Failover " Phase 1 * Phase 2
Failaver D4 for this instance: [T [swPASS0ZANFTLDIN
Failover |D# of the other instance:  [2 [\\PASSO2BAFTLD Intt ><| Biawse \
[ Do not failover when both interfaces lose connection ta P
i H 1 [~ Failover control tags are unsolicited [not scan based)
27 Unlt Fall Uver EnabIEd and Runnlng Rate at which the heartbeat point is updated/checked:  |G000 milliseconds
UFO Type: Spnchranization File Path:
[HaT x| |\passD1\FTHSE_Failover\FTLDInt_FTLD_1 dat Browse
Status | Tag | Exdesc | PaintSouce ~
Mot Created ASIHOT-FTLDInt_1_FTLD_UFO2 ActivelD [UFO2_ActivelD] FTLD
Mot Created &SIHO1-FTLDInt_1_FTLD_UFD2_Heartbeat_1 [UFDZ_Heartbeat1]  FTLD
Mnt Crpaterd ASIHNT-FTIDInt 1 FTI D HFO? Heatheat 2 MIFAZ Heartheat?1  FTID e
< >
Verify that a collective is properly configured in a redundant Historian systems
% Pl Collective Manager [(Administratar) = [m] x
File  Edit Help
Collectives Collective Mame: |ASIHO1 Collective 10
% ASIHOT Desciptiore o] PlarFieFrasioali | [£4247833-1477-4164-2541-28370007 ki | [
. . Last Configuration St
28 Collective Enabled and Running Change Time: |01:62p 2020151827 | [Good |
& % | @
ASIHOZ asih01
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PASS Tab

294

Color-coded cells indicate
threshold issues.

The PASS tab records details about the HMI elements in your application.

IMPORTANT  Make a copy of this worksheet for each PASS in your system.

To verify your FactoryTalk® View Site Edition (SE) HMI design elements, use
the Rockwell Automation Graphic Audit Tool. The audit tool analyzes exported
HMI displays. The Rockwell Automation Graphic Audit Tool can be found in

Knowledgebase Technote, PlantPAx System Release 5.10 Configuration and

Implementation Tools.

Before you run the audit tool, export the HMI application graphic files to an

XML format. Then run the audit tool on the XML file.

# Graphic Audit (Version 1.11) [ ==
s o s nama [a.g. BeswrgHM I}
ﬁ::m Data Chert

¥ Cieate fes for Dasta Chent tool

¥ Creste fie of evposssicns and commands lound © Toisl _
¥ Creats e of okl abiects fourd togr | © s e |

Folder that contans graphic XML fles o pedoim sudit opsestons on
[Echeckist daplays |

Expeassions| S |Okbal - ADipley |0,

Graphic Name Total Tags o o Tre L

The process displays are listed in the Results pane.

# Graphic Audit (Version 1.11) [= =i
Apphcatior: faes rame .9, Brewing/HMI}:
& SE - Mabwork " SE - Local = ME P‘“
M ame:
|narm Data Clhent

¥ Cinate fles for Dala Clert tool

[ Conate fle of eupressions and comemands found © Towltagr @ Urigue tags

¥ Coeale fie of gobal objects found
Folder that contains graphic <ML files to perfom audit operations onc

i:.u_n A i DiesktophF: d dplay _j

Allowe
. Uri s | Al Ghbal | Di Mudty Cache Aiter

GeicHans TotlTags 7% | Exprossons B00  |B000 [T Lr va_::n dvar el
IAFF) Butlees: 1] [1 0 0 0 replace 1 lake [F] [P
(PP Display 1590 mz2 81 1} 56 replace 025 fake lase [
|4PP] Motors 2127 1584 1076 0 87 replace 1 lalse false falie
FPIFID 809 563 518 0 32| replace 1/lakse false falsn
IAFF] Tank 57 2 24 ] 1 replace 1 fakse alse [
PP Tank2 = 1 13 (i} 1 replace 1| lake (™ [
|APP] Tank3 0 18 15 1) 2 replace 1 lalse false False
(5PP] Vabves 6E0 45 <1} o 22| replace 1/ lakse false false
(FRAME] P1F Desciiption a [ [ o 0 replace 1/ lakse ™ [
(FRAME| PRl Foater a [ 1 ] 1 replace 1/ lakse Ialse [
|FRAME) Eadet ] B 15 o 5 replace 1 lakse lalse (L]
[FRAME| P1f Help o 0 0 1] 0 replace 1 lakse false False
PAf HutiorBla [ [ [ ] 0 averday 1/lakse false [
Fi Home i i [ o 0 raplace 1 lakse false [
TOTAL =l | EEE 257 [1} 210

These guidelines apply to HMI applications developed via FactoryTalk View SE

software. Make sure:
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« The FactoryTalk View SE system is correctly installed and configured

(software version, operating system, computer requirements) according

to the PlantPAx system characterized architecture.

«+ Design the FactoryTalk View SE system to accommodate future
additions.

« Develop your HMI displays according to ISA 101 standards

FactoryTalk View SE System

Verify that the HMI server attributes comply with these recommendations.

PASS Tab: FactoryTalk View SE (HMI)
Row Guidelines Description
b Number of Displays The total number of displays does not exceed the display license.
Total Tags on Server
510 Unique Tags Verify that there are no warnings or errors from the Graphic Audit Tool. Consider simplifying any displays
Expressions with warnings or errors.

Global Objects

Display Settings
Display Type
Display Cache
Always Updating
Graphic Update Rate

For display settings, specify:

« Display Type = Replace

« Display Cache = No

« Always Updating + not checked

Verify that the update rate is within recommendation of 0.5 seconds. Any faster rate has a possible impact
on the server and controller.
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FactoryTalk Alarms and Events Server

There are two possible types of alarms on the PASS:
« Server Tag-based alarms
« Logix Tag-based alarms

Server Tag-based Alarms

Server Tag-based alarms that are defined within the FactoryTalk Alarms and
Events server (default for 4.6 or earlier PlantPAx system releases that are using
the 4.1 or earlier Library of Process objects.)

The FactoryTalk Alarm and Event Setup dialog box provides the data.

B §# PlantPa<DCS
[} : Batch Area E] Alarm and Event Setup - RNA://SGlobal/PlantPAxDCS/FTAEArea/FTAE T S
[ a
= L || E AL|e
Alarm and Event Setup
L s FRServerBres Messages Tag Update Rates
7 E ORCArea " Toee [an
17 RSLEAres
(18 RSLEArea? ﬁLLA‘a"";m Hame & |Use Type Input Tag =
(0 RSLEArea3 FT"EEHPE ams AlamaAlwaysON Yes Digital AlamBlwaysON
115 RSLEAread CLX13 PC1_EM_125.T... Yes Digital /RSLEAread: (CLX13Proc
[ RILEAreas CLX13_PCT_EM_T25_T.. Yes Digial FRSLEAeak:(CLR1 3P0
System CLX13_PCI_EM_T25_T... Yes Digial FRSLEAread:(CLT 3P0
Action Groups CL3_PCI_EM_125_T... Yes Digtal /RSLEAread- (CL 3Pro;
Palicies CLX13PCI_EM_125.T.. Yes Digtal /RSLEAread- (CL41 3Proc
138 Computers and Groups CLX13_PCT_EM_125_T.. Yes Digital /RSLEAread: (CLX1 3Proc
(58 Nebworks and Devices CLX13_PCT_EM_T25_T... ‘Yes Diial /RSLEAEad(CLRI 3P0
57 Users and Groups CLX13_PCI_EM_T25_T... Yes Digial /RSLEAread:(CLT 3P0
Connections CL3_PCI_EM_T25_T... Yes Digital FRSLEdraad-[CL 3Pro;
A CL13PCI_EM_125.T.. Yes Digital /RSLEAread-(CL41 3Proc
CLX13_PCT_EM_125_T... Yes Digital /RSLEAread: (CL%1 3Proc
CLX13_PCT_EM_125_T... ‘Yes Diial /RSLEAEad(CLRI 3P0
CLX13_PCT_EM_T25_T... Yes Digital FRSLEAeak:(CLR1 3P0
CLX3_PLI_EM_125_T... Yes Digial FRSLEAead:[CL 3Pro;
CLX13PCI_EM_125.T.. Yes Digital /RSLEArmad: [CL Proc
et S == e
Alsrtns - 1537 tems Detaul mas shelva time; 480 Minutes

e PlantPAxDCS

1108 Batch Area E) Alarm and Event Setup - RNA//SGlobal/PlantPAxD CS/FTAEArea/FTAE e EL
S FTAEAres
B FTAE a B AL e
5] Alarm and Event Setup -
) E HMIServerfirea All Alarms MEssagEs
[ OPCAres Updste Riate  TagHame =
17 E RSLEArea 2 /RSLE Aread::[CLX1 3 Program: PCT_EM_125. Tw/_ALM_P_AINT.Alm_Fai

1 ROLEArRa2 /RSLE Areat:[CLX1 IPragram:PC1_EM_125. Tw!_ALM_P_&IN1.Alm_Hi
10 RLEAread /RSLEAreat:[CLX1 IPragram:PC1_EM_125.Tw_ALM_P_AIN1.4n_La
8 RSLEAread /RSLEAreat:[CLX1 3PragramPL1_EM_125.Tw_ALM_P_AIN1 Cfa_FaiSeveity
| 4 RSLEAreaS /RSLE Aread::[CLX1 3Pragram:PC_EM_125.Tw_ALM_P_AIN1.Cfa_HiSeverlty
Systern /RSLE Aread::[CLX1 3Pragram:PC_EM_125.Tw_ALM_P_AIN1.Cfg_LeSeverity
Action Groups /RSLEAread::[CLX1 3Pragram:PC1_EM_125.Tw!_ALM_P_AIN1.Fai Cig_ManShelT
Bolicies /RSLE Aread: [CLX13Program:PE1_EM_125 Tw!_ALM_P_AIN1 Fai Com_AE 1

/RSLE Aread::[CLX1 3[Program: PC1_EM_125 Tw/_ALM_P_AINT Fail Com_AE.10
/RSLEAresd: [CLX1 3 Program: PC1_EM_125. Tw/_ALM_P_AINT Fai Com_AE.11
/RSLE Aresd: [CLX1 3]Frogram: PC1_EM_125. Tw/_ALM_P_AINT Fail Com_AE.4
/RSLE Aresd: [CLX1 3]Program: PC1_EM_125. Tw/_ALM_F_AINT Fai Com_AE.5
/RSLEAresd: [CLX1 3 Program: PC1_EM_125.Tw/_ALM_P_AINT Fail Com_AE.7
/RSLEAresd: [CLX1 3|Program: PC1_EM_125.Tw/_ALM_P_AINT Fail Com_AE.8
/RELEAread: [CLX1 3 Frogram FC1_EM_125.Twi_ALM_F_AINT Hi Cig_MaxSheliT
/RELEAread: [CLX1 3 Frogram FC1_EM_125.Twi_ALM_F_AINT Hi Com_AE.1
/RLEAreat: [CLX1 3 Frogram: FCT_EM_125. Tw/_ALM_F_AINT Hi Com_AE.10
/RLEAreat: [CLX13|Program: FCT_EM 125, Tw/_ALM_P_AINT HiCom_AE.11
/RSLE Aread: [CLX1 3 Frogram:FC1_EM_125. TW/_ALM_F_AIN1 Hi Com_AE.4
/RSLE Aread: [CLX1 3|Frogram:FC1_EM_125. TW/_ALM_F_AIN1 Hi Com_AE.6 -

Tags - 15805 items Default: 2 = Seconds

Camputers and Groups
1§ Networks and Devices
Users and Graups

Connections

Permission Sets

[T O N O N N N A O i Y

Logix Tag-based Alarms

Logix Tag-based alarms are configured in the Logix Designer software and
stored in controller memory. They are processed directly by the FactoryTalk
Linx data server and do not require a Tag Alarms and Events server. This alarm
type is used by version 5.0 and later of the Process Objects Library.

To determine the number of Logix tag-based alarms:

1. In Logix Designer, export the alarms for each of the controllers with a
defined shortcut on the FactoryTalk Linx (Instance o1) data server.
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2. Open the export file in Excel and filter on Use = True to total the number
of in-use alarms. Record this value in the appropriate row in the
Checklist spreadsheet. Repeat these steps for FactoryTalk Linx (Instance
02) if necessary.

Tools | Window  Help

| Options... o ["; ri“-’- E“‘ |:""
Security
q& Drocumentation Languages... 4 2
' : Favorites Add-On
Import 4
Export L4 Tags and Logic Comments... m

= Component...
4 EDS Hardware Installation Tool :
Alarms...

Motion 4 Alarm Definitions...

Monitor Equipment Phases

Instruction Usage... 1]

Plug-In Manager... m_|OFault | TRIP P_DISCRETE_INPU
m_|QFault | TRIP P_DISCRETE_QUTI

custam Tools.. m_OnFail | TRIP P_DISCRETE_OUTE

&  ControlFLASH Plus m_OffFail | TRIP P_DISCRETE_OUTF
T (| IO TS RETE THTTEI T TAIm In#llTen [ TRID P MISCRFTE OUITE

3. Verify that the alarm server attributes comply with these
| recommendations.

PASS Tab: FactoryTalk Alarms and Events

Row Guidelines Description

% Number of Server Tag-based Alarms (FactoryTalk Alarms

and Events) The FactoryTalk Alarms and Events server supports 20,000 Server Tag-based alarms

Informational field provides a total number of items on the Tag Update Rates of the FactoryTalk

17 Total Items (Server Tag-based alarms only) Alarm and Event Setup dialog box

Update rate recommendation is greater than or equal to 1second. Default is 2 seconds to help

18 Fastest Update Rate (Server Tag-based alarms only) reduce load on the system

All tags associated with Server Tag-based alarms are
from a data server that is hosted on the same PASS as
the alarm server.

The alarm server references the data server that is hosted on the same computer. Move non-
compliant alarms to the appropriate alarm server associated with the data server.

20 Number of Logix Tag-based Alarms (FactoryTalk Linx FactoryTalk Linx instance 1supports 15,000 Logix Tag-based alarms

I I N S O .
—
«©

Instance 1)
20 ll\:]l;rtgt;]igozf)Loqix Tag-based Alarms (FactoryTalk Linx FactoryTalk Linx instance 2 supports 15,000 Logix Tag-based alarms
22 Total Alarms (Server Tag-based + Logx Tag-based; sum The total number of alarms does not exceed 30,000 per PASS

total of previous 3 rows)

Generate the FactoryTalk View Report

The FactoryTalk View Report can automatically generate some of the required
data for the PASS and Controller worksheets. Use the following steps to
configure and generate the report.

IMPORTANT The provided global object, display files, and images in the checklist file must be installed in the HMI before
printing the report. The display files include the following:

Images: icon_gray.png, icon_green.png, icon_yellow.png, icon_red.png
Global object: (RA-LIB) Report.ggfx
Displays: (RA-LIB) Report RSLinxE.gfx, (RA-LIB) Report Controller.gfx, (RA-LIB) Report Controller 5x80.gfx

The information can be found in Knowledgebase Technote, PlantPAx System Release 5.10 Configuration and
Implementation Toals.

1. For each controller, select the appropriate diagnostic Add-On
Instruction. Diagnostic Add-On Instructions are available in the Library
of Process Objects. This library can be downloaded from the Product
Compatibility and Download Center at rok.auto/pedc.
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Use the following guidelines to determine which instruction to use.
« Ifthe controller is from the 5x70 family, use the L_CPU instruction.

« If'the controller is from the 5x80 family, use either the L CPU_5X80
instruction (4.1 library and earlier) or the raP_Dvc_LgxCPU_5X80 (5.0
library and later).

2. For each controller, import and conﬁgure the appropriate Add-On
Instruction. Verify ‘that the instruction's tag is controller-scoped and
named “L_CPU” for the L_CPU or L_CPU_5X8o. If the
raP_Dvc_LgxCPU_5X80 is used the tag name must be
“raP_Dvc_LgxCPU”.

3. The instruction must have Data Collection enabled from the
maintenance tab on the faceplate.

See Rockwell Automation Library of Logix Diagnostic Objects,
publication PROCES-RMo03 for more information on the L_CPU and
L_CPU_s5X80 Add-On Instructions.

See Rockwell Automation Library of Process Objects, publication
PROCES-RM200 for more information on raP_Dvc_LgxCPU_5x80
Add-On Instruction.

4. In FactoryTalk View Studio, go to Global Objects file (RA-LIB) Report and
select the Show Data Server and Controller Report Displays button.

2 FactoryTalk View Studio - View Site Edition (Network Distributed) - [E] x

File Edit View Settings Objects Arrange Animation Tools Window Help

‘MES8 usE O L ACr IR IATIHIAE DR RFAQACER E =T LG+ F
Explorer - HMI Server M Ml [ (ra-1ib) report - /PlantPAx_HMI//HMI (Global Objects) % _
BT HMI Server ol N
5 Systern {ra-lib} report - /PlantPdx_HMI//HMI (Global Objects)
i.B2 Command Line
F- 00 Hil Tags L} LI
=L Gfa[?_h‘cls Show Data Server
L?-%'Sg aYSh_ u and Contraller o
i raphic i
Report Displays
~B Motars i i

B RA_APP_Display " "

Global Objects
-B (ra I|b) repart

5. Copy the Global Object button and paste on to desired display.
6. Select the button and open the Global Object Parameter Values.
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7. Under Tag on the Global Objects Parameter Values dialog box, click
Browse (ellipsis “...”) browse to select a controller shortcut.

W1 Global Object Pararneter Yalues

Hame Walue Tag Description
1 |#1 I ess [hstshorteut > "
7 |#z wee Tlond Shortaut & Tag Browser
3 |#3 ==+ |3rd Shorteut Select Tag
i e [ Folders Contents of /Area/Data::LGXC01 /Onine/DAS000
6 |#6 6th Shortout
7 ez 7th s gttizt i A | Marne Access Rights  Description ol
& _J#8 Bth Shortout = [D";i%?““ & bckDe.  ReadWrite
9 #3 9th Shortcout o
10_l#10 10th Sherteut 20 300 Faultcod & bokFal  Readiite
& i & Ack_Int.,  ReadWirite
a i & Ack_I0..  ReadWWhite
0 Aoia & Bin_Fal  Readwrite
.03 KD & AlmDe.. ReadiWite
W21 FOT100 & Almdnt... Readiiiite
@ FTi00 & Am_I0..  Readiite
o {3 FTI00 Dve & CfgDe. Readiite
-3 FrIona & CfgDe. Readirite
-1 GRPMTRI00 & fg De. Resdiiite
2 GRPMTRIO0 | & Cfa De. ReadWirite
(2 GRPMTRIO0Ir | & Cfg Fail  ReadWrite
-0 GRPMTRIOIr v || & Cig int.. Readiirite
< > v
Refresh &l Folders| T fiter ~]
Selected Tag
| #breaiData [LGRCOTIP4SDI00 |
Home area /DATA
[ ok ][ cace [ Hen |

8. Enter a shortcut path. Use the syntax {/Area/Server::[Shortcut]}. Repeat
until all shortcuts from FactoryTalk Linx Instance o1 are added. Add a
new button and repeat process for FactoryTalk Linx Instance o2 if

necessary.
B Global Object Parameter Values x
MName Value Tag Description
1 |#1 4 Area/Datas[LanCOl Tk +++ | 1st Shorbcut
2 |#2 +++ _|2nd Shorteut
3 |#3 +++__|3rd Shortcut
4 |#4 +++ _|4th Shorbcut
S |#5 +++ |Sth Shorkeut
6 |#6 +++ _|Bth Shorteut
7_1#7 +++ | 7th Shorbcut
g |#*6 +++ |Bth Shorkeut
9 |#9 +++ _|9th Shorteut
10 j#10 +++ _|10th Shorteut
< >
Cancel Help

9. Run a FactoryTalk View Client session and click the Show Data Server
and Controller Report Displays button to generate a report.
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Controller Verification.

Use the information in this section

to complete the Checklist.

(==

(RA-LIB) Repart RSLinxE - /PlantPAx/fArea
Data Servers
Press to Show =]
Controller Shortcut Controller Path Shorteut Hotes
Report Display
Jarea/Data:[LEXCOL] |RSLogx 5000 Ernulator inslot 2 of the virual backplare .
fares/Data[PlantPix] |RSLogix 5000 Ermulator in slot 3 of the virtual backplane .
Jarea/Datas[LGXCO1B] [RSLogx 5000 Emulator in slotd of the virtual backplane
Jirea/Data:[PlantPaxB] |RSLogix 5000 Emulator in slotS of the virtual backplane
Virtual Memory 559172
FPollcd | Avg Packels | Aug Packet
Notes
Controller Shorteut Data Hems | _per Second p Time | Results
Jares/Datas[LGHCO1] 3 ] [} o
» férea /Data;[PlantPix] 25233 75 2 o
fdrea/Data [LGXCO18] 2 2 2 4
firea/Datas]PlantPaxB] 25230 2 2 s
Press to Refresh Totals 50466 43 2
Hame: Signature: Date:
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FactoryTalk Linx Data Server

For each shortcut, verify:
| PASS Tab: Data Server (FactoryTalk Linx Instance 1and Instance 2)

Row Guidelines Description

Select Yes or No to indicate if the Data Server is in use. If yes, then record the memory usage (MB)
from the computer's task manager. PlantPAx recommends the memory usage of each instance of
FactoryTalk Linx not exceed 3,000 MB.

17 Task Manager - O X
File Options View

Processes Performance Users Details Services

19% 47%
Name Status CPU Memory
@ EPCommissionWebSer (32 bit) 0%  146MB "
@) Event Client Multiplexor (32 bit) 0% 54MB
@) Event Server (32 bit) 0% 30MB
[ FactoryTalk Activation Daemon (32 bit) 0% 20MB
I 23& 37 | Memory Usage [E FactoryTalk Diagnostics Reader (32 bif) 0% 100ME
[ FactoryTalk Historian Agent (32 bit) 0% 19MB
v [ FactoryTalk Linx Instance02 OPC Runtime Service (32 bit) 0% 493 MB
&, FactoryTalk Linx Instance02 Service
@ FactoryTalk Linx Net Browser Manager (32 bit) 02%  321MB
v [5 FactoryTalk Linx OPC Runtime Service (32 bit) 0% 67.9 MB
-, FactoryTalk Linx Instancel1 Service
[55] FactoryTalk Linx Security Server (32 bit) 0% 19ME
0 FactoryTalk Linx Services (32 bit) 0% 31.6 MB
@ FactoryTalk Linx Services (32 bit) 05%  3SMB
L‘ FactoryTalk Linx Services (32 bit) 0% 309 MB o
Fewver details End task

24-50 | Number of Polled Data ltems The number of tags that are polled from the controller.

If your controller consistently exceeds the recommended maximum average packets per second,
it's possible your controller is overloaded. Cansider reducing the number of HMI data paints that
are referenced by your HMI displays from that controller. You can also change the display update
rate if you're experiencing performance issues.

The average packet response time of messages to the controller.

If your average packet response time consistently exceeds 200 milliseconds, then it's possible that

your communication adapter has a potential bottleneck. Consider the following troubleshooting

guidelines if your performance isn't satisfactory:

« Examine your network architecture and network hardware. You could be exceeding your switch
capacity or capabilities that can cause slow network performance.

« You could be using an outdated communication adapter in the path to your controller. Or, you
could be exceeding the capabilities of the communication adapter.

24-50 | Average packets per Second

I 24-50 | Average Packet Response Time
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| FactoryTalk Linx OPC UA Connector
[| PASS Tab: Data Server (OPC UA Connector)
Row Guidelines Description
51 Using OPC UA Connector The OPC UA connector should be hosted on a dedicated computer with no other servers (HMI,

Alarm, or Data) present.

The OPC UA server shouldn't have more than 20 OPC UA connections.

Facton/Tulk Line GG UA Carmct o

gy Comectn St TPCTIA Frmasy) | GPCOTH (Saconstinyt

B » Number of OPC UA connections : m“
P
[ | The OPC UA server shouldn't have more than 50,000 active tags.

FactanyTalk Lins 05 LA Conneshar

S FactoryTalk Live Data Active Tags o fen
o=
[ | The OPC UA server shouldn't have more than 50,000 tag updates per second.

FactanyTalk Lins 05 LA Conneshar

g oot Sctes Fiosd T

() Pty [rep——— Merderes 1ag

-
o

g % FactoryTalk Live Data Active Tag Updates/sec

Lirspost Frosessg Tree immte
T p——"

B L
i R Showra D Al o Chty o hagpareg] e amablet

Faled frdpocts
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PASS Tab: Data Server (OPC UA Connector)

Row Guidelines Description
Determining the number of Alarms and Conditions for each OPC UA server that is configured in the
connector. Each connection that is counted in Row 52 must be reviewed individually as specific
55 Total OPC UA Alarms and Conditions configurations of OPC UA servers can vary. The sum total of all alarms and conditions across all

connected OPC UA servers shouldn't exceed 5000. Consider reducing the number of OPC UA alarms
and conditions if there are more than 5000 total across all OPC UA servers.

Controller 5x80 Tab

Controller 5x80 Tab: Properties

The Controller tab records controller properties.

IMPORTANT  Make a copy of this worksheet for each 5x80 controller in your
system.

To gather information for the checklist, you can use the FactoryTalk View
report, see Generate the FactoryTalk View Report.

Select the button shown in the following display to view the Controller Report

Display.
Prisss T Shin
Controller Shortcut Controller Path Shortcut
Report Display

JareaData; [LExC0l] (RELog: 5000 Ermulator in s ot 2 of the virtual backplan

| —

_,-'.-\.re.a_u’l:lata:_:zlanlj:‘.-h| Rl g BO00 Ervulator inslat 3 of the virtud backplane |

farea/Data [LGHCOLE] |RELog: 5000 Ermulator in slot 4 of the vimua backplage |

Sfarea/Data:[PlantPaxck] |RELog: 5000 Ermulatorn inslot'S of the vimua backplarps |

Controller Properties

Verify that the controller properties comply with these recommendations.

Row Guidelines Description
4 Shortcut Keep the shortcut, ACD file reference, and controller name similar (intuitive).
5 Firmware Verify the firmware revision.
6 Module The controller is indicated as available in the PSE.
The controllers in the PSE have been characterized for use within a PlantPAx system.
i’ Redundancy Indicate whether you're using a redundant controller (Yes/No).

Controller 5x80 Tab: CPU Use

CPU Use

Verify that the CPU use complies with these recommendations.

Row Guidelines Description
R At least 25% free for Redundant 5580 controllers. Non-redundant 5x80 controllers can utilize up
8 Logix Engine to 100% of the Logix Engine.
9 Communications Core At least 40% free.
10 Packet Processing Engine At least 25% free.
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Controller 5x80 Tab: Faults

Faults

Verify that the fault handling complies with these recommendations.

Row Guidelines

Description

ll Minor Faults Count

Number of minor faults that have occurred within the controller.
After clearing the minor faults, monitor for a period of time (at least several controller scans)
before reverifying.

12 Task Overlap

Whether a task overlap occurs.

A task overlap must be resolved. Use the predefined task model in the process controller or
simplify the program.

Lengthening the period or raising the relative priority of important tasks disables the predefine
task model in a pracess controller.

Controller 5x80 Tab: Capacity

Capacity
Verify that the controller capacity complies with these recommendations.

To verify controller capacity, open the controller application file in Logix
Designer. Go to Controller Properties > Capacity tab.

Row Guidelines

Description

13& 14 | Program Memory (blocks)

Reserve at least 20%.

15&16 | Nodes

Reserve at least 20%.

Connections

Verify that the total number of connections is 75% or less of the controller

maximum.
Controller 5x80 Tab: Connections
Row | Guidelines Description
Total number of connections includes:
: :D/Pnduced tags
Consumed tags

17-25 | Total I/0

« Messages

« Incoming

» Unconnected buffers
« Message cache

Controller 5x80 Tab: Time Synchronization

Time Synchronization

Verify that the controller is configured for time synchronization.

Row Guidelines

Description

26 Controller is time synchronized

Denotes if the controller is configured for time synchronization (Yes/No).
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Task Structure

Verify the controller program uses only periodic tasks.

Controller 5x80 Tab: Task Structure

Row

Guidelines

Description

27
i

Only periodic task used

Use only periodic tasks and remove any unused tasks
The process controller enforces 4 periodic tasks: Slow, Normal, Fast, and System.

Controller Alarms

Verify the number of controller alarms.

| Controller 5x80 Tab: Controller Alarms

Guidelines

Description

Total number of Logix Tag-based alarms (both IN-USE
and NOT)

The total number of Logix Tag-based alarms (both IN-USE and NOT) stored in a controller
shouldn't exceed 10,000. See Logix Tag-based Alarms on page 296 to determine the number of
alarms on a controller.

Total number of Logix Tag-based alarms (IN-USE only)

The total number of Logix Tag-based alarms (IN-USE only) stored in a controller shouldn't exceed
7500. See Logix Tag-based Alarms on page 296 to determine the number of alarms on a
controller.
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Controller 5x70 Tab

Controller 5x70 Tab: Properties

The Controller tab records controller properties.

IMPORTANT  Make a copy of this worksheet for each 5x70 controller in your

system.

To gather information for the checklist, you can use the FactoryTalk View
report, see Generate the FactoryTalk View Report.

Select the button shown in the following display to view the Controller Report

Display.
Presss T Shiny
Controller Shortcut Controller Path Shiorbcul
Reepiort Display
JhreaData:|LExC0l] RELog: 5000 Ermulator in ot 2 of the virtual backplarj= I <4—

JareafDatas[Flant®es] [Rilog: 5000 Ermulator in slot 3 of the virtusl backplane |

fireaData[LERCOLE] [ReLog: S000 Ermulamor inslon 4 of the virue backglans |

Sarea/Datac[PlantPaxB] |FELog: 000 Emulamor inslotS of thavimua backplangs |

Controller Properties

Verify that the controller properties comply with these recommendations.

Row Guidelines Description
b Shortcut Keep the shortcut, ACD file reference, and controller name similar (intuitive).
5 Module The controller is indicated as available in the PSE. o
The controllers in the PSE have been characterized for use within a PlantPAx system.
g 6 Firmware Verify the firmware revision.
i’ Redundancy Denotes if you're using a redundant controller (Yes/No).

Controller 5x70 Tab: CPU Use

CPU Use

We recommend CPU load in a production environment to be 75% or less. Keep
25% CPU capacity as reserve to handle online edits, data server switchover, and

SO on.

Verify that the CPU use complies with these recommendations.

Row Guidelines Description
8 Free At least 50% of free for redundant controllers
i At least 25% for simplex controllers.
g 9 Total Used Total CPU utilization
The percentage of CPU use to run all application cade in the controller.
10 Total Used: Periodic Tasks Periodic tasks are the only predictable task type on performance and utilization. Keep the
number of tasks to 3 or 4 and do nat use to organize code into process areas.
g Total Used: Communication The percentage of CPU use that is needed to respond to communication requests.
[ Total Used: Motion The percentage of CPU use that is needed to execute motion.
g © Total Used: Messages The percentage of CPU use that is needed to process messages.
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Controller 5x70 Tab: CPU Use

Row Guidelines Description

14 Total Used: Safety The percentage of CPU use that is needed to execute safety tasks.
15 Total Used: Redundancy The percentage of CPU use that is needed to process redundancy.
16 Total Used: System The percentage of system resources

Controller 5x70 Tab: Faults

Faults

Verify that the fault handling complies with these recommendations.

Row Guidelines Description
Number of minor faults that have occurred within the controller.

17 Minor Faults Count After clearing the minor faults, monitor for a period of time (at least several controller scans)
before reverifying.
Whether a task overlap occurs.

18 Task Overlap A task overlap must be resolved. Make changes such as simplifying programs, lengthening the

period, or raising the relative priority of important tasks.

Controller 5x70 Tab: Memory Use

Memory Use

The PlantPAx system requires the free I/O memory to be a minimum of 25% for
simplex controllers. We recommend greater than 50% free memory for
redundant controllers.

Row

Guidelines

Description

19&20

1/0 Memory (bytes)

Reserve:

« At least 50% for redundant controllers

« At least 25% for simplex controllers

If the amount exceeds the recommendations, reduce the number of /0 modules that are
scanned by this controller, make system changes.

21822

Data and Logic (bytes)

Reserve:

« At least 50% for redundant controllers

« At least 25% for simplex controllers

If the amount exceeds the recommendations, upgrade controller for more memory or make
changes to reduce load

Connections

Verify that the total number of connections is 50% or less of the controller

maximum.
Controller 5x70 Tab: Connections
Row Guidelines Description
Total number of connections includes:
: :D/EUduced tags
2331 | Total 0 Consumed tags

« Messages

« Incoming

» Unconnected buffers
« Message cache
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Time Synchronization

Verify that the controller is configured for time synchronization.

Controller 5x70 Tab: Time Synchronization

Row Guidelines Description
[ Contraller is time synchronized Denotes if the controller is configured for time synchronization (Yes/No).
Task Structure
| Verify that the controller program uses only periodic tasks.

Controller 5x70 Tab: Task Structure

Row Guidelines Description

Use only periodic tasks and remove any unused tasks

| JEY Only periodic task used Use only 2-3 periodic tasks (slow, normal & fast) for logic and remove any unused tasks
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HMI Communication Lost

PlantPAx Troubleshooting Scenarios

Figure 23 shows a basic workflow to correct lost communication. To target the
root cause, follow this workflow:

Figure 23 - Resolve Lost Communication

Communication
Lost

h 4
Server/Controller
Comm Evaluation

See page 309

Separate Procedures with Specific Workflows

A4
Client/Server
Comm Evaluation
See page 314
R

¥
Call Technical
Support
See page 314
—_—

If you can’t open a FactoryTalk® View SE client application on your OWS, go
directly to the Client/Server Communication Evaluation section on page 314.

Server and Controller Communication Evaluation

Figure 24 shows how to diagnose a loss of communication between the (PASS)
server and the controller. Make sure that the server has good quality
communication with the controller and follow down the workflow to rule out
any network issues.

Click the link or go to the respective page for specific information on each
topic. If the server checks out okay, then you have the option to go to the client
computer for additional troubleshooting or to call Technical Support.
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Figure 24 - Resolve Server to Controller Communication

Server/Controller
Comm Evaluation

Live Data Current Quality Good
See page 310

Live Data
Quality Good?

Yes

Was Server Servers Evaluation

Worked Before

r Status 0K? See page 312 Comm Loss?
No
Network Evaluation
See page 312

Call Technical Support Application Code Evaluation

See page 314

1l

See page 314

Live Data Current Quality Good

This procedure examines whether the controller communication is available at
the server level. If the current quality is ‘good’, then you can rule out that the

server isn’t talking to the controller.

1. Goto FactoryTalk Tools > FactoryTalk Live Data Test Client and select

Client/Server Comm

See page 314

FactoryTalk and Network as the Initial Connection.

The Initial Connection dialog box appears.
B |nitial Cannection [m] x

(" OPCDAServer | Factory Talk | ¢ Load Config File

oK
Select FactoryTalk Directory =
Cancel

Select the directory pou want to use.

|Network ﬂ owse
Help
I DK I Cancel | Help ‘

= o] JPassm

OPC DA Server Locale ID: |1033
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2. Browse to the data server area and click OK.

B Initial Cannection O x

¢ OPCD&Server Factom Talk ¢ Load Conlig File

- FTViewDemo ~ I oK I

& InstantFizz

- PlantPds_HMI Cancel |

L HMI
EI DATA

: Server 2 &I
- [Ran v neo |

OPC D& Server Machin

= Local = Remote IF‘ASSm ‘
OFC D& Server Locale 1D |1 033

3. The Create Group dialog box appears.
4. Use the default or type your own group name and click OK.

Create Graup b

Mame: | [EETE 1 | [al3 ||

Update Rate: | 260 Cancel I

Active: v Help I
Locale ID: [1033

5. Inthelower, left pane of the Add Item dialog box, browse to the
controller, and select Online.

BoAdd e

ItemlD Items to ddd: 1

((HE=TRE BTN I VPSR TR - (L G0 [Program:PS _PALXT 00 Inp ChanFau

Datatype Cancel
Mative >
Advanced

¥ Active
fdd Branch Item Prapetties | Help

F=T100 Ing ChanFaul

= RN /3G lobal/PlartPdx_HiMl: A

B LBxC0 KT100_Inp_MadFault
: 5T 100 Inp_PA/Data
i tems <T100Inp_PUncertain

ATU_FIC_101
AENZTR:T.C
AEMZTR:11
AEMZTR:1:0

AITI00

AIT3004

AIT3004_Dve

AITI00B

< >

v

6. Intheright pane, if no tags appear then proceed to Servers Evaluation on
page 312. Otherwise, click any tag in the controller and add the item.

The FactoryTalk® Live Data Test Client dialog box appears.

| BOOTP-DHCP Server
FactoryTalk Activation

v v

| FactoryTalk Alarms and Events > Accessibility >

FactoryTalk AssetCentre Client » | |, Administrative Tools >

# || FactoryTalk Historian SE » | |l CodeMeter .

[ Diagnostics Viewer | FactoryTalk Tools | Embedded Lockdown Manager >

{8 FactoryTalk Diagnostics Counter Monitor |, FactoryTalk View + | |\ Enterprise License Manager 3

%5 FactoryTalk Directory Configuration Wizard |\ Logix Designer Tools 8 FLASH Programming Tools B

= _FactonTalk Help J. RSLinx + | |\ Hiprom Software 3

FactoryTalk Live Data Test Client |\ RSLegix 5000 Enterprise Series + | |\ LoopPre Tuner (Reckwell Autemation Edition) b

Bctory Talk BECUrTTy System Configuration Guide ' | RSLogix 5000 Tools » | 1 Maintenance >

Import RSSecurity Configuration ). RSLogix Emulate 5000 » | l. Microsoft Office >

Log On te FacteryTalk |, RSNetWonc » | Ji Microsoft SQL Server 2008 >

RSSecurity Emulator Install . utilities » | 1) Microsoft SOL Server 2008 R2 >

Specify FactoryTalk Directory Location FactoryTalk Administration Console | Microsoft SOL Server 2012 .

£ Windows Firewall Configuration Utility & Restart View Designer Services |\ Rockwell Automation »
& Studio 5000 | Rockwell Software

i . SharePaint 5

g |, Startup 3

I VMware >

| Windows Accessories >

. Windows System >

7. Check that the Current Quality is ‘Good’.

The ‘Good’ status indicates that you have communication from the
server to the controller.

If the status is ‘Bad’, then proceed to Servers Evaluation.
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Servers Evaluation

This procedure verifies that at least one server has active status. Complete
these steps for the Data server and HMI server.

1. Inthe FactoryTalk® Administration Console or FactoryTalk View Studio,
right-click the Data server and choose Server Status.

iri| FactoryTalk View Studio - View Site Edition (Metwork Distributed)

File View Settings Tools Window Help
mHS b0 R ROE w0

Explorer - HMI Server - 3

= Metwork (LOCALHOST)
=g PlantPoo HRI
w0 Runtime Security
IT Seripts
B DATA
= E Server
BE! FactoryTalk Linx Instance 01
mf Communication Setup
w B Server2
cEE FTAE
2B Tag Alarm and Events
5 Alarm and Event Setup
= HMI
e EE™
[l Syste
Ec
ke HMI
@ T Server Status...
] Grap Properties...

Delete

Add Controller Instruction Faceplates.,

The Data server status dialog box appears.

Server Status - PlantPAx_HMI/DATA/Serverl:Factory Talk Linx 01 .

Server status
Primary server: PASS02

Primary status: || Active I ‘

Secondary server: PASS03

—
Secondary status: I| Sbﬂdbyl |

Switchover options
() Continue using the secondary server even when the primary server becomes avaiable again

(®) Switch over to the primary server when it becomes available

Server switchover

Click the Switchover button to switch the Active server. The server thatis currently on
standby will become the Active server and the Active server will become the Standby server.

T

Switchower

2. Make sure that the status is ‘Active’ for at least one of the servers.
3. Repeat for the HMI server.

Was Modification Made?

If you found an issue and made a correction, go back and redo the Live Data
procedure. Reverify that communication has been established between the
server and controller.

Network Evaluation

Now you’re analyzing whether the shortcut to the controller is valid. An
incorrect path affects the controller communication to the server.

Ve In a redundant system, perform these steps for the Primary and
&’  Secondary servers.
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1.
open the Communications Setup.

2l FactoryTalk View Studio - View Site Edition (Network Distributed) - [Communication Setup - ://5Global/PlantPAx_HMI/ /Server 1/FactoryTalk Link Instance
El FactonyTalk vi Studio - Vi Site Edition (Metwork Distributed) - [C tion Sets RNA://5Global/PlantPAx_HMI/DATASS 1/FactoryTalk Linx Inst; 1
IEﬂ File View Settings Tools Window Help

:

O %

; R =T

= [ Metwork (LOCALHOST) ~

@ ﬂCommunicatl'on Setup - RNA://$Global/PlantPAx_HMI/DATA/Server 1/FactoryTalk Linx Instance 01 “

[ Command Line

. g Device Shorkcuts Frimary l
i?woagzntir;e Security Remave | Apply 192,168.1,108, 1796-EM2T, 1756-EN2T/D 2 ~
LT Scripts e A LGHCOL 192,188.1,107, 1756-EM2T, 1756-EM2T/D
—piE DATA 192,168.1,108, 1756-EM2T, 1756-EM2T/D 3
L Server 102,168.1.708, 1756-ENZTR, 1756-EMZTR/C &
5B FactoryTalk Linx Instance 01 192,168.1,110[192.168.1.109], 1756-EN2TR, 17¢
E é"'mﬂ Communication Setup 192,168.1,111, 1736-EM2TR, 1756-EM2TR/C
Gl Server 2 Backplane, 1756-A10/4 or B 4
S E FTAE ! v
-i Tag Alarrn and Events € 3
“dZ] Alarm and Event Setup Muode: Online Mot Brawsing
B LI_EEEMI_:M‘ Sepisr Offline Tag File | | Erowse... |
H Systern Shorteut Type |Processor =

Logix Extended Tag Properties

v Display pass-through values For tag extended

I¥ Upload all extended tag properties properties

i 15 HMI Tags
+ Graphics
+ Logic and Control
+ Data Log
= RecipePro+
= RecipePro+ Editor
= Systern
Act.iu.n Groups -
< o >

[a\| Ok | Cancel | Verify | Help‘

Select the controller shortcut.

If the shortcut does not highlight the correct controller, then select the

correct controller and save the shortcut.
With the correct shortcut selected, expand the backplane.

If you can browse, then you have communication to the controller.
Proceed to Was Modification Made? on page 314.

If you can’t browse, then try to ping the controller from the PASS.
To ping the controller, do the following:

a. Click Start and type CMD into the Search text box.
A command prompt OanS.

b. Type ‘Ping xxx.yyy.zzz.aaa’, where the letters represent the IP address

of the communication adapter.
If the adapter responds, a similar display appears as shown.

E¥ Comrmand Prompt

reserved.

1.111

= 1n milli-secon
& Average

C:wUsershRockwell Automation:

6. Ifyour device does not respond, a ‘Request Timed Out’

message appears.
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If the ping is successful, proceed to the next diagnostic action.
7. Repeat steps 2...6 if you're using a redundant Data server.

Was Modification Made?

If you found an issue and made a correction, go back and redo the Live Data
procedure. Reverify that communication has been established between the
server and controller.

Review Application Code Formatting

If the server and controller are communicating and the problem still exists, we
recommend that you check the project application code. Project components
could be incorrectly configured.

Verify proper Live Data syntax for the following project elements:
« FactoryTalk View SE or FactoryTalk View ME:
- Display parameter files
- Display values, expressions, and animations
- Global object parameters
- Command buttons and macros
- Datalogger
- Event detector
- Derived tags

Contact Technical Support

Call a Rockwell Automation Technical Support representative if the problem
still exists after checking the following:

« Server communication status
« Controller shortcut
« Application code syntax

Email technical support the most recent data that is compiled from the
PlantPAx® checklists.

IMPORTANT  If the size of the information packet can't be sent via email, a
technical support representative can help you post your information
to the Rockwell Automation FTP site.

Client and Server Communication Evaluation

Figure 25 shows a workflow to resolve lost communication between a (PASS)
server and a client. Work through the diagnostic activities until you identify an
issue.

Click the link or go to the respective page for specific information on each
topic. If the issue still exists, contact Technical Support with the details you
have compiled to help with a resolution.
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Figure 25 - Resolve Server to Client Communication

Client/Server

Comms Evaluation

h

Ping Command Evaluation - See page 315

Ping
Successful?

Yes

Was

e Name Resolution Evaluation - See page 316
Modification

Yes

b A

w Before?

Made?

Application Code
Evaluation

Call Technical Support
See page 314

See page 314

Ping Command Evaluation

To check if the client computer is communicating with the server, start by
pinging the computer.
Complete these steps.
1. Click Start and type CMD into the Search text box.
A command prompt opens.
2. Type ‘Ping (and server name)’.
3. Ifthe controller responds, a display appears similar to the following:

EH Command Prompt — O X

ghts reserved.

1] with

y from 17
y from
yw from
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4. Ifyour device does not respond, a ‘Request Timed Out’
message appears.

If the ping is successful, check your application code for proper
syntax. See page 314.

Also, make sure that the firewall rules are not blocking the
communication.

Name Resolution Evaluation

This procedure verifies the mappings of IP addresses to host names. The steps
apply if you're using a domain or a work group, with the latter explained last.

1. Atthe Command Prompt, type the NSLookup and server name and press
Enter.

2. Type the name of the server that is being pinged.

If you receive the message ‘DNS Request Timed Out’, you typically do
not have the Reverse Lookup Zone configured.

If the NSLookup ping provides the server name and IP address (as
shown in the example), the server communication issue still exists.

B Command Prompt - O x

kwell Automation»ping PAS

If the NSLookup ping does not provide a server name and IP address,
then proceed with the following instructions on page 316.

To verify that components do not have duplicate IP addresses, complete
these steps.
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1. From a DNS server, click Tools on the main menu and choose DNS.

[ Server Manager - O X

@ £ 4 Loca| Server 52 '.\g) | r Manage Tools View Help
Active Directory Administrative Center
_ 5= PROPERTIES Active Directory Domains and Trusts
I8 Dashboard . For PADCA Active Directory Medule for Windows f
Active Directory Sites and Services
= Computer name PADCA . :
W& All Servers Domain PlantPAx.RockwellAutomation.com Active Directory Users and Computers
i§l AD Ds ADSI Edit
= Component Services
1‘: Bligl Computer Management
em DNS Windows Firewall Domain: On Defragment and Optimize Drives
ii File and Storage Services b Remote management Enabled DHCP
Remote Desktop Disabled Disk Cleanup
NIC Teaming Disabled =1
Ethemet0 172.201.10 pi I
FTA Binding IPv4 address assigned by DHCP, IPvé enabled EapiE
Group Policy Management
iSCS Initiator
Local Security Policy
Operating system version Microsoft Windows Server 2016 Standard Viassh s S
Hardware information Viware, Inc. ViMware7 1 ODBC Data Sources (32-bit]
QODBC Data Sources (64-bit)
Performance Monitor
The DNS Manager display appears.
£ DNS Manager = ] *

File Action View Help
e @ XEez EmEEE

g‘: DNS MName Type Data
~ [ PADCA & asosios Host (A) 172.201.13
w [ | Forward Lookup Zones ASIHOT Host (4) 172.20.1.14
> 2| _msdes.PlantPAx RockwellAutomation.corr %\i{ﬂ Ho; A 172.20.1.16
+ = PlantPAx.RockwellAutomation.com AS05103 Host (A) 172.20.1.16
| Reverse !_ool(up Zones % HE ) 172.20.1.18
> Tnst Pomts OWsoT Host (4) 172.30.1.18
» || Conditional Forwarders =TEwso: Host (A) 172.20.1.22
E Ewsn Host (4] 172.20.1.54
£ Asosios Host (4] 172.20.1.58
= psosing Hast it 17270 1
EHEws10 Host (&) 172.20.1.60
&l owsoz Host (4] 172.20.1.60
E=135N Fost (&) TIT 20
& Asamm Host (4] 172.20.1.62
&l Passol Host (&) 172.20.1.64
& passn2 Host (4] 172.20.1.67
£ Pass03 Host (4] 172.201.69
& asosioz Host (&) 172.20.1.70
& AsiHOZ Host (4] 172.20.1.71
ElAsiHo3 Host (4] 172.20.1.72
< 2|« >

2. Verify that each name has its own IP address to make sure that you're
pinging the correct server via the client.

The example DNS Manager display shows several ‘bad’ computer
names with the same IP address.

3. Ifyou’re using a workgroup, open the hosts folder in your Windows local
hard disk drive.
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4. Using Notepad, open the hosts file.

=] = 1o -
Home Share Views (2]
5 / . ™ -
B O & cut B rove to - | 3¢ Delete - = e [#] open B setectan
sl Copy path - £ Edit Selectnone
Fin to Quick C Past I - | = N Frapert
L S SRR S ] bt shorteur & Copvio =l Rename b el EH inwert selection
Clipboard Organize Heww Open Select
T <« Lacal Disk (C) » ‘Windows > Systern32 > drivers > etc s Search etc o
B Desktop = Mame Date medified Type Size
[=] Documents [ mosts 7 hosts - Motepad — [m] b4
& Downloads [ 1 imhostssam | File  Edit Format  View Help
b tusic L metworks # For example: ~
| Pictures ] protocol #
B videos L] services # 182.54.94.97 rhino.acme.com # source serwver
- # 38.25.63.1@ ¥.acme.com # x client host
“ie Local Disk (C
# localhost name resolution is handled within DNS itself.
i Metwork
# 127.9.a.1 localhost
~ H# ekl localhost

5items 1 item selected 912 bytes

172.28.1.12 Ewsal

172.2@.1.13 Chs@l

172.28.1.14 PASSGL

172.28.1.15 PASSE2A

172.28.1.16 PASSE2B

172.28.1.17 ASTH@T

172.2@.1.18 ASIHSZ2

172.28.1.19 ASISE1 o
< >

5. Verify that each name has its own IP address to make sure that you're
pinging the correct server via the client.

Was Modification Made?

If you found an issue and made a correction, go back and ping the client
computer again.

Review Application Code Formatting

If the server and controller are communicating and the problem still exists, we
recommend that you check the project application code. See page 314.

Contact Technical Support

Call a Rockwell Automation technical support representative if the problem
still exists. See page 314.

Troubleshooting Scenario: Figure 26 shows a workflow to resolve sluggish HMI displays. To target the
Ligure 26 g8 play g
HMI Display Access is Slow 1ot cause, work through the diagnostic activities until you identify an issue.

If the issue still exists, contact Technical Support with the details that youw've
compiled to help with a resolution.
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Figure 26 - Resolve Slow HMI Display Callup

Communication
Performance

Application System Architecture Checklist - See page 284

Under Limits?

Controller Controller Checklist - See page 303 or page 306

Passed?

Data Server See page 301

Passed?

h 4

. Application Code
Network Checklist - See page 276
Network o Evaluation
Passed? o See page 314

Call Technical
Support
See page 314

Action Description
A good starting paint is to verify that your system design is within the sizing recommendations for a PlantPAx
Application Under Limits? system. Design attributes include the number of servers, number of assets, and so forth.

To verify design attributes, see the System Architecture Tab on page 284.

The next step is to check whether your controllers have the CPU and memory usage as prescribed by the
PlantPAx guidelines. These percentages vary depending on whether your application uses simplex or
redundant controllers.

For details, see the Controller 5x80 Tab on page 303 or Controller 5x70 Tab on page 306.

Controller Passed?

If the application design and controller setup are properly configured, check the Data server. Verify that the
Data Server Passed? server is communicating data from the controllers to the HMI server and operator workstation.
For details, see the FactoryTalk Linx worksheet section on page 301.

The health of the network is critical whether you're using a virtual or traditional operating system. There's a tool

Network Passed? for analyzing network infrastructure.
For details, see the System Infrastructure Tab on page 276.
Review Application Code Formatting For details, see page 314.
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Notes:
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Rockwell Automation Support

Use these resources to access support information.

Technical Support Center Find help with how-to videos, FAQs, chat, user forums, and product notification updates. rok.auto/support
Knowledgebase Access Knowledgebase articles. rok.auto/knowledgebase
Local Technical Support Phone Numbers Locate the telephone number for your country. rok.auto/phonesupport
Literature Library Find installation instructions, manuals, brochures, and technical data publications. rok.auto/literature
rll;ggg;:t Compatibility and Download Center Egtvgg!oad firmware, associated files (such as AOP, EDS, and DTM), and access product release rok auto/ocde

Documentation Feedback

Your comments help us serve your documentation needs better. If you have any suggestions on how to improve our

content, complete the form at rok.auto/docfeedback.

Waste Electrical and Electronic Equipment (WEEE)
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Rockwell Automation maintains current product environmental compliance information on its website at rok.auto/pec.
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